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1 Welcome

 Welcome 
 

Welcome to Trakker – Loan Servicing Software help documentation. Trakker software is a Loan
Servicing program that allows you to service loans of various types. This help documentation will
assist you in fully utilizing Trakker software to service your loans to the software's fullest extent.

The help documentation has been through many different authors and design phases. The current
version of the help file allowed us to relocate the Table of Contents to the left side instead of a long
Table of Contents page. This new format will allow you to locate the information that you are looking
for. The "BOOKS" are Chapters and the "PAGES" are the topics that contain information. If you are
unable to locate the information that you are looking for please use the Index also located on the left.

QUESTIONS AND ANSWERS
If you have any questions about the operation of the program, the documentation, or think the
program has a 'bug', you may contact Multi-Financial Services Company, Inc. by the following
means:

· Write Us:    Multi-Financial Services Company, Inc.
                                P.O. Box 14541
                           Tallahassee, FL. 32317
· Call Us:             850-559-9123
· E-Mail:              Sales Department: sales@thetrakker.com
                           Help Desk: support@thetrakker.com

· Visit our web site for submission of questions: www.thetrakker.com

mailto:sales@thetrakker.com
mailto:support@thetrakker.com
http://www.thetrakker.com
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2 License Agreement

License Agreement 
 Multi-Financial Services Company, Inc. Software License Agreement

This document is a legal agreement between you, the licensee, and Multi-Financial Services
Company, Inc. By using this program, you agree to become bound by the terms of this agreement and
under the laws of the State of Florida and the legal venue of Leon County. If you do not agree to the
terms of this agreement, simply indicate such at the end of this document. Then immediately notify
Multi-Financial Services Co.,Inc. for a full refund within 30 days of purchase, less a 20% restocking
fee. After 30 days there will be no refund!! Refunds are contingent that a full demo of the  program has
been completed with a Multi-Financial Services Co., Inc. salesperson and your company's servicing
manager.

In consideration of paying the INITIAL ONE-YEAR license fee, which is a part of the price evidenced
by the invoice, Multi-Financial Services Co., Inc. grants to the licensee a nonexclusive right, without
right to sublicense, for one year to use this copy of the Multi-Financial Services Co., Inc. software.
Thereafter, the licensee agrees to renew this license agreement yearly at the agreed fee indicated in
the original invoice, but subject to change dependent on factors set but Multi-Financial Services Co.,
Inc. management (e.g. economy, major enhancements to the program, etc.) (Exception: Clients
existing prior to August 1, 2003 may be exempt to full increases in renewal fees, with management
reserving the right to allow for partial renewal fee increases).

Under NO circumstances is the program: to be "re-engineered" whereby the source code is
determined; to be used in developing, modifying, or otherwise changing other programs you or others
use, especially "in-house" programs. To do so, risks you, the user, to the very real possibility of
lawsuits for copyright infringement!

This LIMITED WARRANTY is limited to refunds, as stated elsewhere in this document, and will most
especially not be granted should there be suspicion of either of the above infractions, which will
continue with all rights of use including all upgrades during a licensed period and full technical support
including initial training and on-going support (Free tech support is limited, however, should continuity
of initially trained personnel is ever broken a full retraining fee would be charged). Multi-Financial
Services Co., Inc. reserves all rights not expressly granted, retains title and ownership of the software,
including all subsequent copies in any media. This software and the accompanying written or
electronic materials are copyrighted. You may copy the software solely for backup purposes; all other
copying of the software or the written materials is expressly forbidden.

As the only warranty under this agreement, and in the absence of accident, abuse or misapplication,
Multi-Financial Services Co., Inc. warrants, to the original licensee only, that the disk(s) on which the
software is recorded is free from defects in materials and workmanship under normal use and service.
Multi-Financial Services Co., Inc.'s only obligation under this Agreement is that Multi-Financial Services
Co., Inc. will return initial license payment within the thirty (30) day return policy period (defined as: 30
days from date of purchase as evidenced by either full payment or an initial down payment if financed),
less a 20% restocking fee.

This warranty gives you limited specific legal rights; you may have other legal rights which vary from
state to state. The software and accompanying written/electronic materials are provided as is without
warranty of any kind except as indicated above, including implied warranties of merchantability and
fitness for a particular purpose, even if Multi-Financial Services Co., Inc. has been advised of that
purpose. Multi-Financial Services Co., Inc. specifically does not warrant that the operation of this
software will be liable for any direct, indirect, consequential, or incidental damages arising out of the
uses of or the inability to use such product, even if Multi-Financial Services Co., Inc. has been advised
of the possibility of such damages. Some states do not allow the exclusion or limitation of liability for
consequential incidental damages, so the above limitation may not apply.



License Agreement 6

Copyright Multi-Financial Services Company, Inc. 2012©

The sections above represent the entire license agreement.
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3 Copyright

 Copyright
Copyright © 1998-2013, Multi Financial Services Company, Inc. dba Trakker Loan Servicing

Software, ALL RIGHTS RESERVED.

No part of this document may be copied or reproduced in any form or by any means without the
prior written consent of Multi-Financial Services Company, Inc.

 Multi-Financial Services Company, Inc has made every effort to ensure the accuracy of this
manual. However, Multi-Financial Services Company, Inc. makes no warranties with respect to this
documentation and disclaims any implied warranties of merchantability or fitness for a particular
purpose. The information in this document is subject to change without notice. Multi-Financial
Services Company, Inc. assumes no responsibility for any errors that may appear in this document.

 From time to time changes may occur in the file names and in the files actually included on the
distribution disk. Multi-Financial Services Company, Inc. makes no warranties that such files or
facilities as mentioned in this documentation exist on the distribution disks or as part of the materials
distributed. Every precaution is used to protect against computer viruses. It is strongly suggested
that each disk is scanned for viruses prior to installation.

DISCLAIMER:
This program posts payments to the loan in increments of whole payment amounts or greater. If

the operator accepts partial payments and posts those payments to the suspense account, no credit
is given towards interest until the proper amount is transferred. The application of the payment
occurs in the following order: Escrow (if applicable), Escrow Maintenance(if applicable), Interest
Short (if applicable), Interest, Principal, and Past Dues.

This program was written to cover generic situations that could occur in all agencies. The use of
the suspense account and payment application procedure may or may not be legal in your state. It is
the responsibility of the user to determine legality and usage of the program within legal guidelines.
Multi-Financial Services Company, Inc. accepts and bears NO responsibility for any misuse, whether
intended or not, of this software package. The inputting of an Access Code provided by
Multi-Financial Services Company, Inc. demonstrates the user's acceptance of the procedures used
in the program and responsibility for any misuse.

 All names, addresses, and loan information are fictitious. Any resemblances to real people,
places, or loans are totally accidental.

TRADEMARKS:

 IBM is the registered trademark of International Business Machine Corporation.
 Microsoft, MS, MS-DOS is a registered trademark of Microsoft Corporation.
 Crystal Reports® and Crystal Decisions™ are trademarks of Crystal Decisions™ and Seagate®

Software
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4 Updating Trakker

Updating Trakker

1. Make a backup of your Trakker files. The quickest way to do this is to simply copy
and paste the folder containing your Trakker files to another place on your desktop or,
preferably, to external storage such as an external hard drive, flash drive, or writable
CD.

2. Make sure that no users are using Trakker during the update process.
3. Open My Computer. (Vista/Windows 7 users: Computer)
4. Type the following in the address bar: ftp.thetrakker.com
5. A screen similar to the following should appear:

6.

7. Type TrakkerUpdate in the User name: box.
8. Type Update in the Password box.
9. Uncheck Log on anonymously if it is checked.
10. Click Log On
11. You should see a folder containing these files:
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12.

13. Copy and paste the wintrak.exe file into the folder containing your Trakker files and
choose to replace the old one.
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5 Setting Up The Program

5.1 Hardware & Compatibility

Hardware & Compatibility  

· IBM PC or Compatible
 
· 16 Mb RAM
 
· Windows 95 or newer
 
· 15 Mb of Free space (50Mb Recommended)
 
 · Color Monitor 15" or Larger Recommended a resolution of 800 * 600 or higher is

required.
 
· Printer (Non Specific)
 

Compatibility Notes:
 
 
This program has been thoroughly tested on the following platforms and networks
 
· Operating Systems
 
o Windows 95 (Version A, B, and C)
 
o Windows 98
 
o Windows 98 Second Edition
 
o Windows 2000 Professional
 
o Windows NT 4 (SP6 or higher advised)
 
o Windows XP Home
 
o Windows XP Professional
 
o Windows CE
 
o Terminal Services Client
 
o Cisco Client/Server
 
· Network Platforms (See Networking for details)
 
o Windows NT 4 Server (Service Pack 5 and higher)
 
o Windows 2000 Server (Service Pack 1 and 2)
 
o Windows 2003 Server (also knows as .Net Server)
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o Windows Terminal Server
 
o Cisco Terminal Server
 
o Novell Netware 4.11
 
o Novell Netware 5
 

Please note:  
The program does not send special commands to the printer it just prints the information.  If you

desire letter quality printing from a dot matrix printer, you must preset the printer before running a
report or letter.  

Throughout the program it is assumed that your printer can use either fanfold or single sheet
paper.  With the exception of coupon book and 1098 forms printing, all reports must be done with
either fanfold paper or single sheet paper utilizing a simple dot matrix, laser, or ink jet printers.  For
maximum productivity within the small to medium office it is suggested that coupon, 1098, and past
due notice forms be ordered from Multi-Financial Services Co., Inc. be utilized.

 

5.2 Getting Started

 Getting Started
 
Prior to actually inputting a new loan you will have to make sure that your program is

setup.  Please follow the check off list below to complete the setup of your program:
 
· System Operator
 

Make sure that all information is correct.  This will show up on your reports and letters
where the servicing company information is  required to be printed.

 
Note:  If you change the name or title of your company in this screen your

activation code becomes invalid.  If you wish to change the  name or title of your
company please feel free to contact Trakker Help Desk and we will adjust the
number accordingly for you.

 
· Parameter Options
 

List Loan Comments
 

If checked, this option will show the loan comments in the "List Borrowers" function of
the program.

 
Custom Fees

 
These are reason codes for different functions of the program.  You can add, remove,

and modify these codes at any time.
 

Areas that these fee codes are used in:
 
    Adjusting the balance of a loan
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    Adding or removing fees from an account
 

Escrow Settings
 

This sets the number of reserve months for escrow.  
 

You can set this number to:  0, 1, or 2
 

Auto Coupon Options
 

This is where you can set the number of coupons that you wish to be printed when
utilizing the auto coupon option.

 
Administer Users

 
This is used for setting users in the program and assigning the privileges for that user.

 

5.3 Custom Letter Names

Setting Custom Letter Names

 Custom Letter Names
 

This section will cover the setup of borrower and reporter letter names and how to modify the
letters.  The borrower letters are in the custom1.ovl file and the reporter letters are in custom2.ovl,
both are located in your program directory.  When you install the program five letters are provided,
these letters can easily be modified in Notepad.  Please do not use Word or Word Pad when
making modifications to custom letters, there have been reports of letters not working after being
edited in these programs.  Below are instructions on how to set the names of the borrower and
reporter letters.  At the bottom of this page you will locate links to other documents relating to
customizing letters.

 

To name or rename the Borrower and Reporter Letters
 

From the main program screen click on System
 

1. Click Custom Letter Names
 
2. Click either Borrower Letters or Reporter Letters
 
 A new screen will appear
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From this screen you can Add, Edit, or Delete letter names.
 
If you wish to add a letter name
 
3. Click add
 
4.  Enter the name you wish to name the letter 
 
5. Click OK

 
If you wish to Edit a letter name

 
3. Click on the existing name

 
4. Click Edit
 
 5. Modify the name
   
 6. Click OK
 
If you wish to Delete a letter name
 
 3. Click on the existing letter
 
 4. Click Delete
 

Other resources for Customizing Letters
CUSTOM LETTERS AVAILABLE FIELDS 
CUSTOMIZING LETTERS 

 

5.4 Batch Options

Batch Options 
This option sets the ACH fee for every account that is set up for ACH.
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Please refer to ACH File Import for additional information on how to process an ACH payment file.

5.5 Coupon Font

 Coupon Font
 

 

Sometimes the font needs to be fine tuned in order for all information to fit onto a coupon form.  

 From the Trakker main screen complete the following
 1. Select System>Printer Adjustments>Coupon Font. 
The Printer dialog box will appear 
 

                                   
 

2. Select Print 
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3. Simply input a larger or smaller number depending on whether you need to increase or
decrease the size of letters being printed,
4. Choose OK, 
5. Re-print your coupon book.  

It may take a few attempts to get the size exact.
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5.6 Lender

Lender
For most companies they will have to set up a lender only one time.  For others, however,
who service loans for other lenders this procedure will be done several times.  Whichever
the case may be for you, the lender information needs to be setup up first before any loans
for the lender can be inputted.

· NEW LENDER INPUT
 
 
1.  From the Main Screen, click Review>Lender>New
The program will now ask you if the lender is a Company or Not
2.  Make your selection and click OK
The next screen, seen below, will need to be completed.  In the middle of this screen you
will see a section listed "Credit Agency IDs".  This is this lender's credit reporting ID that is
used when creating a credit-reporting agency file. At the bottom of the screen you will see a
section listed "Agency Reporting Numbers". This is the lenders Agency number with Fannie
Mae.
3. After you are finished inputting the information click OK 

 
· REVIEWING/CHANGING LENDER INFORMATION
 
 1. From the Main Screen, choose Review>Lender>Review 
 2. You can either enter a number or you can click List 
 NOTE: If you click List a window opens up listing all of your current lenders  
 3. Double click on the lender's number or click Select 
 Once you have entered the lender's screen you will see a window similar to the one above. 
 You can change any of the information listed 
4. After you have completed your changes click OK to save the changes or Cancel to exit
without saving.
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5.7 Inputting Collection Codes
1. From the main screen, choose Dates/Data>Misc. Database>Add/Modify>Late Notice
 
2. Input the first account number which should have a Collection Code and choose OK
 
3. Highlight the Collection Code needed then choose OK
 
4. Continue entering accounts until completed
 
5. If you need to delete a Collection Code do #3 & #4 above then go to the end of the list, highlight
"No Late Letter Reason" and choose OK



Part
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6 Demoing The Program

6.1 Quick Reference
 

DEMO
First, what you're looking at is THE FULL PROGRAM. There are no modules that have been
left out, no sections where reports cannot be printed, no areas where you can go just so far
and then a message appears "Sorry, the demo doesn't allow you to go further"!  You have the
FULL program and will be able to enter a maximum of ten (10) total loans.  We have included
three loans for demonstration purposes (records 1001-1005, with 1003-1005 demonstrating a
multi-investor scenario). It is highly suggested you take a few minutes at this point and look
over the table of contents and become familiar with some of the available topics. HELP is
arranged just like a manual, however, since it is "on-line" it is much easier to go from section
to section, any of which can easily be printed by choosing 'PRINT" on the toolbar at the top. 
This manual is updated with each release of the program.
 
This section of HELP is intended to suggest various areas to review in order to quickly get you
familiar with the program and develop an understanding of many of the program's important
features and benefits.  Additionally, as in many HELP sections, you will be given information,
which may have links to other parts of HELP.  This is true of our program and links are shown
in "green".  Simply click on the link and you'll be immediately brought to the appropriate
sections.  Choose the "Back" button at the top to return to the original page.

Once you are satisfied with the function of the program, simply contact our sales
Representative or the Trakker Sales Department at 800-326-4112 to request an invoice. Upon
completion of payment processing our Help Desk will contact you to arrange activation and
training.  If payment is received by credit card, there's a very good chance you can be up and
running within 48 hours, depending upon the availability of your staff and IT department.
 
Have questions as you're previewing the demo?  Call 850-559-9123 and ask for the Help
Desk Department for assistance!

This section is intended to provide a quick overview of the program and is not intended to be a
complete explanation of any particular function.  If additional information on any subject is
needed, just choose the link next to the subject heading.  Once you're ready to begin demoing
the program, please choose the "PRINT" button above and use the printout as you review the
demo.
 
· Reviewing an Account (MAIN BORROWER'S SCREEN)
1. Choose function key F4 or using your mouse, choose Review>Loan>Review
2. Input 1001 or choose LIST to see a list of all accounts
3. If you choose LIST, double click on the account number or name
NOTE:  Clicking on the column heading sorts that column. To see individual sub investors or a
multi-investor loan, simply check the box on  the top right that says "Show Sub-Accounts."
4. Review information at the top, in the gray area, which summarizes the loan
5. Review information at the bottom, in the white area, which summarizes the last 9
transactions.  Use the scroll bar to view the     information to  the right
6. On the tool bar select History>View to see the full history of payments, contact, suspense,
maintenance,or escrow history
 
· Posting a Payment (POST) 
1.  Choose  F2 or  Post>Quick Post
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2.  Enter the date, amount paid, and type of payment (Move box with your mouse to see next
due date. Payment date should be on or after next due date shown.)
NOTE: payment entered should be at least the Payment (P&I) plus Escrow Amount plus
Escrow Maintenance Fee. (For payments less than the required amount, Trakker will instead
display a screen allowing the disbursement of funds to be determined manually. Note that
payments entered this way will update the next due date.)
3.  Review information posted at the bottom.  If the account was posted after a grace period
and had a late fee, it should have an amount posted in the "Late" column. The "Past Due"
column indicates fees not yet paid
 
· Reviewing Payment History (HISTORY)
1. Choose History, View and indicate you do not want information for a particular year
2. The Payment History screen displays all payments and transactions posted
3. The Contact History displays all contact notations by everyone and the system automatically
4. The Suspense History summarizes postings to the Suspense account; usually for payments
less than the normal payment
5. The Maint. History displays all the payments and transactions posted to the maintenance
account
6. The Escrow History displays all the payments and transactions posted to the escrow
account.
7. Print will allow you to print any of the information above simple by having that information in
the dialog box.
 
· Posting Contact Information (CONTACT)
1. Press F5 or choose History>Contact
2. Input borrower contact information (until the program stops you at the line end)
3. Choose Add
The program will continue prompting for additional comments until you choose "Close"
 
· Printing Past Due Notices (PAST DUE NOTICES)
NOTE: Although the program will print past due notices automatically based on system
parameters you enter, you are able to print them individually while in the borrower screen. 
Future decisions by the program will account for notices printed in the borrower's screen)
1. Choose Letters
2. Choose a notice to print
 
· Print Payoff Letter (PAYOFF )
1. Choose Payoff, input an effective date and choose OK
2. Payoff information is shown
3. Choose Print a Payoff Letter (generally you would want to print on letter head but for this
test you can print on plain paper)
 
· Change (CHANGE)
1. Under General you are able to change any field shown
2. Choose Collateral Address, a dialog box will appear with the address. Change something in
this dialog box and click OK.
The screen will blink and you will see the change you made immediately.

Likewise, all other options have items that can be easily changed (NOTE: items such as Next
Due Date,  Lender #, Interest Type, Payment Frequency, and Balloon Amount are NOT
changeable for security reasons)
 
To get back to the main Trakker screen choose "Close"and Cancel on the next dialog box.

Now we will review entering a new loan and the report functions:
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· Entering a New Loan ( ENTER NEW LOAN )
1. Choose  F7 or Review>Loan>New
2. Go to List and choose a sample Lender.
NOTE: You will input your own investors and lenders into this area upon purchasing the
program.
3. Begin entering all requested information
NOTE: "Class Code" this allows you to divide loans into various classifications/types (e.g. 1st
mortgages, 2nd mortgages, re-hab loans, mobile home loans, etc.) which will allow you to
printing reports for each type separately
 NOTE: You are able to go backward to a prior screen by choosing "Back"
4. At the last screen you have the opportunity to review your information when you are satisfied
it is correct choose "Finish" 
5. The system will give you an account number associated with this borrower
 
· Printing Reports (REPORTER )
NOTE: reports are printable on any type of printer as long as the printer has been
appropriately set as the default printer and mapped within a network environment
1. Choose Reporter>Management Reports – these are the core management reports used
most frequently
2. Choose Account Summary Report,By highlighting it with your curser, enter a date and enter
NO when asked for a particular Lender and Class Code
3. If you've posted payments, choose Payment Summary report, indicate the requested
information and be sure to include a date range for payments you posted
4. Choose Delinquency Report and answer requested information.  Note: comments inputted
for the prior 30 days are shown automatically
 
· Special Topics 
Due to their specialized nature and the need to keep this Quick Reference Section as short as
possible,you are invited to review the links below for additional information on any of the
following subjects.  Naturally, the Sales Staff and/or the Help Desk are always willing to
answer any questions on a particular topic at anytime!

-Customizing Letters 
-Collection System 
-IRS Form Filing 
-Important Dates/Database
-Exporting Data and Purging Accounts: Utilities 
-Transferring Loans From an Existing Servicing System 
-Rounding Errors 
-Changing Loan Fee and Past Due Fee Balances 
-Accrual of Interests 
-HUD Aggregate Escrow Analysis 
-Loan Class Codes 
-ODBC Compliancy 
-Escrow Maintenance Fee 

6.2 Running The Program
 

Running the Program

 If the program is not setup as a shortcut on your screen, then go to Start and Programs. Find your
loan-servicing program and click on it. As an alternative, right click on Start, go to Explorer, and find
the "MFS" directory. Then find "wintrak.exe" and double click on it.
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If you are still Demoing the program then go to Start, Windows Explorer, MFS, Demotrak,
wintrak.exe.

· REVIEW
This selection is the real heart of the program. Everything you need to do with any individual loan is

accomplished here. Not only can you setup a new loan, post payments, and do account
maintenance through this option, but also setup Lender and Investor information and modify both.

For information on entering a New Loan:              Entering A New Loan Overview
For information on entering a New Loan via EDI:  Entering a New Loan via EDI Link
For information on entering a New Lender:           Lender
For information on the Borrower's Screen:           Main Borrower's Screen
For information on the Borrower's Tool Bar:         Borrower's Tool Bar

Since there is so much information requested by the program for new account input, there is a
blank data entry form provided which you are free to copy and use. All the manipulation of lender
and investor information is accomplished when you make this selection. If you are servicing loans for
others, you could be using this selection often. If you are servicing loans only for yourself or your own
company, then you will need this selection very seldom. The Lender/Investor Information on the
Lender page details this selection's operation. If you have misplaced your copy or need a new copy
you can click on the following link for a printable copy: New Loan Worksheet

· DATES/DATA
Within this selection are two important categories. First is Important Dates, which allows for the

tracking of 16 key important dates on each loan. Such things as: Escrows that need to be paid, when
coupon books need to be printed on any account, when Interest rates need to be changed, and
several User Defined categories. Depending on the item being tracked, you can be notified at
various time frames.Second is Misc. Database, which allows you to add/modify data such as: ACH
Borrower, Borrower Fee, Credit Reporting, Escrow Interest, IRS 1098 Printing, No Late Notice,
Points Paid as well as review if any information is already in these fields.

· REPORTER
There are many different types of reports provided with your loan servicing program and include

various management reports, IRS reporting, and Utilities which includes the coupon book printing
function. Reporter is a detailed explanation of each report and provides a sample of each report
available.

· SYSTEM

    • OPERATOR 
The information that was entered during the installation procedure can be changed using this

selection. This information is used on the 1098 form, coupon book and past due notices. Enter the
appropriate change(s), and then choose OK. (NOTE: for Company Name changes, you will need to
call Multi-Financial Services Co., Inc. to get a new access code.)

    • IMPORTERS
This selection allows each workstation to indicate the type of printer they will print to (NOTE: you

will still need to indicate the same printer as your default under My Computer/Printers).

    • PARAMETER OPTIONS
Choosing this option allows the operator to have their borrower's Comment Field included in the

List function when needing to get an account number. The Comment Field can then be used to input
any unique "in-house" account number that may exist.

     • CONFIGURE
Choosing this option allows you to customize the shortcut keys on this view enabling the user to

click icons to perform items done on a daily basis, such as post a payment, enter a new loan, quick
comment etc. without having to enter the borrowers screen first.
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    • COLLECTION CODES/PARAMETERS
This section allows you to set up the collection codes and frequencies for the letters sent. This

process must be done prior to setting up a new loan.  For more information please review  Defining
Collection Codes as well as Defining System Parameters

     • CUSTOM LETTER NAMES
This section allows you to set up the Customer and Reporter letters that you will be using through

the course of using Trakker.  For more information on this please review Customizing Letters
Overview

    •  PRINTER ADJUSTMENTS
This section allows you to customize the print size for Coupons and 1098 forms so that they print

correctly. For more information in this please review Coupon Font and 1098 Printing

    • UTILITIES

This section give you options to convert your data, purge an account, generate credit reports and
generate the IRS data report. You would also use this option to generate and send your files to our
Help Desk if needed.

       
· HELP
Select this option to enter the on-line manual. Choose the corresponding subject matter to access

the appropriate section or appendix.

· QUITTING THE PROGRAM
Alas, every good thing must come to an end. Whether you need the computer for something other

than servicing loans or it is simply time to quit for the day, this selection is the one you need. One
word of warning, DO NOT quit the program by turning off the computer. There is quite a bit of
information stored in memory that will be lost if you just turn off the computer without properly exiting
the program. To exit, go to Review and choose, EXIT.

 

6.3 Program Features
 

Trakker Loan-Servicing software provides features that are commonly found on big mainframe
systems and some that are not. Some of these features are:

• Automatically tracks insurance due dates
• Automatic identification of past due accounts
• Automatic alerts for troubled accounts
• The display of full account history
• Complete stand alone program, not dependent upon licensing of another company's software
• Built-in customer letters (i.e. past due, bad check, late fee, and more)
• Custom letters (These are letters that you can customize)
• Numerous printed reports
• Capability for developing specially designed report generating programs to make the reports you

need
• This can be done through a built-in data conversion utility or through the use of the custom

reporter
• The tracking of multi-investor loans
• Develop an electronic file for the IRS & print 1098s
• Print coupon books (both automatically and manually)
• Handle Prepaid/Credit Interest collected at closings
• Automated Variable Interest Rate System

Add-On Specials
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• Crystal® Reporter
• MDB Reporter
• FNMA Reporting
• ASP Online viewing of your Client's accounts
• Credit Bureau File Processing
• Contingency Planning
• On Location Training Available



Part
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7 Parameter Options

7.1 Administer Users

Administer Users
This menu item allows you to set or remove restrictions on users of Trakker.

Note: Trakker passwords must contain exactly seven characters including at least one
capital letter and one number.

Add User
1. Click Add. The User Login screen should appear:                               

2. Type desired user name in the Name text box.
3. Type desired password in the Password text box.
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4. The New Password window should now appear. Re-type the password in the text boxes.

5. Click OK. Now the user rights window should appear. These are the rights that can be given
to a user. More information on those here: User Rights Defined                  

6. Check the boxes corresponding to the rights you wish the user to have.
7. Click OK.

Edit User's Rights
1. Select the user name to be edited.
2. Click Edit. The user rights window should appear.
3. Add or remove rights as desired by checking or unchecking the corresponding boxes.
4. Click OK.

Delete User
1. Click the user name to be deleted.
2. Click Delete.

Note: The Delete button does not provide a confirmation window. Deleting a user is not
reversible. A user who is deleted accidentally must be created again.

Change User's Password
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1. Select the desired user in the User Administration window.
2. Click Edit.
3. Click Change Password. The New Password window should appear.
4. Type desired password in the text boxes.
5. Click OK on the password change screen.
6. Click OK on the user rights screen.

7.1.1 User Rights Defined

User Rights Defined

1 User Administrator Gives the user the ability to Add, Edit, and
Delete users from Trakker.

2 Purge Gives the user the ability to Purge loans from the
system.

3 Suppress Credit Data Gives the user the ability to stop a particular
borrower’s account from reporting to the credit
bureau.

4 No Late Notice Gives the user the ability to prevent late notices
from being sent to a specific borrower.

5 View Purge Log Gives the user the ability to view what loans
have been purged.

6 Rate/Payment Gives the user the right to change the rate and
payment of a borrower.

7 File Maintenance Gives the user the ability to utilize the file
maintenance feature of Trakker.

8 Modify Balance/Fees Gives the user the ability to manipulate the
balance of the loan and fees applied to a
borrower’s account.

9 Modify Days per Year Interest Basis (On Simple Interest Loans Only)  Gives the user
the ability to toggle interest from being computed
on a 360 or 365 day basis.
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10 Modify Borrowers Gives the user the ability to change borrower
information (Address, SSN, Phone, Email) and  
modify term, escrow, late fees, reporting options,
posting and voiding payments)

11 Borrower Fees Gives the user the ability to adjust borrower's
fees.

12 Appraisal/Collateral Gives the user the ability to change appraisal
and collateral information.

13 View Credit Inform Gives the user the ability to view the borrower's
credit information.

14 Payment Posting Order Gives the user the ability to alter the payment
posting order.

7.2 Auto Coupon Printing

Auto Coupon Printing

What is Auto Coupon Printing?
This utility allows the user to print several coupon books in a shorter period of time than with the
manual coupon printing found in earlier versions. Please see PRINT COUPONBOOKS for more
on manual coupon printing.

This powerful utility, when executed, will look at the last available coupon for each account.  The
program will then print out coupon books for those accounts whose last coupon falls within 30
days of the day the utility is executed.  When the program finishes spooling through the
accounts, it waits to see if there are errors, then automatically updates the last coupon date for
the books that were printed. The parameters need to be set only once and, from that point on,
simply point and click and the program will do the rest.  

Note: When using the manual coupon printing function, the coupon dates must still be
manually entered and the program must be told how many to print for each account.  
 
The following coupon book options can be changed:  
· The header (name on top of the coupon book letter)
· Who the checks should be made to
· Where the checks should be mailed to

 These options can be set by following the directions below.
 

Setting Global Parameters
The first step in using the Auto Coupon Printing utility is defining the global parameters.
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1. From the main program screen, select System -> Parameter Options -> Auto Coupon
Options.

2. In the white text box, input the number of coupons that should be printed for every account.
3. Select a cover page option. This controls whose information appears on the cover page.
4. Select a Checks Payable To option.
5. Select a Mail To option.
6. Select Bold in either of these boxes to bold them on the coupon books.
7. Select Include Lender Information if the lender's information is to be included in the book.

Note: If upgrading from a version prior to 1.6.0, the Last Coupon date in the
Dates/Database must be set for each account.  Please refer to Important Dates/Data Base
for more information on defining Coupon Book Due Dates.  For new loans that are
entered into the system after updating to Version 1.6.0, this step is not needed; the
process has been totally automated.  
 
Note: By default, the coupon options value is set to zero.  The Cover Page options, Make
Checks Payable to, and Mail Checks to, is set to Servicer.

Executing Auto Coupon Printing
 Once the global parameters have been set, the Auto Coupon Printing feature can be utilized. 
 

1. From the main Trakker screen, select Reporter.
2. In the Reporter window, click the forward arrow.
3. Select the Utilities tab.
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4. Select Auto Coupon Printing.

5. Click Execute. The Auto Coupon Printing utility now spools through the accounts and prints
coupons for those accounts whose due date falls within the next 30 days.

6. The Coupon Printing Complete dialog box should appear. If there are any errors, click No.
Otherwise, click Yes. The Couponbooks Due Report will print detailing which accounts

received coupon books.   
7. If No was selected in the Coupon Printing Complete dialog box, the Couponbooks Due Report

will still print, but the data file storing the coupon book information (coupon.dta, located in the
folder where Trakker itself resides) will not be updated, allowing corrections to be made. Once
all errors are corrected, repeat steps 1 through 6 to print the corrected coupon books.

Note: Users will not be able to post payments while the Auto Coupon Printing utility is
spooling.  Users may, however, browse accounts and review information, make notes in
the Contact Log, or make changes to the Miscellaneous Database.

 

7.3 Batch Options

Batch Options 
This option sets the ACH fee for every account that is set up for ACH.
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Please refer to ACH File Import for additional information on how to process an ACH payment file.

7.4 Change Password

Change Password
 

This option changes the password of the current user. The process is functionally identical to
changing a user's password from the User Rights screen. See Administer Users for details.

Reminder: Trakker passwords must contain exactly seven characters including at least
one capital letter and one number.

 
Note:  The system administrator must reset the password for a user who has forgotten it.

Click OK
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7.5 Password Change Parameters

Password Change Parameters
Note:  This function is a security feature of Trakker.

Function located in System -> Parameter Options -> Password Change Parameters

This function gives you the ability to change how often Trakker User's passwords will expire and how
may attempts to get the password correct before Trakker will lock the user out of the system.

Note:  By default Trakker passwords expire every 90 days and will allow a user 4 attempts to
get their password correct.

7.6 Credit Reporting
 

Setting Up Your System for Credit Reporting
 

 

In Order to use the Credit Reporting Function of your software it must first be setup.  Before
you can setup the program's Credit Reporting abilities you must contact your local credit
bureau(s) to setup an account.  Any fees for the account(s) that you setup or software that is
required are not the responsibilities of Multi-Financial Services Company, Inc.  

IMPORTANT NOTE:  We have tested our files with Transunion and Experian thoroughly.  Due
to "Internal Policies" within Equifax we were unable to verify that our file that was created per
their specifications is correct.  Therefore we cannot, at this time, verify that the Equifax file can
be read by that agency.  We are working to find a way around this issue and will let you, our
customers, know when the file has been verified.
 

Please note:   The method of data submission is entirely up to you, the customer, and the
Credit Bureau(s) that you choose.  Should you have any questions concerning data submission
or how to submit data please contact the appropriate credit reporting agency.  If the question
concerns how to generate the data file hat will be sent to the credit bureau please review our
section on How to Generate A Credit Reporting File or contact our Help Desk.
                                                                      Transunion               312-258-1818                       
www.transunion.com 
                        Experian                  800-854-7201                         www.experian.com 
                        Equifax                    888-202-4918                         www.equifax.com 
 

http://www.transunion.com
http://www.transunion.com
http://www.experian.com
http://www.equifax.com
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Should you have any questions concerning format or content please contact the Consumer
Data Industry Association at:
 
                        Phone                      202-371-0910
                        Fax                          202-371-0134
                        Web                         www.cdiaonline.org/ 
 
After obtaining your account number with the credit bureau(s) you must enter them into your
program

1. Click on System>Parameter Options>Credit Reporting Options. 
 A dialog box will open and have two sections. The top section allows you to set the agency(s)
you will be generating the credit file for.  The bottom section will list the last date that the credit
file was generated.  
NOTE: After the file is generated it is solely up to you to send the file to the credit agency.  
2. Click on the agency(s) that you will be using 
3. Click on OK.  

 Now you will need to set the code you have received from the credit agency(s) into the lender. 

4. Click on Review>Lender>Review.  
5. Click on List or select the lender number of your choice
6. Click  OK.  
You will notice at the bottom of the window there is a section titled "Credit Agency ID's".  
7. Type in the code issued to you by the credit agency(s) in the appropriate fields, 
8. Click OK.  

 
NOTE:  Upgrade Information

 
After you have upgraded your program to Version 2.0, you will need to go into each account
and edit the borrower's and co-borrower's personal information.  This is due to the program
now storing full information on each person listed on your accounts.  For example, if you have
a borrower and co-borrower on a Joint account, you will need to go to that account and edit the
both borrowers personal information and make sure that all of the information is entered and is
correct.  
 
To change the personal information on your borrowers and co-borrowers please review the
following:
1. Print out an Account Summary report
2. At the Trakker main menu select Loan>Review or F4
3. Type in the first account number on the Account Summary Report
4. Click OK
5. Click on Change>General>Borrowers
6. Click on that borrower's name 
7. Click Edit.  
NOTE:  There are three tabs at the top, Borrower, Address, and Demographics. 
8. Be sure that you have a valid social security number, click on the Address tab 
9. Be sure that you have a valid address Click on the Demographics tab

10. Be sure that you have the correct sex of the borrower Click OK
11. Click the co-borrower's name and click on Edit.  There are two tabs at the top for a
co-borrower, Borrower and Demographics
      Go through step 8 and 10 above.
12. Click OK
Follow Steps 3 through 12 for each account that you will be reporting to the Credit Bureau.

http://www.cdiaonline.org
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Other Items of Interest:
Account Credit Reporting Information  
How to Generate A Credit Reporting File 

7.7 Custom Fees
 

Setting Up Custom Fees
 

 

Custom Fees are used in a number of places. Custom Fees are used to assess
non-interest-bearing fees such as bankruptcy fees, attorney fees, processing fees, etc. The
Custom Fees are also used as reasons to adjust loan balances, such as principal-only
payments and loan adjustments. Listed below are all of the sections that currently utilize the
settings that are set in the Custom Fees option.  These are reasons that a particular action was
taken.  You can set these reasons at any time and you can type virtually anything in.  Listed
below are some examples that we have noted that are currently in use.  These are only
examples and by no means are to redefine how your company conducts business.  At the
bottom you will find directions on how to set the Custom Fees.
 

 
FUNCTIONS UTILIZE THE CUSTOM FEES REASONS
 
o Add to fees
 
o Add to balance
 
o Decrease balance
 
 
EXAMPLES OF CUSTOM FEES
 
o Principal only payment
 
o Legal fees
 
o Appraisal fees
 
o Non cash payoff
 
o Insurance fees
 
 
INSTRUCTIONS TO SET THE CUSTOM FEES
 
o From the Main Screen
 
o Click on System
 
o Click on Parameter Options
 
o Click on Custom Fees
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o To add a reason click Add
 
                 Type in the reason and click OK
 
o To Edit a reason click on that reason and click Edit
 
                 Modify that reason and click OK
 
o To Delete a reason click on that reason and click Delete
 
o Click OK when done
 

7.8 Escrow Options

 Escrow Options
You will need to setup your Escrow Reserve and Escrow Maintenance Fee Options even if your
company does not maintain loans with escrow.

The reserve is used if the account becomes delinquent so that there is enough funds to pay taxes
and/or insurance when it is due.  You can set this at one of three settings.  A zero will not collect
any reserve, a one will collect one-month reserve, and a two will collect two-month reserve.  The
reserve will be broken down across multiple payments.

  
 
To set your reserve, simply follow the directions below:
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1. Open the Trakker program
 
2.  At the Main menu, click on System>Parameter Options>Escrow Options 
3. Enter the number of months you wish to set as reserve
            0 for none,  1 for one,  2 for two
 4. Click OK

 
Next we will set up your Escrow Maintenance Fee options.  See screen shot above
The Escrow Maintenance Fee Cap is a whole dollar amount only, example 5000 for $5000.00.
This is the maximum total dollar amount.

On the bottom is the Escrow Maintenance Fee Payment.  This is the payment that will be accepted
for each account, this is a whole dollar amount only field, example 10 for $10.00 

For more information on Escrow Maintenance Fees please review the Escrow Maintenance
Overview.
 

7.9 Market Indexes - Setup & Updating
 

 Before entering a Market Index based loan you will need to setup your Market Indexes. 
 
1. Go to the System>Parameter Options>Market Indexes
2. Choose Add
3. Type the name of the Index
4. Click OK.  

See the screen shots below
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Enter the effective dates of rate changes indicated in the index by clicking Add in the second
screenshot shown above. The window below should appear. In the Effective Date box, enter the
date of the rate change in question. In the Rate box, enter the new interest rate as of the
effective date. Repeat this process for each change in the interest rate according to the index.
See also: Variable Interest Rate Loans
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7.10 Payment Posting Order

Payment Posting Order
Function located in System -> Parameter Options -> Payment Posting Order

Adjusting the payment posting order gives Trakker administrators the ability to modify the priority of the
allocation of monies from each payment posted.

7.11 System Default Options
 

Setting Up Loan Defaults
 

In Version 2.0 we have included a new function that will allow you to set defaults for new loans.
Setting the defaults is completely up to you and/or your company.  When you are entering a new
loan into the program these will assist you in completing the new account more quickly, if set. 
Below is a breakdown and instructions on what defaults can be set and what their meaning. 
Please note: These items can be changed during the entering of a new loan and are fields that
may be changed in the program.
 
 
To set the loan defaults please follow the directions below:

From the main screen Click on System>Parameter Options>System Defaults
 
A new window will open that displays three sections.  The top section deals with the type of loan,
city, and state.  The bottom  left deals with the Late Fee, and the bottom right deals with the
service fee.
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The TOP SECTION – TYPE OF LOAN
This section has four selections:
 
· ·   Portfolio   
    The portfolio is the main type of account, and can be set by clicking on the down arrow at the
right.  Select what type of account you wish to use, then click on it.
 
·    Loan type 
    The loan type is the "sub" type of account, and can be set by clicking on the down arrow at the
right.  Select what type of account you wish to use click on it.
·         Country
    Select the country you are located in or service the most loans from.
·     State  
    Select the state you are located in or service the most loans from.
 
 The BOTTOM LEFT SECTION – LATE FEE
 
 This section sets the default late fee and has four sections:
 
·    Permitted Days Late
 
    This is the number of grace days you wish to allow.
 
·    Amount
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    This is the dollar or percentage figure that you wish to charge if the grace period is passed
before a payment is received.
 
·    Type of Charge
 
    This is the type of charge, dollar or percentage, which you set in the above option as the fee.
 
·    No Late Fee
 
    If you wish not to charge a late fee by default click on the box at the bottom.
 
The BOTTOM MIDDLE SECTION – SERVICE FEES
 
This section sets the default service fee and has three sections:
 
·    Amount
 
    This is the dollar or percentage figure that you wish to charge as a service fee.
·    Type of charge
 
    This the dollar or percentage figure that you wish to charge.  You have three options:
 

Flat Dollar
Percent Of Payment 
Percent Of Balance

 
·    No service fee
 
    If you wish not to charge a service fee by default click on the box at the bottom.
The far right section – IRS 1098 filter
 
This section sets the filter used when printing the IRS 1098 forms and generating the IRS file.

The EDI Linking
 
As of June 1997 the firs Electronic Data Interchange (EDI) link was established with various
national origination software companies.
With this link you are now able to link our program with:

· Point by Calyx (Point)
· Encompass by Ellie Mae
· TQS by Byte
· Dynatek

For specific loan origination file information and automatically input approximately 90% of the
needed for setting up new loan and instructions on Creating the EDI file, please refer to the
following sections: Establishing EDI Link with origination software

If you want to transfer loans from an existing servicing software system, Please refer to:
Transferring loans from an existing servicing system
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7.12 User Defined Fields

 User Defined Fields
User defined fields are a set of customizable fields that must be set in order to use.  You can use
these fields for a variety of functions. Some of which are:
 

· Alternate Contact Numbers
 
· Fax Numbers
 
· E-Mail Numbers
 
· Who was the last servicing company
 
· Last servicing company's phone number
 
· Loan Officer
 
· Alternate account number
 
· Locator Number

Please Note:  When you add, edit, or delete a user defined field this will affect every account that
you have or will have in your system.  For example if a field is created as a fax number and you edit
that field's properties and change it's name to a phone number, it will change this title for all
accounts.

The different types of fields that can be setup are:
 

· Number:  This is a general number, and can be used as a phone number, fax number, etc
 
· Decimal:  This is a 7.2 type number, and can be used to show a dollar amount.  Example

1234567.12
· Date:  This is a standard date format.  Example 01/01/2001
 
· Alpha-Numeric:   This is a text/numeric based field.  This can be used for just about any

function.  When setting up this field you must set the size of the field.  The max size is 255
characters.  

 
· Memo: This is a text only based field.  This can be used as a notepad to store various different

types of information.  When setting up this field you must set the size you wish the field to be. 
The max size is 255 characters.
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To Add a User Defined Field, 

1. Click on System>Parameter Options> User Defined Fields.  
The program will open a new window that displays each different type of field you can setup.
(see above screen shot)
 NOTE: Each tab can contain up to 50 different fields of that type.  
2. Click on the tab that best describes what information you wish to store, 
3. Enter the title that best describes the information, and set the length (if applicable),   After
you have entered in the entire information, 
4. Click on OK.

 

To Edit an existing User Defined Field
1. Click on System>Parameter Options>User Defined Fields, 
2. Click the tab that contains the item you wish to edit
3. Click the field you wish to edit
4. Click  Edit.  
After you have completed your changes 
5. Click OK.

To Delete an existing User Defined Field 
1. Click on System>Parameter Options>User Defined Fields
2. Select the Tab that contains the item you wish to delete
3. Select the field you wish to delete
4. Click on Delete at the bottom of the screen.  
NOTE:  When you change or delete any field this will affect ALL accounts currently in the
software.  
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7.13 Electronic Imaging Directory

Electronic Imaging Directory

This option allows the user to set the directory in which document PDF images are to be stored. 

Click the Document Directory button to choose a directory in which to store document images.

Note: Available only in version 2.4.0.8426 or later.



Part

VIII
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8 New Loan Wizard

8.1  Entering A New Loan Overview
 

This section will cover each screen you will see when you are entering a new loan into your program. The information is
entered in a series of several steps that are explained below.  At the end of each step, simply press NEXT and continue
to the next step.  If at anytime you realize that information entered on a prior screen should be changed or altered, simply
choose BACK.  Should you wish to stop, just choose CANCEL.  NOTE:  Once you get to the end and choose FINISH,
there is NO going BACK to correct what is considered CRITICAL SECURITY information (e.g. Beginning Loan Balance,
Balance of Loan, Property Address, Date of Note, Date Last Paid, and Date Began Servicing). 
 
If you are converting loans from an existing servicing system and you wish to automatically setup the new loans in this
loan servicing system, please refer to: Transferring Loans From an Existing Servicing System . This will allow you to
automatically setup 1 to unlimited number of new loans at ONE time!

From the main Trakker menu select  Review>Loan>New or F7
 
 

·    Lender, EDI Link, and Borrower Type
 

 On this screen you will select your Lender number, whether or not to use the EDI link, and the type of borrower.
 
 

EDI Link
The EDI Link is short for Electronic Data Interface Link.  This will link your program to an Origination program.  If you wish
to find out more information on this subject please review our ESTABLISHING EDI LINK WITH ORIGINATION
SOFTWARE section.  
 

 

Borrower Type
 

This is where you choose what type of borrower this account belongs to.  You have two choices, Individual and
Corporation, select the one you want and click next.
 

Multi-Investor
 

Check the Multi-Investor box if this is a Multi-Investor loan and click next .

· Portfolio and Loan Type
 

On this screen you will set the type of loan this customer has.
 

There are two drop down boxes.  To set each option simply click on the down arrow and scroll through the menu until you
locate the option which best describes this type of loan, click on that option to select it.  After you have set both options
click Next.
 

· Naming the Account
 

This screen is the "Visible" name for the account.  This is the name that will appear on reports, screen shots, and
printouts.
 
 

If this account has a single borrower then enter the customer's First Name and Last Name on this screen.  However if
this account has two borrowers enter the Primary borrower's name, a "/", and then the Secondary borrower's name.
 

· For Example:
 

o A single borrower's account:                 First Name: John
 

o                                                                 Last Name: Doe
 

o A multiple borrower's account:               First Name: John/Jane
 

o                                                                 Last Name: Doe/Doe
NOTE: You do not have to repeat the last name if it is the same
 

· Address/Collateral and Loan Class Code Screen
 

This screen lists the loan's address or collateral.  Please note that you do not have to enter an address in this screen.
For example, if the collateral is a car, then you would list a short description of that car in this screen.  There will be
another screen later, which will ask for the mailing address of the borrower(s) on this account.
 

Address/Collateral
 

As stated above this screen is used to track the collateral, which is attached to this account.  Because the collateral is
attached to the promissory note, once this loan is completely entered this information cannot be changed.  If you need to
change it due to a mistake the loan must be purged and re-entered.  
 

Loan Class Code  
 

The Loan Class Codes enable the user to be able to categorize loans and print reports by individual loan type, if so
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desired.  Each code is user defined and consists of two characters that can be a number, a letter, or a combination of
both.  Loan Class Codes will allow you to divide loans into various classifications/types such as: 1st Mortgage, 2nd
Mortgage, Auto, Unsecured, etc.  By classifying loans you will be able to print reports for each class specified.

 
·    Borrower's Screen 

This screen consists of the Borrowers and Co-Borrowers, which will be attached to this account.  To aid you in inputting a
loan we have set the program to "copy" the information you keyed in earlier when naming this account into the primary
borrower and co-borrower areas.
 

Note:  If your company plans to report to a credit bureau in the future you must edit the borrower's personal information
and enter the proper information.  This includes the ECOA Code and Social Security Number.  (The ECOA Code is the
statement of what type of borrower this is, Individual, Joint, Joint Contract Liability, etc).
 

Adding/Editing Borrowers
 

To add a borrower to this account simply click on Add and a new window will open.  This window consists of two tabs
initially.  At the top of this screen you will see the tabs, Borrower and Demographics.  On the Borrower's tab you will enter
the type of borrower this person or company is, select whether the borrower is a individual or company, record the SSN
or Federal Tax ID, the customer's First, Middle, and Last Name (or if selected the name of the Company), and the
Generation (If applicable).
 

If the customer is a company then the Demographics tab will disappear.  Also if the Co-Borrowers address is different
you will need to click on the box stating so, and then enter the proper information.
 

·  Other Contacts
 

This screen allows you to add multiple alternate contacts to the account.  This could be used for such items as:  Work,
neighbors, family, etc.
 

Adding Other Contacts
 

To add a borrower to this account simply click on "Add" and a new window will open.  The screen that opens will have
fields for the following information:  First Name, Last Name, Relation (this is a drop down box), Address, Phone Number,
and Work Number.
 

· Appraisal/Collateral
 

This section records the Appraisal amount and Collateral Description.
 

Appraisal
 

 The Appraisal amount is a dollar figure.  This field is in a 7.2 format.  An example is 1234567.12
 

Property ID
This field will allow you to store that Tax Appraisal's Property ID.
 

Collateral
 

This field may be used to hold a detailed description of the collateral.  This field may contain up to 180 characters.
 

· Late Fee/Service Fee
 

This section allows you to set the late fees and service fees that will be applied to the account.  This information can be
set in the Loan Defaults section.  For more information regarding setting the defaults please review Setting Loan Defaults
.
 

Late
 

This section deals with the grace period and penalty for payments that are paid outside of the grace period.  If the grace
period is set for 15 days then on the 16th day the fee will be in affect.  When the customer pays the payment for that due
date after the grace period has expired the fee will be added.
 

Service Fees
 

This section sets the service fee that is charged to the lender and how that fee is calculated.  Your options include:  Flat
Dollar Fee, Percent of Payment, and Percent of Balance.
 

· Pre Payment Penalty/Past Due Amounts
 
This section deals with the pre payment penalty and past due amounts.  The Past Due Amounts
section deals with existing loans that are past due before they are entered into the program.
 
Pre Payment Penalty
 
If you want to charge a penalty to the account if it is paid off early, enter a percentage and date on
this screen.  When you compute a payoff the program will look at this date and add a penalty to



Trakker - Loan Servicing Software Help File51

Copyright Multi-Financial Services Company, Inc. 2012©

the payoff if it is calculated before the date entered.
 
Past Due Amounts – For existing loans
 
This pertains to existing accounts that are past due.  If the account is past due when entered into
the program enter the total of the fees that have acuminated in this field. 

 
· Begin Date/Escrow/Points
 
This section deals with four items:  The beginning date of the loan, the escrow, points, and
interest.  
 
Beginning Date
 
This is the date that your company began servicing this account.
 
Escrow Payment and Balance
 
In this section enter the escrow information.  If the account does not have a balance but requires
an escrow payment then enter the payment and a zero dollar amount in the balance field.  On
loans that do not require escrow click the "Non-Escrow Account" button on the right.  If the loan
does require escrow then enter in the appropriate information.  
 
Escrow Maintenance Fee Required
 
If you choose "Required", this account will require the Escrow Maintenance Fee.  If you choose
"Not Required", it will not.  Please review Escrow Maintenance Overview for additional
information.
 
After you click on "Required" you will need to setup the maintenance fee account.  The Balance
window allows you to set an existing balance.  If there is not a balance as of the date you are
entering this account then enter 0.  The Fee window is the fee that will be deducted from each
payment.  The "Cap" is the maximum amount that the maintenance fee balance for this account
can reach.
 
Points Paid
 
If there were points paid on this loan then click on the Points Paid button on the right and enter in
the dollar amount that was paid.  This is to be used to reflect the dollar amount of points paid on
the purchase of a principal residence.

Prepaid/Credit/YTD Interest
 
If a new loan pre-paid interest was collected or a credit interest given at the closing then choose
the "Prepaid/Credit Interest" box and indicate the amount and whether it was prepaid or a credit.
(WARNING: For loans with prepaid interest AND this is an interest bearing method loan, DO NOT
put the "Last Payment Received" as the date of the note!!  Instead, please put the date the
prepaid interest was calculated TO!").

 
· Dates and Comments
 
This screen is where you will enter the original closing date of the loan, the last payment that was
received, the next payment due date, and a comment about the account. 
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Note:  If a date entered in conflicts with any of the three notes below ( Listed in red ), then you
will receive a warning message asking you to correct the information.  
 

Note:  If you are entering in an existing loan you will be prompted to enter paid interest and
accrued interest.  If your company does not do accruals, then press the next button to continue.  If
your company does do accruals, then enter the total interest accrued and paid since the original
closing of the loan.
 
Loan Closing Date
 
This is the original closing date of the loan.
 
Note:  The closing date cannot be after the begin servicing date.
 
Last Payment Received
 
This is the date of the last payment that you received.  If this is a new loan then this is the same
as the closing date.
 
Note:  The last payment received cannot be before the closing date, and the last payment date
cannot be after the begin servicing date.
 
Next Due Date
 
This is the date the next payment is due.  The program will set the due dates by this date.  For
example if you enter a date of 01/01/2002 and the payments are monthly based then after the first
payment is paid the next due date will be 02/01/2002.
 
Note:  The next due date cannot be before the closing date.
 
Comments Field
 
The loan's comment can be up to 34 characters.  If not used for recording an "in-house" account
number, it can be used for just about anything you wish, however, it is NOT a computational field.

 
· Type/Payment Basis/Interest Basis
 
This screen allows you to set the type of loan, the period between payments, and the interest
basis.    This information can be set in the Loan Defaults section.  For more information regarding
setting the defaults please review Setting Loan Defaults.
 
Loan Type
 
This section gives you two options, Straight and Balloon.  A Straight loan is a loan that has a term
and makes payments until the loan balance reaches zero or the account is paid off.  A Balloon
note is a loan that has a term and a Balloon payment due at the end of that term.
 
Payment Period
 
This section allows you to set the frequency of the payments.   To set the frequency, simply click
on the box to the left of the type that matches the loan.
 
Interest Basis
 
This section has two selections, Interest Bearing/Simple Interest and Regular Amortizing. 
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Interest Bearing/Simple Interest loans add interest daily.  You can select the basis of the interest
between 365 and 360 days per year.  
 
Note:  If you select the Interest Bearing/Simple Interest you will be prompted to enter any past
due interest.  This amount is as of the "Last Payment Received Date".
 
Regular Amortizing loans add interest monthly.  
 
Interest Only
 
This section allows you to set an account as an Interest Only account.  This account will not
expect any principal with the payments.
 
Interest Rate Type
 
In this section you will select the type of interest rate that is on this loan.  The default is Fixed. 
This is a basic single interest rate loan.  Example:  6.5%
 
For information on variable types of interest rates, see the information below:
 
o Date Scheduled 
 
o Market Index 
 
o Payment Scheduled 

 
· Balance/Rate/Term/Balloon
 
This screen sets the original and current loan balance, the interest rate, the term, and the Balloon
payment due/amount.  If the loan you are entering is not a Balloon based loan then the Balloon
information will be grayed out. 
 
Original Loan
 This is the Original dollar amount that was or is on the loan at the beginning.
 
Current Balance
 
If you are entering in a new loan then this number should be the same as the original balance.  If
this is an existing loan then this should be the balance as the loan stands as of now. 
 
Interest Rate
 
This is the Interest rate.  The program will accept a maximum interest rate of 999.999.  Please
note that after entering in the third digit past the decimal you will no longer "see" this number.  The
program will store this number and perform calculations with this number.    
 
Term
 
This number is based on the number of payments.  If you are entering a new loan with a length of
five years and the payments are monthly based then you would enter 60 in this field.  If this is an
existing loan, then enter the remaining term.
 
Balloon Due and Amount
 
The Balloon Due is the payment number that the balloon payment is due on.  The amount is the
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dollar amount that is due at that payment. 

 
· Final Screen
 
This screen allows you to view the main information on this account.  If there is any information
that does not look "correct" you can click Back to make changes to any option.  If the loan that you
are entering is a Balloon account you will notice that the Balloon Due Amount includes the last
payment and interest for that payment.  If your Balloon amount includes these items please press
back until you get to the balloon amount screen and adjust the Balloon amount accordingly.
 
After you click Finish the loan will be entered, and you will be asked if you wish to print a coupon
book.  If you click on Yes, you will then be asked if the borrower pays the service fee for that loan. 
The program will then begin printing out a coupon book, the number of books preset in the AUTO
COUPON PRINTING setting determines the number of coupons printed.  The next screen
informs you of what that loan number will be.
 
Account Number Example:  9999-1002 This consists of: Lender number - Record Number
 
Note:  If you are entering a Multi-Investor account you will receive a screen that displays all of the
new account numbers.
 
After you click on OK the next screen will ask if you wish to add another loan.
 

 

8.1.1 Entering a New Loan

Entering a New Loan
This section will give you a step by step instruction on entering a Standard Loan. To proceed
with entering a new loan some things need to already be established, such as: Lender
information Lender, Loan Defaults Loan Defaults,and Custom Fees, Custom Fees to mention a
few.

1. From the Trakker main menu select Review>Loan>New or F7

2. Type in your lender # or select list and double click on the lender number or name.
3. Click on the Borrower type (default is individual)
4. Click Next
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5. Click on Portfolio (default is mortgage) and select which option you need 

6. Click on  Loan Type (there are 24 different options to choose from)
7. Scroll down to the one that best fits your needs
8. Click Next
9. Complete the First Name/Last Name field. To separate the first names with a /
If the last names are the same you only need to enter it once.
10. Click Next

11. Complete the Address/Collateral information and Loan Class Code
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NOTE:  Loan Class Code will allow you to divide loans into various classifications/types such as:
1st Mortgage, 2nd Mortgage, Auto, Unsecured etc. By classifying loans you will be able to
print reports for each class specified.

12. Click Next
13. Highlight the name click EDIT

14. A new dialog box will appear Complete and fill in the areas needed. (To edit the address or
demographics click on the tabs)
NOTE: Do not click OK until all tab changes have been made
15. Click OK

16. Highlight the co-borrowers name and click EDIT
17. Complete the needed information. (Be sure that the Type has the necessary information) 
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18. After ALL the tabs have been corrected click OK

19. Click NEXT
20. You will see a dialog box where you can add another co-borrower or guarantor
21. Click NEXT
22. Fill in the appraisal and collateral information click Next
      (You can use any thing you are using as collateral such as Auto, ATV, savings, CD, and is
not limited to real estate, or leave it blank)
23. Click NEXT
24. Complete the Late Fee Requirements and Service Fee needs of the note (optional)
25. Click NEXT
26. Complete the Pre Payment Penalty and Past Due Fee information (optional)
27. Click NEXT
28.  Click NON-ESCROW ACCOUNT  (Begin Date is the date you begin servicing this note)

This will grey out the escrow information
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29. Click on Points Paid and Prepaid/Credit/YTD interest if require.  (if no points, prepaid
interest, or accrued interest were not paid at closing do not mark this box)
30. Click NEXT
31. Complete the information requested. (This will come from the Loan document signed by the
borrower's)
NOTE: The comment section will be an ideal place for any account information on
existing loans, such as the original account number.
32. Click NEXT

For the purpose of this example the next screen will not have any changes
33. Click NEXT
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34. Complete the information requested in the next screen. (This comes from the loan document
that the borrower signed)

35. Click NEXT
Review the information on this next screen for accuracy. (If any information is incorrect select
the BACK tab until you are on the screen to change the information then select NEXT until your
are back to the this screen)

36. Click FINISH
You will be then prompted for Coupon Books (be sure coupon paper is in your default printer)
37. Click YES
38. If Borrower is responsible for the Borrowers fee Click YES  if Not click NO
39. You will then see a dialog box with your Trakker account number. 

CONGRATULATIONS you have just completed a standard loan set up in Trakker
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8.1.2 Escrow Loans

Escrow Loans
This section will give you a step by step instruction on entering an Escrow Loan. To proceed with
entering a new loan some things need to already be established, such as: Lender information 
Lender, Loan Defaults Loan Defaults,and Custom Fees, Custom Fees to mention a few.

1. From the Trakker main menu select Review>Loan>New or F7

2. Type in your lender # or select list and double click on the lender number or name.
3. Click on the Borrower type (default is individual)
4. Click Next

5. Click on Portfolio (default is mortgage) and select which option you need 

6. Click on  Loan Type (there are 24 different options to choose from)
7. Scroll down to the one that best fits your needs
8. Click Next
9. Complete the First Name/Last Name field. To separate the first names with a /
If the last names are the same you only need to enter it once.
10. Click Next
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11. Complete the Address/Collateral information and Loan Class Code

NOTE:  Loan Class Code will allow you to divide loans into various classifications/types such as:
1st Mortgage, 2nd Mortgage, Auto, Unsecured etc. By classifying loans you will be able to
print reports for each class specified.

12. Click Next
13. Highlight the name click EDIT

14. A new dialog box will appear Complete and fill in the areas needed. (To edit the address or
demographics click on the tabs)
NOTE: Do not click OK until all tab changes have been made
15. Click OK
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16. Highlight the co-borrowers name and click EDIT
17. Complete the needed information. (Be sure that the Type has the necessary information) 
18. After ALL the tabs have been corrected click OK

19. Click NEXT
20. You will see a dialog box where you can add another co-borrower or guarantor
21. Click NEXT
22. Fill in the appraisal and collateral information click Next
      (You can use any thing you are using as collateral such as Auto, ATV, savings, CD, and is
not limited to real estate, or leave it blank)
23. Click NEXT
24. Complete the Late Fee Requirements and Service Fee needs of the note (optional)
25. Click NEXT
26. Complete the Pre Payment Penalty and Past Due Fee information (optional)
27. Click NEXT
28.  Click ESCROW ACCOUNT (Begin Date is the date you begin servicing this note)
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29. Click on Points Paid and Prepaid/Credit/YTD interest if require.  (if no points, prepaid
interest, or accrued interest were not paid at closing do not mark this box)
30. Click NEXT
31. Complete the information requested. (This will come from the Loan document signed by the
borrower's)
NOTE: The comment section will be an ideal place for any account information on
existing loans, such as the original account number.
32. Click NEXT

For the purpose of this example the next screen will not have any changes
33. Click NEXT
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34. Complete the information requested in the next screen. (This comes from the loan document
that the borrower signed)

35. Click NEXT
Review the information on this next screen for accuracy. (If any information is incorrect select
the BACK tab until you are on the screen to change the information then select NEXT until your
are back to the this screen)

36. Click FINISH
You will be then prompted for Coupon Books (be sure coupon paper is in your default printer)
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37. Click NO
38. You will then see a dialog box with your Trakker account number. 

CONGRATULATIONS you have just completed a escrow loan set up in Trakker

Now you have to tell Trakker about the escrow needs

This is done through the Borrowers screen. At the Trakker main menu 

1. Select Review>Loan>Review or F4
2. Type in the Trakker account number you need or select LIST
3. Click Select
You are now looking at the Borrowers Main Menu

4.  Select Escrow on the Tool Bar

5. Select STANDARD ESCROW ITEMS
6. Select Analysis
7. Select in SCHEDULE
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`
8. Select the item you are recording (Hazard, County, City) and double click

9. Fill in the information required select OK
10. Complete steps 8 and 9 until all Escrow items are recorded
11. Select Close or Print if you prefer.
12. You are now ready to run the coupon book or  post paymentsBorrower's Tool Bar

8.2 EDI Links with Loan Origination Software

EDI Links with Loan Origination Software
Trakker can import loans from popular origination software including Calyx Point, Ellie Mae
Encompass, and Byte BytePro. The following topics will coveer procedures for setting up and
executing these EDI links.

8.2.1 Ellie Mae Encompass
Encompass by Ellie Mae

This is how to do an EDI link from Encompass. 
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1.  You will need to log into Trakker™. 
2.  Go  to menu item Review/ Loan/ New. 
3.  Click on EDI link button  
4.  Click on the button labeled Encompass.
5.  This will launch the Encompass login. 
6.  Put in your Encompass Username, password and server IP number. 
7.  This will launch the Encompass Loan import. 
8.  Look for the file and click on it 
9.  Click on the Import button. 
10. Once this is done click next and verify information.
11. Information not transferred or required by Trakker™, may be entered into the appropriate
fields.

8.2.2 BytePro
TQS by Byte

This is how to do an EDI link from TQS. 

1.  You need to open up the file in TQS that you want to export. 
2.  Once the loan file is open
3.  Go to the menu communication
4.   Click the menu item export to other interfaces. 
5.  Then click on the item Trakker™ and export file. 
6.  Launch the Trakker™ program. 
7.  Log into Trakker™ like normal 
8.  Click on menu item review; then click menu item loan; then click on menu item new. 
9.  Click on EDI link button 
10. Click then on the button labeled TQS. 
11. Locate the TQS file in the TQS folder.
12. Click the file  
13. Click  Open
14. Click next in Trakker™. 
15. Verify information on each screen by clicking next.
16. Information not transferred or required by Trakker™, may be entered into the appropriate
fields.

8.2.3 Calyx Point

Calyx Point

The next section describes how to import loans from Calyx Point.
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8.2.3.1 Before Importing from Calyx

Before Importing a Loan from Calyx Point
Here are the steps that should be taken in Trakker and Point before importing a loan from Calyx Point:

1. Set up lender information.
2. Set system defaults.
3. Set up custom fees.
4. Set up collection parameters.
5. Set up payment posting order.
6. If importing adjustable rate mortgage loans, set up market indexes, using the names given in field

ID 12523 in the Registration and Rate Lock form in Point. Note that some of the names exceed
Trakker's 35-character limit on index names; in that case, use only the first 35 characters.

7. Using Point Administrator, create a data folder called LoansToBeServiced. In Point, copy all loans
that are ready for servicing to this folder. Trakker looks for this data folder by default when importing
loans.
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8.2.3.2 Importing a Loan from Point

Importing a Loan into Trakker from Calyx Point
In Trakker, begin by creating a new loan as normal: Review -> Loan -> New.
Click the EDI Link button on the first screen.

Click Point on the screen that follows.

The Calyx Loan Importer should then appear:
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In the LoansToBeServiced folder, find the loan to be imported, then click
Import. It may take a few minutes, depending on the speed of your computer.
Trakker will ask for a default lender number; enter the lender number for the
desired lender here. (If the number is not known, it can be specified using List)

When this is finished, the information from the Point file will be imported into the
New Loan Wizard. Navigate through each of the screens of the new loan and
verify the information, changing and adding where necessary. Some information
does not carry over from Point; the table below is a complete listing of every item
in Trakker's New Loan Wizard and where it is located in Point.
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8.2.3.3 Point-Trakker Conversion Table

Point to Trakker Conversion Table
This table connects all the information in Trakker's New Loan Wizard to its counterpart in Point. Some
of the fields are Trakker-specific, and other items are not imported from Point. These items are noted
in this table as well. To view Field ID Numbers in Point, select Utilities -> Display Field ID, then click
on a field. Its Field ID is then displayed in the lower right hand corner.

Trakker Field Name Corresponding Calyx
Location

Calyx
Field ID
Number

Will this transfer
over from Calyx
Point?

Will this need to be
manually setup in
Trakker's New Loan
Wizard?

Lender Manual N/A No No

Borrower Type Borrower Information 100 No Yes

Multi-Investor N/A N/A No Yes

Portfolio Borrower Information 915 No No

Loan Type Borrower Information 26 No No

First Name Borrower Information 100 Yes No

Last Name Borrower Information 101 Yes No

Collateral Address
Street

Borrower Information 31 Yes No

Collateral Address
City

Borrower Information 32 Yes No

Collateral Address
State

Borrower Information 33 Yes No

Collateral Address Zip Borrower Information 34 Yes No

Collateral Address
Country

Default N/A No No

Loan Class Code Manual N/A No Yes

Fed ID Borrower Information 108 Yes No

Middle Name Borrower Information 117 Yes No

Generation Borrower Information 119 Yes No

Primary Address
Street

Borrower Information 102 Yes No

Primary Address City Borrower Information 103 Yes No

Primary Address StateBorrower Information 104 Yes No

Primary Address Zip Borrower Information 105 Yes No

Primary Address
Country

Borrower Information 115 Yes No

Home Phone Borrower Information 106 Yes No

Work Phone Borrower Information 136 Yes No

DOB Borrower Information 118 Yes No

Sex Loan Application - 4 1496 Yes No
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Race Loan Application - 4 1548 Yes No

Appraisal Borrower Information 801 Yes No

Property ID Manual N/A No Yes

Collateral Manual N/A No Yes

Late Fee (Permitted
Days Late)

Truth in Lending 2190 Yes No

Late Fee (Percentage
of Dollar Amount)

Truth in Lending 2185 Yes No

Service Fee (Type) N/A N/A No Yes

Service Fee (Amount) N/A N/A No Yes

Service Fee (Percent) N/A N/A No Yes

Pre Payment Penalty Truth in Lending >
Prepayment > eLoanFile >
Loan Product > Prepayment
Penalty

12816 Yes No

Penalty Paid Before
This Date

Manual N/A No Yes

Past Due Fees N/A N/A No Yes

Loan Begin Date Manual N/A No Yes

Escrow Payment Borrower Information 753-756 Yes No

Escrow Balance N/A N/A No Yes

Non Escrow Account GFE > Escrow Account
Information

9309 Yes No

Escrow Interest
Required

N/A N/A No Yes

Haz Ins Next Due
Date

Manual N/A No Yes

Haz Ins AMT Borrower Information 753 Yes No

City Taxes Next Due
Date

Manual N/A No Yes

City Taxes AMT Fees Worksheet > Section 9 1096 Yes No

County Taxes Next
Due Date

Manual N/A No Yes

County Taxes AMT Borrower Information 754 Yes No

MIP Next Due Date Manual N/A No Yes

MIP AMT Borrower Information 755 Yes No

HO Assoc Fees Borrower Information 756 Yes No (in Escrow
Scheduler)

Escrow Maintenance
Fee

N/A N/A No Yes

Points Paid Dollar
Amount

Loan Application - 4 808 Yes No
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Owner Occupied
Home

Loan Application - 4 1476 Yes No

Pre-paid Interest HUD-1A 13518 Yes No

Credit Interest Manual N/A No Yes

Loan Closing Date Track > Status> Closed 6023 Yes No

Last Payment
Received

Manual N/A No Yes

Next Payment Due
Date

Manual N/A No Yes

Straight Loan Type Manual N/A No Yes

Balloon Loan Type GFE > Summary of Loan 553 Yes No

Payment Period TIL Section 32 2345 Yes No

Interest Basis (Simple
Interest)

N/A N/A No Yes

Interest Basis (Reg
Amort)

Default N/A No Yes

Days Per year Interest
Basis

N/A N/A No Yes

Interest Rate Type
(Fixed)

Loan Application -1 550 Yes No

Interest Rate Type
(Market Index)

Loan Application -1 560 Yes No

Interest Rate Type
(Date Scheduled)

N/A N/A No Yes

Interest Rate Type
(Payment Scheduled)

N/A N/A No Yes

Market Index Rate Registration & Rate Lock 12523 Yes (Only 35
Characters of
Market Index
Name will be
used)

No

Market Index Eval
Period

Registration & Rate Lock 2331 Yes No

Margin Registration & Rate Lock 2332 Yes No

Fixed Initial Rate Registration & Rate Lock 12 Yes No

Fixed Initial Rate
Calendar

Manual N/A No Yes

Rate Change Limits
(Maximum Decrease)

Manual N/A No Yes

Rate Change Limits
(Maximum Increase)

Registration & Rate Lock 2324 Yes No

Rate Floor Amortization Schedule 2332 Yes No
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Rate Cap Amortization Schedule 2325 +
12

Yes No

Payment Changes
(Keep Payment the
Same When Rate
Changes)

N/A N/A No Yes

Payment Changes
(Adjust the Payment
When Rate Changes)

N/A N/A No Yes

Original Loan Amount Borrower Information 21017 Yes No

Current Balance Borrower Information 21017 Yes No

Variable Interest
Calculation

Manual N/A No Yes

Payment Borrower Information 527 Yes No

Term Borrower Information 13 Yes No

Balloon Due Borrower Information > Due3190 Yes No

Balloon Amount GFE > Summary of Loan 528 Yes No

Vendor Information
for Haz Ins

Agent List 450 No Yes

Vendor Information
for County Taxes

Agent List 12968 No No

Vendor Information
for City Taxes

Agent List (User Defined) N/A No No

Vendor Information
for Mortgage
Insurance

Agent List 460 No No

.



Part

IX
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9 The Borrower's Screen

9.1 Main Borrower's Screen

 Main Borrower's Screen

The Main Borrower's Screen can be accessed from the main program in two different ways.  
1. Click on Review>Loan>Review 
2.  Enter (or click List to scroll through he list of accounts) the account number you wish to

view/edit; 

OR 

1. Click on F4 
2. Enter (or click List to scroll through the the list of accounts) the account number you wish to

view/edit.  

 
· The Borrower Screen

 
Below you will see the Borrower's Screen.  This screen contains information specific to this
borrower  

 
Listed below you will find brief summaries of each of the item's on this screen. 
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· The Borrower Screen Tool Bar
 
Located at the top, this menu system will allow you to modify this account. A full listing of this tool
bar can be viewed in the Borrower's   Screen Tool Bar section.
 
 
· Escrow Type
 
The type of escrow that is attached to this account will be listed here.  If it only requires standard
escrow the window will have standard  typed in this field.  If the account requires only Maintenance
Escrow, then it will read Maintenance.  If both types of escrow are required, then it will read STD &
Maintenance.
 
· STD Escrow
 
This shows the required Standard Escrow Payment to be accepted with each payment.
 
· Maint. Escrow
 
Shows the required Maintenance Fee Payment to be accepted with each payment.  Note: This
may vary according to the balance of the maintenance fee account verses the cap that was set.
For more information refer to Escrow Maintenance Overview
 
First Payment
 
Shows the date the first payment is or was due.
 
Next Payment
 
Shows the next due date for this account.
 
Payments Behind
 
If the account is behind on payments you will see a number listed here that shows the number of
payments this borrower has missed. Note: This is a current figure not cumulative.
 
Suspense Balance
 
If you utilize the suspense account the current suspense balance will be shown here.
 
Last Coupon
 
The date of the last coupon printed that was sent to the borrower. (example 12 coupons printed
the last coupon date was 7/15/2006 this borrower needs a new coupon box for his next payment)
 
Insurance Due
 
The date when Hazard Insurance is due.
 
Address/Collateral
 
This is the Collateral description or Address of the Collateral that is listed on this account.
 
City State Zip
 
Continuation of the Address/Collateral and lists the City, State, and Zip of the collateral.
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Type
 
Shows the type of account, payment period, and interest basis.
 
Amount
 
The original balance of the account.
 
Balance
 
Shows the current balance on this account.
 
Rate
 
The interest rate that is charged to this account.
 
Balloon Due
 
If the account is a Balloon type account, then the number listed here is the payment that the
balloon payment would be due on.
 
 Payment
 
The regular scheduled payment.
 
Principal
 
The principal balance that will be paid on a Balloon type account
 
Term
 
The term that this account is based on.
 
Final Payment
 
If the account is a Balloon type account then the balloon payment will be listed here.
 
Comment
 
This is an operator definable and changeable field.  It is intended for use as a simple on-screen
reminder to the operator for some fact about the loan.  It is not to be confused with or used to
replace the Contact History Log for chasing accounts.  This field can hold up to 34 characters and
all changes are recorded. This can be used for In-House account number, or any other misc.
information.
 
 Credit
 
A cumulative count that starts at the beginning of the loan (or the start of transactions within this
program).  Listed below is a breakdown of each of the items listed.
 
 Curr.   The number of payments that were made on time.
   <30     The number of payments that were past the grace period but under the 30-day mark.
     30     The number of payments that were made from 30 to 59 days past the grace period.
     60     The number of payments that were made from 60 to 89 days past the grace period.
     90     The number of payments that were made from 90 to 119 days past the grace period.
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 >120     The number of payments that were made over 120-days past the grace period.
 
At the bottom of the screen is a listing of the last 5 transactions.  The following indicates
what each column means:
 
TX Date
 
Transaction Date =The date of the transaction
 
HP
 
How Paid = What this transaction is and/or how it was paid.

See Payment Codes for more information about the How Paid codes.

Pay't Paid
 
 Payment Paid = Which payment was paid (due date) with this transaction
 
BTW
 
Days Between Payments 
 
This will be shown for Interest Bearing/Simple Interest loans and is the number of days since the
last payment.  If the account is a Regular Amortizing account, this column will not be shown.
 
Amt Recd
 
The amount of funds that was received on this transaction
 
Escrow
 
The amount of Escrow that was removed from the payment and applied to the Escrow account.
 
Interest
 
The amount of interest that was paid from this payment.
 
Please note that on Regular Amortizing loans this figure will show the amount of interest that was
due on this payment.  If the payment does not cover the interest due you will see a negative figure
in the "Principal" column.
 
Principal
 
The amount of funds that was applied to the principal balance
 
Balance
 
The "running" total of the principal balance.
 
Fees
 
This reflects any fees that were incurred on this transaction
 
Example:  Late Fees, NSF Fees
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Past Due Int.
 
This column contains information that pertains only to Interest Bearing or Simple Interest Loans
Only.  It is the Past Due Interest that has not been paid by the borrower.
 
Total Past Due
 
The amount of past due late fees, NSF fees and Past due interest (Interest Bearing or Simple
Interest Loans Only) that have not been paid by the borrower.
 

 

9.2 Borrower's Tool Bar

Borrower's Tool Bar
 

 

When you first enter a borrower's account you will notice at the top a Tool Bar.  Listed below is a
breakdown of this tool bar going from left to right.

 

 
Please note that the sections listed below marked with a Red " # " are secured areas

and may be "locked" down by the program Administrator.  For more information regarding
system security please review our Program Security section.

 
Post
 
This section handles payment processing.
 
Post To Loan
 
To accept a payment for the regular payment amount or a larger payment click on Post to Loan.
 
For regular payments simply make sure that the date is the date you wish to enter the payment,
check the amount and correct if necessary, and select the type of payment accepted (i.e. Check,
Cash, Money Order, etc.).  Examples of different types of payments and how to handle them can
be reviewed at our Types of Payments section.  For full details on how to process a payment
please review:  Regular Payments
 
The program will process a payment in the following manner.
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Amount Received
 
– Escrow
 – Interest
 
– Interest Short (if Interest Bearing or Simple Interest Loans)
 
– Current Past Due
 
– Principal
 
– Other Past Due Fees
 
– Other Fees
 
Post To Suspense
 
The suspense account can be referred to as a holding area for each account.  Utilize the
Suspense account when accepting short or multiple payments.  
 
Short payments can be placed into the suspense account until the customer makes up the rest of
the payment.
 
Multiple payments can be placed into the suspense account and then transferred out in single
payments.
 
Transfer From Suspense > Post to Loan*
 
When making a payment from the suspense account simply click on Transfer from Suspense and
enter the date and dollar amount you wish to transfer from the suspense account to make the
payment.

Transfer From Suspense > Post to Fees**

This is identical to Transfer from Suspense > Post to Loan above, except in that the amount
entered will be transferred from suspense to current and past due fees instead of a normal
payment.

Transfer From Suspense > Post to Escrow**

This is identical to Transfer from Suspense > Post to Loan above, except in that the amount
entered will be transferred from suspense to the escrow account instead of a normal payment.
 
Debit Suspense
 
Debiting the suspense account removes money from the account and out of the program.  This
could be used when an amount entered into the suspense account is invalid or after a payoff is
received there remains a suspense account balance.

See Utilizing the Suspense Account for more information about these functions.

Post to Fees
 
Use this function to record fee payments. This is identical to recording a regular payment, except
that the amount entered is applied to current and past due fees.
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*This function is listed as Transfer From Suspense in versions prior to 2.4.0.8361.
**This function is not available in versions prior to 2.4.0.8361.

 History 
Contact
 
This function serves multiple purposes. The contact log's primary function is to serve as a log of
notes between your company and your customer.  It also keeps a log of modifications to the
account (ie. Manual Balance Modifications, Interest rate and Payment changes, and many more.) 
Selecting to View the account's history, selecting to view the contact log, and then pressing the
Print button can print this log. 
 
Interest
 
This function shows the interest accrual history for the account.  Each month makes an entry into
this log. The entries list the Month/Year, Accrual of Interest, Interest Paid, and the Accrual
Balance. Selecting Print at the bottom of the screen can print this. 
 
 
View
 
When you click on View the program inquires if you wish to view this account history by a specific
year.  If you choose to view it by a year then you will only see that year's information.  If you
answer No then you will see the full history on this account.  After you answer the question a
window will open with three tabs; Payment, Suspense, and Contact.
 
             Payment
 
This tab will show the payment history and is broken down in the same manner as the partial
history that you see on the bottom of the borrower's screen.  You can print this by selecting Print at
the bottom of the screen.  Note:  Posting Errors (PE) will not be printed.
 
            Contact
 
This tab will show the contact log and details each manual modification and contact entry that
pertains to this account. On the screen you will see the comment and the date that the comment
was entered into this account. You can print this by selecting Print at the bottom of the screen.
Note:  Posting Errors (PE) will not be printed.
 
            Suspense
 
This tab will show the suspense account history. It is broken down by the Date of transaction, what
activity was done, the dollar amount transferred, and the balance. You can print this by selecting
Print at the bottom of the screen.
 
           Maint.
 
This tab will display the Escrow Maintenance Fee account history.This screen is broken down by
the Date, Activity, Amount, and Balance.  It includes ALL transactions both coming into and going
out of the Escrow Maintenance Fee Account. If you wish to have a printout of this history, simply
choose Print at the bottom of the screen.
 
            Escrow
 
This tab will display the Escrow account history. This is not to be used as an Escrow Analysis; it is
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simply the transaction history. This screen is broken down by the Date, Activity, Amount, and
Balance. It includes ALL transactions both coming into and going out of the Escrow Maintenance
Fee Account. If you wish to have a printout of this history, simply choose Print at the bottom of the
screen. 
 
Print
 
This function prints an account's Payment History and Contact History. Please note that this can
be selected to run by a specific year or by the account's entirety.
Void
 
 
Incorrect Posting
 
Allows you to void a payment from the transaction log.  When you select this you will void the
LAST transaction from the log.  This will not remove the entry from this account but it will place a
"PE" (Posting Error) in the "HP" (How Paid) column.  It will zero out everything but the amount
received.
NSF Check
 
When you receive a Non Sufficient Funds check you can remove that payment from the account
by selecting this option. If you have setup a fee for returned checks (This can be set in the
System/Operator screen) then the fee will automatically be added to this account.  When you
select this function you must enter the Date you received the check, the Check Number, the
Amount of the check, and the Number of payments the check paid.
Dates
This tab will allow you to update date changes as well as allow you to view miscellanous data.
                 
Important Due Dates
Within the 'Important Dates' Function, you are able to flag accounts with up to 16 key dates. 
Important dates are such things as when taxes or insurance are next due to be paid on an
account, when an interest rate needs to be changed, when a balloon note is due, etc.  This
includes 5 User Defined dates and 4 Other Escrow items along with the standard items.

 
Change 
This menu allows you to change various aspects of this account. Please note that many of the
options listed in this menu are protected by system security.  If you wish to find out more about
system security please review our Program Security  section.  
 
General
 
General Information
 
Contains the Account Name, Loan Class Code, and Loan Comment
 
Borrowers 
 
Contains all borrowers listed on this account.  There can be up to 6 borrowers and co-borrowers
on a single account.
 
Other Contacts
 
Can be used for alternate contacts such as neighbors, work, family, etc.
 
Appraisal/Collateral 
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Used to track the dollar amount and detailed description of the collateral.  We have also added a
Site Id field. This would be used to track a county ID or location ID on an account, if so required.
 
Credit Information 
 
Lists the current credit information on an account.  Please refer to our Account Credit Reporting
Information section for more details.
 
Defined Fields
 
Also known as User Defined Fields.  There are five different groups of fields, these are:  Date,
Decimal, Number, Memo, and Alpha/Numeric.                  
 
Financial 
 
Change Late Fee 
 
Allows you to change the number of permitted days the account can be late, the fee (either by the
percent of payment or dollar amount), or to choose not to charge a late fee at all.
 
Rate/Payment  
 
Allows you to change the interest rate that the program charges per payment period and the
payment that is due at the end of the period. 
 
Annual Interest Basis 
 
This section only pertains to Simple Interest and Interest Bearing accounts. You can change the
basis from 360 to 365 and vice versa.
 
Change Service Fee 
 
The service fee your company charges to the customer for servicing the account.  This charge is
applied at the end of each payment period.
 
Pre-Payment Penalty 
 
Allows your company to charge a percentage of the balance if a customer pays off the account
early.  On this screen you can set the percentage and the date for the penalty.  If the customer
pays off the account before the date that is set you will see in the payoff screen a Pre-Payment
Penalty that will be added to the payoff amount.
 
Adjust Fees 

 
Add To Fees 
 
Allows you to add custom fees to an account manually.  You can setup these custom fees by
accessing the Custom Fees function on the main program screen under the System, Parameter
Options section.  Examples of custom fees are:  Legal Fees, Processing Fees, and Appraisal Fee.
 
Reverse Fees
 
Allows you to reverse a Returned Check Fee, a Late Fee, or a Borrower Fee.  A Borrower Fee is a
fee, which was added in the previous section (Add To Fees).
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Adjust Balance 

 
Add To Balance 
 
Allows you to add money directly to the balance of the account. Once selected you will have to
enter the date, the amount of money you wish to add to the balance and the reason.  Please note
that the reason box is a "drop down" box that lists the codes you have stored in your Custom Fees.
You can setup these custom fees by accessing the Custom Fees function on the main program
screen under the System, Parameter Options section.
 
Decrease Balance 
 Allows you to manually decrease the balance of a loan.  There are multiple reasons for this, one
common reason is referred to as a Principal Only payment.  Once selected you will have to enter
the date, the amount of money you wish to decrease the balance by and the reason.  Please note
that the reason box is a "drop down" box that lists the codes you have stored in your Custom Fees.
You can setup these custom fees by accessing the Custom Fees function on the main program
screen under the System, Parameter Options section.
 
Prior Interest 
 
Incurred    Allows you to enter Prepaid interest that incurred before the account was entered into
the program.
 
Paid    Allows you to enter Prepaid interest that was paid before the account was entered into the
program.
 
 
Investor Accounts
 
Allows you to attach investor accounts to this account.  Please refer to our Investor Relationship
section for more details on this subject.
 
 
Close/Reopen Account 
 
Allows you to close and reopen an account.  If the account is closed it will not appear on any
reports unless specified to do so.  Please note that if the account is closed it will be included in the
1098 printing, I.R.S. file generation, and the Credit Bureau file generation process.  If your
company wishes to close out an account it is advised that this be done after year-end closeout and
Tax filing has been completed, to make sure there are no problems.

Payoff 
 
This function will calculate a payoff based on current data.  To review more information on this
function please go to our Payoff section.
 
Bring Current
 
If the account is past due and you click on this function the program will calculate the amount
required to bring this account current.  This includes all past due payments that were not paid, all
past due fees, and any escrow that would be paid for each payment that is behind.  If there are any
funds in the suspense account it will be subtracted before the amount is displayed.
 
You have two options on this screen.  You can print a Bring Current Letter or Exit.
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Escrow
 
This menu section deals with the Escrow and Escrow Maintenance Fee. You can review more
information on Escrows in our Escrow section.
 
Standard Escrow Items 

Analysis
This provides an extensive analysis screen and letter to the customer utilizing payments made for
the prior 12 months.  This will then project a new escrow payment as needed to meet future needs
while holding a reserve (if so setup).  When setting up NEW accounts you can begin immediately
analyzing the account's escrow status, HOWEVER, payments just disbursed or previously
disbursed (e.g. yearly taxes) NEED TO BE INPUTTED AS PAYMENTS with these payments
added to the 'actual' balance for new account input.
Deducting Payments

To post an Escrow payment click on the Escrow menu and select the type of payment you wish to
post.  The program will then ask you for a date, amount, and check number.  After you have
entered in the appropriate information click OK.
 
Overage/Adjust Balance
 
If for any reason you wish to manually adjust the balance of an Escrow account you can do so.
From Standard Escrow Items select Overage/Adjust Balance; enter the Date, Amount, and
Reason.  After you have entered in the appropriate information click OK.
 
Change Escrow Required
 If the account currently requires escrow and you select this option the program will ask you if
escrow is still required.  You have three options; Yes, No, and Cancel.  If you click Yes; the
program will then open a window allowing you to modify the escrow payment.  If you click No, the
program will then remove the escrow payment and mark the account as Non Escrow.  If you click
Cancel it will not make any changes. If the account currently does not require escrow and you
select this option the program will ask you for a payment amount.  Enter the appropriate amount
and click OK.
  
 Displaying Transactions
 
The entire escrow account payment history may be displayed using this option.  You may choose
displaying this history by topic; hazard insurance, taxes, or by date (all historical data).  When the
topic choice has been made, the appropriate history is displayed showing the date, check number,
amount, and the topic for which the check was written. 
 Payment and Dates
This screen allows you to see the payment dates and frequency of the required deductions at a
glance.

 
Escrow Maintenance Fee Menu
 
Change Payment/Cap Amount
 
This item will allow you to modify the fee and cap that is or needs to be set on an account.  When
you click on it a new window will open that displays the "old" fee and cap that are currently set.  At
the bottom of this window there are two boxes.  If you wish to modify the fee and cap that is
currently set just enter the information in the two boxes and choose OK.
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This allows you to remove money from the Escrow Maintenance Fee account.  After clicking on
the Deduction menu item a new window will open allowing you to enter the date of the transaction,
the amount, and the reason.  If you wish to reverse a transaction simply enter the exact
information of the transaction that you wish to reverse and click on the "Check to INCREASE
Maintenance Fee Balance" box.
 
View Deductions

When you click on View Deductions a window will open detailing all transactions coming into and
out of the Escrow Maintenance Fee Account.  This information can also be seen in the History,
View menu items.

 Reporting Options
The Reporting Options allow you to change, add or remove information

 Add/Modify  
This tab allows you to change/remove ACH Borrower, Credit Reporting, IRS 1098 Printing options,
No Late Notice, Agency Reporting Number information.

Change
This tab allows you to change existing information in the the Add/Modify tab.

Review
This tab allows you to review several different aspects of your account such as, 1098 status,
Points Paid, Prior interest Paid, ACH Borrower status, etc. 

Summary Report
This tab will print out a summary report of the Reporting Options and the values stored for each
variable.    

 
Letters

 
This menu allows you to print late notices, custom letters, as well as a Bring Current notice.
 
 Custom
 
These are custom letters that you have defined in the program.  Please refer to the following topics
for instructions on how to setup the custom letters and how to customize provided letters.
 
o Setting Custom Letter Names 
o Customizing Letters 
 
 Notices
 
The notices menu allows you to manually print three notices.  Examples of each notice can be
seen by clicking on the examples below.  Please note that if you have customized these letters
they may appear different that those shown below.  You can customize these notices, please refer
to CUSTOMIZING LETTERS.
 
o Notice 1 
 
o Notice 2 
 o Notice 3 
 
 
Bring Current
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Prints a Bring Current letter.  An example can be seen through the link below.
 
o 10-DAY BRING CURRENT CERTIFIED LETTER 
 

9.2.1 Posting Overview

Posting Overview
1. The first check performed is to determine if the payment was posted after the grace period
established during the initial entry of the loan.  If the payment was late, then the late fee is
established, posted to the FEES column, and then added to the PAST DUE column amount. 
Nothing is subtracted from the amount received at this point.
 
2. The type of loan amortization determines the second check performed.  If the loan is Interest
Bearing/Simple Interest:
 
     -The escrow payment is deducted
 
     -Then a check is made for any interest short from previous payments.  If there is, then as much
of this amount as possible is subtracted from the payment received.
 
     -The remaining portion of the payment is then applied to the remaining calculations below.
 
      If the loan is Regular Amortizing:
 
      -Go to Step 3.
 
3.  Next is the calculation of the interest due. The interest is then subtracted from the payment
received and posted against the interest column.  The remaining amount is applied to the next
process. 
 
4.  After the interest has been deducted, the amount of principal due on this payment is calculated,
subtracted from the amount  received, and posted to the principal column.
 
5.  For Regular Amortizing loans, if there is an amount remaining AND the account requires an
escrow, the amount of the established escrow is deducted from the amount remaining.  If an
account requires an escrow payment and the amount remaining is not enough to cover this escrow
payment, then the program will reject the amount posted and the operator must post the entire
payment to the suspense account.
 
6.  If there is an amount remaining after any escrow is deducted, the program checks for any past
due fees. If there is a past due fee as much of the amount remaining is applied against the past
due until this amount has been reduced to $0.00.
 
7. The final check is for any amount remaining at this point in the posting process. If there is an
amount remaining, then the program flags the operator if the extra amount should be posted to `1)
Principal', `2) Suspense', or `3) Entire amount to suspense'. If `1) principal' is selected, the new
principal will be re-posted to the principal column.  If `2) Suspense' is selected, the extra amount is
posted to the suspense account.  If `3) Entire amount to suspense' is selected, the entire payment
received will be posted to the suspense account.  This gives the operator the capability of bringing
an overdue account current over a period of time with payments greater than the amount due.
 
8. The final process is to subtract the principal from the old balance and establish the new
balance.
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Once these processes are completed, the operator has the option of printing a receipt letter
showing all the postings for the amount received to be provided to the borrower.  Then the review
display screen is updated, and the operator is returned to the full display of the Borrower's Screen.

If you wish to change the order in which the payment is posted such as Late fees first,
Interest and then Principle.  You need to do the following before you post the payment
    -Go to System/Parameter Options/Payment Posting Order
   -Select the process you want by moving the items up or down in the menu box
NOTE: If this is a one time payment posting be sure to go back and reset the posting to the
original order
 

9.2.2 Regular Payments

Regular Payments

 
 This section will cover a few types of payments that are regularly inquired about.  These are not

the only types of payments that can be entered into your program.

Regular payments can be entered into the program in three ways.

 
· Normal Payments
 

 
 From the main program screen: 

1. Click on Review>Post (This can also be done by pressing F2 on your keyboard)>Quick
Post

2. Enter the account number or click List and select the accoun
3. Click Post> Post to Loan (This can also be done by pressing F2 on your keyboard) 

The next screen prompts for a date (Today's date is the default) you can change this date if
you need to

4. The  Amount is the payment that you have received (the normal payment is the default) 
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 NOTE: If they are paying 2 or more normal payments you will want to post as a suspense
transfer Utilizing The Suspense Account if you want to advance the next due date.
5. The Method is the type of instrument of the payment. Below is a breakdown of what the
codes mean:
 

Code Meaning
CA Paid with cash
CH Paid with check
MO Paid with money order
VI Paid with Visa card
MC Paid with MasterCard
AM Paid with American Express Card
AC Paid with ACH transaction
OT Other payment source as defined by user
RC NSF or returned check
PE Posting Error
ST Paid with suspense transfer
SF* Suspense transfer to fees
SE* Suspense transfer to escrow account
PF* Fee payment
PP Pre-paid interest paid at closing
PC Credit interest allocated at closing
BC Bring current transaction

  
*Not available in versions prior to 2.4.0.8361
     
 
6. Press OK or OK-Receipt

 
· Larger Than Normal Payment
 

This will cover Large payments that will be entered in as a single payment
 

This can be posted the same way as a normal payment 
 
         After you post the payment and click OK, the program will post the appropriate interest, fees,

principal, and any other amounts due.  It will then let you know if there is any money left over
via a pop up window. 

         This window will ask you what you want to do with the overage.  Your options are:
 

1. Overage to Principle
 
2. Overage to Suspense Account
 
3. This is a Sub-Investor Loan – Do Nothing
  Select the appropriate option
4. Then select ok.

· Shorter Than Normal Payment
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This will cover Short payments that will be entered in as a single payment
 

This can be posted the same way as a normal payment 
 
         After you post the payment and click OK, the program will inform you that you are trying to

post a payment that is less than the normal payment.  

If you click YES a new screen will appear asking how you want this money distributed.  

 
When you click on OK, you will then see how the money was posted in the payment view on
the Borrowers screen
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9.2.3 Other Types of Payments

Other Types of Payments
· Principal Only Payment

 
This section will cover posting a payment in which all of the funds received will go directly to
principal.

 1. From the Borrower's screen click Change>Adjust Balance> Decrease Balance
You will see the following screen

 
2. Enter the Date, Amount, and Reason. Note: The reasons need to be set in the Custom Fee

section prior to posting this type of transaction.
3. Click OK
You will then see how the money was posted in the payment view on the Borrowers screen

· Defer Payments Non-Escrow Account

This section will cover posting a payment that will affect the Next Due field but will not affect
the balance or interest.

1. Go to the borrower's screen that you want to defer
2. Make a note of the Next Payment date, P&I amount, and Term .
3. Go to Change>Financial>Rate/Payment  you will see the next screen click Yes

4. Change both to 0 (zero) Note: You are now back to the Borrower's screen
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5. Post the number of payments you need to defer by going to Post>Post to loan. (the amount
field should be $0.00)

    until the next due date is correct.
6. Go back into Change>Financial>Term and ADD the number of payments you deferred. 
Example: beginning term was 120 months you deferred 5 payments the new term would be
125 months.
7. Go back into Change>Financial>Rate/Payment and put the P&I and Rate that was on the

loan before you started this process.  

· Defer Payments Escrow Account
We do not suggest that you defer an escrow account because the taxes or insurance
will be short
But you can do it and this is how you would defer an escrow account.

 1. Calculate the amount of Escrow you need to collect from the borrower to ensure that the
taxes and insurance will be paid

2. Make a note of the Next Payment date, P&I amount, Term  and Escrow amount.
3. Go to Change>Financial>Rate/Payment  you will see the next screen click Yes

4. Change both to 0 (zero) Note: You are now back to the Borrower's screen
5. Go to Escrow>Standard Escrow Item>Change Escrow Payment, you will see the next

screen, click Yes

5. Change the payment amount to 0 (zero)
6. Post the number of payments you need to defer by going to Post>Post to loan. (the amount

field should be $0.00)
    until the next due date is correct.
7. Go back into Change>Financial>Term and ADD the number of payments you deferred. 

Example: beginning term was 120 months you deferred 5 payments the new term would be
125 months.

8. Go back into Change>Financial>Rate/Payment and put the P&I and Rate that was on the
loan before you started this process.  

9. Go back into Escrow>Standard Escrow Item>Change Escrow Payment, Click Yes on the Is
the Escrow still required and put the Escrow payment amount back in.

If you have collected the Escrow needed up front you can now post the amount directly to the
Escrow portion of the account.

1. Go to Escrow>Standard Escrow Item>Overage/Adjust Balance, you will seen the next
screen click OK
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 You will see the next screen

2. In the Amount field enter the amount of the Escrow due that you required from the
borrower 

3. Click CHECK TO INCREASE ESCROW BALANCE, because you want to add this to the
current escrow balance

4. Reason (you only have a few spaces to put your reason so you will need to keep it short)
Example: Deferred amt. or pmt defer cost etc.

5.  Click OK, you do not have to enter the Escrow Next Payment Date.  

  

9.2.4 Utilizing The Suspense Account

Utilizing The Suspense Account
The suspense account is basically a holding area for funds.  This area can be used when posting
multiple payments, holding partial payments until the customer brings in the rest of the payment,
holding extra funds from larger than normal payments, etc. To use the suspense account please see
the directions below:

· Posting funds into the Suspense Account
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1. From the Borrower screen, click on Post.
2. Click Post to Suspense.
3. Enter the date you wish to show the posting.
4. Enter the amount you wish to post.
5. Click OK.
 
· Transferring funds from the Suspense Account as a payment
 
1. From the Borrower screen click Post.
2. Click Transfer from Suspense.
3. Click Post to Loan. (Skip this step if not using version 2.4.0.8361 or later.)
4. Enter the date you wish to show the posting.
5. Enter the amount you wish to transfer.
6. Click OK or OK - Receipt.

· Transferring funds from the Suspense Account directly to Past Due Fees*

1. From the Borrower screen, click Post.
2. Click Transfer from Suspense.
3. Click Post to Fees.
4. Enter the date you wish to show the posting.
5. Enter the amount you wish to transfer.
6. Click OK.

· Transferring funds from the Suspense Account directly to the Escrow Account*

1. From the Borrower screen, click Post.
2. Click Transfer from Suspense.
3. Click Post to Escrow.
4. Enter the date you wish to show the posting.
5. Enter the amount you wish to transfer.
6. Click OK.

· Removing funds from the Suspense Account and from the Borrower's account
 
1. From the Borrower screen click Post. 
2. Click Debit Suspense.
3. Enter the date you wish to show the posting.
4. Enter the amount you wish to remove.
5. Click OK.
 
· Receiving overage into the Suspense Account
 
After receiving a payment that is larger than the required funds (principal + escrow + interest + fees),
a window will appear inquiring what to do with the extra funds.  If Overage to Suspense is clicked,
the extra funds will be posted to the suspense account.
 

*Not available in versions prior to 2.4.0.8361
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9.2.5 Posting Directly to Past Due Fees

Post to Fees

New in version 2.4.0.8361, payments can be posted directly to past due fees. Follow the
instructions below to post a fee payment:

1. From the Borrower screen, click Post.
2. Click Post to Fees. 
3. Type the amount being posted. Note: The default amount is the total amount of fees due.
4. Click OK.

The suspense account can also be used to pay fees. See Utilizing the Suspense Account for
more information.

Note: This function is not available in versions prior to 2.4.0.8361.

9.2.6 Reverse Bad Check Fee

Reverse Bad Check Fee
 Just as there might be a time when you want to refund the late fee, there might be a time

when you will want to refund the charge assessed for a returned check.  This is the choice
for that action.  

WARNING!  If you wish to reverse the bad check charge for several payments, please
note the reversal will be deducted from the total shown on the LAST line.

 

9.2.7 Contact Log

 Contact Log

ENTER & VIEW
 
 
The Contact Log feature of the program allows you to enter any conversations with the borrower,
relevant facts or happenings on the account that should be recorded, and any other uses the user
deems appropriate.  It is a simple text file which can be viewed later in the History Screen under
Contact.  The Contact Log also records certain things automatically such as when each past due
notice or payoff letter is printed, when a rate or payment was changed, and when an insufficient
check was received and a payment is reversed.  This automatic feature cannot be turned off since
it is for security and auditing purposes.
 
This option now indicates the following options:
 
-Contact  this allows you to enter a contact.  Simply type information in the field provided until the
program stops you then hit Enter. Should you be in the middle of a word, simply backspace hit
Enter and type the word on the next line.
 Warning: Once you hit Enter, the text CANNOT be altered!  Use your Arrow Keys to review text
prior to hitting Enter.
-View  this allows you to view a contact for either all contacts or those for a certain year.  There is
no editing allowed.
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-Print  this will immediately print the entire contact log.
 

9.2.8 Contact Activity

Contact Activity
 

This selection is the 'chase' or 'comment' log for this particular loan.  The previous comments are
shown on the screen and you can enter your next comment.  Each comment is associated with
today's date displayed automatically; however can be changed.  The comment itself can be no
longer than 65 characters.  If more than 65 characters are needed, make two separate entries for
the same date. Choose OK to input each comment line.  Continue entering comments on each
blank line provided until finished then choose CANCEL.
 
 
Not all comments need to be entered by the operator.  Certain operations within your loan
servicing program automatically place comments in the log.  Some examples of the automatic
comments are; all past due letters are listed when they are printed, when a rate and payment
change are made, when an account is closed and reopened.  Thus, you have an activity track
record not totally dependent upon human action for comments.

9.2.9 Changing Account Information

Changing Account Information

In this section we will discuss the changing of a borrower's account information.  You will find links
to detailed information on certain subjects.  You can access this section of your program by
entering an account and clicking on the Change menu Item.

 

 
Now that you know how to access the Change menu items we will briefly go over each section.
 
 
Please note that the sections marked with a " # " are secured areas and may be "locked"
down by the program Administrator.  For more information regarding system security
please review our security section.

CHANGE
 
This menu allows you to change various aspects of this account.  Please note that many of the
options listed in this menu are protected by system security.  If you wish to find out more about
system security please review our Program Security  section.  
 
GENERAL
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General Information
 
Contains the Account Name, Loan Class Code, and Loan Comment
 
Borrowers 
 
Contains all borrowers listed on this account.  There can be up to 6 borrowers and co-borrowers
on a single account.
 
Other Contacts
 
Can be used for alternate contacts such as neighbors, work, family, etc.
 
Appraisal/Collateral 
 
Used to track the dollar amount and detailed description of the collateral.  We have also added a
Site Id field.  This would be used to track a county ID or location ID on an account, if so required.
 
Credit Information 
 
Lists the current credit information on an account.  Please refer to our Account Credit Reporting
Information section for more details.
 
Defined Fields
 
Also known as User Defined Fields.  There are five different groups of fields, these are:  Date,
Decimal, Number, Memo, and Alpha/Numeric.  

FINANCIAL 
 
Change Late Fee 
 
Allows you to change the number of permitted days the account can be late, the fee (either by the
percent of payment or dollar amount), or to choose not to charge a late fee at all.
 
Rate/Payment 
 
Allows you to change the interest rate that the program charges per payment period and the
payment that is due at the end of the period. 
 
Annual Interest Basis 
 
This section only pertains to Simple Interest and Interest Bearing accounts.  You can change the
basis from 360 to 365 and vice versa.
 
Change Service Fee 
 
The service fee your company charges to the customer for servicing the account.  This charge is
applied at the end of each payment period.
 
Pre-Payment Penalty 
 
Allows your company to charge a percentage of the balance if a customer pays off the account
early.  On this screen you can set the percentage and the date for the penalty.  If the customer
pays off the account before the date that is set you will see in the payoff screen a Pre-Payment
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Penalty that will be added to the payoff amount.
 
ADJUST FEES 
 
Add To Fees 
 
Allows you to add custom fees to an account manually.  You can setup these custom fees by
accessing the Custom Fees function on the main program screen under the System, Parameter
Options section.  Examples of custom fees are:  Legal Fees, Processing Fees, and Appraisal Fee.
 
Reverse Fees
 
Allows you to reverse a Returned Check Fee, a Late Fee, or a Borrower Fee.  A Borrower Fee is a
fee, which was added in the previous section (Add To Fees).
 
ADJUST BALANCE 
 
Add To Balance 
 
Allows you to add money directly to the balance of the account.  Once selected you will have to
enter the date, the amount of money you wish to add to the balance and the reason.  Please note
that the reason box is a "drop down" box that lists the codes you have stored in your Custom Fees.
You can setup these custom fees by accessing the Custom Fees function on the main program
screen under the System, Parameter Options section.
 
Decrease Balance 
 
Allows you to manually decrease the balance of a loan.  There are multiple reasons for this, one
common reason is referred to as a Principal Only payment.  Once selected you will have to enter
the date, the amount of money you wish to decrease the balance by and the reason.  Please note
that the reason box is a "drop down" box that lists the codes you have stored in your Custom Fees.
You can setup these custom fees by accessing the Custom Fees function on the main program
screen under the System, Parameter Options section.
 
PRIOR INTEREST 
 
Incurred  Allows you to enter Prepaid interest that incurred before the account was entered into
the program.
 
Paid  Allows you to enter Prepaid interest that was paid before the account was entered into the
program.
 
 
INVESTOR ACCOUNTS
 
Allows you to attach investor accounts to this account.  Please refer to our Investor Relationship
section for more details on this subject.
 
 
LOAN POSITION

Allows the loan position (1st mortgage, 2nd mortgage, etc) to be set or changed. 

DUE DATE DAY

Allows the day of the month that the loan is due to be changed. 
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NOTE: Changing this may cause a loss or credit of accrued interest.
NOTE: Changing the day to the 31st may cause errors in some older versions of Trakker
during months that do not have 31 days.

CLOSE/REOPEN ACCOUNT 
 
Allows you to close and reopen an account.  If the account is closed it will not appear on any
reports unless specified to do so.  Please note that if the account is closed it will not be included in
the 1098 printing, I.R.S. file generation, nor the Credit Bureau file generation process.  If your
company wishes to close out an account it is advised that this be done after year-end closeout and
Tax filing has been completed, to make sure there are no problems.

9.2.10 Changing Loan Balance & Past Due Fees

Changing Loan Balance & Past Due Fees

· PREPARING FOR CHANGING A LOAN'S BALANCE, ADDING FEES, ETC.
 
To properly monitor reasons a loan's balance is being changed whether for fees, extra principal
payments, etc., the user needs to define these "reasons".  Go to System/Options and choose
Custom Fees.  Here you can put in any definition you wish, such as:
 

-Attorney Fees – Balance
-Insurance Fees – Balance
-Maintenance Fees – Balance
-Grant Reduction
-Extra Principal Payment by Borrower

Likewise, may be have some of the following for adding to the Past due Fees column on the
Borrower screen:

-Attorney Fees – Fees
-Insurance Fees – Fees
-Maintenance Fees – Fees

 
Note: The similarity between the two groups but the distinction between Balance and Fees.  Just
a suggestion, since these definitions will also show up in the Contact Log (with the user's name)
as an additional audit trail!

Note: Before you can make changes to loan balances or to borrowers fees you must
define users and passwords. Please refer to Program Security  for more information on
defining user names and passwords.

· PERFORMING TRANSACTIONS
 
Changes to the Loan Balance:

-Bring up the borrower's account
-Choose Change and Adjust Balance
-Choose the transaction desired, noting differences closely
-Enter the date and dollar amount
-Choose the down arrow in the Fee Type field and choose the appropriate reason
-Choose OK.
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Changes to the Borrower Fees
-Bring up the borrowers account
-Choose Change and Adjust Fees
-Choose Add to Fees
-Enter the date and the dollar amount
-Choose the down arrow in the Fee Type field and choose the appropriate reason 
-Choose OK

· INTEREST CALCULATIONS ON LOAN BALANCE CHANGES
 
For Regular Amortizing loans, the loan interest is calculated on the new balance for the next
payment made.  For Interest Bearing/Simple Interest loans, interest is still calculated from the
date of the last payment through the day before the next payment is made.  However, your
program will recognize balance changes and, thus, change the daily interest calculated
accordingly.
 

· REVERSING BALANCE CHANGES FOR LOAN AND PAST DUE FEES
For reversing past due fees previously entered:

-From the borrower's screen choose Change, Adjust Fees, Reverse Fees, input amount, choose
the type of fee you wish to reverse, and then choose OK
 
For reversing balance changes previously entered:
 
-From the borrower's screen choose Void and Incorrect Posting.

9.2.11 Account Credit Reporting Information

 Account Credit Reporting Information
 

 

In this section we will discuss the steps to modify an accounts credit-reporting file.  Please note
that the information that is sent to the credit bureau is encrypted in your programs internal files at
all times.  Additional security has been put in place to guarantee that a trail is in place to any
modifications to an accounts setup.  You can obtain more information to this by reading the 
Program Security section(s).
 

 
There has been a section added to the borrowers screen relating to the credit reporting
information.  This information is simply a few notes that a user can set to be sent.  You can access
this screen by entering into a borrower's screen, clicking on Change, General, Credit Information.
This screen contains the following information and can be seen below.  
 
 

Type of Portfolio
 

Type of Loan
 

Status of the account 
 

The current date *Cannot Be Edited*
 

A Credit Comment Field
 

The Current Condition of the account
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Other Information 

 

                                         

NOTE:  Any questions regarding the use of the bottom three sections, "Credit Comment,
Condition, and Information", should be directed to your CPA or the Manager of your Accounting
Department.  If they are not able to assist you, more information can be obtained at the following
locations:
 
       Web Site Links: 
        Associated Credit Bureaus                        www.cdiaonline.com 
        Federal Trade Commission                         www.ftc.gov/os/statutes/fcrajump.htm 
        Transunion                                                  www.transunion.com 
        Experian                                                      www.experian.com 
        Equifax                                                        www.equifax.com 
 
        Phone Numbers:
        Associated Credit Bureaus, Inc.®              1-202-371-0910
        Transunion                                                  1-312-258-1818
        Experian                                                      1-800-854-7201

http://www.cdiaonline.org
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        Equifax                                                        1-770-740-6265

9.2.12 Investor Relationship

Investor Relationship

This option pertains ONLY to Multi-Investor Loans where a Main Loan account is setup and then
sub-loans and the user wishes to have payments and other transactions made on the sub-loans
automatically; thereby, allowing for tracking of payments made to the sub-loans and owed to outside
investors.  

 
 
This option should FIRST be used in the Main Loan of a Multi-Investor relationship.  Secondly, the

Investor Number and Lender Number should also be known for each sub-loan.  You are also given 3
options:

 
-Add -Edit -Delete
 
-To indicate the sub-loans, indicate Add, and then input the appropriate information.  While in the
Main Loan, DO NOT check the box "Investor Account".

- Go to each sub-loan and just check the "Investor Account" box.
 
- The user should determine which accounts SHOULD NOT receive a year-end Mortgage Interest

1098 form for mortgage loans, then go to Important Dates/Data and indicate this information. (See 
Important Dates/Data Base for more information!).  If this is NOT done, the user  runs the risk of the
borrower receiving more 1098 forms than should have.  

9.2.13 Payoff

Payoff
 

 

The amount needed to satisfy the loan is calculated when this selection is made.  You are first
asked for the date through which to calculate the payoff.  Once this date is entered, the payoff is
calculated.  An example of the payoff calculation can be seen at the bottom of this page.

If this is a MULTI-INVESTOR account you must pull a payoff on the sub loan and use the 
Multi-Investor Payoff Worksheet to ensure that you have the correct amount to payoff all the
accounts.

The program starts with the balance and adds the interest owed since the last payment date, any
late fees that might be due, and any amount past due.  From this resulting amount, any balance in
the suspense account and escrow account is subtracted.  This new amount is displayed as the
payoff.  The per diem is then calculated and displayed.  For auditing and good accounting practices
you need to go to Escrow screen and deduct from the overage's/adjustments selection the balance
of the escrow using a reason of loan paid off. 

 
Interest Calculations:
Simple Interest is calculated based on the number of days since the last payment date.  
((Principal Balance * Rate) / 365) * Number of days
Example: ((25000.00 * 15%) / 365) * 442) = 4541.10
Regular Amortizing (365):
Regular Amortizing (365) is calculated based on the number of days since the last payment
paid through date.
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(Payoff requested date - last payment paid through date) = Number of days
                 Example: (04/01/2001 – 1/15/2000) = 442
 (Principal Balance * Rate) / 365) * Number of days

 Example: ((25000.00 * 15%) / 365) * 442) = 4541.10
Regular Amortizing (360): 
Regular Amortizing (360) is calculated based on the number of days since the last payment
paid through date.
(Payoff requested date - last payment paid through date) = Number of days
Example: (04/01/2001 – 1/15/2000) = 442
((Principal Balance * Rate) / 365) * Number of days
Example: ((25000.00 * 15%) / 360) * 442) = 4604.31

The operator may now print a letter to the borrower stating the amount of the payoff and the per
diem, if appropriate.  If a letter is not desired, the program returns to the full display.

 

Should the operator wish to payoff the loan, then choose Accept Payoff and input the amount
being used as the payoff.  The program will warn the operator if the amount is LESS than the
computed pay off and then prompt whether to continue.  If the amount received is less than the
computed pay off, it is assumed that the operator wished to accept either less interest or less fees;
however,the system expects AT LEAST the principal.  The operator is then prompted to input how
the amount received should be applied.
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9.2.14 Escrow Account Information

Escrow Account Information
 

ESCROW ACCOUNTS
 
 
Is an escrow account required?  If so, you must enter the amount of the escrow payment and the

beginning balance of the escrow account. This beginning balance is the amount collected at closing
for a loan that has not had any payments received.

 
 
Your servicing program is able to keep track of not only escrow payments made monthly by your

borrower but also up to 6 different categories of escrow's; for example, city taxes, county taxes,
insurance, and 3 other user defined categories.  In addition, an analysis of the escrow account can
be displayed and printed out at anytime; however, certain historical data has to be inputted at the
time a new loan is inputted IF AN ESCROW ANALYSIS IS NEEDED IMMEDIATELY AND PRIOR
TO AT LEAST ONE PAYMENT BEING MADE ON EACH ESCROW CATEGORY BEING
TRACKED.  Therefore, if you wish to obtain an escrow analysis immediately, then follow procedures
in CREATING AN ESCROW ANALYSIS ON NEW LOAN .  If not, then simply input the escrow
account's current balance and payment when asked.

 

9.2.15 Escrow

Escrow

ESCROW MANAGEMENT
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Escrow Management's complete sub-menu is available only with those loans that have an
associated escrow account or who wish to change from a non-escrowed account to one being
escrowed.  All the activity concerning the escrow account is accomplished here.  A new menu with
seven options is displayed.  For the first three options, you will be asked for your check number,
the date the check was written, and the amount of the check.
 
· DEDUCT HAZARD INSURANCE
 
When you are making the premium payment on the hazard insurance policy, THIS OPTION IS
REQUIRED.  The check amount entered is deducted from the escrow balance and the transaction
is recorded in the escrow account history.
 
· DEDUCT COUNTY TAX PAYMENT  
 
Real estate tax payments are accomplished using this option.  The check amount entered is
deducted from the escrow balance and the transaction is recorded in the escrow account history.
 
· OTHER PAYMENTS/ADJUSTMENTS  
 
This option allows for overage's to be paid back to your clients and also to make manual
adjustments/corrections to the escrow balance.  Complete this option as normal for any other type
of deduction.  Due to the purpose of this option, it DOES NOT affect your escrow analysis in
calculating the monthly escrow payment.
 
· CHANGE MONTHLY ESCROW PAYMENT 
 
The operator may change the required escrow payment at any time if this option is selected.  THIS
OPTION SHOULD BE USED SPARINGLY since the number being entered can be arbitrarily
chosen and not necessarily accurate. 
 
· ESCROW ANALYSIS  
 
This provides an extensive analysis screen and letter to the customer utilizing payments made for
the prior 12 months.  This will then project a new escrow payment as needed to meet future needs
while holding a TWO-MONTH RESERVE.  The customer letter now indicates monthly balances as
escrow funds are received and disbursed for the upcoming twelve months.  When setting up NEW
accounts you can begin immediately analyzing the account's escrow status, HOWEVER,
payments just disbursed or previously disbursed (e.g. yearly taxes) NEED TO BE INPUTTED AS
PAYMENTS with these payments added to the 'actual' balance for new account input.  Although
the new account screen provides information on what to do, PLEASE call Help Desk should you
have any doubts.

Note: 4-digit ZIP code extensions in the borrower's address may cause errors when
printing the analysis letter. Create a user-defined field for ZIP code extensions if this
information needs to be captured.
 
· DISPLAY TRANSACTIONS  
 
The entire escrow account payment history may be displayed using this option.  You may choose
displaying this history by topic; hazard insurance, taxes, or by date (all historical data).  When the
topic choice has been made, the appropriate history is displayed showing the date, check number,
amount, and the topic for which the check was written.
 
· CHANGE ESCROW REQUIRED (Y/N)  

This option allows you to set up an account on escrow or to remove an account from escrow.
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9.2.16 Creating An Escrow Analysis On A New Loan

Creating An Escrow Analysis On A New Loan

· HANDLING ESCROW FOR A NEW LOAN
 
When your new loan input is complete, bring up the borrower's new account and choose Escrow.
 
 Input each historical payment for each escrow category. When asked for the check number,
simply input  'NEW ACCOUNT INPUT' or something similar that will indicate to your organization
that this was historical information.  When asked for the date, indicate the date that either the
borrower or former owner of property last paid this.
 
 
When the above is complete, go to the Escrow Analysis and the Actual Balance should now be the
amount collected at the closing and you will have a recommended escrow payment indicated at
the bottom of the screen. This amount (or an amount you prefer) now needs to be entered as the
new escrow payment within the Escrow screen - Change Monthly Escrow Payment.

 
· PROCEDURES FOR INPUTTING HISTORICAL INFORMATION FOR AN IMMEDIATE

ESCROW ANALYSIS
 
1. Determine the dates that each and EVERY escrow category had its last payment and the

amount; especially, for those paid by the seller of a piece of property and not yet paid by the
new owner.

 
2. Determine the amount of pre-paid escrows that were collected at the loan closing and

transferred from the seller to the buyer (e.g. city and county taxes are the most common).
3. Add #1 and #2 above to get a total and input this total as the Escrow Balance figure.
4. Enter $0.00 as the Escrow Payment amount.
5. Continue inputting the new loan.  After the new loan has been entered see 'Handling Escrow

for a new Loan' at the end of this section.
 
· How will you be charging the lender for servicing this loan? 
 
There are four possible selections:
 
· Flat Dollar Fee
 
· Percentage Of The Payment
 
· Percentage Of The Balance
 
· No Service Fee
 
Make your selection and enter the appropriate amounts.

9.2.17 Escrow Maintenance Overview

Escrow Maintenance Overview
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· Overview

A new feature added to Trakker in Version 2.2.0, the Escrow Maintenance Account would allow
your company to track an escrow fee that is used for keeping property up to par.  This fee is setup
for each account and can be turned on and off.  Your company can setup a fee "cap", or the
highest amount to be stored in the Escrow Maintenance Account.  Once this amount has been
reached the "fee" will no longer be required.  When the Escrow Maintenance Account balance
drops below the set "cap", the fee will be required again.  
 
·  Areas Affected

The following areas of The Trakker software have been changed to reflect this new feature 
Payment processing on an account with this fee enabled will occur as follows:  
Money In = (Escrow + Escrow Maintenance Fee) – Interest – Principal – Current Late Fees – Past
Due Late Fees.  
The New Loan Wizard has also been modified.  On the same screen that allows you to setup the
Escrow account now has a small section for the Escrow Maintenance Fee to be setup.

The Coupon Book Printing function has also been modified to reflect this new feature.  The
Coupon Book will now include the Escrow Maintenance Fee in the required payment.  After an
account has reached the set maximum on their Escrow Maintenance account you will be prompted
to reprint coupon books.  If an account ever has their Escrow Maintenance account drop below the
set maximum you will be prompted to reprint coupon books for that account.
 
The Borrower's Screen has been modified to allow for the new Escrow Maintenance Fee menu
Item(s).  
These can be reviewed under the Escrow menu.
The Payment History Screen, accessible by clicking on History & View, includes the New Escrow
Maintenance Fee information.
 
·  Reports Affected
Payment Summary Report 

PAYMENT SUMMARY REPORT - SAMPLE 
Account Summary Report

ACCOUNT SUMMARY REPORT - SAMPLE 
Coupon Books
 COUPON BOOK - SAMPLE 
 

 

9.2.18 Correspondence Letters

Correspondence Letters

·  PAST DUE NOTICES AND 10-DAY BRING CURRENT LETTER

The past due notices and the "10-Bring Current" letter that can be printed are listed. Just press the
appropriate button of the letter to be printed, and it will print.
The notices and letter provided with the program are generic and may be freely used and/or
changed by you (for  changing see CUSTOMIZING LETTERS). The notices assume you will be
using the past due notices supplied by the vendor which is a mag-mailer type form easily used on
any dot-matrix printer. The format for the letters assumes that you will be using letterhead
stationary and either your printer can be fed single sheet paper or the stationary is in fanfold form.

·  CUSTOM LETTERS
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For printing and/or developing Custom Letters in the program for either sending to one borrower,
one or more lenders, and one or more class codes, please refer to: CUSTOMIZING LETTERS

9.2.19 Fannie Mae Borrower

Fannie Mae New Borrowers 

In the Borrowers screen:
You must set up the values for the Action Codes
Go into Change>General>Defined Fields the dialog box will appear
Select DATE and highlight the field name >>>>>>
Click Edit and a Date prompt will appear input the loan Origination date (MM/DD/YYYY)

Then Select Alpha/Numeric

highlight the field name and click EDIT
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Here you input the 2 digit code that Fannie Mae gave you  (This is an Alpha/Numeric field)
Click OK

Trakker can not generate this code and the Help Desk does not have this information
Please contact Fannie Mae if you have any questions regarding the 2 digit code.

To run reports on this Borrower be sure that the Fannie Mae 10 Digit number is recorded in the
Agency Reporting Number Field
.
To check this you would select Report Options>Add/Modify>Agency Reporting Numbers
Here you should see the 10 digit FM loan #, if it is not there you can input the number now 
Click Apply and then OK
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9.2.20 Electronic Images

Electronic Images
As of version 2.4.0.8426, Trakker has support for electronic imaging. To enable this: 

First enable electronic imaging in System -> Operator.

Then, select a folder in which to store the images (System -> Parameter Options -> Electronic
Document Directory):
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As documents are scanned to PDF (the documents MUST be in PDF format to be read by Trakker),
use the following naming scheme when naming them:

(lender #)-(account #)-(document type code)-(time in 24h format with no punctuation)-(four-digit year)
Example: 9999-1001-1C-1345-2012

The document type codes are in the table below:

Document Type Code
Loan Setup 1
Loan Setup Correspondence 1C
County Tax 2
County Tax Correspondence 2
City Tax 3
City Tax Correspondence 3C
Insurance 4
Insurance Correspondence 4C
Other2 (Escrow) 5
Other2 Correspondence 5C
Other3 (Escrow) 6
Other3 Correspondence 6C
Escrow Analyses 7
Escrow Analyses Correspondence 7C
General Borrower Correspondence 8
Bankruptcy 9
Miscellaneous 10
ACH Signup Request 10A
Return Check/ACH 10B
Payment Adjustments 10C
Lender Correspondence 10D
Return Payment Letter 10E
Payoffs 10F
Foreclosure 11
Collections - Lender 12
Collections - Borrower 13
Mortgage 14
Promissory Note 15
Appraisal 16
Title Insurance 17
HUD-1 18
Other Closing Documents 19
Maintenance 20
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Once scanned into the folder and named in the proper format, the documents can be opened from
Trakker in the Images menu in the borrower screen. If multiple documents of the same type and year
exist in the folder, a choice will be given for which document to open.

Note: Available only in version 2.4.0.8426 and later

9.3 Helpful Hints

Helpful Hints
 

The following information represents some things that have been learned over time by Multi
Financial Services Co., Inc. while using the program and, hopefully, will be of use to you.  If you
find any others that you'd like to share, please pass them along so they can be included here and
shared with others.  You can contact our Help Desk staff at: Help Desk[****] 
 

· EXTENSION PAYMENTS
 
If you would like to extend one or more payments for a client due to personal and probably
temporary problems, this can be accomplished within the program.  At the present, it has to be
done in a sort of round-about fashion; however, Multi-Financial Services Co., Inc. has been using it
quite successfully for the past two years. 
 
 
First, bring up the borrower's account and change their payment amount to $0 and interest rate to
0%.  Once done, you simply enter the number of payments desired for the day extended as
$0.00001.  As you enter each payment, you'll notice the 'Next Payment Due' indicator changing,
however, the balance stays the same!  Once completed, go back into Change and re-input the
correct payment amount and interest rate.
 

· TELEPHONE NUMBERS
 
As you enter a new account and input the person's telephone number, you'll notice two extra
spaces at the end.   We use those spaces to indicate what telephone number it is for, e.g. home
(hm), work (wk), mother's (mo), etc.  When you print a delinquency report, the telephone number is
printed and when you call you'll know what to expect.  Naturally, when a new telephone number is
received, you can go into the Change/Personal and change it using the same philosophy.
 

Should you receive an indication that the phone has been disconnected or is now unlisted, you
might consider entering something like: DISCONNECTED or UNLISTED in the phone number
field.  This will also print on the delinquency report for your use.

· COMMENT FIELD
 
The comment field content is asked for just after you enter new account information on loan
balance, interest rate, etc.  This is a field that you can use for whatever purpose desired.  Some of
our lenders have files in their office setup by 'Project #', e.g. 95-010 meaning the 10th project in
1995.  The 95-010 is put into the Comment Field and they can easily refer back to their filing
system when reviewing one of our reports.  This Comment Field is displayed in the Borrower's
Screen and is printed on all of the major management reports including:
 
Account Summary
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Payment Summary
Delinquency Report
 
Additionally, we even input information as to when past due notices should be sent out or phone
calls made, since some of our lenders have different instructions.  For example, a typical Comment
Field might show as: 95-010 15/20/30
 
Which means:  
Project 95-010
First Notice at 15 days late
Second Notice at 20 days late
Make a telephone call at 30 days late
 

· PAST DUE NOTICES & PAYOFF LETTERS
 
 
Formats for the past due notices including the `10 Day Bring Current' certified letters are found in
the `LETTERS.OVL' file within the MFS directory.  Should you wish to change any of the
information this can easily be accomplished using Notepad.  Please review the following sections
for more information on modifying these letters:
 
CUSTOMIZING LETTERS 
 
CUSTOM LETTERS AVAILABLE FIELDS 
 



Part

X
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10 Special Loans

10.1 Interest Only Loan

 Interest Only Calculations

Interest only loans are easy to setup within Trakker.  Due to experience in dealing with these types
of accounts the following is suggested.  Please note this type of setup is not required for this
account to function properly. 

 
When going through the New Loan Wizard you will need to keep your eye on a few items to make

sure that the loan works properly. You can set up an interest only loan as either Simple Interest or
Regular Amortizing.  Regular Amortizing is the suggested method due to the inherent nature of the
calculations.  This is because regular amortizing accounts calculate the interest with the same
number of days between each payment.  Simple Interest loans should be avoided when setting up
an Interest Only Loan, unless specified by the accounting documents or your company's
management.  The reason is due to the way simple interest accounts calculate each payment and its
breakdown. Simple interest loans are based on the payment-received date and have a varying
number of days between each payment.

 
As of version 2.2.0 of Trakker, you now have the ability to select Interest Only as a type of loan.

This will instruct Trakker to only expect Interest payments.  Trakker will ask you what you want to do
with any excess funds when posting payments.
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Listed below is an example of an Interest Only Loan set up, and includes all calculations to show

you how we got the numbers that are displayed.

 
Account Balance:                $2500.00
Interest Rate:                       10%
Term:                                    60 Months
Payment Freq.:                     Monthly
Balloon Due:                         $2500.00 on the 60th Payment
Payment:                              $20.83
Calculation to get the Interest Only Payment
                                             12 / (Balance * Rate) or 12 / (2500.00 * 10%)

 

10.2 Agency Loans

Agency Loans
An Agency Loan is where you have an account with organizations such as: Fannie Mae.

To set these up in your Trakker profile you must:

For each FNMA Agency Lender: 
Enter the FNMA Lender number: 
At the Main Menu select
Review -> Lender -> Review -> Select Lender 
Enter the 9 digit Lender Number assigned by the agency at the bottom of the screen
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Before you enter a FNMA loan you must set up certain User Defined fields that are required
for reporting to Fannie Mae

At the main menu screen select SYSTEM>Parameter Options>User Defined Fields
A dialog box will appear choose the DATE tab click ADD

The field name you are adding is: FNMAActionCodeDate
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NOTE:This has to be exactly as stated. No spaces and Capitalized as stated

Then select the Alpha/Numeric tab and Select Add

Type in FNMAActionCode and add a length # (2)

NOTE:This has to be exactly as stated. No spaces and Capitalized as stated

For each FNMA Loan: 
Review -> Loan -> Review -> Select Loan account
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In the Borrowers screen select:
Reporting Options -> Add/Modify->Agency Reporting Numbers 
Enter the 10 Digit Loan Number assigned by the agency 

Click Apply or Ok

10.3 Single Payment Balloon, Regular Amortizing

Single Payment Balloon, Regular Amortizing
In this example we are looking at a loan that only has one payment at the end of the term, which
essentially is a payoff. Typically these are Interest Only notes. To calculate this correctly while
allowing for the easiest use, it is suggested that the loan be set up in simple interest (see
example, Single Payment Balloon, Simple Interest However, occasionally the promissory note will
call for a regularly amortized schedule. Let's assume the following characteristics of the loan:

Loan Amount and Balance: $80,000.00
Type: Fixed, Interest Only
Term: 60 Months
Interest Rate: 8.5%
Closing Date: January 1, 2000
Last payment received: January 1, 2000
First Payment Due: February 1, 2000
Balloon Date: January 1, 2005
Calculation: Regular Amortized
Payment cycle: Monthly
No Late Fee
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Please note that the Payments Behind section states "60." By setting the First Payment Due Date
to February 1, 2000, we have captured the interest on the entire length of the loan, thus the payoff
amount is exactly the same as if we had done it in simple interest. However, since there is really
only one payment due on the loan, there can be no late fee, otherwise the system will add 59
months of late fees to the payoff. Should the actual payoff be paid late, then the late fee would
have to be added to the payoff letter as a separate fee, either by creating a custom fee (see Help >
Fees > Adjust Fees) and posting the calculated amount prior to performing the Payoff, or by simply
entering it into the Payoff Letter as a handwritten entry. 

10.4 Single Payment Balloon, Simple Interest

Single Payment Balloon, Simple Interest
In this example we are looking at a loan that only has one payment at the end of the term, which
essentially is a payoff. Typically these are Interest Only notes. To calculate this correctly while
allowing for the easiest use, it is suggested that the loan be set up in simple interest. Let's assume
the following characteristics of the loan:

Loan Amount and Balance: $80,000.00
Type: Fixed, Interest Only
Term: 60 Months
Interest Rate: 8.5%
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Closing Date: January 1, 2000
Last payment received: January 1, 2000
First Payment Due: January 1, 2005
Balloon Date: January 1, 2005
Calculation: Simple Interest, 360 days per year
Payment cycle: Annual

The payoff date reflects the total amount due at the first/only payment. Note that there is no late
fee (even though it shows 1828 days of Past Due Interest), because we set the first payment due
date at the end of the loan. 
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10.5 Draw Balance Above Original Loan Amount

Draw Balance Above Original Amounts
Construction Draw Balance Above Original Loan Amount - characteristics

· Should be simple interest loan

· When setting up loan, Original Loan Amount is equal to the max. LOC (line of credit). Current
Balance is equal to the amount client has requested (drawn) of the Original Loan Amount.

· If client needs to draw an amount that will put their balance above their original LOC, Trakker will
allow this.

· In Borrower’s screen, click Change > Adjust Balance > Add to Balance

· Enter Date, Amount of draw and choose Fee Type from drop down list (Fee Type must have been
previously defined in System > Parameter Options > Custom Fees)

· If the amount entered increases the balance above the original loan amount, you will receive this
message. Click Ok. 

· The new balance will be reflected in the Borrower’s screen information. The original loan amount
will remain the same in Amount filed.

10.6 Non-Performing Loan

Non-performing Loans
Existing Non-Performing Loan - characteristics

· Does not have info on # of payments paid

· Does not have info on Last Payment Received

· These type loans occur when, for whatever reason, the borrower falls behind in payments

· Typically, the original lender sells these type loans to another company that specializes in
distressed loans.

· Once the new loan company has their paper work for the loan in hand, they have the option of
handling the input of information into Trakker as they deem necessary
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· We, (Multi-Financial Services,) as a company cannot and will not be responsible for determining
pertinent information concerning the loan (i.e. interest rates, closing dates, next due dates or
amounts, etc.). This will be the responsibility of the new lender.

· Once the complete information of the loan is obtained, it can then be input into Trakker.

10.7 Construction Style Loans

 Construction Style Loans

Trakker has the ability to setup construction loans which can then be turned into a permanent
loan.  Once a line of credit has been approved you can begin setting up the new account.  It is better
to setup the new account with a zero balance and then begin posting the draws from the account. 
Payment wise, it is suggested that a payment of an appropriate payment amount that would allow for
a late fee to be calculated in the event that the borrower pays their line of credit interest late.

 
Notes: 
1. You can enter a zero balance when entering a new account.  This allows for the tracking of the

draws from the account.
 
2. A P&I amount should be entered, that when multiplied times the late fee percentage will give an

appropriate late fee in the event  that the borrower makes his/her payment late.

Example:  If $200.00 payment is entered and the late fee is 5% the late fee will be $10.00.
 
Once your company decides to issue construction style loans you will need to setup the

appropriate descriptions in the Custom Fees section.  You can set these descriptions from the Main
screen by clicking on System, Parameters Options, and Custom Fees.  To add a description:  click
Add, enter the description, and click OK. Examples of descriptions are:  Normal Advance, Attorney
Fees, Recording Fees, and/or any other advances normally associated with a line of credit.

 
If you wish to develop an invoice to bill the borrower for the appropriate amount for periodic billing

you can do so by editing one of the custom letter files. For more information on editing the custom
letter files please review:  CUSTOMIZING LETTERS 

Lastly, after the construction project is completed it is a simple matter to change the P&I amount to
the appropriate agreed on amount in the permanent loan documents, as well as to the appropriate
interest rate, and issue a coupon book.
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10.8 Variable Interest

Variable Interest Rate - Overview
A variable interest rate loan is a loan that the interest rate changes based on a Market Index,

Scheduled Date, or Scheduled Payment Number.  As of Version 2.2.0 you can now enter these
complex loans into Trakker easily.  

Market Index Loans
These are loans that are "tied" to a specific market.  For example LIBOR Market Index changes it’s

interest rate on a daily basis.  This change can be found online.  Please see Market Indexes - Setup
& Updating for info on setting up and updating the Market Indexes in Trakker.  Once you have setup
a market index loan and the rate changes simply update the rate on that index and Trakker will
change the rate on all loans "tied" to that index automatically.

Scheduled Date Loans
This variable interest rate function allows you to change a loan’s interest rate on specific dates in

the future.  Naturally, the first date that will be entered is the closing date of the loan and its
corresponding rate.  This gives Trakker a starting point.  The next dates you enter will tell Trakker to
change the interest rate on that loan on that date.  When you open Trakker on that date you will be
prompted to process rate changes.  After Trakker has completed the processing you will receive a
report of any changes made.

Scheduled Payment Number Loans
This variable interest rate function allows you to change a loan’s interest rate on specific payments

in the future.  Naturally, the first payment number will be #1 as of the closing date of the loan and its
corresponding rate.  You will then enter the other scheduled rate changes for that account.  After you
post a payment and the next payment is the scheduled payment Trakker will prompt you to process
the rate change.

10.8.1 Entering a Date Schedule

Entering a Date Schedule

This section will walk you through the two screens in the New Loan Wizard that deal with Date
Scheduled Loans.  For information on the beginning of the New Loan Wizard please review 
Entering A New Loan 

· Interest Rate

1. Click on type of account
2. Click on payment period
3. Click on interest Basis
4. Click if interest only payments
5. Click on interest type Date Schedule
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6. If you select Simple Interest a new window will appear

7. If there is any past due interest from the last payment made you need to add this here
8. Click Ok
9. Click Add and enter the date and new interest rate. 
Note: you will need to set the initial interest rate.  
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· Balance/Rate/Term/Balloon
This screen sets the Original and Current loan balance, the Interest Rate, the Term, and the
Balloon Payment Due/Amount.  If the loan you are entering is not a Balloon based loan then the
Balloon information will be grayed out.
10. Enter the Original Loan Balance
11. Enter the Current Loan Balance
12. Variable Interest Calculation for simple interest loans can only be Average over calculation
period.

NOTE: the rate is averaged based upon its daily value.
So if a rate changed twice during a period (say from 1/1 to 2/15) it would be calculated as such:
 1/1  - 1/10  @ 5% (10 days @ 5)   - 50
 1/11 - 1/31  @ 6% (21 days @ 6)   - 126
 2/1  - 1/15  @ 7% (15 days @ 7)   - 105
                   46 days        - 281
 So the average rate would be 281 / 46 = 
 6.1086956521739130434782608695652
but each adjustment period would be average independently.

Consider the previous rates I used for an example. If we threw in a balance adjustment on 1/20,
we'd end up with two calculations that basically get added together
Calc 1 (for 1/1 - 1/20)
1/1  - 1/10  @ 5% (10 days @ 5)   - 50
1/11 - 1/20  @ 6% (10 days @ 6)   - 60
    20 days        - 110 = 5.5%
Calc 2 (for 1/21 - 2/15)
1/21 - 1/31  @ 6% (11 days @ 6)   - 66
2/1  - 2/15  @ 7% (15 days @ 7)   - 105
              26 days        - 171 = 
6.5769230769230769230769230769231

13. Click Next
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With Regular Amortizing loans you can select the Variable Interest Calculation that best suits your
needs

For Example
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10.8.2 Entering a Market Index

Entering a Market Index

This section will walk you through the two screens in the New Loan Wizard that deal with Date
Scheduled Loans.  For information on the beginning of the New Loan Wizard please review 
Entering a New Loan.  Prior to entering an account that is linked to a Market Index, you will need to
first setup the Market Index.  Please read Market Indexes - Setup & Updating for more
information.

·   Interest Rate
1. Click on type of account
2. Click on payment period
3. Click on interest Basis
4. Click if interest only payments
5. Click on Market Index

6. If you select Simple Interest a new window will appear
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7. If there is any past due interest from the last payment made you need to add this here
8. Click OK
A new window will open
9. Click on the Market Index name
10. Select the Evaluation period (IMMEDIATE IS AN OPTION)
11. Select the margin
12. Select if a Fixed rate for the initial period
13. Select the Max Decrease/Increase 
14. If there is a Limit Period select the term and for how long
15. Select the floor rate and the Cap

· Balance/Rate/Term/Balloon
16. Click Next
17. Enter the Original Loan Amount
18. Enter the Current Loan Amount
19. Variable Interest Calculation on simple interest is always Averaged over calculation period.
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NOTE: the rate is averaged based upon its daily value.
So if a rate changed twice during a period (say from 1/1 to 2/15) it would be calculated as such:
 1/1  - 1/10  @ 5% (10 days @ 5)   - 50
 1/11 - 1/31  @ 6% (21 days @ 6)   - 126
 2/1  - 1/15  @ 7% (15 days @ 7)   - 105
                   46 days        - 281
 So the average rate would be 281 / 46 = 
 6.1086956521739130434782608695652

but each adjustment period would be average independently.
Consider the previous rates I used for an example. If we threw in a balance adjustment on 1/20,
we'd end up with two calculations that basically get added together
Calc 1 (for 1/1 - 1/20)
1/1  - 1/10  @ 5% (10 days @ 5)   - 50
1/11 - 1/20  @ 6% (10 days @ 6)   - 60
    20 days        - 110 = 5.5%
Calc 2 (for 1/21 - 2/15)
1/21 - 1/31  @ 6% (11 days @ 6)   - 66
2/1  - 2/15  @ 7% (15 days @ 7)   - 105
              26 days        - 171 = 
6.5769230769230769230769230769231
20. Click Next  

With Regular Amortizing loans you can select the Variable Interest Calculation that best suits your
needs.

For Example
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10.8.3 Entering a Payment Schedule

Entering a Payment Schedule
This section will walk you through the two screens in the New Loan Wizard that deal with Payment
Scheduled Loans.  For information on the beginning of the New Loan Wizard please review 
Entering A New Loan .  Prior to entering an account that is linked to a Market Index, you will need
to first setup the Market Index.  Please read Market Indexes - Setup & Updating for more
information.

· Interest Rate

1. Click on type of account
2. Click on payment period
3. Click on interest Basis
4. Click if interest only payments
5. Click on interest type Date Schedule
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6. If you select Simple Interest a new window will appear.

7. If there is any past due interest from the last payment made you need to add this here
8. Click OK
9. A new window will open when you click on NEXT.  
10. Click Add and enter the payment the rate will change and new interest rate.
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·  Balance/Rate/Term/Balloon

11. Enter the Original Loan Amount
12. Enter the Current Loan Amount
13. Variable Interest Calculation on simple interest is always Averaged over calculation period.
NOTE: the rate is averaged based upon its daily value.
So if a rate changed twice during a period (say from 1/1 to 2/15) it would be calculated as such:
 1/1  - 1/10  @ 5% (10 days @ 5)   - 50
 1/11 - 1/31  @ 6% (21 days @ 6)   - 126
 2/1  - 1/15  @ 7% (15 days @ 7)   - 105
                   46 days        - 281
 So the average rate would be 281 / 46 = 
 6.1086956521739130434782608695652

but each adjustment period would be average independently.
Consider the previous rates I used for an example. If we threw in a balance adjustment on 1/20,
we'd end up with two calculations that basically get added together
Calc 1 (for 1/1 - 1/20)
1/1  - 1/10  @ 5% (10 days @ 5)   - 50
1/11 - 1/20  @ 6% (10 days @ 6)   - 60
    20 days        - 110 = 5.5%
Calc 2 (for 1/21 - 2/15)
1/21 - 1/31  @ 6% (11 days @ 6)   - 66
2/1  - 2/15  @ 7% (15 days @ 7)   - 105
              26 days        - 171 = 
6.5769230769230769230769230769231

14. Click Next  
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With Regular Amortizing loans you can select the Variable Interest Calculation that best suits your
needs.

For Example
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10.9 Multi-Investor - Overview

 Multi-Investor - Overview
Investor Reporting 
 
· BACKGROUND INFORMATION
 
Since a portion of some lending companies' source of funds is from outside investors, the program
has the ability to relate loans to   these outside investors in various ways: 
 
Loans made by the Investor or Lender direct to the borrower  (TYPE 1)
 
Loans made by the Investor to the lending company who then re-lends to the borrower (TYPE 2)
 

Steps in setting up multi-investor accounts are:

Setup a primary loan' account corresponding to the borrower's promissory note
Setup separate  "sub-investor loans" corresponding to the contribution made by each outside
investor and/or the lending company itself
Have your loan-servicing program relate the Primary loan with each Sub-investor loan

Based on feedback from our clients, the following are definitions and philosophies
common to Multi-Investor lending:
 
 If an outside investor lends directly to the borrower and you service the loan for the investor (who
is the ONLY investor on the loan), this is NOT a Multi-Investor loan.  You simply setup the loan
with the investor as the lender
 
 Outside Investor:  any entity/person existing outside the lending company
 
 Lending Company: that which makes the loan to the borrower and whose name shows on legal
documents
 
 Primary Loan: the loan made directly to the borrower and to which the regular payment is posted
and from which coupon books are printed and past-due notices are sent
 
 Sub-Investor Loan: the accounts attributed to each outside investor or the lending company
itself for their individual portion of their participation
 
 The source of sub-investor loan funds can come from any source including the lending company
itself by advancing its own funds
 
 An outside investor can lend directly to the lending company or to the borrower
 
 If the outside investor lends to the lending company then the lending company is defined as the
'borrower' for one of the sub-investor loans;therefore, you will be able to track each individual loan
you owe to outside investors BY outside investor
 
 Each investor can have their own interest rate
 
 Each investor can choose whether to have a late fee or not...as such, for those investors not
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having a late fee during a month that a borrower makes a late fee payment the program will
recognize a portion of the main account's late fee as an 'overage' for the sub-investor loan...as
such you should indicate to have it applied to the PRINCIPAL and not to the suspense account;
 The total of all payments going to each investor should equal the total of the main loan
 
ONLY the primary loan will have an escrow payment indicated at time of setup since sub-investors
are not participants in escrowing of taxes,insurance, etc.
 

As an example, let's say that a loan of $50,000 was made to Mike & Mary Borrower with
payments of $650/mo. at 12%.  The source of funds and repayment schedule BY INVESTOR is as
follows:

 
 $15,000 lent from Investor #1 to your company with payments of $200/mo. at 8% (Type 2)

 
 $10,000 lent from Investor #2 to your company with payments of $100/mo. at 9% (Type 2)

 
 $25,000 from you (the lending company) with payments of $350/mo. at 8.5% (Type 1)

 

As payments are posted to the primary account (the $50,000 loan) payments will automatically
be posted to the sub-investor loans.  Naturally, should a report on any individual investor's loans be
needed, the Reporter portion of the program will print all reports requested by their own unique
lender #.

 
****STEPS IN SETTING UP AN INVESTOR RELATED LOAN****

 
· PREPARING FOR INPUTTING OF INVESTOR RELATED LOANS
 
 

Prior to entering a loan for which an Outside Investor is a participant, a new 'Lender #' for your
Investor will need to be created if one does not currently exist (see Lender ).

· SETTING UP YOUR NEW INVESTOR RELATED LOANS
 
 
To setup new Investor related loans, it is strongly recommended that the New Loan Worksheet -

Multi-Investor and New Loan Worksheet be used.  First, complete the form for the primary loan, and
then complete Multi-Investor worksheet for each investor loan, noting each investor's own 'Lender #'.
Additionally, enter your own company's participation as a separate loan since it too can be tracked, if
needed.

Once all forms have been completed, add up the 'Original Loan Amount' on each Sub-Investor
Loan setup sheet.  The total should be the 'Original Loan Amount' found on the primary loan setup
sheet.  See Investor Reporting 

NOTE:  For IRS reporting purposes, since your company is servicing a loan for an investor who
lends directly to a borrower you are responsible for reporting interest collected through your
company.  Therefore, the `1098' forms reporting portion of the program will print out 1098 forms for
each borrower that had only monies lent to them directly by an investor and your company if it also
lent money to the borrower. To read more on this select IRS Filing

Remember to include the sub-loans from your investor to your company, should there be any, so
future payments can be credited to them automatically.

 

For Type of Loan, remember the following:
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1. Investor lends directly to borrower
 

2. Investor lends to lending company
 

You've now entered your primarily loan and each related sub-investor accounts.

· EXCLUDING CERTAIN ACCOUNTS FROM 1098 FORM PRINTING
 
 
Lastly, go to the Main Screen and choose Important Dates/Data.  Here you will indicate in Data

that a 1098 form SHOULD NOT be printed for certain accounts.  
 
RULES TO DECIDE WHICH ACCOUNTS TO SEND 1098 FORMS TO:
 
· 1098 forms should NOT be sent to investors who lend money directly to your company, therefore,

input these sub-loan number(s) which this includes
 
· 1098 forms should NOT be sent on the primary loan number, when ALL sub-investor loans are

made DIRECTLY to the borrower.
 
· 1098 forms should NOT be sent on sub-investor loans, when ALL sub-investor loans are made to

your company
 
· PRINTING INVESTOR RELATED COUPON BOOK
 
 
Since the borrower's promissory note is actually your 'primary loan', the coupon book should be

printed with this account number.

POSTING PAYMENTS
 
 
When a payment is received it should ONLY be posted to the "Primary Loan Account".  Once it is

entered and you indicated whether a receipt is needed, the program automatically looks at your
database and determines if this account has sub-investor loans associated with it.  If so, it will
automatically post the appropriate payments to each sub-investor loan including any overage's and
late fees.  As it is posting automatically, the program will indicate which sub-investor loan it is
working on.  When completed, you will be returned to the primary loan screen.

 

Should an overage be received on the primary loan and you wish the overage to be applied to
principal, indicate the same for each sub-investor loan. Should part of a payment be posted to
suspense on the primary loan account, choose `Do Nothing This is a Sub-Investor Loan' for each
sub-investor loan posting.  Should you have enough funds in the primary loan suspense account to
post another payment, simply go through the normal 'Transfer Suspense to Loan' and the program
will again post automatically to the sub-investor loans whether there was a regular payment, one with
a late fee, or a payment needing the extra applied to principal.

 
· PRINTING INVESTOR REPORTS
 
 
All 'Reporter' reports available for an individual lender are also available for each of your investors

simply by utilizing their own unique 'Lender #' (NOTE: Investor # should NOT be used...Lender #
should be!). Likewise, if you have utilized the 'Type Code' feature for sub-dividing loans into various
types, it can also be entered for that particular type loan.
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10.9.1 Multi-Investor Loan Information

 Multi-Investor Loan Information
Entering a Multi-Investor Loan
 
 
This section will cover entering a new Multi-Investor loan.

 ·    Lender, EDI Link, and Borrower Type
 
On this screen you will select your Lender, whether or not to use the EDI link, and the type of

borrower. Be sure at this screen you select Multi-Investor by checking the Multi-Investor box and
click next .    

Since all of the screens are the same as entering a new loan please refer to New Loan Wizard  .
When you get to the Balloon Due/Balloon Amount section the next screen will appear 

·     Multi-Investor Entry
 
This screen will allow you to add your sub accounts.  To the right will be listed the amount of the

principal balance.  This amount will decrease based on the sub accounts that you enter. 
 

 
Adding a Sub Account
 
· To add a sub account click on ADD.  The screen (shown below) will allow you to enter the

information that pertains to your sub account.
 
· Click on List to select your Lender or key in the lender number.  This will be the Investor's

Lender number.
 
· The Investor to Borrower and Investor to Lender option is basically:  Who gave the money to the

borrower, The Lender or the Investor?
 
· The Balance boxes allow you to enter a dollar amount or percentage (of the principal amount).
 
· Interest Rate is the interest rate that you will be paying the investor.  This box is a percentage

field, to enter 3% enter 3.0
 
· The Payment boxes allow you to enter a dollar amount or percentage (of the Main Account's P&I

payment).
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· Class Code allows you to enter a class code for this account.
 
· Print 1098 allows you to turn on or off the printing of a 1098 for this account.
 
· The Comments box is a 34 character box that allows you to place a comment on this account.
 

 
· Final Screen
 
This screen allows you to view the main information on this account.  If there is any information

that does not look "correct" you can click Back to make changes to any option.  If the loan that you
are entering is a balloon account you will notice that the balloon due amount includes the last
payment and interest for that payment.  (If your note's balloon amount includes these items
please press back until you get to the balloon amount screen and adjust the balloon amount
accordingly).

 
After you click Finish the loan will be entered, and you will be asked if you wish to print a coupon

book.  If you click on Yes, you will then be asked if the borrower pays the service fee for that loan. 
The program will then begin printing out a coupon book, the number of books preset in the AUTO
COUPON PRINTING setting determines the number of coupons printed.  The next screen informs
you of what that loan number will be.

 
Account Number Example:  9999-1002

 
This consists of: Lender number - Record Number

 
Note:  If you are entering a Multi-Investor account you will receive a screen that displays all of

the new account numbers.
 

After you click on OK the next screen will ask if you wish to add another loan.
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10.9.2 Substituting Investors on a active loan

Substituting Investors on a active loan

Substituting Investors on a Borrower's account

1. You need to do is check to see if the new investor already exists.
NOTE: To do this you go to the main Trakker screen select Review>Lender>Review select the
List option 

If the Investor is there make a note of what the Lender number is. If the Investor is not there you
will need to add the new investor. Please review Lender for steps to add a new Investor.

2. Once you have your Investor information go to the Borrower's Screen of the INVESTOR you
need to cash out (remove)

3. Make a note of the original loan date, (this is optional) next due date, last payment received,
and balance. (not the payoff).

4. Go to the New Loan Wizard (Main Trakker screen select Review>Loan>New) and go through
the steps to loading a new standard loan. Entering A New Loan. NOT A MULTI-INVESTOR
SET UP

NOTE: When you get to the BEGIN SERVICING date you will want to use the date you
negotiated the contract with the NEW Investor. The Loan Closing date should be either the
Original Loan Date or the date you negotiated the contract with the NEW investor. The Last
Payment Received is the date that the borrower paid the last payment on the investor account
you are cashing out. Next Payment Due is the date the next payment is due on the investor
account you are cashing out. The Original Loan amount is the Original Loan Amount from the
investor account you are cashing out. Current Balance is the current balance on the investor
account you are cashing out. Interest Rate is the rate you have negotiated with the new
investor. Term is the REMAINING term of the investor account you are cashing out. You can
choose to have Trakker set the payment amount or you can figure that out manually. Review
the information for accuracy and then select FINISH and note the new account number.

5. Change the investors on the Main Borrowers account.

NOTE: To do the you will go to the main BORROWER'S account number (it is extremely
important that it is the main account and not any of the sub accounts). Select from the tool bar
Change>Investor Account. Highlight the Investor your are wanting to REMOVE and select
delete. In the same screen select ADD type the new borrowers account number (the one you
just loaded)and select the appropriate box,

Investor to Borrower or Investor to Lender
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6. Select OK
7. Go to the Investor Account that you are substituting and cash it out.
8. Go to the Borrower's Loan that you are removing and pay it off.(this account is not longer a
Multi-Investor account). Payoff



Part

XI
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11 Important Dates/Database

11.1 Important Dates/Data Base

 Important Dates/Data Base
 

 

· IMPORTANT DATES 
 
Within the 'Important Dates' Function, you are able to flag accounts with up to 16 key dates. 

Important dates are such things as when taxes or insurance are next due to be paid on an account,
when an interest rate needs to be changed, when a balloon note is due, etc.  This includes 5 User
Defined dates and 4 Other Escrow items along with the standard items.

Each important date is coded as to when you should be notified that either an important date is
approaching or has already passed.  For example:  If you print a Hazard Insurance due report you
will get all account numbers whose Hazard Insurance is due within the next 30 days (this particular
escrow is coded with a "C".)  If you print reports that are coded with an "A: you'll see all accounts that
are due within 45 days.  Below is a list of each code and its key:

 
Code Meaning

 
 
   A 45 day warning & based on the due date
   B 0 day warning & based on the due date
   C 30 day warning & based on today's date

· USING THE IMPORTANT DATE FUNCTION
 
 
From the Main Toolbar, Click Dates/Data, Important Due Dates.  From the next menu, simply

choose the "Important Due Date" that you wish to set.  The next window will give you the following
options:

 
 

Update the chosen important date
 

Print the important date's particular report
 

Review (on-screen) information on a particular account for this important date
 
 
For updating, simply type in the account number and the new date you wish stored.  For reviewing,

just type in the account number and the current stored date is shown.  For printing, the report will
print automatically when chosen.

When using the User Defined functions, be sure to note that #1 & #2 are for Code A, #3 is Code B,
and #4 & #5 are Code C; therefore, you have the capability to define several according to your own
'in-house' needs.

 
For a sample of various reports, please refer to Appendix A 
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11.2 Important Dates - Example Report

 Important Dates - Example Report
 

· IMPORTANT DATES INFORMATION
 
 
From Main Screen Menu select: DATES/DATA

The Important Dates functions allows the user to track up to 16 key dates for each borrower, then
print reports periodically (e.g. at the end of or beginning of each month) to see what has occurred or
will be occurring over the next 30 – 60 days depending on which report is printed.  However, the
reports are only as important as the user keeping information current in the Important Dates
function.

Please refer to Important Dates/Data Base for additional information.

Appendix B provides a copy of the reports generated within your program's Important Dates
function.  These reports provided cannot be changed as with the letters in Appendix A .    

More management reports are available within "Reporter" on the Main Menu Bar (see Appendix C)

For making additional reports for your own unique situation, it may be advisable to use the
program's "Data Out" function (see Utilities) on converting data from a binary format to a
tab-delimited format useable in spreadsheet, word processing, database, or similar programs where
data can be imported.

11.3 Miscellaneous Database

 Miscellaneous Database

As the needs of you, our valued clients, have grown we have tried to aid you in tracking important
information as it relates to Loan Servicing.

Features of the Miscellaneous Database
The Database function includes such information as:
 

Credit Reporting 
 

Borrower Pay Fee 
 

IRS 1098 Printing 
 

Escrow Maintenance Fee 
 

No Late Notice 
 

Points Paid 
 

ACH Borrower 
 

Utilizing The Miscellaneous Database
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The Miscellaneous Database can be found on the main program screen under the Dates/Data
menu. When changing, adding or removing information you will always use the Add/Modify section
of the Misc. Database menu.

· ACH Borrower
Used to track the accounts that are using the ACH System. Accounts with this attribute will not be
sent coupon books when using AUTO COUPON PRINTING .

 
1) From the Add/Modify section of the Misc. Database menu select ACH Borrower. 
 
2) Enter the account number of the loan that you wish to denote as an ACH borrower. Click OK.
 
3) Simply click on the check box (clicking on the check box when there is already a check in it will
remove the check) and click OK. 
 
Note: By default the check box will not be selected. If there is already a check in the box
then another user has already assigned the account the ACH attribute.
 
4) A prompt will appear asking if you wish to Add/Modify another account. Select YES if you wish
to Add/Modify another account, go to step 2. Select NO if you wish to exit the Misc. Database.
 
 

 
· Borrower Pay Fee
 
To be used when the borrower pays the service fee set forth by the License Agreement. The
amount entered will automatically be printed on the coupons (see COUPON BOOK - SAMPLE)
and the correct amount disbursed when the payments are posted to the system.

 
1) Under the Add/Modify section of the Misc. Database menu choose Borrower Pay fee. 
 
2) Enter the loan account number that you wish to Add/Modify the Borrower Pay Fee for. Click OK.
 
3) In the white text box enter the amount of the service fee. Click OK.
 
Note: The default setting for this feature is 0.00. If another value appears then another user
has already set the fee for that account.
 
4) A prompt will appear asking if you wish to Add/Modify another account. Select Yes if you wish to
Add/Modify another account, go to step 2. Select No if you wish to exit the Misc. Database.

· Credit Reporting
 
To be used to define if the account will be reported to the credit bureau or not.  To set this option
click on Dates/Data, Misc. Database, Add/Modify, Credit Reporting.  After you select this option
you will be asked to enter the account number you wish to modify.  After you have entered in the
account number and selected OK, a new window will appear.  The program will ask you if you do
not wish to report this account to the credit bureau.  If you wish do not wish to report the account
click the box Suppress Credit Reporting and APPLY the OK. 
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· Escrow Interest
 
This option allows you to have interest calculates for escrow accounts.   
 
1) Under the Add/Modify section of the Misc. Database choose Escrow Interest.
 
2) Enter the loan account number that you wish to modify. Click OK.
 
3) Select the option that applies to the status you wish applied to the account. Click OK.

· IRS 1098 Printing
Used to establish the printing status of 1098 Forms for reporting of interest to the Federal
Government. (By Default all accounts will be printed a 1098 Form unless they are set up as
Corporations in the New Loan Wizard. For more on the New Loan Wizard please refer to Entering
A New Loan.)

 
1) Under the Add/Modify section of the Misc. Database choose IRS 1098 Printing. 
 
2) Enter the loan account number that you wish to modify IRS 1098 printing for. Click OK.
 
3) Select the option that applies to the status you wish applied to the account. Click OK.
 
Note: DELETE this account will reset the status to NORMAL PRINTING and the payer will
receive a regular 1098 Form. 
 
4) A prompt will appear asking if you wish to Add/Modify another account. Select YES if you wish
to Add/Modify another account, go to step 2. Select NO if you wish to exit the Misc. Database.

 
 
· No Late Notice
Used to define which accounts are NOT to be sent a late notice. (Before you can utilize this feature
you must define Collection Codes; please refer to Defining Collection Codes  for more information
on Collection Codes.)

 
1) Under the Add/Modify section of the Misc. Database select No Late Notice.
 
Note: If you have not defined Collection Codes then you will receive an error message and
will not be allowed to use this feature until Codes have been defined.
 
2) Enter the loan account number that you wish to add the No Late Notice attribute to. Click OK.
 
3) From the dialog box choose the code/reason that No Late Notice is to be printed or choose to
remove the attribute from the account.  Click OK.
 
4) A prompt will appear asking if you wish to Add/Modify another account. Select YES if you wish
to Add/Modify another account, go to step 2. Select NO if you wish to exit the Misc. Database.
 
 
· Points Paid
To be used to reflect the dollar amount of points paid on the purchase of a principal residence.
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1) From the Add/Modify section of the Misc. Database select Points Paid.
 
2) Enter the number of the account you wish to modify. Click OK.
 
3) First you must check the box "Points being recorded are for Purchase of Principal Residence".
Then the text box will become available. Enter the dollar amount of the Points being paid. 
 
4) A prompt will appear asking if you wish to Add/Modify another account. Select YES if you wish
to Add/Modify another account, go to step 2. Select NO if you wish to exit the Misc. Database.
 
 



Part

XII
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12 Importing Loans/Payments

 Overview

Transferring Loans From an Existing Servicing System
 
Your servicing program has the capability to transfer existing loans from another loan servicing
system in a very quick and efficient manner provided, however, that the other servicing system
is able to EXPORT borrower information in an ASCII/Text format and in the order of information
indicated in FILE FORMAT - TRANSFER EXISTING LOANS .  

Should you wish instead to setup recently closed loans automatically from your origination
software package, please refer to EDI Links with Loan Origination Software.
 
Once this file is created, please use the following steps to automatically setup the loans:
 
1  From the Main Screen choose System, Importers, Import Standard File;
 
2  Browse to the ASCII/Text file name that you've created and choose Open;
 
3  Enter the lender number you wish these loans to be setup under;
 
4  Program will first review the file for correctness and indicate on the screen any problems by line
number.  If any messages received, review the appropriate line, make corrections, and re-run
steps 1- 3;
 
5  Once completed, the program will print a summary report indicating the new loan account
number and borrower's name – you are now complete – congratulations!

12.1 Importing Loans
12.1.1 File Format - Standard Import File

 File Format - Standard Import File

FILE FORMAT - TRANSFER EXISTING LOANS

There are two ways to import existing information from an existing servicing system. The first way
is to follow the directions below. This will allow your company to import loans directly into Trakker
and with out any additional cost to you or your company. The second way is to contact our Trakker
Support Group and request an Export/Import Excel file. This will allow your company to place the
existing information into a format that our Support Group can import into data files that Trakker
can use. This type of import will generate a fee, as our Support Group will have to review the data,
convert it into Trakker data files, and test to guarantee that your company does not experience any
problems. If you wish to utilize the second option for your import please contact our Trakker
Support group at 850-559-9123 or by e-mail at support@thetrakker.com

The following is the file format for importing loans from an existing loan servicing system/program.
This information should be in ASCII/Text format with ONE field to a line and each loan
IMMEDIATELY following the last loan’s information. The program is designed to first read the
entire file, determine if all information has been formatted correctly and, if not, indicating problems
by line number with "on-screen" messages; thus, the reasoning for having information on separate
lines. A Carriage Return Line Feed should also follow each line. If you wish to view an example of

mailto:support@thetrakker.com.
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how this file should look please click on the appropriate link: 
Single Account Import File Example
Multiple Account Import File Example

If you wish to import Escrow history please review: Importing Escrow Information 

NOTE: Some fields have multiple choices. If so, then the second and third columns below will
contain appropriate information to indicate what codes are needed to designate a certain choice.

NOTE: Need assistance in developing this ASCII/Text File? This can usually be accomplished on
a consulting fee basis, time permitting. Please be aware that support calls and high priority projects
must come first. Call our Support Group at 850-559-9123 for more details.

NOTE: If there is a Red * next to the Line number:

* = Required Field
** = Advised but not required
*** = Escrow info is required if Line # 40 = 1 (yes)

Line Number Field Name Code Import File
1* Acct Type 1\2 Individual\Company
2 Blank
3 Blank
4 ** First Name First/First John/Sue
5 ** Last Name Last/Last Sam/Que
6 ** Collateral Addr 1 123 N. Main St
7 ** Collateral Addr 2 Apt 2
8 ** Collateral City Oz
9 ** Collateral State GA
10 ** Collateral Zip 99099-1234
11 ** County USA
12 Loan Class Code Alpha/Numeric Field ER or E4
13* 1st Borrower 1st Name First B John
14* 1st Borrower Last NameLast B Sam
15* SSN Do not use - 888776666
16* Mailing Addr 1 344 E. Broughton St.
17 Mailing Addr 2 Apt 8
18* Mailing City Birmingham
19* Mailing State AL
20* Mailing Zip 44944-3478
21 Phone Do not use - 8883332212
22 Sex 1/2/0 Unknown/Male/Female
23 Race 1/2/3/4/5/6/7/8 Unknown/Caucasian/African
American/Native Indian/Asian/Hispanic/Other
24 2nd Borrower 1st Name First B Suzy
25 2nd Borrower Last Name Last B Que
26 SSN Do not use - 777665552
27 Phone Do not use - 3334442212
28 Sex 1/2/0 Unknown/Male/Female
29 Race 1/2/3/4/5/6/7/8 Unknown/Caucasian/African
American/Native Indian/Asian/Hispanic/Other
30 Appraisal Numeric Field 78000.00
31 Collateral Description Alpha/Numeric Field This is the collateral
description.
32* Grace Days Numeric Field 15 
33* % of Payment Numeric Field 5
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34* Service Fee Code For Fee Code 1 Dollar amount
For Fee Code 2 =% 2.5
For Fee Code 3 =% 5.0
For Fee Code 0 Leave Blank

35* Service Fee Amt Numeric Field 10.00
36 Pre Payment % Numeric Field 25
37 Pre Payment Date MM/DD/YYYY 01/01/2004
38 Past Due Fee Numeric Field 100.00
39* Begin Servicing Date MM/DD/YYYY 01/01/2003
40*** Escrow Required 1/2 Yes/No
41*** Escrow Payment Numeric Field 25.00
42*** Escrow Balance Numeric Field 100.00
43 Maint. Escrow Req. 1/2 Yes/No
44 Maint. Escrow Balance Numeric Field 200.00
45 Maint. Escrow Payment Numeric Field 10.00
46 Maint. Escrow Cap Numeric Field 2000.00
47** Pre Paid Interest Numeric Field 125.00
48* Loan Type 1/2 Straight/Balloon
49* Payment Period 1/2/3/4
Annual/Semi-Annual/Quarterly/Monthly
50* Interest Type 1/2 Adjustable/Fixed
51* Original Balance Numeric Field 30000.00
52* Current Balance Numeric Field 25000.00
53* Interest Rate Numeric Field 12.375
54* Rate Type Numeric Field 1.00
55* P&I Amount Numeric Field 225.00
56* Term Numeric Field 360     
57 Balloon Due Numeric Field 300
58 Balloon Amount Numeric Field 15000.00
59* Closing Date MM/DD/YYYY 01/01/2003
60* Last Payment Received MM/DD/YYYY 02/01/2003
61* Next Due Date MM/DD/YYYY 03/01/2003
62 Comment Alpha/Numeric Field This is the comment
CONTINUE WITH NEXT BORROWER’S INFORMATION WITHOUT SKIPPING A LINE

12.1.1.1 File Format - Single Account Import Example

 File Format - Single Account Import Example
 

 

1

JOHN / Jane
DOE / Doe
103 NORTH MAIN ST

OZ
GA
00999-1234

4
John
Doe
123456789
103 NORTH MAIN ST
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OZ
GA
00999-1234
888 559-8679
1
1
Jane
Doe
123457890
888 558-8780
2
2
12535056

15
0.05
0
0
32
10/11/2020

1/1/2001
1
0
0
3706.61
1
12
1
86483.00
83634.04
0.06625
2
553.38
361
0
0
8/7/2001
9/7/2001
10/7/2001
Test Import Acct 1



Trakker - Loan Servicing Software Help File155

Copyright Multi-Financial Services Company, Inc. 2012©

12.1.1.2 File Format - Multiple Account Import Example

 File Format - Multiple Account Import Example
 

1

JOHN / Jane
DOE / Doe
103 NORTH MAIN ST

OZ
GA
00999-1234

4
John
Doe
123456789
103 NORTH MAIN ST

OZ
GA
00999-1234
888 559-8679
1
1
Jane
Doe
123457890
888 558-8780
2
2
12535056

15
0.05
0
0
32
10/11/2020

1/1/2001
1
0
0
3706.61
1
12
1
86483.00
83634.04
0.06625
2
553.38
361
0
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0
8/7/2001
9/7/2001
10/7/2001
Test Import Acct 1
1

JOHN / Jane
DOE / Doe
103 NORTH MAIN ST

OZ
GA
00999-1234

4
John
Doe
 
123456789
103 NORTH MAIN ST

OZ
GA
00999-1234
888 559-8679
1
1
Jane
Doe
123457890
888 558-8780
2
2
12535056

15
0.05
0
0
32
10/11/2020

1/1/2001
1
0
0
3706.61
1
12
1
86483.00
83634.04
0.06625
2
553.38
361
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0
0
8/7/2001
9/7/2001
10/7/2001
Test Import Acct 2
1

JOHN / Jane
DOE / Doe
103 NORTH MAIN ST

OZ
GA
00999-1234

4
John
Doe
123456789
103 NORTH MAIN ST

OZ
GA
00999-1234
888 559-8679
1
1
Jane
Doe
123457890
 
888 558-8780
2
2
12535056

15
0.05
0
0
32
10/11/2020

1/1/2001
1
0
0
3706.61
1
12
1
86483.00
83634.04
0.06625
2
553.38
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361
0
0
8/7/2001
9/7/2001
10/7/2001
Test Import Acct 3
1

JOHN / Jane
DOE / Doe
103 NORTH MAIN ST

OZ
GA
00999-1234

4
John
Doe
123456789
103 NORTH MAIN ST

OZ
GA
00999-1234
888 559-8679
1
1
Jane
Doe
123457890
888 558-8780
2
2
12535056

15
0.05
0
0
32
10/11/2020

1/1/2001
1
0
0
3706.61
 
1
12
1
86483.00
83634.04
0.06625
2
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553.38
361
0
0
8/7/2001
9/7/2001
10/7/2001
Test Import Acct 4
1

JOHN / Jane
DOE / Doe
103 NORTH MAIN ST

OZ
GA
00999-1234

4
John
Doe
123456789
103 NORTH MAIN ST

OZ
GA
00999-1234
888 559-8679
1
1
Jane
Doe
123457890
888 558-8780
2
2
12535056

15
0.05
0
0
32
10/11/2020

1/1/2001
1
0
0
3706.61
1
12
1
86483.00
83634.04
0.06625
2
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553.38
361
0
0
8/7/2001
9/7/2001
10/7/2001
 
Test Import Acct 5

12.1.2 File Format - XML

File Format - XML 

File Format for XML                                               Definition of field                       Format
Example

<xml version="1.0" encoding="UTF-8"?> XML Header

<Loans> Begins Importing Loans

 <Import> Begins Import process

  <ImportRecord> Begins Importing
Record

<Lender>Numeric</Lender>                 
   Lender Number 9999

<Portfolio>Alpha</Portfolio> What kind of account Mortgage (not available in
LOS imports)

<Loan Type>Alpha</Loan Type> What type of account Conventional (not
available in LOS imports)

<ShortFirstName>FName</ShortFirstN
ame> Borrower’s First Name John (separate multiple

borrowers with /) 

<ShortLastName>LName</ShortLastN
ame>                      Borrower’s Last Name Sanders (separate

different last names with /)

<Collateral> Begins collateral
information

<Address1>Alpha/Numeric.</Address1
> Street Address W Adam St

<Address2>Alpha/Numeric</Address2
> Apt or Suite # Apt 3

<City>Alpha</City> City Salem

<State>Alpha </State> State NC (2 digits)

<Zip>Numeric</Zip> Zip or Zip +4 45621or 45621-4581
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<Country>Alpha</Country> County or Province USA

<Description>Alpha/Numeric</Descripti
on>

Collateral Description
(character limit) Legal description

<Appraisal>Numeric</Appraisal> Appraised value 2500000.00

<PropertyID>Alpha/Numeric</PropertyI
D> Tax Collector ID # Parcel 5A-4567978

</Collateral> End of Collateral
information

<Borrowers> Begins of Borrower
section

If borrower is a Company,
see Company section
below

<Borrower> Begins of borrower
information

Continue format for each
borrower one under the
other

<Type>Alpha</Type> Borrower classification Individual or Joint

<FName>Alpha</FName> Borrower’s First Name John

<MName>Alpha</MName> Borrower’s Middle Name M or Michael

<LName>Alpha</LName> Borrower’s Last Name Sanders

<TaxID>Numeric</TaxID> Social Security Number 123-34-2245

<Address1>Alpha/Numeric.</Address1
>

This could be the mailing
address P O Box 18567

<Address2>Alpha/Numeric</Address2
>

Suite or Apartment
number

<City>Alpha</City> City Salem

<State>Alpha</State> State NC (2 digits)

<Zip>Numeric</Zip>  Zip or Zip +4 45621or 45621-8567

<HomePhone>Numeric</HomePhone> Home Phone number 888-543-2145

<WorkPhone>Numeric</WorkPhone> Work Phone number 888-543-2576

<Race>Numeric</Race> Nationality
Unknown, Caucasian,
African American.,Native
Indian, Asian, Hispanic,
Other
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<Sex>Alpha</Sex> Sex Male, Female, Unknown

<DOB>Date</DOB> Date of Birth 08/15/1925

<Generation>Alpha</Generation> Name Suffix Jr, Sr, IIII etc Could spell
out as well (not available)

</Borrower> End of the borrower’s
information

Add additional borrowers
in above format

<Borrower Company="Boolean"> Information if borrower is a
company Yes/No 

<TaxID>Numeric</TaxID> Tax Identification Number 72-6578942

<Name>Alpha/Numeric</Name> Full Name of Company 98 Lending Company,
LLC

<Address1>Alpha/Numeric</Address1
> Business address 123 W Main Street Suite

4000

<City>Alpha</City> City Rough Road

<State>Alpha </State> State VA (2 digit classification)

<Zip>Numeric</Zip> Zip or Zip +4 45093 45093-4000

<HomePhone>Numeric</HomePhone> Personal Contact number 888-524-6321

<WorkPhone>Numeric</WorkPhone> Business Phone number 800-524-8963

</Borrower> End of Company
information

</Borrowers> End of Borrower’s
section

<Fees> Begins Fee section

<LateFee> Begins Late Fee Section

<GraceDays>Numeric </GraceDays> Number of Grace Days
from payment date  2 digit 15

<AmountPercent="Payment">Numeric
</Amount>

Percentage of Payment or
Payment Amount

“Percent” enter: 5.00 or
“Payment”:  15.00

<Receiver>Alpha</Receiver> Who gets fee Lender/Servicer

  </LateFee> End Late Fee Section

  <PastDueFees> Begins Pastdue Late
Fees
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     <Amount>Numeric</Amount> Amount of Pastdue Fees
on an existing loan

215.00

   </PastDueFees> End of Pastdue Late
Fees

  <PrePayFee> Begins PrePayment
Penalty

     <Date>Date</Date> Date Prepayment Penalty
Ends

02/15/2008

     <Amount>Numeric</Amount> Percent of Prepayment
Penalty

5.0

    </PrePayFee> End of Prepayment
Penalty

<ServicingFee> Begins Servicing Fee
Section

<Amount
Percent="Balance">Numeric</Amount>

Percentage=”Balance”, or
Percentage=”Payment”, or
Amount of Service Fee
Annual Computation

5.00 (5%) or 15.00 for
amount (leave off Percent
info)

</ServicingFee> End of Servicing Fee
section

</Fees> End of the Fee section

<Escrow> Begins Escrow
Information

     <Payment>Numeric</Payment> Escrow Payment Amount 250.00

     <Balance>Numeric</Balance> Escrow Balance at
Transfer

800.00

     <Maintenance> Begins Escrow
Maintenance Fee section

         <Payment>Numeric</Payment> Escrow Maintenance
amount 25.00

         <Balance>Numeric</Balance> Escrow Maintenance
balance 125.00

         <Cap>Numeric</Cap> Maximum of  money you
can collect 5000.00

     </Maintenance> End of Maintenance
section

 </Escrow> Ends Escrow
Information

<Dates> Begins the Date section
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<Service>Date</Service>
Date you start servicing
the account – suggest
using system date

12/06/2005

<Closed>Date</Closed>
The Date the Borrower
signed the Loan
documents

12/06/2005

<LastPayment>Date</LastPayment>
The last payment received
date( same as closing
date if new loan)

12/06/2005

<NextPayment>Date</NextPayment> Next payment due date 01/01/2006

    <Hazard>Date</Hazard> Date of next hazard
insurance payment 01/15/2007

    <City>Date</City> Date of next city tax
payment 11/01/2006

    <County>Date</County> Date of next county tax
payment 12/01/2006

</Dates> End of the Dates section

<Interest Simple="Boolean"
InterestOnly="Boolean">

If Simple Interest (Regular
Amortizing is alternative)
or Interest Only (P&I
payment is alternative)

True/False

<Existing>
Begin Prepaid Int, Rate
(non-ARM), & Points
Section

          <Existing Credit=>”Boolean”</Existing
Credit>

Prepaid interest if True
than complete the
following fields 

True/False

          <Amount>Numeric</Amount> The monetary value of
prepaid interest 500.00

<Points>Numeric</Point>
Amount of Points Paid –
use only if loan for
purchase of primary
residence

$2000.00

<Rate>Numeric</Rate> Current Interest Rate (If
not an ARM loan 12.50

</Existing> End of Prepaid Int, Rate,
& Points Section

  <ARM> Begins Adjustable Rate
Mortgage section - 

     <Index>Alpha Numeric</Index>
Name of Index used –
Wording in
Trakker-Market Index has
to be exactly the same 

NYC Prime



Trakker - Loan Servicing Software Help File165

Copyright Multi-Financial Services Company, Inc. 2012©

     <Initial> Begins the Initial set up
of the loan

<Rate>Numeric</Rate> Initial Rate of ARM loan at
closing 4.00

<EndDate>Date</EndDate> When you review the rate 02/01/2006 
MM/DD/YYYY

     </Initial> End of the initial loan
information

         <Evaluation Period=”Alpha”>
Evaluation Period: 
Immediate, Months,
Quarters, Half-Year,
Years, & Payments

         <Multiplier>Numeric</Multiplier>
If NOT Immediate,
indicate number of periods
between Evaluations

1 for Years would mean a
Yearly Evaluation of the
ARM rate, 1 for Quarters
would be quarterly
evaluation, etc.

      </Evaluation> End of ARM Evaluation

      <Margin>Numeric</Margin> ARM Margin 2.00

      <Limit>

Max Increase/Decrease
of the rate during
EVALUATION of the
Loan

<MaxIncrease>Numeric</MaxIncreas
e>

Max Increase during the
period 5.00

<MaxDecrease.numeric</MaxDecrea
se

Max Decrease during the
period 3.00

      </Limit> End of Evaluation Limits

<Cap>Numeric</Cap> Rate Cap during life of
loan 8.00

<Floor>Numeric</Floor> Floor Rate during life of
loan 2.00

     </Evaluation> End of the Evaluation
section

   </ARM> End of the ARM section

</Interest> End of the Interest
Calculation section

 <Balloon> Begins the Balloon
section

Only for Balloon notes!

<Amount>Numeric</Amount> Balloon Amount 20000.00
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<Due>Numeric</Due> Payment # Balloon Due 60

</Balloon> End of the Balloon
section

<Balance> Begins the Balance
section

<Original>Numeric</Original> Original Loan Balance 30000.00

<Current>Numeric</Current> Current Loan Balance 30000.00

</Balance> End of the Balance
Section

  <Payment> Begins Payment section

<PerYear>Numeric</PerYear> Payments per year 12  (2 digits only )

<Amount>Numeric</Amount> P/I amount 250.00

<Term>Numeric</Term> Term of the loan 360 (must be in months)

       </Payment> Ends Payment section

  <ClassCode>Alpha/Numeric</ClassCode>

Loan Class Code – 2 digit
numeric, alpha, or
combination of either code
allowing separation of
different types of loans
within a Lender #

3B, AA, or 12 

  <Comment>Alpha/Numeric</Comment>
Comment field shown on
borrower screen & reports 
– 34 characters 

When past due call
parents – PH:
850-555-2344

  </Import> End of Import for this
record

</Loans> End of Importing all
records

  

12.1.2.1 File Format- XML- Example Standard

File Format- XML- Example Standard
<?xml version="1.0" encoding="utf-8"?>
<Loans>
<Import>
 <ImportRecord>
    <Lender>9999</Lender>
    <ShortFirstName>John</ShortFirstName>
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    <ShortLastName>Ryan</ShortLastName>
    <Collateral>
      <Address1>1233 Brown Street</Address1>
      <City>Tallahassee</City>
      <State>FL</State>
      <Zip>32308</Zip>
      <Country>USA</Country>
      <Description>Lot #345, in Section Z of Plantation Woods Subdivision</Description>
      <Appraisal>250000.00</Appraisal>
      <PropertyID>A3456AA98</PropertyID>
    </Collateral>
    <Borrowers>
      <Borrower>
        <Type>Individual</Type>
        <FName>John</FName>
        <MName>T</MName>
        <LName>Ryan</LName>
        <Address1>5677 Monroe Street</Address1>
        <Address2>Suite #456</Address2>
        <City>Gainesville</City>
        <State>GA</State>
        <Zip>34556</Zip>
        <Generation>JUNIOR</Generation>
        <TaxID>777989677</TaxID>
        <HomePhone>(404) 667-9877</HomePhone>
        <WorkPhone>(404) 445-9785</WorkPhone>
        <Race>Caucasian</Race>
        <Sex>Male</Sex>
        <DOB>12/19/1948</DOB>
        </Borrower>
    </Borrowers>
  <Fees>
     <LateFee>
        <GraceDays>15</GraceDays>
        <Amount Percent="Payment">5.00</Amount>
     </LateFee>
     <PastDueFees>
        <Amount>15.00</Amount>
     </PastDueFees>
     <PrePayFee>
        <Date>02/15/2008</Date>
        <Amount>5.0</Amount>
     </PrePayFee>
     <ServicingFee>
        <Amount Percent="Balance">1.500</Amount>
     </ServicingFee>
  </Fees>
  <Dates>
      <Service>01/25/2005</Service>
      <Closed>01/15/2005</Closed>
      <LastPayment>01/15/2005</LastPayment>
      <NextPayment>03/01/2005</NextPayment>
   </Dates>
  <Interest Simple="True" InterestOnly="True">
      <Points>1000</Points>
      <Existing>
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        <Amount>500</Amount>
      </Existing>
          <Initial>
          <Rate>6.00</Rate>
     </Initial>
 </Interest>

    <Balance>
      <Original>200000.00</Original>
      <Current>200000.00</Current>
    </Balance>
      <Payment>
      <PerYear>12</PerYear>
      <Amount>1199.10</Amount>
      <Term>360</Term>
    </Payment>
  <ClassCode>MM</ClassCode>
  <Comment>Prior Loan #2366</Comment>
 </ImportRecord>
</Loans>
To import multiple records  remove the </loans> and continue with the following format DO
NOT use a space between records           

    <ImportRecord>
             [loan data in here]
    </ImportRecord>
    <ImportRecord>
           [loan data in here]
    </ImportRecord>
    <ImportRecord>
          [loan data in here]
    </ImportRecord>
    </Import>
  </Loans>

12.1.2.2 File Format XML- Example ARM

File Format XML- Example ARM 
?xml version="1.0" encoding="utf-8"?>
<Loans>
<Import>
 <ImportRecord>
    <Lender>9999</Lender>
    <ShortFirstName>John</ShortFirstName>
    <ShortLastName>Ryan</ShortLastName>
    <Collateral>
      <Address1>1233 Brown Street</Address1>
      <City>Tallahassee</City>
      <State>FL</State>
      <Zip>32308</Zip>
      <Country>USA</Country>
      <Description>Lot #345, in Section Z of Plantation Woods Subdivision</Description>
      <Appraisal>250000.00</Appraisal>
      <PropertyID>A3456AA98</PropertyID>
    </Collateral>
    <Borrowers>
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      <Borrower>
        <Type>Individual</Type>
        <FName>John</FName>
        <MName>T</MName>
        <LName>Ryan</LName>
        <Address1>5677 Monroe Street</Address1>
        <Address2>Suite #456</Address2>
        <City>Gainesville</City>
        <State>GA</State>
        <Zip>34556</Zip>
        <Generation>JUNIOR</Generation>
        <TaxID>777989677</TaxID>
        <HomePhone>(404) 667-9877</HomePhone>
        <WorkPhone>(404) 445-9785</WorkPhone>
        <Race>Caucasian</Race>
        <Sex>Male</Sex>
        <DOB>12/19/1948</DOB>
        </Borrower>
    </Borrowers>
  <Fees>
     <LateFee>
        <GraceDays>15</GraceDays>
        <Amount Percent="Payment">5.00</Amount>
     </LateFee>
     <PastDueFees>
        <Amount>15.00</Amount>
     </PastDueFees>
     <PrePayFee>
        <Date>02/15/2008</Date>
        <Amount>5.0</Amount>
     </PrePayFee>
     <ServicingFee>
        <Amount Percent="Balance">1.500</Amount>
     </ServicingFee>
  </Fees>
  <Escrow>
      <Payment>250.00</Payment>
      <Balance>800.00</Balance>
  </Escrow>    
  <Dates>
      <Service>01/25/2005</Service>
      <Closed>01/15/2005</Closed>
      <LastPayment>01/15/2005</LastPayment>
      <NextPayment>03/01/2005</NextPayment>
      <Hazard>01/15/2007</Hazard>
      <City>11/01/2006</City>
      <County>12/01/2006</County>
    </Dates>
  <Interest Simple="True" InterestOnly="True">
      <Points>1000</Points>
      <Existing>
        <Amount>500</Amount>
      </Existing>
    <Arm>
      <Index>Monthly ARM</Index>
        <Initial>
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          <Rate>6.00</Rate>
          <EndDate>06/01/2005</EndDate>
        </Initial>
       <Evaluation Period="Years">
         <Multiplier>1</Multiplier>                           
        </Evaluation>
       <Margin>2.00</Margin>
         <Limit Period="Months">
         <MaxDecrease>2.25</MaxDecrease>
         <MaxIncrease>3.2</MaxIncrease>
         <Multiplier>3</Multiplier>         
        </Limit>
        <Cap>8.00</Cap>
        <Floor>1.00</Floor>
    </Arm>
  </Interest>
    <Balance>
      <Original>200000.00</Original>
      <Current>200000.00</Current>
    </Balance>
    <Balloon>
       <Amount>150000</Amount>
       <Due>60</Due>
    </Balloon>
    <Payment>
      <PerYear>12</PerYear>
      <Amount>1199.10</Amount>
      <Term>360</Term>
    </Payment>
  <ClassCode>MM</ClassCode>
  <Comment>Prior Loan #2366</Comment>
 </ImportRecord>
</Loans>

12.1.2.3 File Format XML- Example Escrow

File Format XML- Example Escrow
?xml version="1.0" encoding="utf-8"?>
<Loans>
<Import>
 <ImportRecord>
    <Lender>9999</Lender>
    <ShortFirstName>John</ShortFirstName>
    <ShortLastName>Ryan</ShortLastName>
    <Collateral>
      <Address1>1233 Brown Street</Address1>
      <City>Tallahassee</City>
      <State>FL</State>
      <Zip>32308</Zip>
      <Country>USA</Country>
      <Description>Lot #345, in Section Z of Plantation Woods Subdivision</Description>
      <Appraisal>250000.00</Appraisal>
      <PropertyID>A3456AA98</PropertyID>
    </Collateral>
    <Borrowers>
      <Borrower>
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        <Type>Individual</Type>
        <FName>John</FName>
        <MName>T</MName>
        <LName>Ryan</LName>
        <Address1>5677 Monroe Street</Address1>
        <Address2>Suite #456</Address2>
        <City>Gainesville</City>
        <State>GA</State>
        <Zip>34556</Zip>
        <Generation>JUNIOR</Generation>
        <TaxID>777989677</TaxID>
        <HomePhone>(404) 667-9877</HomePhone>
        <WorkPhone> (404) 445-9785</WorkPhone>
        <Race>Caucasian</Race>
        <Sex>Male</Sex>
        <DOB>12/19/1948</DOB>
        </Borrower>
    </Borrowers>
  <Fees>
     <LateFee>
        <GraceDays>15</GraceDays>
        <Amount Percent="Payment">5.00</Amount>
     </LateFee>
     <PastDueFees>
        <Amount>15.00</Amount>
     </PastDueFees>
     <PrePayFee>
        <Date>02/15/2008</Date>
        <Amount>5.0</Amount>
     </PrePayFee>
     <ServicingFee>
        <Amount Percent="Balance">1.500</Amount>
     </ServicingFee>
  </Fees>
  <Escrow>
      <Payment>250.00</Payment>
      <Balance>800.00</Balance>
  </Escrow>    
  <Dates>
      <Service>01/25/2005</Service>
      <Closed>01/15/2005</Closed>
      <LastPayment>01/15/2005</LastPayment>
      <NextPayment>03/01/2005</NextPayment>
      <Hazard>01/15/2007</Hazard>
      <City>11/01/2006</City>
      <County>12/01/2006</County>
    </Dates>
  <Interest Simple="True" InterestOnly="True">
      <Points>1000</Points>
      <Existing>
        <Amount>500</Amount>
      </Existing>
          <Initial>
          <Rate>6.00</Rate>
     </Initial>
 </Interest>

    <Balance>
      <Original>200000.00</Original>
      <Current>200000.00</Current>
    </Balance>
    <Balloon>
       <Amount>150000</Amount>
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       <Due>60</Due>
    </Balloon>
    <Payment>
      <PerYear>12</PerYear>
      <Amount>1199.10</Amount>
      <Term>360</Term>
    </Payment>
  <ClassCode>MM</ClassCode>
  <Comment>Prior Loan #2366</Comment>
 </ImportRecord>
</Loans>

12.1.3 Importing Escrow Information

 Importing Escrow Information
 

Below is the format for importing escrow information into Trakker's data file.  The data imported
should not contain any header or field names. Also, this should be saved as text information in a file
named "escrow.dta" The Account number should be the one that Trakker assigns to the clients file. 
The codes that are needed to associate this file with the correct payment go as follows.

  Escrow Transaction Codes        

  Hazard Insurance          

  County Tax Payment         
  

  City Tax Payment          

  Other 2           
  Other 3           
  Other 4           

  The Next Lines Explain the Layout
             

  
  Column Description   

Account Number   Month   Day  Year   Action   Amount       Check # or Reason
          
 This is how a typical Escrow.dta file should look.

1003 1 11 2001 1 35155 3510 
1003 6 2 2001 2 23013 4591
1003 3 25 2001 3 15320 6542 
1003 5 17 2001 31 12435 7533 
1003 2 1 2001 32 12623 3514 
1003 4 16 2001 33 6282 1595 
1004 1 11 2001 1 32235 3540 
1004 6 2 2001 2 22331 4571
1004 3 25 2001 3 12322 6352 
1004 5 17 2001 31 12628 7953 
1005 3 4 2001 1 12521 4863 
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12.1.4 Importing Existing New Loans and Payments from Prior Servicing Systems

Importing Existing New Loans and Payments from Prior
Servicing Systems

 
From your main Trakker screen, select the System > Utilities > Convert Data option.

1. When this process is finished, a ‘Complete’ window will appear with the message informing that ‘
Files are exported’. Click the okay button.

2. Now, you will need to go to the root directory in which Trakker is installed (C:\MFS). In this folder
is located a subfolder called dataout. Open this folder.

3. Locate any file with the format year.xls (i.e. 2006.xls). Double click this file to open it in an Excel
spreadsheet.

4. In excel, select all rows except the row containing column headers and delete this information.

5. Save the file as year.xls which will now have just column headings.

6. Next, the payment history data must be imported. For an explanation of definitions of each
column, Dataout - Year Files.

7. Once all data has been inputted, sort the information by year, saving each year as a separate
file (i.e. 2004.xls, 2005.xls, 2006.xls, etc.).

8. These files can now be sent to the Help Desk to be converted into the proper data files for 
Trakker to interpret.

12.1.5 Importing from Loan Origination Software

Importing from Loan Origination Software

Trakker can import loans from popular LOS packages, including Calyx Point, Ellie Mae Encompass,
and Byte BytePro. See this section for details.
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12.2 Importing Payments
12.2.1 Historical Payment Import

Historical Payment Import

Following the successful transfer of payment information into Trakker via Excel, the following steps
need to be accomplished in order for past historical payment information to be available:  

1. After loan setup information has been input into Trakker via Excel, run the Account Summary
Report, by selecting the Reporter Menu from the main Trakker screen. From the Management
Reports tab, choose Account Summary and then click the Execute button. This step is done in order to
first confirm balances, Next Due dates, etc. and, second, to be able to reference their borrower
account numbers for Step #3.

2. Next, review the spreadsheet format of Trakker’s payment files (click here for example).

3. Next, the Payment History needs to be input into individual spreadsheet worksheets for each
year.xls file they wish to record payment for by Trakker’s new account number.

4. The following criteria should be used when setting up these files.  
    a. There should be a header row similar to the sample above.  
    b. All fields should be formatted as text.  
    c. Numeric fields should contain no punctuation or decimals (example $5,000.00 should be input as
500000.        
    d. All rows should have same number of tabs as header. 

5. All year.xls files then need to be zipped and forwarded to MFS for conversion from spreadsheet files
to Trakker's binary format.  MFS is NOT responsible for verifying the authenticity of information
being converted. It is highly recommended that you perform balancing of payment information
within each spreadsheet prior to forwarding to MFS for the conversion.       

12.2.2 ACH File Import

 ACH File Import

The ACH file import utility allows you to process a payment file received from your bank or
payment processing center.  

Note: The file is "Tab Delimited" and simply has the Account Number in the first column and
the amount of the payment in the second.  Notice the payments do not include the decimal.
A payment for Account 1002 is $179.33, this should be displayed as 17933.  

To access the ACH file import
At the Main Trakker menu

1. Choose Review>Post> Batch Imports or F6
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2. Click YES

 
 
3.  Choose Import. Trakker will produce a ASCII file on your computer

4.  Browse to the file's location and open it.  
This will populate the list with of the payments that you have imported.  At this point you can
change the imported information

The format on the ACH file is as follows: 
(This is just an example you can have any and all of the fields in the screen above displayed)

Acct Payment
 
1001 25000
1002 17933
1003 33214
1004 11201
1005 224442

 To Change the information
  
5.  Choosing the payment 
  
6.  Click Edit.  
Once you have decided that the list is correct and are ready to process the payments 
  
7. Click Process.  
When the program has completed the import process you will receive a report (printed to your
default printer) that displays the payments that were processed.  
 
NOTE:  As of Version 2.2.0 the only amounts that can be processed with this function are
payments that are equal to the default payment on that individual account.  Example:  Acct
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1001 has a payment of $125.65.  The only payment that can be imported is $125.65 for this
account.  If you try to import a payment other than the required payment the program will not
import the payment and will display an error on the report describing the reason.



Part

XIII
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13 Reports

13.1 Reporter Overview
 

Reporter Overview
 From the reporter menu you can access most reports.  The menu is broken down into categories.

 
Management Reports
Custom Reporter
IRS Tax Filing
Custom Letters
Collection System
Utilities 
Consumer Credit Reporting File

Under Management Reports you can access the reports that you will need to process daily /
weekly / monthly processing.  The most used reports are the Account Summary Report, the
Payment Summary Report, the Escrow Transaction report, and the Suspense Account Summary.

 
The Custom Reporter menu item allows you to access the Custom Reporter module.  This module

is a purchasable add on to the Trakker software.  If you would like more information on this module
please feel free to contact our Support Department at 800-326-4112.

I.R.S. Tax Filing allows you to process your 1098s and create your IRS Data file.  Develop IRS
Data File is used to create the IRS file that you will mail or upload to the IRS.  Print 1098 Forms will
allow you to print your 1098 forms.

 
Note:  The printing of the 1098 forms can be done on as many times as you want.  It will not affect

your data or what will be printed.
Form A - To be mailed to the IRS

If you will be reporting electronically you will not need to purchase or
print this form.

Form B - This is the Borrower's copy.
Form C - This is your Company's copy and should be filed with your Client's

folder.

Custom Letters will print your custom letters for all accounts.  It will allow you to "filter" by Lender
and Loan Class Code.  The letters listed here can be modified by editing the Custom2.ovl file via the
Notepad program.

The Collection System will allow you to print your Past Due Notices, Collection Call Report, Bring
Current Recommendation Report, Collection Code Report, and you Late Letter Report.  The Past
Due Notices menu item will automatically print the proper past due notice based on the history of
each account and the parameters that you have setup in the Collection Parameters.  The Collection
Call and Bring Current Recommendation Report will print an account that is past due and fits the
parameters that you have setup in the system.  The Collection Code Report will print out each
account with a collection code set.  The collection codes are used to disable the past due notice
printing of past due accounts for various user defined reasons.

 
The Utilities menu will allow you to print Address Labels, Amortization Schedules, Auto-Coupon

Printing, Coupon Books, and a Borrower Listing report.  The address labels function will export to a
text file named Labels.txt.  Please review printing Address Labels in this help file for additional
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information.  The Amortization Schedule function will print an schedule for Regular Amortized loans
only.  This function will "look" at the account and print a schedule based on the current balance and
the current due dates.  The Auto Coupon Printing function will print coupon books for accounts that
the next coupon book is due and the next due date is due within 30 days of today's date.  The
Borrower Listing report will print out an alphabetical report of all borrowers currently in the system
with their account number.

 
Consumer Credit Reporting File will process all of your account and develop the Credit Bureau file

based on the current account information.

 

 

13.2 Borrower Listing Report

 Borrower Listing Report

ALPHA LISTING OF BORROWERS
 
 
This report provides an alphabetical listing of borrowers with their account numbers.
 

  To print this report go to the Main Screen, Click on Reporter, Utilities, and Borrower Listing.  You
will now be asked if you wish to print this report by Lender.  If you answer Yes, you will have to enter
the lender number or click List and choose the lender.  Click OK to continue printing this report.

 
To see an example of this report:  Borrower Listing Report - Sample 

13.3 Management Reports
13.3.1 Account Summary Report

 Account Summary Report
 

 

For each lender and/or loan type specified, this report will print the following information: loan
account number, name of the borrower, date and amount of last payment received, next payment
due date, amount past due (if any), beginning and ending principal balances, escrow balance (if
any), and suspense account balance (if any).  Additionally, this report will show the following accrual
information based on various rules set forth in the program (see Accrual of Interest ):

 
-Rate
-Per Diem
-Current Accrual for this period
-Total Accrual on this loan
-Total Interest Paid to date
-Accrual ending balance
-Original Loan Amount totals included
-Per Diem totals
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Sample Report  ACCOUNT SUMMARY REPORT - SAMPLE
                          Account Summary - Investor Report Sample 
 

Need Accrual amounts on a daily basis?
Just click yes when prompted and Accrual Amounts will be listed and totaled on the Account

Summary Report. 
(For more on Accruals please see Accrual of Interest )

Executing the Account Summary Report
 
To execute the Account Summary report go to Reporter from the main program screen, then to

Management Reports and choose Account Summary. Choose whether you wish to print a Regular
Report or an Investor report. Enter the Report Date and answer the following questions and Trakker
will generate the Account Summary Report.

Note: Any Accounts with a Begin Date that is after the Report Date WILL NOT appear on the
Account Summary Report.

 

13.3.2 Payment Summary Report

 Payment Summary Report
 

 

The Payment Summary Report is a summary of payments received between 2 dates you specify
and for either all Lenders or a certain one and for either all Class Codes or certain ones.  The
following information is printed:  loan account number, name of the borrower, date payment was
received, the amount of principal and interest paid, the balance of the account, the escrow balance
(if any), any late fees that were paid, and the servicing fee charged.  At the end of the report are
appropriate totals for interest, principal, escrow,  and fees received.  Therefore, an accountant only
need to take these figures and make the appropriate credit and debit entries to their General Ledger.

 

To execute the Payment Summary Report go to Reporter from the main program screen, then to
Management Reports and choose Payment Summary. Choose the type of Payment Summary
Report you wish to run (the most common report is Regular Report) and then enter the date
parameters you wish to use. The dates are inclusive to the report so that if you wish to run a report
for the entire month of May you would use the dates 5/01/01 to 5/31/01. Answer the subsequent
questions and Trakker will then print the report.

 

An example of this report can be viewed at: PAYMENT SUMMARY REPORT - SAMPLE

13.3.3 Year End Statement
 

Yearly History Statement to Borrower
 

 

The Yearly History Statement to the borrower is a summary of interest, principal, and
fees paid between two dates.  Naturally, the usual time period is January 1st through
December 31st.  A sample of this statement is found in: Year End Statement .  The
Statement is in a letter format and spaced 1.75" from the top to allow for use of letterhead
paper.

The Statement is accessed through the Main Screen's Toolbar Reporter then under the
sub-menu item, Management Reports with the following options available:
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-All lenders or a certain lender
-All class codes or a certain one

 

 

13.3.4 Interest Paid Report

 Interest Paid Report
 

 

This report is used in conjunction with either electronic or manual filing of IRS form 1099.  It is a
very lengthy report --- it lists payment by payment, the interest that borrowers paid on each payment
made (see sample report at: INTEREST PAID SUMMARY REPORT - SAMPLE )

 
Executing the Interest Paid Report

 
From the main program screen go to Reporter, Management Reports and select Interest Paid.

Answer the subsequent questions and then set the date parameters (as shown below). The dates
are inclusive so that if you wanted a report for all of the interest paid for the year 2001 up until May
you would use the dates 01/01/01 to 05/31/01. Click OK after you have set the dates and Trakker
will then print the report.

 

13.3.5 Escrow Transaction Report

Escrow Transaction Report 
 

 

This report lists escrow received for each borrower as well as monies paid out for taxes,
insurance, etc. over a given period of time. 

(see sample report at: ESCROW ACCOUNT TRANSACTION REPORT - SAMPLE  )

13.3.6 Aging Report

Aging Report
 

This report (2 pages) will print the following information on each loan that is delinquent: 

The first page prints  loan account number, name of borrower, date payment was due, amount of
expected payment, account balance, and how many days the payment is past due (30, 60, 90, or
120 days). 

The second page prints a summary for the lender and/or loan type you requested.  The following
information is printed: total number of payments over 30 days, 60 days, 90 days, and 120 days, total
number of accounts that are due over 30 days, 60 days, 90 days, and 120 days, total number of
accounts, total number of delinquent accounts, total amount of overdue payments, and the total
amount of income that would be received if everyone were to make their monthly payment. 

 
See sample report at: AGING REPORT - SAMPLE
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13.3.7 Delinquency Report

 Delinquency Report

This report summarizes the accounts that are delinquent as of a certain date you specify and for
either all lenders or certain ones and for either all Class Codes or, again, only certain ones.  Note
that on the far right side of the report there is a column for the borrower's phone number. This report,
therefore, makes it especially useful for past due collectors to utilize in making phone calls.
Additionally, just below the borrower's primary account information is a summary of your contact log
for the prior 30 days; thus, allowing the past due collector to know what has been done, phone calls
that have been received in the recent past, etc.  
 
For example, suppose Account Number 1010 was delinquent.  The borrower is John Jones who has
a telephone number of 722-9160.  The last posting to the loan account was on April 2, 2001 and
today's date is May 22, 2001.  Mr. Jones' due date is the first of each month.  On May 10, Mr. Jones
was called and he stated that he had some problems and that his payment would be in your office by
May 14.  Then on May 15 it was noticed that Mr. Jones' payment was not received.  He was called
again.  Mr. Jones apologized and stated that the payment would be made by May 20.  Given this
information, the Daily Delinquency Summary would look similar to our sample below. 

 

13.3.8 Late Fees Due Report

 Late Fees Due Report
 

 

These reports list the amount of late fees due by a borrower within a given lender number and/or
loan type.  They are available by either Detail or Summary Reports, i.e. shows only Borrower's name,
account number, and fees owed.  Additionally, the user is given the option to automatically print late
fee notices for any amount and above and, again by lender and/or class code.  These notices are
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formatted to easily fit onto standard Past due Notices "mailer" forms or to print 2 per page on an 8 ½
X 11 sheet of paper.  See sample report below  (NOTE: NOTICES ARE NOT SENT TO
ACCOUNTS WHICH HAVE BEEN PREVIOUSLY DEFINED IN COLLECTION SYSTEM AS ONES
THAT SHOULD NOT BE CONTACTED)

       

13.3.9 Suspense Account Summary

 Suspense Account Summary
 

This report can be printed at any time on a daily, weekly, bi-weekly, or monthly basis, or whenever
there is a need to resolve accounts. The Suspense Account Summary provides the name of the
borrower, the account number, and the amount in the borrower's suspense account as of the date of
printing.  At the end of the report, the total of all suspense accounts is printed,  (see sample report
at: SUSPENSE ACCOUNT SUMMARY REPORT -SAMPLE ) with the following  information:

 
-Borrower name and account number
-Beginning balance at the beginning of the first day entered
-Cash amount that came into Suspense:
-Direct posting
-Overage's on payoffs
-Adjustments made for:
-Returned checks
-Fee reversed too many times
-Credits for:

-Transfers to the loan for payments
-Direct withdrawals

-Ending balance as of the second date entered at the end of day;
-Change between the beginning balance (date) and the ending balance (date).
 

Your balancing department to balance back to daily deposits can then easily use this information.  
Please see the following for additional information:  

SUSPENSE ACCOUNT SUMMARY REPORT -SAMPLE 
Balancing Procedures 

DATE RANGES INPUTTED: USE THE ACTUAL DATE RANGE NEEDED.  FOR EXAMPLE, IF
YOU LAST BALANCED ON JUNE 30TH, NOW RUN THE NEXT SUSPENSE REPORT
BEGINNING ON JULY 1ST AND THROUGH WHATEVER DATE IS BEING BALANCED
THROUGH.
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13.3.10 New Loan Report

NEW LOAN SUMMARY REPORT
 

 

This report summarizes new loans that have been inputted AFTER a certain date and will allow for
choosing either all lenders or a particular one and/or all class codes or a particular one. 

 
To run this report:  From the main screen click on Reporter, Management Reports, New Loans. 

You will then be asked for a Start Date, Enter the appropriate date and press OK.
 

13.3.11 Examples
13.3.11.1 Account Summary Report - Example

 Account Summary Report - Example
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13.3.11.2 Account Summary - Investor Report - Example

 Account Summary - Investor Report - Example
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13.3.11.3 Payment Summary Report - Example

 Payment Summary Report - Example
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13.3.11.4 Payment Summary Report - Investor Due - Example

Payment Summary Report - Investor Due - Example
 



Reports 188

Copyright Multi-Financial Services Company, Inc. 2012©

13.3.11.5 Year End Statement - Example

 Year End Statement - Example

13.3.11.6 Interest Paid Report - Example

Interest Paid Report - Example
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13.3.11.7 Escrow Transaction Report - Example

 Escrow Transaction Report - Example
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13.3.11.8 Aging Report - Example

 Aging Report - Example
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13.3.11.9 Late Fees Due Report - Example

 Late Fees Due Report - Example

13.3.11.10Borrower Listing Report - Example

 Borrower Listing Report - Example
 

13.3.11.11Suspense Account Summary Report - Example

Suspense Account Summary Report - Example

 



Trakker - Loan Servicing Software Help File193

Copyright Multi-Financial Services Company, Inc. 2012©

13.3.11.12Report Manager

 Report Manager

The report manager is a window that contains all items currently listed under the Reports menu on
the main screen of Trakker.  This will allow you to easily pull your reports without having to browse
through the menu system.  

13.4 Collection Reports
13.4.1 Aging Report

Aging Report
 

This report (2 pages) will print the following information on each loan that is delinquent: 

The first page prints  loan account number, name of borrower, date payment was due, amount of
expected payment, account balance, and how many days the payment is past due (30, 60, 90, or
120 days). 

The second page prints a summary for the lender and/or loan type you requested.  The following
information is printed: total number of payments over 30 days, 60 days, 90 days, and 120 days, total
number of accounts that are due over 30 days, 60 days, 90 days, and 120 days, total number of
accounts, total number of delinquent accounts, total amount of overdue payments, and the total
amount of income that would be received if everyone were to make their monthly payment. 

 
See sample report at: AGING REPORT - SAMPLE
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13.4.2 Aging Report - Example

 Aging Report - Example
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13.4.3 Delinquency Report

 Delinquency Report

This report summarizes the accounts that are delinquent as of a certain date you specify and for
either all lenders or certain ones and for either all Class Codes or, again, only certain ones.  Note
that on the far right side of the report there is a column for the borrower's phone number. This report,
therefore, makes it especially useful for past due collectors to utilize in making phone calls.
Additionally, just below the borrower's primary account information is a summary of your contact log
for the prior 30 days; thus, allowing the past due collector to know what has been done, phone calls
that have been received in the recent past, etc.  
 
For example, suppose Account Number 1010 was delinquent.  The borrower is John Jones who has
a telephone number of 722-9160.  The last posting to the loan account was on April 2, 2001 and
today's date is May 22, 2001.  Mr. Jones' due date is the first of each month.  On May 10, Mr. Jones
was called and he stated that he had some problems and that his payment would be in your office by
May 14.  Then on May 15 it was noticed that Mr. Jones' payment was not received.  He was called
again.  Mr. Jones apologized and stated that the payment would be made by May 20.  Given this
information, the Daily Delinquency Summary would look similar to our sample below. 

 

13.4.4 Late Notice Report

 Late Notice Report

This report will detail any late notices printed
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13.4.5 Late Fees Due Report

 Late Fees Due Report
 

 

These reports list the amount of late fees due by a borrower within a given lender number and/or
loan type.  They are available by either Detail or Summary Reports, i.e. shows only Borrower's name,
account number, and fees owed.  Additionally, the user is given the option to automatically print late
fee notices for any amount and above and, again by lender and/or class code.  These notices are
formatted to easily fit onto standard Past due Notices "mailer" forms or to print 2 per page on an 8 ½
X 11 sheet of paper.  See sample report below  (NOTE: NOTICES ARE NOT SENT TO
ACCOUNTS WHICH HAVE BEEN PREVIOUSLY DEFINED IN COLLECTION SYSTEM AS ONES
THAT SHOULD NOT BE CONTACTED)
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13.4.6 Late Fees Due Report - Example

 Late Fees Due Report - Example

13.4.7 Collection Code Report

Collection Code Report 

This prints what codes are in the system parameters.
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13.4.8 Bring Current Recommendation Report

Bring Current Recommendation Report

This prints a report that recommends which loans need to pay to bring them current.  You will see below an example of
this report. 

 

 

13.5 Other Reports
13.5.1 Amortization Schedule

 PRINT AMORTIZATION SCHEDULE
 

 

This option will print an amortization schedule for a given account from the CURRENT due date
until the end of the note.  
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13.5.2 Auto Coupon Printing

Auto Coupon Printing

What is Auto Coupon Printing?
This utility allows the user to print several coupon books in a shorter period of time than with the
manual coupon printing found in earlier versions. Please see PRINT COUPONBOOKS for more
on manual coupon printing.

This powerful utility, when executed, will look at the last available coupon for each account.  The
program will then print out coupon books for those accounts whose last coupon falls within 30
days of the day the utility is executed.  When the program finishes spooling through the
accounts, it waits to see if there are errors, then automatically updates the last coupon date for
the books that were printed. The parameters need to be set only once and, from that point on,
simply point and click and the program will do the rest.  

Note: When using the manual coupon printing function, the coupon dates must still be
manually entered and the program must be told how many to print for each account.  
 
The following coupon book options can be changed:  
· The header (name on top of the coupon book letter)
· Who the checks should be made to
· Where the checks should be mailed to

 These options can be set by following the directions below.
 

Setting Global Parameters
The first step in using the Auto Coupon Printing utility is defining the global parameters.
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1. From the main program screen, select System -> Parameter Options -> Auto Coupon
Options.

2. In the white text box, input the number of coupons that should be printed for every account.
3. Select a cover page option. This controls whose information appears on the cover page.
4. Select a Checks Payable To option.
5. Select a Mail To option.
6. Select Bold in either of these boxes to bold them on the coupon books.
7. Select Include Lender Information if the lender's information is to be included in the book.

Note: If upgrading from a version prior to 1.6.0, the Last Coupon date in the
Dates/Database must be set for each account.  Please refer to Important Dates/Data Base
for more information on defining Coupon Book Due Dates.  For new loans that are
entered into the system after updating to Version 1.6.0, this step is not needed; the
process has been totally automated.  
 
Note: By default, the coupon options value is set to zero.  The Cover Page options, Make
Checks Payable to, and Mail Checks to, is set to Servicer.

Executing Auto Coupon Printing
 Once the global parameters have been set, the Auto Coupon Printing feature can be utilized. 
 

1. From the main Trakker screen, select Reporter.
2. In the Reporter window, click the forward arrow.
3. Select the Utilities tab.
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4. Select Auto Coupon Printing.

5. Click Execute. The Auto Coupon Printing utility now spools through the accounts and prints
coupons for those accounts whose due date falls within the next 30 days.

6. The Coupon Printing Complete dialog box should appear. If there are any errors, click No.
Otherwise, click Yes. The Couponbooks Due Report will print detailing which accounts

received coupon books.   
7. If No was selected in the Coupon Printing Complete dialog box, the Couponbooks Due Report

will still print, but the data file storing the coupon book information (coupon.dta, located in the
folder where Trakker itself resides) will not be updated, allowing corrections to be made. Once
all errors are corrected, repeat steps 1 through 6 to print the corrected coupon books.

Note: Users will not be able to post payments while the Auto Coupon Printing utility is
spooling.  Users may, however, browse accounts and review information, make notes in
the Contact Log, or make changes to the Miscellaneous Database.

 

13.5.3 Coupon Books

 PRINT COUPON BOOKS
 

 

This option allows the user to print a given amount of coupons for a specific borrower. You will be
prompted to input the following: the amount of coupons desired, who pays the monthly payer fees
(lender or borrower), and whether or not you need a new coupon summary card.  A coupon summary
card gives you a paper copy of the most pertinent account information, such as the loan account
number, the borrower name and address, the lender name and address, payment amount, interest
rate, late fee charge, and servicing fee.  This card is usually printed and filed for quick reference. (for
sample see: COUPON BOOK - SAMPLE )
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13.5.4 Coupon Book - Example

Coupon Book - Example 



Reports 204

Copyright Multi-Financial Services Company, Inc. 2012©
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13.5.5 Coupon Book Due Report

Coupon Book Due Report

This report is used mainly as a reminder to the user of accounts that will be in need of coupon
books.  It shows the account number, the last date the coupons were printed on, and the next due date
when they will need to be printed again.

To print this report:  From the main screen, Click on Dates/Data, Important Due Dates, Coupon
Books.  The program will now give you three options; Update Due Date, Print Report, and Review Due
Date.  Click on "Print Report".

 
An example of this report is below

     As of:  May 8, 2001

(The Following Information is for Coupon Books that have had their last coupon used based on their next due date)

Account Last Coupon Next Due Date
=======================================================================
1002 4/5/2001
7/5/2001
1003 1/1/2001
6/1/2001
1004 2/1/2001
5/1/2001
1005 4/1/2001
6/1/2001
1006 4/1/2001
6/1/2001
=======================================================================

 

13.5.6 Pending Insurance Due Report - Example

 Pending Insurance Due Report - Example
 

  For July 6, 2001

                                                      Insurance
      Account  Borrower             Telephone         Due Date
      ===============================================================
      1200     Henry Tutor          412-555-3234      8/22/2001
      1255     Alexander Hickey     904-235-0034      7/29/2001

13.5.7 Important Dates Report - Example

 Important Dates - Example Report
 

· IMPORTANT DATES INFORMATION
 
 
From Main Screen Menu select: DATES/DATA

The Important Dates functions allows the user to track up to 16 key dates for each borrower, then
print reports periodically (e.g. at the end of or beginning of each month) to see what has occurred or
will be occurring over the next 30 – 60 days depending on which report is printed.  However, the
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reports are only as important as the user keeping information current in the Important Dates
function.

Please refer to Important Dates/Data Base for additional information.

Appendix B provides a copy of the reports generated within your program's Important Dates
function.  These reports provided cannot be changed as with the letters in Appendix A .    

More management reports are available within "Reporter" on the Main Menu Bar (see Appendix C)

For making additional reports for your own unique situation, it may be advisable to use the
program's "Data Out" function (see Utilities) on converting data from a binary format to a
tab-delimited format useable in spreadsheet, word processing, database, or similar programs where
data can be imported.

13.5.8 County Taxes Accounts Due Report

County Taxes Accounts Due Report
 

 

This report gives the account number and due date for the County Taxes. As with all of the Import
Dates reports the due date must be defined prior to attempting to print this report.

To print this report:  From the main screen, Click on Dates/Data, Important Due Dates, County
Taxes.  The program will now give you three options; Update Due Date, Print Report, and Review Due
Date.  Click on "Print Report".

To see an example of this report:  County Taxes Accounts Due Report - Sample 
 

13.5.9 County Taxes Accounts Due Report - Example

County Taxes Accounts Due Report - Example

County Taxes
Accounts Due Report

As of: May 8, 2001

(The Following Information if for Accounts that are or will soon be due and is based on today's calendar date)

Account Due Date
===================================================================

1400 7/1/2000

5042 1/1/2001

4558 1/1/2001

5070 12/1/2000

===================================================================
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13.5.10 Pending Insurance Due Report

Pending Insurance Due Report
 

This report is used mainly as a reminder to the user of accounts that have insurance.  It shows the
account number, the account name, the account's telephone number, and the next due date.

To print this report:  From the main screen, Click on Dates/Data, Important Due Dates, Hazard
Insurance.  The program will now give you three options; Update Due Date, Print Report, and
Review Due Date.  Click on" Print Report".

 
To see an example of this report:  Pending Insurance Due Report - Sample 

13.5.11 Interest Rate #1 Report

 Interest Rate #1 Report
 

This report is used mainly as a reminder for user of upcoming accounts who have variable interest rates that need to be
changed in the system.
To print this report:  From the main screen, Click on Dates/Data, Important Due Dates, Interest Rate Change, #1.  The
program will now give you three options; Update Due Date, Print Report, and Review Due Date.  Click on "Print Report".
 

To see an example of this report:  Interest Rate #1 - Sample 
 

13.5.12 Interest Rate #1 - Example

Interest Rate #1 - Example

Interest Rate #1
Accounts Due Report

As of: May 8, 2001

(The Following Information is for Accounts that are or will soon be due and is based on today's calendar date)

 

Account          Due Date Next Payment Due Date
 

4342 8/20/2000 4/22/2001
 

4487 5/1/2001 6/1/2001
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13.5.13 Agency Reporting

Agency Reporting

This report is only for clients with Fannie Mae accounts. 

RUN AGENCY REPORT FROM TRAKKER
From the Main Trakker menu 
-Select Reporter>Agency Reports
-Select FannieMae:LoanActiveReport by Highlighting it, then click Execute
-Enter the AS OF DATE (any activity after this date will not be reflected on this report)
 A Create Fannie Mae Dialog box will appear. This is where your report will be saved. You can save
this file anywhere you choose>BUT it must be saved as a .txt file (We suggest creating a new file
on your server or Computer). The default to the report name is FNMA-LAR-YYYYMM.txt, you will
need to rename this file because  the upload to Fannie Mae will not accept files with hyphens or
spaces.

-Enter the desired file name and location 
-Click SAVE
The report runs, then displays a confirmation message that includes the location and the number of
loans that were included in the report. 

You will receive a dialog box that says Report Completed with the number of accounts that are
contained 

- Click ok

You will now need to go to the Fannie Mae website and use their SURF application to upload
the file generated by the report.

  TRANSMITTING THE REPORT TO FANNIE MAE

If you have any problems with the information below you will need to contact Fannie Mae
directly.
Trakker is not responsible for and can not assist with any problems or questions regarding
the website below:

In order to submit an initial LAR file via SURF you will need to schedule a Test
Transmission. 
Fannie Mae only conducts tests at specific times and you will need to contact Fannie Mae
to schedule the Test Transmission.

SURF Test Transmissions
Website: http://www.efanniemae.com/sf/technology/index.jsp
1. Scroll Down To - Servicing & Investor Reporting section
2. Find - SURF™
3. Click on Launch
Uploading the Test File

Upload the test file by following the steps below:

1. Log onto SURF by typing in “user id” and “password”.
2. From the “Loan Reporting” menu, click the blue “LAR File Transmit” button.
3. A Java Security window appears.  Click on the “Run” button on the Java Security Window.  This

Java window appears the first time you use the upload function during a processing session.  If
you exit and re-enter, the security window will appear again.
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4. The “LAR File Transfer upload” screen appears along with the “Select Files to Upload” window.
5. Click on the “Add” button to browse through your local drive and select the files(s) to be

uploaded.
6. Select the drive where the file is located and then navigate to the file. When located, click on the

file so that it appears in the “Select File and Upload” window.
Note: The file should be stored on a local drive; the SURF applet may not be able to ‘see’ all
network/shared drives.

7. Click on the file name to select it.
8. The “Applet File Upload” window appears displaying the file(s) to be uploaded. 
9. Click the “Upload” button in the “Applet File Upload” window to begin the file transfer process.
10.The Upload Progress window appears displaying the progress of your file transfer.
11.When completed, the system displays the following message in red.

”LAR file transferred successfully!”
12.Click the blue “Back” button to exit the LAR File Transfer screen.
13.SURF will notify you when your Confirmation Notice is ready.

Retrieving the Confirmation Notice

Retrieve the confirmation notice by following the steps below:

1. Click the “Get download” link to the right of the “Your download is ready” message to retrieve
the confirmation notice.

2. A Java Security window appears.  Click on the “Run” button on the Java Security Window.  This
Java window appears the first time you use the upload function during a processing session.  If
you exit and re-enter, the security window will appear again.

3. The “Applet File Download” window appears displaying the file(s) to be downloaded.
4. Click on the file name to select it in the “Applet File Download” window
5. Click on the “Save As” Button in the “Applet File Download” window to browse through your

local drive and select the location to save the file.
6. Navigate to the Confirmation Notice File on your local drive and Open the file.
7. Verify that the transaction counts agree with your totals. If not, check the count for Rejected

Transactions. 
8. This notice is simply a means to confirm that all the items in your data file were received for

processing by LASER. To determine if the processed transactions were accepted and applied,
you will need to review the LAR Rejects and Reports for the reporting period.
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14 IRS Filing

14.1 IRS Filing Background

 IRS Filing Background

BACKGROUND INFORMATION
 
 
Prior to January 31 each year, lenders are required to send a 1098 IRS form to each borrower
indicating the amount of interest paid in prior year.  Servicers of loans held by other lenders can do
this as a service to their lenders.  Additionally, by February 28 this same information is required to
be sent by the lender or servicer to the IRS
NOTE: YOU NEED TO CONTACT YOUR ACCOUNTANT/BOOKKEEPER TO FIRST
DETERMINE WHAT TYPE OF 1098 FORMS TO PURCHASE.. E.G. 2 PART, 3 PART, ETC.,
ETC.
 
THE PROGRAM is able to complete the vast majority of your reporting and includes the ability to:
 
· Print a summary report of borrowers and lenders having federal tax identification number
problems on file with you (e.g. you may have entered all `9's' until one was received)
 
· Print a summary report of interest each borrower paid on each payment
 
· Print 1098 forms for each borrower with a copy sent to or retained by the lender
 
· Create a computer file which can be copied to a diskette and send to the I.R.S. for filing
magnetically or electronically (magnetically utilizes your diskette to send information, whereas
electronically information is sent via a phone line directly to their computer).
 

 
If you wish to file magnetically/electronically with the IRS, (it is mandatory if you report more
than 250 accounts) it is necessary for you to have a completed their Application for Filing
Information Returns Magnetically/Electronically' Form #4419.  It is suggested that you do this as
soon as possible to file in a timely manner.  Any questions can be directed to the IRS's
Martinsburg Computing Center in Martinsburg, VA at 1-304-263-8700.  Once received, the I.R.S.
will assign a Transmitter Control Code' (TCC) to identify your company.  A copy of this form is
found in Exhibit I.

· PROCEDURE

· Go to System/Parameter Options/System Default Option/Change 1098 filing to 0
· Exit and reopen Trakker select F8 to change Print to Printer to Print to Screen
· Select Reporter/Management Report/Interest Paid when finished write down the Interest Paid

total 
· Select IRS FORMS/Print 1098 Forms (you are still printing to screen) when finished (this could

take a while) compare the Interest Paid total to this total
· If these totals do not match exit Trakker select F8 to change from print to screen to print to

printer, print the same report out on plain paper and compare the borrower's information- contact
the Help Desk should you have any unresolved problems

· When everything is in balance print 1098 forms and mail
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14.2 IRS TAX FILING

IRS TAX FILING
 

 

Within this section, you have 3 items on a drop down menu:
-Develop IRS Data File
-Print 1098 Forms
-Print 4804 Form

 
Although the program provides the means to file either magnetically (on diskette) or

electronically (by modem) to the IRS, Multi-Financial Services Co., Inc. does NOT advise
on how  you should file nor provide tax advice, other than to indicate that the IRS requires
you to file magnetically or electronically if you have more than 200 filings each year. 
Therefore, if you will be filing magnetically/electronically, you should contact the IRS as
soon as possible in order to get "pre-registered" and obtain a TCC account number.

 

For additional information on printing 1098 and 4804 forms, please consult the section, 
I.R.S. Form Filing  

Develop IRS Data File
 
This option calculates the interest that the borrowers have paid for a given year.  You will

be required to enter a tax filing code (TCC).  A file called IRSTAX.001 will be created and
must be copied to a diskette for electronic I.R.S. filing.  A report of all accounts without a
social security number and those accounts with zero interest paid can also be printed at
this time.

 
 

Print 1098 Forms
 
 
This allows for borrower 1098 forms to be printed.  Forms are available from

Multi-Financial Services Co., Inc. beginning in December of each year and are currently
continuous tractor feed forms for faster printing and ease in mailing.  That is, once the
forms are printed, you only need to affix postage and mail!

 

Print 4804 Form
 
 
This allows transmittal of information returns to be reported magnetically/electronically.
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14.3 1098 Printing

1098 Printing

PROCEDURES FOR 1098 PROCESSING WITH THE PROGRAM
 
 
 

NOTE1:  If you do not wish to file magnetically/electronically the following procedures for printing
your management reports and printing your 1098 forms can still be used.  Notes will be made in
the following procedures to indicate what you do not have to do. 

NOTE2: Changes by the IRS for printing and filing 1098's will also be made automatically in the
Trakker program.  However, although Multi-Financial Services Co., Inc. will make every effort to
make the program in compliance, it is the responsibility of each client to keep their software up to
date and to stay informed of all IRS tax filings and notify their borrowers.    
 

PRINTING 1098 FORMS
 
  
· Load the proper 1098 forms in your printer
 
· Choose Reporter
 
· Choose 'Print 1098 Forms'
 
           
At this point the program will begin printing 1098 forms, however, it's suggested that you let the
computer print a couple of forms to see how they're printing inside the mailer.  If you wish to stop
or pause this print job, go to your printer's properties and select Pause (to pause) or Purge (to
stop).

TEST PAGE

We strongly suggest that you run a the test page option before you run your complete file. 
The test page must be run on a 1098 form to ensure that the information is lining up correctly

NOTE:  THE MONETARY DATA IS PRE DEFINED IN THE TEST SYSTEM. IT WILL NOT
MATCH YOUR DATA

14.4 IRS Data Filing
IRS Data Filing

VERIFYING FEDERAL TAX I.D. NUMBERS AND CREATING COMPUTER FILE FOR IRS MAGNETIC/ELECTRONIC
FILING

  

· Be sure the printer is turned on and has enough paper (For Reports)
 

· Go to Reporter and choose Utilities
 

· Choose "Develop IRS Data File"
 

· Enter the year you are filing for and the TCC identifying number  (if you are not filing magnetically/electronically, just
enter 999's for the TCC  number).

 

Once chosen, Trakker will review each account, compute the interest paid for each borrower and write information to a
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file `IRSTAX.001'.   However, should the report indicate accounts needing correct Federal Tax I.D. numbers, it will be
necessary to get that information and change your borrower or lender records within Trakker.  Should this be necessary, the
`Develop IRS Data File' procedure can easily be performed as many times as need to write the correct information to the
`IRS.001' file.  Also, running this procedure DOES NOT affect any data you have stored

 



Part
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15 Letters

15.1 Overview

Overview

SAMPLE LETTERS - INTRODUCTION
  
This appendix provides a copy of each letter that is supplied with your program.  They are generic

so that they may be used by many different organizations.  As such, each client should consult with
their own management team and legal advisor as to the wording of each letter and notice to conform
with laws and statutes in your state and policies of your own company.

 
 
The letters are changeable by the operator by using any Text Editor program (like Notepad) and

editing either of the .OVL files in the Trakker directory.  However, only the combinations listed below
can be used automatically by the computer in any letter.

 

The following is a list of all the letters provided:
PAST DUE NOTICE #1 
PAST DUE NOTICE #2 
PAST DUE NOTICE #3 (RECENT PAYMENT MADE) 
10-DAY BRING CURRENT CERTIFIED LETTER 
PAYOFF LETTER 
INTEREST RATE CHANGE LETTER 
RETURN CHECK NOTICE 

15.2 Past due Notice #1 - Example

 Past due Notice #1 - Example

Your Company Letterhead Stationary or Notices
 

Your Company Name
Company Address
City, St Zip

June 15, 1996            ****IMPORTANT PAST DUE NOTICE***

RE:       Account Number 9999-1002
As of the above date, we have NOT received your payment of
$293.75 which was due on 6/1/01, plus a late fee of $14.69.
If you have not mailed your payment, please send $308.44
immediately.  If you have already mailed your payment, then
please disregard this notice.
 

PH # Company Phone Number
 

 

Sally Smith
123 Main Street
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Lynn Haven, FL 32444

15.3 Past due Notice #2 - Example

Past due Notice #2 - Example
 

Your Company Letterhead Stationary or Notices
 

Your Company Name
Company Address
City, St Zip

June 16, 2001  ***URGENT...URGENT...URGENT...PASTDUE NOTICE
RE: Account Number 9999-1002
You have NOT replied to our past reminders of your overdue
account and your account remains $293.75 SERIOUSLY PAST DUE!! If
you are not capable of making this payment, please call so we may
help.  We would appreciate a word from you -- as well as your
check.  Remember that your payment history CAN AFFECT your credit!
 

PH # Company Phone Number
 

 

Sally Smith
123 Main Street
Lynn Haven, FL 32444

15.4 Past due Notice #3 - Example

Past due Notice #3 - Example

 #3 (RECENT PAYMENT MADE)
 Your Company Letterhead Stationary or Notices
 

Your Company Name
Company Address
City, St Zip

June 17, 1996 RE: Account Number 9999-1002
Your recent payment was received on 2/12/01 for $293.75 and has
been applied  to  your  account.   Although we appreciate this
payment, your account remains due in the amount of $293.75 and is
now due for 6/1/01, plus $14.69 in total late fees.  If you have
not previously  made  arrangements  to make  your  next  payment,
please give us  a call AS  SOON AS POSSIBLE  so that your  credit
 

record is not harmed.
 

PH # Company Phone Number
 

 

Sally Smith
123 Main Street
Lynn Haven, FL 32444
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15.5 Bring Current Letter - Example

Bring Current Letter - Example

10-DAY BRING CURRENT CERTIFIED LETTER
 
 Your Company Letterhead Stationary
 

June 18, 1996

Sally Smith
123 Main Street
Lynn Haven, FL 32444

RE: Account Number 9999-1002

Dear Customer:
Your account is $293.75 overdue.  All our previous attempts to
bring your account current have  failed and M.F.S. has  exhausted
resources and patience.  If we have not received the payment of
$293.75 within 10 days of the date of this letter, you will leave
us no choice but  to take other actions  to protect our  client's
interest.   Please also be advised that once your account is
 

turned over to a local attorney their fees will be added to  your
outstanding balance as stipulated in your promissory note.

Should you wish to discuss your  account,  please  call   me
immediately at PH# Company Phone Number.

Sincerely,

Your Company Name

           CERTIFIED MAIL RECEIPT #____________________________________

           CC:  LENDER: Your Lender Name

15.6 Payment Receipt - Example

Payment Receipt - Example
 

Your Company Letterhead Stationary
 

           Sally Smith
           123 Main Street
           Lynn Haven, FL 32444

           RE: Account Number 9999-1002

           Dear Customer:
           Thank you for your payment.   Please use this as your receipt as
           well as the breakdown of your payment.

                     Balance prior to payment:     $  9856.25
                     Amount received:              $   293.75
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                     Amount applied to escrow:     $     0.00
 

                     Interest paid:                $   147.84
                     Principal applied:            $   145.91
                     Late fees/Interest short:     $     0.00
                     Past due balance:             $     0.00
                     New loan balance:             $  9710.34

           Your next payment is due 5/1/2001 in the amount of $293.75.  This
           amount reflects any outstanding payments and past due charges, if
           applicable.
 

           Sincerely,

           Your Company Name
           Telephone Number

15.7 Return Check Notice - Example

 Return Check Notice - Example

                     Your Company Letterhead Stationary

           June 30, 2001

           Sally Smith
           123 Main Street
           Lynn Haven, FL 32444

           RE: Account Number 9999-1002

                          RETURNED CHECK NOTICE
           Dear Customer:
           This letter is to inform you that your check number 1232 which
           was dated 6/20/01 in the amount of $293.75 has been returned from
           the bank with the notation:
 

                     _____ INSUFFICIENT FUNDS
                     _____ UNCOLLECTED FUNDS
                     _____ STOP PAYMENT
                     _____ OTHER REASON
                     ________________________________
           Due to the above, the following has occurred on your account:
                     _____ Your check has been re-deposited and we are
                           awaiting word  from your bank  that the check  has
                           been paid;
 

                     _____ Your check is unable to be processed again;
           In addition, a return check charge of $20.00 is now assessed on
           your account and will be due on your NEXT PAYMENT!
                     _____ Your due date has been changed and now shows due
                          for 6/15/01
                     _____ ____________________________________________
                     __________________________________________________

           Should you have any questions, please call anytime at Your
 

           Company Phone Number.

           Sincerely,

           Your Company Name
           Telephone Number
           cc:  Lender:          Your Lender's Name
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15.8 Payoff Letter - Example

Payoff Letter - Example
 

Your Company Letterhead Stationary
 

June 23, 2001

Sally Smith
123 Main Street
Lynn Haven, FL 32444
 

RE: Account Number 9999-1002
 

Dear Customer:
This is to inform you that the payoff on your loan through 6/30/01 is $10015.38 with a per diem
of $4.92. In addition, the following additional charges will apply when your payoff is processed:

$_______________    For compiling payoff quote.

$_______________    Fax Fee

$_______________    Other______________________

$_______________    Other______________________

$_______________    Total Due

If you have any questions, please contact this office.
 

Sincerely,

Your Company Name

Telephone Number
                  

15.9 Interest Rate Change Letter - Example

Interest Rate Change Letter - Example
 

 
Your Company Letterhead Stationary
 

           June 2, 2001

           Sally Smith
           123 Main Street
           Lynn Haven, FL 32444

           RE: Account Number 9999-1002

           Dear Customer:
           This letter is to inform you  that the interest rate on the  loan
           associated with  the above  account number  has been  changed  to
           16.5% effective the date of this letter.  This change in the rate
           forces a change in your payment  which is now $275.00. Your  next
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           payment is due 7/1/2001 and must be this new amount.

           If you have any questions, please contact this office.

           Sincerely,

           Your Company Name
           Telephone Number



Part
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16 Customizing Letters

16.1 Overview

Overview

Introduction
There are four files that contain letters that you can easily customize to fit your company's needs.
These files reside in your program's folder.  You can locate these files by right clicking on your
shortcut, click on Properties, click the Shortcut tab, and click on Find Target.  This will take you to
the program folder.  The four files are:  Letters.ovl, Custom1.ovl, Custom2.ovl, and Rpt_ltrs.ovl.  
These files can only be edited in Notepad (due to formatting issues).  
 
To edit any of these "ovl" files double click on one of the files, Windows© will ask you what
program you wish to edit the file with, choose Notepad, and select "Use this program for this file
type".  The next time you wish to edit any of these files Windows© will not ask you what program
you wish to use, and will automatically open Notepad.  Each letter in these files are separated by a
" ^ " in the upper left corner of the document.  These characters must remain in those areas in
order for the letters to function properly.  You will need to account for the number of lines to
leave blank when printing on a letterhead, if used.
 
Listed below are descriptions of each file and it's contents.  Please use the directions above to
locate and edit each of these files.  If you need further assistance please contact our Help Desk

Letters.ovl
This file contains 14 different letters that are used from various parts of the program.  The Past
Due Notices can be printed using the Automated Collection System located on the Main screen
under Reporter, Collection System, and Past Due Notices.  The Past Due Notices can also be
individually printed from the borrowers screen under Letters and Notices.  The remaining letters
listed below can be printed from their respective menu item on the Borrower's Toolbar.
 
· Past Due Notice 1
 
· Past Due Notice 2
 
· Past Due Notice 3 (Recent Payment Made)
 
· Bring Current Letter
 
· ** Not Used In Current Version **
 
· ** Not Used In Current Version **
 
· Interest Rate Change Letter
 
· ** Not Used In Current Version **
 
· ** Not Used In Current Version **
 
· Returned Check Notice ( NSF Letter )
 
· Payment Receipt
 
· Payoff Letter
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· ** Not Used In Current Version **
 
· ** Not Used In Current Version **
 

Custom1.ovl
This file contains five letters, which are printed from each individual borrower screen, when you
select Letters, Custom.  To name these letters go to the Main Program screen and select System,
Custom Letter Names, and Borrower Letters.  To Add a letter name click on Add, to Delete a letter
name select that letter and select Delete, to Edit a letter name select that letter and select Edit. 
The first letter name is linked to the first letter located in the Custom1.ovl file, and the second is
linked to the second letter, etc.  
 

Custom2.ovl
This file contains five letters, which are printed from the Main Program screen under Reporter and
Custom Letters.  This will print letters based on a specific Lender, Loan Class, Closed Accounts,
or All Accounts.  To name these letters go to the Main Program screen and select System,
Custom Letter Names, and Reporter Letters.  To Add a letter name click on Add, to Delete a letter
name select that letter and select Delete, to Edit a letter name select that letter and select Edit. 
The first letter name is linked to the first letter located in the Custom2.ovl file, and the second is
linked to the second letter, etc.  
 

Rpt_Ltrs.ovl
This file contains the Coupon Book.  Please be aware that it is made up of four sections:  Heading,
Main Body, Payment Information, and Ending Letter.  The ONLY section that you can edit is the
Main Body.  As of version 2.0 you can modify the Heading, and part of the Payment Information
(who to make and mail the payments to) from the Auto Coupon Settings menu option.  

Related Information:
CUSTOM LETTERS AVAILABLE FIELDS  
Setting Custom Letter Names 
Changing Fonts in Letters 

16.2 Setting Custom Letter Names

Setting Custom Letter Names

 Custom Letter Names
 

This section will cover the setup of borrower and reporter letter names and how to modify the
letters.  The borrower letters are in the custom1.ovl file and the reporter letters are in custom2.ovl,
both are located in your program directory.  When you install the program five letters are provided,
these letters can easily be modified in Notepad.  Please do not use Word or Word Pad when
making modifications to custom letters, there have been reports of letters not working after being
edited in these programs.  Below are instructions on how to set the names of the borrower and
reporter letters.  At the bottom of this page you will locate links to other documents relating to
customizing letters.

 

To name or rename the Borrower and Reporter Letters
 

From the main program screen click on System
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1. Click Custom Letter Names
 
2. Click either Borrower Letters or Reporter Letters
 
 A new screen will appear
 

From this screen you can Add, Edit, or Delete letter names.
 
If you wish to add a letter name
 
3. Click add
 
4.  Enter the name you wish to name the letter 
 
5. Click OK

 
If you wish to Edit a letter name

 
3. Click on the existing name

 
4. Click Edit
 
 5. Modify the name
   
 6. Click OK
 
If you wish to Delete a letter name
 
 3. Click on the existing letter
 
 4. Click Delete
 

Other resources for Customizing Letters
CUSTOM LETTERS AVAILABLE FIELDS 
CUSTOMIZING LETTERS 
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16.3 Changing Fonts in Letters

 Changing Fonts in Letters
 

Letters in the Letters.ovl file and any custom letter you develop can have the following features:
-Bold, italic, and underline text
-Columns set at specific spots
-Left margins

Tags used, their definitions, and examples are the following:
~FONT~NAME=" name of font" SIZE = xx

 
Where the program expects the font name to be put within the quotes and the font's size in place
of the "xx" shown

~COL~x.x~
 
Where you indicate the distance in inches in place of the "x.x" shown how far from the left side of
the paper you wish a SINGLE line to begin
 

~LMARGIN~x.x~
 
Where you indicate the distance in inches in place of the "x.x" shown how far from the left side of
the paper you wish text to be printed.  This command continues, line after line, until a new
LMARGIN command is given
 

BOLD=ON
Turns characters after it to bold – has to be shown WITHIN a FONT and SIZE

statement
ITALIC=ON
Turns characters after it to italic – has to be shown WITHIN a FONT and SIZE

statement
UNDERLINE=ON
Underlines characters after it - has to be shown WITHIN a FONT and SIZE

statement

EXAMPLES
~FONT~NAME="Courier New" SIZE=12~      

     
 
Changes all characters after it to Courier New, font size of 12

 ~FONT~NAME="Courier New" SIZE=12 UNDERLINE=ON BOLD=ON ITALIC=ON~ 
Same as prior example, but now underlines, bold's, and italicizes all characters after it
NOTE: To turn off the underline, bold, and italic, simply re-input the FONT NAME and

SIZE only after the text
~COL~2.5~

 
Put at the beginning of a line of text will start that line ONLY 2.5 inches from the left side of the
paper
 

~LMARGIN~1.25~
 
Put at the beginning of a line of test will have all following lines 1.25 inches from the left side of the
paper until the left margin is changed again
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16.4 Available Fields

Available Fields
(NOTE: for instructions on changing fonts, sizes, etc. see: Changing Fonts in Letters
topic)

VARIABLE NAME TO INPUT WHAT IT CONTAINS
~pos~#~ Position # column to print
~account_nbr~ Borrower's account number
~first_name~ Borrower's First Name
~last_name~ Borrower's Last Name
~ssn~ Borrower's federal tax id #
~mail~0~ Borrower's street address
~mail~1~ Borrower's city
~mail~2~ Borrower's state
~mail~3~ Borrower's zip code
~mail_add2_country~0~ Borrower's street address 2nd Part
~mail_add2_country~1~ Borrower's country name
~due_date~ Account's current due date
~days_late~ Number of grace days account is allowed late
~date~ Today's date from computer
~lender~ Lender Number
~lender~0~ Lender's Name - First Part
~lender~1~ Lender's Name - Second Part
~mortgagee~0~ Lender's name (only used in rtp_ltrs.ovl)
~lender~2~ Lender's street address
~lender~3~ Lender's city
~mortgagee~2~ Lender's city (only used in rtp_ltrs.ovl)
~lender~4~ Lender's state
~mortgagee~4~ Lender's zip code (only used in rtp_ltrs.ovl)
~lender~5~ Lender's zip code
~szFedID~ Lender's federal tax id #
~pay+penalty~ Payment with late fee
~pay+escrow~ P&I payment plus escrow
~interest_due~ Calculates interest due on a Simple Interest loan

as of the current date from the last date paid
~totpay~ Calculates next payment amount due including any

past due amounts
~bring_current~ Amount needed to bring account current
~item~0~ Payment amount last posted
~item~1~ Interest paid on last posted
~item~2~ Principal paid on last posted
~item~3~ New loan balance
~item~4~ Late fees + interest short
~item~5~ Past due balance
~item~6~ Amount just applied to escrow
~penalty~ Late fee amount
~rate~ Loan interest rate
~prior_bal~ Balance just before last payment
~prepay_penalty_amount~ Prepayment Penalty Amount
~payoff~ Payoff amount based on date inputted
~bad_fee~ NSF fee amount you charge
~rcvd~ Last payment received date
~company~0~ Servicer's company name
~company~1~ Servicer's street address
~company~2~ Servicer's city
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~company~3~ Servicer's state
~company~4~ Servicer's phone number
~maint_fee~ Maintenance fee amount 
~maint_cap~ Maintenance fee cap
~maint_amount_paid~ Maintenance fee paid amount
~maint_date~ Maintenance fee date
~maint_action~ Maintenance fee action/comment
~principledue~* Principal past due
~interestdue~* Interest past due
~escrowdue~* Escrow past due
~maintdue~* Maintenance fee past due
~latefessdue~* Late fees due
~pastdue~* Late fees past due
~servicefeedue~* Service fees past due
~intshortdue~* Interest short due
~suspbalance~* Suspense balance
~escrowshort_bal~* Escrow short balance

*Not available in version 2.4.0.8349 or prior versions

16.5 Reporter Letters

 Reporter Letters
 

 

This section will cover the setup of Reporter letter names and how to modify the letters.  The
Reporter letters are in the Custom2.ovl file, located in your program directory.  When you install the
program five letters are provided, these letters can easily be modified in Notepad.  Please do not use
Word or Word Pad when making modifications to custom letters, there have been reports of letters
not working after being edited in these programs.  Below are instructions on how to set the names of
the borrower letters.  At the bottom of this page you will locate links to other documents relating to
customizing letters.

 

To name or rename the Reporter Letters
 
· From the main program screen click on System
 
· Click Custom Letter Names
 
· Click Borrower Letters
 
· A new screen will appear
 
· From this screen you can Add, Edit, or Delete borrower letter names.
 
· If you wish to add a borrower letter name
 

Click add
 

Enter the name you wish to name the letter 
 

Click OK
 
· If you wish to Edit a borrower letter name
 

Click on the existing borrower letter
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Click Edit

 
Modify the name

 
Click OK

 
· If you wish to Delete a borrower letter name
 

Click on the existing borrower letter
 

Click Delete
 

Other resources for Customizing Letters
CUSTOM LETTERS AVAILABLE FIELDS 
CUSTOMIZING LETTERS 

16.6 Borrower Letters

Borrower Letters
This section will cover the setup of borrower letter names and how to modify the letters.  The

borrower letters are in the Custom1.ovl file, located in your program directory.  When you install the
program five letters are provided, these letters can easily be modified in Notepad.  Please do not use
Word or Word Pad when making modifications to custom letters, there have been reports of letters
not working after being edited in these programs.  Below are instructions on how to set the names of
the borrower letters.  At the bottom of this page you will locate links to other documents relating to
customizing letters.

 

To name or rename the Borrower Letters
 
· From the main program screen click on System
 
· Click Custom Letter Names
 
· Click Borrower Letters
 
· A new screen will appear
 
· From this screen you can Add, Edit, or Delete borrower letter names.
 
· If you wish to add a borrower letter name
 
. Click add   Enter the name you wish to name the letter 
 

.       Click OK
 
· If you wish to Edit a borrower letter name
 

.       Click on the existing borrower letter
 
. Click Edit  Modify the name
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.       Click OK
 
· If you wish to Delete a borrower letter name
 
. Click on the existing borrower letter
 

.       Click Delete
 

Other resources for Customizing Letters
CUSTOM LETTERS AVAILABLE FIELDS 
CUSTOMIZING LETTERS 
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17 Collections

17.1 Overview

Overview

 COLLECTION SYSTEM
 
Your loan-servicing program has an automated Collection System which is accessible on the
main program screen under Reporter.  It is also tied closely to the Collection Codes & Parameters
functions accessible under Reporter on the main program screen.  The Collection System and
Collection Codes/Parameter functions are the heart of the automated past due collection process
whereby you are able to:
 
· Set System Parameters as to when past due notices should be sent
 
· Set System Parameters as to when 10-day Bring Current Letters should be printed
 
· Set System Parameters as to when calls should be made to borrowers
 
· Define Collection Codes for later use in indicating by borrower who SHOULD NOT receive

past due notices, letters, and phone calls
 
· Print past due notices automatically by lender number, class code, or all loans
 
· Re-print past due notices starting at a particular account number should miss-prints occur
 
· Print a Collection Call Report listing borrowers who are over the System Parameters to make

calls to and showing contacts made in the past 30 days
 
· Print a Bring Current Recommendation Report listing accounts, which are over the System

Parameters for Bring Current Letters
 
· Print various reports summarizing accounts with Collections Codes and the type code (very

important for internal control reasons!)
 

 
The Collection System allows you to print past due notices based on the System Parameters
indicated and does NOT print a notice when a Collection Code is on an account, no matter how far
past due they are!  (WARNING!  It is imperative for internal control reasons that utilizing various
available Collection System reports described above closely monitors the use of Collection
Codes). The automatic printing of past due notices is based on:
 
· Due date of a loan
 
· Grace period of a loan
 
· Parameters you input as to when notices should be sent AFTER the grace period
 
· When the last notice was printed and the type of notice
 
· Whether a collection code is on the account; therefore it is NOT suppose to receive notices

due to various reasons YOU have defined, e.g. already in bankruptcy, is now being handled by
the company's attorney, etc., all user defined
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Some features available in the Notice Printing function:
 
· On any day of a month, you will be able to tell the system to print past due notices and it will do

so automatically without any       intervention from you
 
    You will still be able to manually go to a borrower's account and indicate to send a particular

past due notice.  The system will record information of this notice and will make appropriate
judgments on future notices based on this manual notice being printed

 
· Automatic notices can easily be printed for loans with various late grace periods; that is, some

loans can have a 15-day grace period and other loans have a 20 day grace period
 
· System Parameters define the number of days that you wish past due notices printed:
 

After the grace period for Notice #1
 

After Notice #1 has been sent for Notice #2
 

After a payment has been received, however, the account is still past due for Notice #3
 
· System Parameters also define the number of days after the grace period that you wish phone

calls to be made and to send a #4-10  day Bring Current Letter printed (separate reports for
each are available)

 
· Past due notices are printed based on the number of days you entered into the System

Parameters as to when they should be printed after the grace period.  For example, let's say
you have a loan with a 15-day grace period, and your company has decided to send Notice #1
IMMEDIATELY after the grace period ends. The parameter for Notice #1 should be set at
zero.

 

 
This section will now explain how to use the system effectively so you, the user, print notices in a
timely manner with minimal manual intervention.  Additionally, you will find very detailed steps to
setup System Parameters, Collection Codes, and other important information.  EXTREME caution
should be exercised in proceeding from step-to-step; especially, if you have an existing portfolio! 
When in doubt, please call   the Help Desk at anytime (850-559-9123).  Since several requests
will be made to use Explorer, copy files, delete files, etc., it is preferred that the person calling the
Help Desk be VERY familiar with these commands.
 

Below are steps to use in setting up your Automatic Past due Notice Printing System.  Please note
that there are FOUR different sets of instructions:

1.  Defining System Parameters (Defining System Parameters)

2.  Defining Collection Codes (Defining Collection Codes)

3.  Existing Loan Portfolios (Existing Loans - Introduction)
 
 For companies with existing loan portfolios that are
 
- Currently being serviced on this servicing system; however, never converted to the Collection
System
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- OR have been serviced on another servicing system and the loans are being transferred to
this system

4.  New loan portfolios ( Entering A New Loan ):
For companies just starting to service loans

It is imperative that you do #1 & #2 FIRST, then choose either #3 or #4, depending on your
company's loan status!

17.2 Existing Loans - Introduction

 Existing Loans - Introduction
 

 Since you have an existing portfolio of loans, it is IMPERATIVE that a database of information be
developed as to what notices should have been sent out over the last 4 weeks as the Collection
System would have sent it out.  That is, the system you now have relies not only on current due
dates, but also on HISTORICAL information to make logical decisions as to what should be done at
any point in time you choose to print notices in the future.  To create this historical information, you
will be asked at some point to change your computer's time clock BACKWARDS to dates starting 4
weeks ago and it will be assumed you know how to do this through your Windows Control Panel
prompt.  It is, therefore, also strongly suggested that if you are on a network, that you utilize a 
workstation that is NOT being utilized by other workstations since you will be re-booting your
machine at least 4 times.

 

Steps in converting existing loans to the Collection System:
A.   Entering Collection Codes
 
1. Run an Account Summary Report as of the current date 
2. Go down the Account Summary Report and decide which accounts should have a Collection
Code and write the number next to the borrower's name. 
3. Now go to: Inputting Collection Codes 
 

 
B. Developing database information for Collection System
 
The Collection System stores information in a data file named "Late.dta" in which dates Notices

#1, 2, & 3 were sent out is stored.  Prior to printing any notice, this data file is read and the system
determines what notices have already been sent out in the past and then determines, based on your
system parameters, what should be done, if anything.  Thus, in order for you to start sending out
notices historical information needs to be created.

 
1. Change your computer's system date to a date 4 weeks ago by going to Start, Settings, and
Control Panel then choose the icon "Date/Time" 
2. Re-start your computer by logging off ….you do not need to power down 
3. Turn off the printer you are connected to since we do not wish to actually print past due notices
 
4. Run past due notices by choosing Reporter/Collection System, select Past Due Notices and
indicate all lenders and all class codes 
5. The program will now process past due notices and write appropriate information to the
late.dta file.  Do not do anything when your desktop indicates it cannot print to the printer.  You can
move the printer status box to the side in order to see the Collection System working. 
6. When completed the program will ask if any past due notices were printed INCORRECTLY



Trakker - Loan Servicing Software Help File235

Copyright Multi-Financial Services Company, Inc. 2012©

.just answer NO. 
7. Purge print jobs by going to Start, Settings, Printers, select your printer, choose Printer on the
toolbar, then select Purge Print documents. You may also need to choose Cancel on the printer
status box that was on your screen while the past due notice processing was being performed. 
8. Now, continue changing your computer date for an additional 3 weeks by working backward
(week 3, then week 2, and finally week 1) and performing steps 1 through 7 until completed
 

You have now created your database of historical information congratulations!!
 

17.3 Defining System Parameters

Defining System Parameters

                                  Steps for defining the Collection System's Parameters:
 

· From the main screen of the program choose System then Collection Codes/Parameters
 
· Now choose Parameters
 
· In each blank box, indicate the following information:
 

The number of days AFTER the grace period when Notice #1 should be sent
 

The number of days AFTER Notice #1 is sent that Notice #2 should be sent
 

The number of days AFTER a payment is received, however, the account is still past due, that
a Notice #3 should be sent
 

The number of days AFTER the grace period when an account should show up on the
Collection Call Report
 

The number of days after the grace period when an account should show up on the Bring
Current Recommendation Report
 

Then after reviewing, choose OK.  Later if you wish to change any entries, just highlight the
appropriate box and enter the new data.

17.4 Defining Collection Codes
Defining Collection Codes

Steps for defining the Collection Codes:
 

· Develop a list of reasons an account SHOULD NOT be sent notices, called, or sent a Bring Current Letter, (E.g. In
bankruptcy, at attorney, sent Bring Current Letter, in foreclosure, etc.) up to a limit of 99 different reasons

 

· From the main screen choose System then Collection Codes/Parameters
 

· Now choose Collection Codes
 

· Choose Add and type in the name of the first Collection Code you wish, e.g. In Bankruptcy, and choose OK
 

· Continue Adding additional Collection Codes depending on your company definitions up to the limit of 99
 

· If you need to change one or more, simply highlight it, then choose Edit and proceed to edit the name
 

· If you wish to delete a Collection Code, simply highlight it, and then choose Delete
 

Then choose OK after reviewing.

You should now print a summary report of accounts with Collection Codes and review against your Account Summary
Report for accuracy and/or any changes needed.  Go to Reporter, select Collection System, then choose Collection Code
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Report.  Although you are able to print a report by Collection Code, it is recommended that you answer NO and print a report
with all codes, all lenders, and all class codes in order to easily compare it to your Account Summary Report.  Once
completed, you should now print out reports for each collection code for distribution among appropriate management
personnel for review.

 

17.5 Collection Reports
17.5.1 Aging Report

Aging Report
 

This report (2 pages) will print the following information on each loan that is delinquent: 

The first page prints  loan account number, name of borrower, date payment was due, amount of
expected payment, account balance, and how many days the payment is past due (30, 60, 90, or
120 days). 

The second page prints a summary for the lender and/or loan type you requested.  The following
information is printed: total number of payments over 30 days, 60 days, 90 days, and 120 days, total
number of accounts that are due over 30 days, 60 days, 90 days, and 120 days, total number of
accounts, total number of delinquent accounts, total amount of overdue payments, and the total
amount of income that would be received if everyone were to make their monthly payment. 

 
See sample report at: AGING REPORT - SAMPLE
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17.5.2 Aging Report - Example

 Aging Report - Example
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17.5.3 Delinquency Report

 Delinquency Report

This report summarizes the accounts that are delinquent as of a certain date you specify and for
either all lenders or certain ones and for either all Class Codes or, again, only certain ones.  Note
that on the far right side of the report there is a column for the borrower's phone number. This report,
therefore, makes it especially useful for past due collectors to utilize in making phone calls.
Additionally, just below the borrower's primary account information is a summary of your contact log
for the prior 30 days; thus, allowing the past due collector to know what has been done, phone calls
that have been received in the recent past, etc.  
 
For example, suppose Account Number 1010 was delinquent.  The borrower is John Jones who has
a telephone number of 722-9160.  The last posting to the loan account was on April 2, 2001 and
today's date is May 22, 2001.  Mr. Jones' due date is the first of each month.  On May 10, Mr. Jones
was called and he stated that he had some problems and that his payment would be in your office by
May 14.  Then on May 15 it was noticed that Mr. Jones' payment was not received.  He was called
again.  Mr. Jones apologized and stated that the payment would be made by May 20.  Given this
information, the Daily Delinquency Summary would look similar to our sample below. 

 

17.5.4 Late Notice Report

 Late Notice Report

This report will detail any late notices printed
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17.5.5 Late Fees Due Report

 Late Fees Due Report
 

 

These reports list the amount of late fees due by a borrower within a given lender number and/or
loan type.  They are available by either Detail or Summary Reports, i.e. shows only Borrower's name,
account number, and fees owed.  Additionally, the user is given the option to automatically print late
fee notices for any amount and above and, again by lender and/or class code.  These notices are
formatted to easily fit onto standard Past due Notices "mailer" forms or to print 2 per page on an 8 ½
X 11 sheet of paper.  See sample report below  (NOTE: NOTICES ARE NOT SENT TO
ACCOUNTS WHICH HAVE BEEN PREVIOUSLY DEFINED IN COLLECTION SYSTEM AS ONES
THAT SHOULD NOT BE CONTACTED)
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17.5.6 Collection Code Report

Collection Code Report 

This prints what codes are in the system parameters.

17.5.7 Bring Current Recommendation Report

Bring Current Recommendation Report

This prints a report that recommends which loans need to pay to bring them current.  You will see below an example of
this report. 
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18 Utilities

18.1 Utilities
 

Data Conversion Utility
 

 

This utility converts the encoded binary database files in the servicing program to a readable 'character' or ASCII tab
delimited text format.  You can then use your data in a Spreadsheet, database, report writer or whatever you need.   Many
companies use this data to perform in-house analyses, special one-time use reports, etc.

 

Executing the Data Conversion Utility
 

 

Select this option from the Main Program Screen. Go to the System Menu, then to Utilities, Convert Data and follow the
instructions. When executing this feature please note the path where the folder called "Dataout" is created. By default this
path is C:\MFS\DATAOUT. This path will be DIFFERENT if you have installed on a server or are executing this feature over
a networked drive. 

 
 

  Files That You May Be Interested In
 

  A few of the more pertinent data files are:
Mortgor.xls contains borrower and loan set up information
(Year).xls                 contains payment information for that year
Nextdue.xls contains next payment due dates as well as other pertinent information
Escrow.xls contains escrow transactions made for each account
Datamisc.xls contains pertinent miscellaneous data such as 1098 status and points paid
(*)date.xls contains the due dates for various expenses such as taxes and insurance
userfields.xls contains the User Defined Fields

To start learning about available data in each file, it's suggested that you open each in a spreadsheet program such as
Excel.  When opening remember they are in ASCII and Tab-Delimited format since the spreadsheet program will
immediately recognize them as text files.  Suggested instructions on opening each file in a spreadsheet program are:

 

Open your spreadsheet program
 

    Choose the File Open option
 

    Browse over to the folder where your servicing program is stored
 

    Look for a sub-folder called "Dataout"
 

    Choose the file you need, and open as a "Tab-Delimited" format
 

After opening a file, you'll notice column headings are printed automatically on the first line.  Please refer to Appendix H
for definitions of each column and the data contained in each. You can also change the widths of the columns and change
the order of the columns.  You can also delete or add columns.  All dollar amounts come over in integer * 100 format.  If you
have specific questions about these data variables, please call our Help Desk (850-559-9123).

 
 

Finally, this is ONLY an EXPORT utility and not an EXPORT/IMPORT utility.
 

 

18.2 Purge Account
 

 

Purging an account means to take an account's information completely off your system!  Therefore, before performing
this routine, it is imperative that you decide if this is what you really want to do.  Once completed there is NO turning back
and getting this account's information, unless it has been previously backed up.  

 

Executing the Purge Account Utility
 

 

Go to the Main Screen and choose System/Utilities/Purge Account.  From here you'll be asked the account number, be
given additional warnings and the account will then be purged from all data files.

 

Note:  When purging an account ask all other users to exit the program before executing the Purge command.
After you have purged ALL of the loans that you wish to, it is recommended that you close the program and then
reopen the program before you perform any other functions.  This will allow the program to "Re-Index" all of its
files.
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19 Dataout

19.1 Overview
  

 

The following information explains the various files created by the "Data Out" function, which takes binary file information
and converts it to a useable ASCII – Tab-Delimited format.  The following is broken down by the converted file name with a
general explanation of each file and the definition of each column heading.  All files can be brought directly into Excel or into
an MDB Database.  Listed below is a full list of each file that is exported.  To review a full explanation of each file click on
the name of the file.  

 

Note: Due to the width of each file please note that the descriptions for each file will be listed vertically instead of
horizontally.

 

(Year).xls                            Payment Files
balldate.xls                          Balloon Due Dates
citydate.xls                          Escrow City Due Dates
cntydate.xls                         Escrow County Due Dates
comment.xls                        Loan Comment Line
contactlog.xls                      Account Contact Logs
coupon.xls                           Coupon Due Dates
datamisc.xls                         Data Misc. File
escrow.xls                          Escrow Transactions
insrdate.xls                          Escrow City Transactions  
intdate1.xls                          Escrow City Transactions
intdate2.xls                          Escrow City Transactions
invest3.xls                           Investor Primary & Sub Account Links
investor.xls                          Investor Listing
late.xls                                 Late Letter Printed Dates
lender.xls                             Lender Name & Number
lender2.xls                           Lender Detail Information
maintenance.xls                   Lender Detail Information
maintenance2.xls                 Lender Detail Information 
mor3relatives.xls                 Account Other Contacts
morcontacts.xls                   Borrower List & Personal Information
mortgor.xls                           Primary Table - Includes MOST information entered during the "New Loan Wizard"
mortgor3.xls                         Borrower  Detail & Credit Bureau Information
nextdue.xls                          Account Current Balance, Next Due & Last Payment Recv'd Dates, & Past Due Balance
oth1date.xls                         Important Due Dates (Other 1)  
oth2date.xls                         Important Due Dates (Other 2)
oth3date.xls                         Important Due Dates (Other 3)
oth4date.xls                         Important Due Dates (Other 4)
purgelog.xls                         Purge Log
suspense.xls                       Suspense Account Transactions
userfields.asc                      User Defined Fields
usr1date.xls                         Important Due Dates (User 1)
usr2date.xls                         Important Due Dates (User 2)  
usr3date.xls                         Important Due Dates (User 3)
usr4date.xls                         Important Due Dates (User 4)
usr5date.xls                         Important Due Dates (User 5)
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19.2 Dataout - Suspense
 

This file contains all suspense account transactions.

A.  Account Number                       Account #
B.  suspense month                       Month of transaction
C.  suspense day                           Day of transaction
D.  suspense year                         Year of transaction
E.  suspense code                         Transaction Code
                                                       0 = Beginning of account
                                                       1 = Extra from payment
                                                       2 = Direct posting to the suspense account
                                                       3 = Transfer to loan from the suspense account
                                                       7 = Void (This is when you process a transfer and then void it)  
F.  begin balance                            Beginning balance with this transaction
G.  end balance                              Ending balance after this transaction

19.3 Dataout - Purgelog
 

This file displays the Purge Log.  The purge log is a log that shows whom and when an account was purged.

A.  Account Number               Account # purged
B.  Purge Date                         Date account purged
C.  Purge Comment                 Who was signed in when the account was purged.

 

19.4 Dataout - Morcontacts
 

This file contains the detailed information on each borrower.  Each item should be self-explanatory.  If you need
information on this file please contact our Trakker Support Department.

A.  Account Number
B.  First Name
C.  Middle Initial
D.  Last Name/ Company
E.  SSN
F.  Sex
G.  Race
H.  Date of Birth
I.  Street
J.  Suite
K.  City
L.  State
M.  Zip
N.  Work Phone
O.  Home Phone
P.  ECOA Code

 

19.5 Dataout - Mortgor3
 

This file contains additional information about each account.

A.  Account Number                          Account #
B.  Appraisal                                      Appraisal Value
C.  PrePay Penalty                             Amount of the Pre Payment Penalty
D.  PrePay Date                                 Date entered for the Pre Payment Penalty
E.  Portfolio Type                               Type of portfolio
F.  Account Type                              Type of account
G.  Account Status                           Credit status (info for the Credit Bureau)
H.  Special Comment                         Additional comment (info for the Credit Bureau)
I.   Condition Code                             Account condition (info for the Credit Bureau)  

J.  Information Ind                              Account comment (info for the Credit Bureau)
K.  Number of Relatives                     Number of additional contacts
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L.  Number of Borrowers                  Number of borrower's listed
M.  Collateral                                      Collateral description
N.  Property ID                                   Property ID
 

19.6 Dataout - Mor3relatives
 

This file contains the additional contacts that are associated with each account.

A.  Account Number                         Account #
B.  First Name                                   First name
C.  Last Name                                   Last name
D.  Street                                          Mailing address
E.  Suite                                            Mailing address 2
F.  City                                              Mailing city
G.  State                                            Mailing state
H.  Zip                                               Mailing zip
I.   Work Phone                                 Contact work phone
J.  Home Phone                                Contact home phone
K. Relation                                       What relation is this client to the account or borrower

19.7 Dataout - Maintenance
 

This file contains the detailed funds leaving or paid out of each account's Maintenance Fee Account.

A.  Account Number                 Account Number
B.  TX Date                                Date of Transaction
C.  Amount Paid                        The amount withdrawn or added to the account
D.  TX Activity                           Description of activity
 

19.8 Dataout - Lender 2
 

This file contains the Lender's name.

A.  Lender Number       Lender #
B.  Lender FName        First Name
C.  Lender LName        Last Name
 

19.9 Dataout - Maintenance2
  This file contains the Maintenance Fee account setup information.

A.  Account Number                       Account Number
B.  Fee Required                              If a fee is required or not   1 = Yes    0 = No
C.  Maintenance Fee Amount          The "Per Payment" amount to be placed into the Maintenance Fee Account
D.  Maintenance Cap                       The maximum amount allowed to be in the Maintenance Fee Account

 

19.10 Dataout - Lender
 

This file contains the primary information on each of the lenders.

A.  Lender Number                                  The lender number
B.  Tax ID                                                 Federal ID
C.  Creditor Class                                    What "Type of company" this lender is associated with.
D.  Equifax Number                                 Equifax reporting account number
E.  Experian Number                               Experian reporting account number
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F.  Transunion Number                           Trans Union reporting account number
G.  Address                                            Mailing address
H.  City                                                    Mailing city
I.   State                                                  Mailing state
J.  Zip                                                     Mailing zip
K.  Phone Number                                   Contact phone number
 

19.11 Dataout - Late
  This file contains the dates that the late notices were printed for each account.

A.  Account Number             Account #
B.  Notice 1                           Date Notice 1 was printed
C.  Notice 2                           Date Notice 2 was printed
D.  Notice 3                           Date Notice 3 was printed
 

19.12 Dataout - Investor
 

This file contains all Investors that are listed in the program.

A.  Investor Fname                   Investor's First Name
B.  Investor Lname                   Investor's Last Name
C.  Investor Number                 Investor #
D.  Investor ID                          Federal ID Number
E.  Address 1                          Street Address Line 1
F.  Address 2                          Street Address Line 2
G.  City                                     City
H.  State                                   State
I.    Zip                                      Zip
J.  Area Code                          Phone Number Area Code
K.  Phone Number 1                 Phone Number
L.  Contact                               Who To Contact
M.  Bank Name                         Bank in Use  
N.  Routing Number                  Routing Number for Bank
O.  Account Number                Bank Account Number
P.  Country                               What country is the investor located
Q.  Area Code                          2ndPhone Number's Area Code
R.  Phone Number2                  2nd Phone Number

19.13 Dataout - Invest3
 

This file contains all of the linkage for multi-investor accounts.

A.  Account Number                 Main Account
 B.  Number Investors                Total number of investors attached to this account
C.  Sub account 1 Number       Sub account number 1
D.  Investor Number                  Investor number attached to this sub account
E.  Type Of Account                1 = Investor to Lender
                                                 2 = Investor to Borrower

Note:This account has too many items to list.  The section "Sub account 1 Number" to "Type Of Account" duplicate until
the file reaches "Sub account 50 Number".  Please use the definitions listed in the above section for the remaining listings.
 

19.14 Dataout - Contact Log
 
 

This file contains all of the notes in the contact log for each account.

A.  Account Number                       Account #
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B.  Contact Date                             The date for the contact
C.  Contact Comment                      The comment entered in the contact log
 

19.15 Dataout - Coupon
 

This file contains when each account should receive their next coupon.  This information is the Coupon Due Date.

A.  Account Number                  Account #
B.  Coupon Month                      The month the next coupon is due
E.  Coupon Day                         The day the next coupon is due
F.  Coupon Year                       The Year the next coupon is due
 

19.16 Dataout - Comment
 

This is the data entered into the comment field.

A.  Account Number                 Account #
B.  Comment                             The data stored in the 34 character field in the comment field.

19.17 Dataout - Userfields
  

 

Userfields.asc
 
Data files created by the User Defined Fields.  If you have entered information in an account's User Defined Field then it will
be listed here, If there has not been any information entered then that account will not be listed in this file.  The Accounts are
listed in account order.

Account Number        Account Number
Field Name                  The "Heading" for each field
Field Type                   The variable stored in the file that informs Trakker what type of field this is.  (ie: Number, Date, Memo,
etc.) 
Field Value                  The data entered in each field.

 

19.18 Dataout - Date
 
 

(*) DATE.XLS
Data files created by the Important Dates/Data Base, these files summarize the due dates of various payments to be made
such as, Balloon Payment Due Dates (balldate.dta), Insurance (insdate.dta), etc. 

 
Account Number          Borrowers Account Number
(*) Month                      Month Payment is scheduled
(*) Day                         Day Payment is scheduled
(*) Year                       Year Payment is scheduled
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19.19 Dataout - Datamisc
 
 

DATAMISC.XLS
 

This file summarizes values entered into the Miscellaneous Database from the Dates/Data menu on the main program
screen. 

 
A.  Account Number                  Borrower's Account Number
B.  Status of 1098 Printing         0=Normal 1098 Printing
                                                  1=Do not send a 1098
                                                  2=Serviced Account
C.  Points Paid                            Points paid at closing
D.  BrwrPayFee                         Service fee amount paid by the borrower
E.  ACH Borrower                     Denotes ACH Accounts
                                                  0=No    1=Yes
 
Many fields in this file are labeled "future use" and are intended for just that purpose, to be used in later versions of the
program.

19.20 Dataout - Escrow
 

ESCROW.XLS
This file summarizes escrow transactions made on specific accounts.

 
A.  Account Number                            Loan Account Number
B.  Escrow Date                                  Date of Transaction
C.  Reason for Withdrawal                  1=Hazard Insurance
                                                             2=County Taxes
                                                             30=City Taxes (Other #1)
                                                             31=Other #2
                                                             32=Other #3
                                                             33=Other #4
                                                             34=Other #5 (Overage/Balance Adjustment)
D.  Escrow Amount                             Amount of Transaction
E.  Escrow #/Comment                        Check Number/Reason for Transaction
 

19.21 Dataout - Nextdue
 

 

 NEXTDUE.XLS
 
This file summarizes the next due date of each loan along with some related information.  

 
A.  Account                          Loan account number
B.  Open/Closed                   Account open indicator   0=Open 1=Closed
C.  Next Due                         Month loan next due
D.  Next Due                         Day loan next due
E.  Next Due                         Year loan next due
F.  Grace Days                     Number of grace days allowed
G.  When Paid                       Month last paid
H.  When Paid                       Day last paid
I.    When Paid                      Year last paid  
J.  Balance                           Loan Balance  
K.  Pastdue Fees Int             Last due late fees and interest short amount (simple interest loans only)
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19.22 Dataout - Year Files
  

(year).XLS
 

There will be one file for each year the servicer has inputted data.  These files contain all payment data each calendar
year and contain the following data:

 

 

A.  account nmbr                      Borrower's account number
B.  Transx Nmbr                       The overall transaction number from inception of servicing
C.  When Rcvd                         Month payment received
D.  When Rcvd                         Day payment received
E.  When Rcvd                         Year payment received  

F.  Investor.How Paid              How payment was paid, payment reversals, increase/decrease in loan balance or past due
fees 
                                           via cash/non-cash transaction (Letters in parentheses indicate codes shown on screen)
                                                                                                                                     1=Cash (CA)  2=Check (CK)  3=Money Order(MO)  4=Return Check (RC)   5=Posting Error (PE)   

 6=Suspense Transfer  7=Not used 8=Paid Off   9=Prepaid Interest  10=Credit Interest 
-1=Visa(VI)  -2=M/C (MC)  -3=Amer.Express (AE)   -4=ACH(AC)   -5=other  -6=Balance
Change – non-cash (BF) -7=Balance Change - Cash (PC) 

 

G.  Days Between                    Days between payments
H.  Amt Rcvd                            Amount received for each payment
I.    Interest                                Interest amount for each payment
J.  Principal                               Principal amount for each payment
K.  Balance                               Balance of loan after principal payment
L.  Fees Paid                            Fees paid with payment
M.  Outstanding Fees               outstanding fees 
N.  Escrow Paid                       Escrow amount paid
O.  Interest Short                      Interest short on payment (simple interest loans only)
P.  Maintenance Fee                Amount that went to the Maintenance Account
Q.  Service Fee Paid                 Amount of fees paid (soon to be added)
R.  Who Gets Fee                     Who gets the late fee      0=Servicer 1=Lender
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19.23 Dataout - Mortgor
 MORTGOR.XLS
This file contains the basic information on each borrower, as the following will indicate.

A.  Lender#                                   This is the lender #  
B.  Account#                                 This is this borrower's loan #
C.  Loan type                                 This corresponds to the loan type: 
                                                       1=Individual  2=Company  
D.  Open/Closed                             This is the Open/Closed code indicating whether the loan is open or closed:
                                                       0=Active      1=Closed
E.   Escrow                                    This indicates whether the account is an escrowed account
                                                       1=No            2-Yes
F.  Straight                                      Indicates if the loan is a straight or balloon loan:
                                                       1=Straight    2=Balloon
G.  Number Payments                     Indicates the number of payment periods per year to be paid
H.  Type Interest                             Indicates the type interest calculation
                                                       1=Simple      2=Regular Amortizing
I.     Term                                          Number of payments to be paid
J.    Balloon Due                               The payment number the balloon is due
K.    Month Closed                            Month loan was closed
L.    Day Closed                               Day loan was closed 
M.    Year Closed                             Year loan was closed
N.    Month First Pay                         Month of first payment (next payment if loan was pre-existing)
O.    Day First Pay                            Day of first payment
P.    Year First Pay                           Year of first payment
Q.    Month Last Rcvd                      Month last payment received (if new loan will be month closed)
R.    Day Last Rcvd                          Day last payment received(  "  )
S.    Year Last Rcvd                        Year last payment received(  "  )  
T.     mor.last_due[0]                        Date am account was last due prior to the Bring-Current invoked (variable no longer

used actively)
U.     mor.last_due[1]                           " 
V.     mor.last_due[2]                           " 
W.     mor.ins_required                     Is insurance required – no longer used
X.     mor.ins_due[0]                         Date insurance due – no longer used
Y.     mor.ins_due[1]                           " 
Z.     mor.ins_due[2]                           "  
AA.  Grace Days                              Number of grace days prior to late been incurred
AB.  Type Serv Fee                         Type servicing fee if loan serviced for outside lender
                                                         1=Flat Fee  2=% of Payment   3=% of Balance
AC.  Month Begin Serv                     Month servicer began servicing loan
AD.  Day Began Serv                       Day servicer began servicing loan
AE.  Year Began Serv                     Year servicer began servicing loan
AF.  Fixed/Adjustable                       Fixed or adjustable rate loan
                                                         1=Adjustable    2=Fixed
AG.  Market Index                             0=No    -1=Uses market index
AH.  mor.fin_required                       Financial Statement required – no longer used
AI.  mor.fin_date[0]                           Date Financial Statement due – no longer used
AJ.  mor.fin_date[1]                           "  
AK.  mor.fin_date[2]                           "  
AL.  Balance New Loan                    Current balance of new loan at time of setup
AM.  Original Amount Loan                Original amount of loan when closed
AO.  Rate                                           Note's interest rate
AP.  P&I Payd                                     Principal and Interest payment amount
AQ.  Balloon Prind                              Principal amount of balloon payment when due
AR.  Late fee%                                  Percentage of payment for late fee
AS.  Escrow Payment                       Amount of escrow payment
AT.  Servicing Fee                             Servicing fee – dollar or percentage amounts
AU.  First Name                                  First name of borrower
AV.  Last Name                                  Last name of borrower
AW.  Collateral Addrss                       Collateral address location
AX.  Collateral City                             Collateral city location
AY.  Collateral State                           Collateral state location
AZ.  Collateral Zip                              Collateral zip code
BA.  Borrower Mail Address             Mailing address of borrower
BB.  Borrower Mail City                     Mailing city of borrower
BC.  Borrower Mail State                   Mailing state of borrower
BD.  Borrower Mail Zip                      Mailing zip code of borrower
BE.  Borrower Ph Nbr                        Phone number of borrower
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BF.  Tax ID                                         Federal tax I.D. of borrower
BG.  Class Code                                Loan's class code (2 digit letters or numbers or combination of both to allow printing

of management reports based on class code)
BH.  initial rate end month                  Used with market index
BI.  initial rate end day                       Used with market index
BJ.  initial rate end year                     Used with market index
BK.  initial rate                                    Used with market index
BL.  rate adjust                                  Used with market index
BM.  max rate decrease                     Used with market index
BN.  max rate increase                      Used with market index
BO.  rate period                                  Used with market index
BP.  minimum  rate                              Used with market index
BQ.  maximum rate                             Used with market index
BR.  rate increase period                   Used with market index
BS.  period multiplier                           Used with market index

 

19.24 Reports to Excel
  Trakker Reports to Excel

Note:  Before attempting to export Trakker Reports to Excel it is necessary to have a PDF
creator installed on your computer.

Exporting specific Trakker reports to excel is an easy process, but there are a few steps to it. 

1)  Utilize Trakker’s print to screen function by pressing the F8 key. 

2)  Then open Reporter and run the report that you would like. The report will appear on the screen
after it is compiled. 

3)  Select the printer icon in the top left of the window. Select a pdf printer to print your report to PDF.
Open the PDF. 

4)  Use your mouse or shift and arrow keys to select all text. Right click selected text and select copy. 

5)  Open Note Pad. Paste copied PDF text into note pad. 

6)  Highlight all text again and select copy. 

7)  Open excel and paste all copied text from note pad into excel. 

Complete.



Part
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20 Special Topics

20.1 Rounding Errors
 

 

 

As with any mathematical process involving money, amounts are necessarily rounded to the nearest cent.  The results
can be disturbing in interest calculations and screen or printed displays.  For example a payment of 132.16 must be broken
into amounts to be applied against interest and principal.  If the interest amount is displayed as 83.33, the actual amount of
interest may be 83.32765.  IT IS THIS LATTER NUMBER THAT IS USED BY THE COMPUTER IN ALL CALCULATIONS,
but because cents takes up only two decimal places, the .32765 is rounded to .33 FOR DISPLAY PURPOSES.  Thus the
principal amount is actually 48.83235, rounded to 48.83.  The extra .00235 is kept in the system and applied against the
account when rounding can represent a full cent.  Thus, from time to time there is a possibility that the numbers that appear
may not add up to the exact penny.  Every effort has been made to correct this situation within the program, but there will be
times that a rounding error appears.  Do not be alarmed because each rounding error will be corrected at the earliest
possible time.

 

20.2 Accrual of Interest
 

The accrual of interest earned monthly is a necessity for those companies who are not on the "cash" method of
accounting for income.  Your loan-servicing program has the ability to accrue interest and utilizes the Account Summary
Report ACCOUNT SUMMARY REPORT - SAMPLE to report the following information for each loan:

 

· Current month's accrual
 

· Total accrued-to-date since the original closing of the loan
 

· Total interest that has been paid
 

· The loan's accrued interest balance
 

The report then indicates the total of each of these categories for all loans.   Additionally, at the bottom of the report there
is a summary of:

 

· Current Month Accruals that breaks out interest earned on Regular Amortizing and Interest Bearing/Simple Interest
loans separately in case you need this information;

 

· Open Loan Accrual Totals, which summarize for all open loans:
 

Total interest accrued since the loan was made
 

Total interest paid-to-date
 

Uncollected accrued interest on payoffs (i.e. less interest was collected at the time a payoff was accepted that had been
accrued, thus, this figure needs to be credited back to a company's Accrued Interest G/L category)

 

New to Version 1.6.0!
You can now run the accruals for the Account Summary Report on a daily basis! Instead of having to wait until the last

day of the month or having to go to another screen entirely you can add accruals to the Account Summary Report whenever
you choose to do so.

Calculation of Accrued Interest Amounts
 

 

The actual calculation of accrued interest has been done according to the following guidelines developed as of August
1999.  Clients are urged to review these guidelines and submit ideas, concerns, etc. to the Help Desk (850-559-9123)
should changes be needed:

 

· General Guidelines for all loans:
 

Interest accruals will ONLY show on the Account Summary Report if a month-end date is entered
 

As of March, 2000, existing loans can have their "Life to Date" accrued interest added to the "Total Accrued Interest" –
this is available on the last New Account Input screen and pops up when the Note Date and Last Payment Received are
different – thus, the system recognizes the loan as an existing loan

 

Separate calculations are made for Regular Amortizing and Interest Bearing/Simple Interest methods
 

Both interest methods should consider whether pre-paid/credit interest was a part of the original loan closing
 

Pre-paid/credit interest figures should ALWAYS be used for the accrual figures for that month since they were manually
calculated by the user and should be considered correct

 

When loans are paid off, determine the accrued interest normally; however, recognize any "unpaid accrued interest" that
was not collected at payoff

 

 

· Guidelines for Regular Amortized loans:
 

Should accrue interest for each full month a loan is open
 

If a loan has a note date of say 3/15/99 and a first payment due date of 5/1/99 then the program will accrue only for 4/1/99
through the end of April (a prepaid interest figure should be available to the program for March's accruals)
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If a loan is paid-off during a month, accrue only for the number of days it was open during the month since the pay-off
function calculates the payoff on a daily amount

 

Accruals will be based on what interest is due monthly based on the loans NORMAL payment schedule, no matter if it is
paid ahead or past due

 

As of March 2000, the accrual system will consider changes made to a loan's balance (pay downs made by the borrower,
additional fees added to the balance, etc.) and develop a new amortization schedule within the program

 

 

· Guidelines for Interest Bearing/Simple Interest loans:
 

Should only accrue interest from the first of each month to the date of a payment on the beginning balance, then accrue
for the new balance until the end of the month

 

If multiple payments or balance changes are made during the month, the program will calculate interest accrued for each
succeeding balance based on the number of days during the month that balance remained (i.e. accrued interest is calculated
on a daily basis based on that day's balance)

 

Accrue only for the number of days a loan is open when it is paid off
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20.3 HUD Aggregate Escrow Analysis
 

 

In 1994-1995, HUD made extensive changes to the way companies calculated the escrow payments on mortgage loans. 
As a result, the amounts being paid by borrowers was reduced considerably and amounts needed to cover periodic
disbursements were still maintained.  The purpose of this section is to make users of this servicing program aware of
various federal regulations that have to be followed for escrow accounts and provide a summary of some arithmetic
computations on future calculations.  This section is NOT intended to be a complete summary of HUD regulations by any
means and it is HIGHLY recommended that the regulations be reviewed and legal counsel consulted as to how the
regulations should be specifically implemented in your company.
 

First, full information on escrow accounting can be found in HUD's Real Estate Settlement and Procedures Act (RESPA).
For your convenience, it can be found on the Internet at:  www.hud.gov.fha/sfh/res/respareg.html as of 12/31/1999.
Again, it is HIGHLY suggested that someone in your organization become familiar with these regulations.  

 
Secondly, the following information on aggregate escrow analysis is based on:
 
-That your servicing software ONLY calculates the escrow payment required from the FIRST anniversary of the loan and
onward.  Your origination/closing software should have the ability to calculate and provide all necessary disclosures at
closing for the first year.  If it doesn't please refer to RESPA regulations and rules on how to calculate the first year escrow
payment and provide the borrower with their appropriate disclosure statement;

-That you will set up a "reminder" system to perform yearly escrow analysis since one is suppose to be done within 30
days of the loan's anniversary date.  (note:  please refer to:  Important Dates/Data Base for a means to tracking these
anniversary dates).
 

 

 
The arithmetic steps for computing a borrower's escrow payment after the first year are:

 
1) Take all projected disbursements over the next twelve months, (most lender use the past year's bills) add together and
divide by twelve  (taxes $900 + insurance $300 = $1200, or $100 per month)- your servicing program's escrow analysis
does this automatically
 

 
2) Run a projected trial balance, you will have a beginning balance (for this example-Sept $100) based on the prior 12
months payments:
 

Month                     Escrow                         Disbursement                   Pay 't             Ending Balance 
Sep                                                                                                       100
Oct                          100                                                                                                      200
Nov                         100                                   300                                                                 0
Dec                         100                                                                                                      100
Jan                          100                                                                                                      200
Feb                          100                                                                                                      300
Mar                          100                                                                                                      400
Apr                          100                                                                                                      500
May                         100                                                                                                      600
Jun                          100                                                                                                      700
Jul                           100                                   900                                                            -100
Aug                         100                                                                                                          0
Sep                         100                                                                                                       100
 

 
2) The account should fall to  "0" usually after the largest bill has been paid.  However, in this example it is -100 so there is
a deficiency of $100
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3) If no cushion/reserve is required, the account should have had a beginning balance of $200 (Sep Beginning Balance of
$100 plus $100 to cover the –100 Jul balance), most lenders would divide the $100 and spread the amount over 12
months, making the monthly escrow payment $108.67; however since the deficiency is not more than 1 months escrow
payment, you can require the borrower to pay the deficiency.
 

 
4) Many lenders require the maximum cushion of 1/6 of the total disbursements or two months payments. In this example
there would be an additional $200 shortage (2 months times $100/month payment).  Most lenders would add the 200+ 100
deficiency for a $300 shortage and spread the collection over the next 12 months with an escrow payment of $125.00
($300/12 = $25)
 

 
Month           Escrow               Disbursement             Ending Balance               Pay 't
 

Sep                                                                                                                     100
Oct                   125                                                          225
Nov                  125                         300                             50
Dec                  125                                                          175
Jan                   125                                                          300
Feb                   125                                                          425
Mar                   125                                                          550
Apr                   125                                                          675
May                  125                                                          800
Jun                   125                                                          925
Jul                    125                         900                           150
Aug                  125                                                          275
Sep                  125                                                          400
 

 
The FOLLOWING year the beginning balance would NOW be $400 (theoretically, if the escrow payments remained the
same) and the low point would be $200.  The escrow payment would go back to $100; again, if taxes and insurance
remained the same amounts.
 

 
Month            Escrow                  Disbursement             Ending Balance               Pay 't
 
Sep                                                                                                                         400
Oct                   100                                                                  500
Nov                  100                             300                               300
Dec                  100                                                                  400
Jan                   100                                                                  500
Feb                   100                                                                  600
Mar                   100                                                                  700
Apr                   100                                                                  800
May                  100                                                                  900
Jun                   100                                                                1000
Jul                    100                             900                               200
Aug                  100                                                                  300
Sep                  100                                                                  400
 

 
If the borrower had a low point of $250 in Jul, the overage of $50 would have to be returned after the analysis.
 

 
In performing the Escrow Analysis, you may find that "Your Final Escrow Account Next 12 Month Activity Summary
Report" doesn't show any "Ending Esc Bal" below the reserve amount.  This means that a REFUND might be in order. 
Refunds are REQUIRED if they are in excess of $50.  To determine the refund amount:
 
-Find the lowest balance in the final summary report and subtract its amount by the reserve amount
-Round this amount to an even dollar amount
-Go to the Escrow menu item and choose Overage/Adjust Balance – input today's date and the above dollar amount to
adjust the balance by – suggest you put "Fund – Ck #xxx"
-Re-print the analysis and review the lowest ending balance



Special Topics 258

Copyright Multi-Financial Services Company, Inc. 2012©

-If the lowest ending balance is below your reserve amount, the analysis is ready to mail; however, if not, re-determine a
HIGHER refund amount and input that amount to Escrow/Overage/Adjust Balance (REMEMBER: just input the NEW
amount – DON'T add the prior adjustment to the new adjustment amount!)
 
-Once the lowest balance is BELOW OR EQUAL to the reserve amount, mail the analysis to your borrower

 

20.4 Loan Class Codes

 The Loan Class Codes enable the user to be able to categorize loans and print reports by individual loan type, if so
desired.  Each code is user defined and consists of two characters that can be a number, a letter, or a combination of
both.  These codes give the operator the ability to analyze each TYPE of loan that is made; first loan, second loan, mobile
home, land, and so forth.  The following are some examples of code assignments:

01  Single Family, Owner Occupied
 
02  Single Family, Non-owner Occupied
03  Duplex Rental
04  Triplex
05  Quadruple
     .   
     .   
10  Commercial Building
     .   
     .   
     .   
99   Unimproved Land
AA  Mobile Home Only
AB  Mobile Home and Land

    .   
    .   
    .   
ZZ

Remember, these are user defined to fit organizational requirements.  The type codes can be used in any manner desired.
Simply create your own code chart and use it when you set up each loan.

The program itself does not use these codes, it only stores them.  In order to use 'The Reporter', a class code MUST be
entered for each loan.  If you do not want to use 'The Reporter', a class code need not be entered.
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20.5 ODBC Compliancy
 

ODBC are drivers that allow programs to import, export or link to data files from other programs, thus making the Trakker
program compatible with ODBC capabilities. The files that are exported can, with ease, be brought into Microsoft (MS)
Excel, Access, Word and a variety of other programs.  This gives the FLEXIBILITY in creating custom reports using the
files exported to the Dataout folder.  Therefore, there is no limit to the ways a client can generate reports.  All the
information that contains their clients' data is within reach. 
 
More information about ODBC can be viewed at:  www.microsoft.com/data/odbc/default.htm 
Why not use the raw data in the MFS folder?  By keeping the "Raw" data in an encrypted file this assures Data Integrity,
which in this case keeps all the client information untouched.  This data is very sensitive and pertinent  and if left
unsecured can cause problems, for clients and companies that service loans.  Therefore, the solution is to allow the data
files to be exported out of the MFS folder.  The Trakker program creates a folder (Dataout) within the MFS folder. 
Modifications to the exported files will not, in any way, affect the raw data that is stored in the main MFS folder. 
 
To create a database with the files exported some steps are needed: 

First:                 Open the data file that you want to use in MS Excel.  
Second:            Save it as a MS Excel file. 
Third:                Open MS Access click on the new button then click link table.
Fourth:              Find the file you want to link in the Dataout folder.
Fifth:                 Click and highlight the file then click Link
Sixth:                Follow the directions on the screen. 

The database is now created and can be fully updated by simply following the first two steps. Since the link is already
created it will always show the current data information. The clients now can create custom reports to reflect the data that
has been linked. 
 

 

http://www.microsoft.com/data/odbc/default.htm
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20.6 Balancing Procedures
 

 
In this section we discuss the recommended balancing procedures to insure accuracy of input using two balancing
methods:
 
Method 1:
-Balancing to deposit slips for a range of dates
 
Method 2:
-Balancing to your checkbook
 
On a predetermined day each week, it is advisable to balance your receipts against the computer reports.  Following is a
detailed process to help you balance on a weekly basis.  This is the recommended balance period.  Please note you can
adapt this to your individual needs (i.e. bi-weekly, monthly, etc.)
 

Complete the next 3 sections for either balancing procedure.
 
 

ENTER DEPOSITS
 
 
Be sure all payments have been posted for the period.  This should include the last day of the period.  For example if your
period cut off day is Wednesday, be sure all payments have been posted for Wednesday. Also be sure all deposits have
been recorded in your checkbook register.
 
          
 
EXAMPLE:     Dates of Period

Period runs Thursday October 19, 1995 through Wednesday October 25, 1995 so when program asks for date of period
you would input 10 then 19 then 95 enter then 10 then 25 then 95 enter
 

RUN A PAYMENT SUMMARY REPORT
 
 
Run a payment summary report for each lender that you will be balancing reports for this period.
See Reporter should you have questions on running this report.
 

RUN A SUSPENSE ACCOUNT SUMMARY REPORT
 
 
Run a suspense account summary report for each lender that you will be balancing reports for this period.
See Reporter should you have questions on running this report.
 
 
 
Suggested reconciliation forms can be found in Appendix G for both reconcilement methods described more fully below.
Make one copy of this form for each lender you will be balancing.  Complete the form as follows.
 

METHOD 1 RECOMMENDED BALANCING PROCEDURES
 
 

(Recommended Balancing Form: Appendix G – Example I)
 
1.   Settlement Date -- Enter the last date of the period being balanced 
2.   From the Payment Summary Report, enter: 

-NSF and Late Fees received from the "Fees" column
-Service Fee received from clients (if this is your company's policy)
-Principal and Interest received
-Enter escrow payments received from the "Escrow" column

 
3.   From the Suspense Report, enter
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-Cash In total
-Credit total

 
4.   Total the amount from Part 2 & 3 on the Total line
 
5.   Enter the total of all deposit slips
 
6.   Determine the difference (if any) from Steps 4 & 5
 

Recommendations for out-of-balance situations:
-Re-add the balancing report

 
     -Re-add your deposit slips to see if they are correct
 
     -Compare the amounts for each borrower on the deposit slips to the Payment Summary and Suspense Reports to see
if they were inputted correctly

 
METHOD 2 RECOMMENDED BALANCING PROCEDURES

(Recommended Balancing Form: Appendix G – Example II)
1.  Settlement Date -- Enter the last date of the period being balanced
2.  Servicing Fees Due Settlement –
 
Beginning Balance: Enter the previous periods ending balance on this line.
 Indicate additional fees received and can be included
 Fees due this period: Enter your servicing fees due this period if you provide outside servicing - see service fee column
on payment summary report.
 
NSF fees collected: Enter fee amount received from any insufficient checks - see Fee column on payment summary
report.
Charge back fees: Deduct any charge back fees.
Other changes: Use this line to add/deduct any other charges
Ending balance: Add/subtract all the lines and place the balance on this line.
 

ESCROW BALANCE SETTLEMENT
 
 
Beginning Balance: Enter the previous periods ending balance on this line.
 
Additions to escrow: Enter the additional money received for escrow on this line. This amount can be found on the
payment summary report under the Escrow column.
 
Payments of escrow: Enter any payments you have made to escrow companies on behalf of the borrower.
Ending balance: Add/subtract all the lines and place the balance on this line.
 

SUSPENSE ACCOUNT SETTLEMENT
 
 
Beginning Balance: Enter the previous periods ending balance on this line.
 Enter Cash In, Adjustments, and Credit totals on their corresponding lines
Determine balance of Suspense Account
 

PRINCIPAL & INTEREST SETTLEMENT
 
 
Beginning Balance: Enter the previous periods ending balance on this line.

P&I this period: Enter the principal and interest amount for this period.  This amount can be found on the Capital Payment
Summary Report in the P&I column.
Subtractions this period: Enter any amounts that have been sent to your lender customers.
Corrections:  Use this line for any corrections.  Such as return check reversals.
Ending balance: Add/subtract all the lines and place the balance on this line.
 
RECONCILIATION BALANCE
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Add all the ending balances and place the total on this line.
 

CHECK BOOK REGISTER BALANCE
 
 
Enter the current balance in your checkbook register on this line.  This amount should be the same as the
Reconciliation Balance.  If it is different see Recommendations to Find Difference below.
 

RECOMMENDATIONS TO FIND DIFFERENCE
 
 
Subtract Check Book Register Balance from Reconciliation Balance and write difference on the line provided.
 
Get the Payment Summary Report and the itemized deposit slips.  Check off on the Payment Summary Report in the P&I
column each deposit amount for each individual account.  You may find a check was not posted in the computer or that it
was inputted twice in the computer.
 
Check the math addition on the deposit slips. 
Make necessary adjustments until amounts balance.
 

20.7 Helpful Hints

Helpful Hints
 

The following information represents some things that have been learned over time by Multi
Financial Services Co., Inc. while using the program and, hopefully, will be of use to you.  If you
find any others that you'd like to share, please pass them along so they can be included here and
shared with others.  You can contact our Help Desk staff at: Help Desk[****] 
 

· EXTENSION PAYMENTS
 
If you would like to extend one or more payments for a client due to personal and probably
temporary problems, this can be accomplished within the program.  At the present, it has to be
done in a sort of round-about fashion; however, Multi-Financial Services Co., Inc. has been using it
quite successfully for the past two years. 
 
 
First, bring up the borrower's account and change their payment amount to $0 and interest rate to
0%.  Once done, you simply enter the number of payments desired for the day extended as
$0.00001.  As you enter each payment, you'll notice the 'Next Payment Due' indicator changing,
however, the balance stays the same!  Once completed, go back into Change and re-input the
correct payment amount and interest rate.
 

· TELEPHONE NUMBERS
 
As you enter a new account and input the person's telephone number, you'll notice two extra
spaces at the end.   We use those spaces to indicate what telephone number it is for, e.g. home
(hm), work (wk), mother's (mo), etc.  When you print a delinquency report, the telephone number is
printed and when you call you'll know what to expect.  Naturally, when a new telephone number is
received, you can go into the Change/Personal and change it using the same philosophy.
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Should you receive an indication that the phone has been disconnected or is now unlisted, you
might consider entering something like: DISCONNECTED or UNLISTED in the phone number
field.  This will also print on the delinquency report for your use.

· COMMENT FIELD
 
The comment field content is asked for just after you enter new account information on loan
balance, interest rate, etc.  This is a field that you can use for whatever purpose desired.  Some of
our lenders have files in their office setup by 'Project #', e.g. 95-010 meaning the 10th project in
1995.  The 95-010 is put into the Comment Field and they can easily refer back to their filing
system when reviewing one of our reports.  This Comment Field is displayed in the Borrower's
Screen and is printed on all of the major management reports including:
 
Account Summary
Payment Summary
Delinquency Report
 
Additionally, we even input information as to when past due notices should be sent out or phone
calls made, since some of our lenders have different instructions.  For example, a typical Comment
Field might show as: 95-010 15/20/30
 
Which means:  
Project 95-010
First Notice at 15 days late
Second Notice at 20 days late
Make a telephone call at 30 days late
 

· PAST DUE NOTICES & PAYOFF LETTERS
 
 
Formats for the past due notices including the `10 Day Bring Current' certified letters are found in
the `LETTERS.OVL' file within the MFS directory.  Should you wish to change any of the
information this can easily be accomplished using Notepad.  Please review the following sections
for more information on modifying these letters:
 
CUSTOMIZING LETTERS 
 
CUSTOM LETTERS AVAILABLE FIELDS 
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20.8 Routine Processing, Etc.
 

 

Once you've created historical information in the Late.dta file, you are now ready to process past due notices for whatever
time frame you wish, i.e. daily, weekly, semi-weekly, etc.  Routine processing is accomplished by:
     
PRINT PAST DUE NOTICES
 
-Choose Reporter from the Main Screen, select Collection System, and then Past due Notices
-Notices will now print automatically
-Review notices for printing accuracy, alignment, etc. and make note of any that need to be re-printed
-Answer YES or NO depending on whether notices need to be reprinted
-If YES (do need to reprint), indicate the account number you need to start re-printing from and choose OK
-Once finished, that's it!
     
 PRINT COLLECTION CALL REPORT
-Choose Reporter from the Main Screen, select Collection System, and then Collection Call Report
-Give to your collection calling person for determining calls to make based on contacts showing for the past 30 days.
 

  PRINT BRING CURRENT RECOMMENDATION REPORT
 
-Choose Reporter from the Main Screen, select Collection System, and then Bring Current Recommendation Report
-Determine who needs to be sent a Bring Current letter and do so
-Change the accounts Collection Code (see Inputting Collection Codes)
 

PRINT COLLECTION CODE REPORTS 
 
-Periodically print collection code reports for review by management and other servicing personnel for accuracy and
changes that may have occurred (no longer in bankruptcy or at the attorney, etc.).
 

PRINT THE LATE LETTER REPORT
This report can be used to determine why a particular notice was or was not sent to a borrower.It will list ALL borrowers
who have ever been sent a notice and can be printed by lender, class code, combination of both, or all borrowers.   To do
so:
 
-Choose Reporter from the Main Screen, select Collection System, and then Late Letter Report.

20.9 How to Generate A Credit Reporting File
 

We have made the file generating process as simple as possible.  

To generate the file:
 

Click on Systems from your main screen
 Click on Utilities 
 Click on Consumer Credit Reporting File
 

The file will then be generated and stored in the program directory under a Sub-Directory listing the Credit Bureau's Name
 Example:  Transunion
 C:\MFS\Transunion\????.txt
 The ???? would be the Lender number.
 The file is in a "Metro2" format per the request of the credit bureaus we worked with.
 

After the program has completed generating these files it will print a report that will detail the accounts that were NOT
reported to the Credit Bureaus due to an error.  Please review the section Setting Up Your System For Credit Reporting for
more information.

20.10 Crystal Reporter

Although Trakker comes with Crystal Reports®, should you wish to use another software application to develop
custom reports, easy access is provided to your data via our .mbd file. Additionally, Trakker comes with
pre-designed Crystal reports which are available for purchase at a nominal fee. Support for the setup and use of
pre-designed reports is provided at no charge. However, if you wish to modify these reports a local consultant
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should be used and future support for the modified report will also need to be provided by a local consultant. 
Click here to read more about pre-designed Crystal reports

Already have Crystal Reports® or another popular reporter writer, however, need to access your data? Trakker's 
MDB Module is just for you! This module converts data into a readable format, importable into report writing
programs, as well as database and other programs.

Crystal Reports'® extensive formula language includes over 100 built-in functions and operators as well as
user-defined functions for complete control over report formatting, complex logic and data selection. 

Publish reports to a variety of familiar formats, including: 

· XML 

· PDF 

· HTML 

· Excel 

· RTF 

· Word 

· Text 

· CSV 

· ODBC

Requirements

Crystal® Reports requires the following to run properly: · A 166MHz based computer · 32mg RAM · 50mg Hard
Drive Space (for database storage) 

 Trakker Custom Reporter Module
Run the custom reporter by clicking on the Reporter Menu (within Trakker), then Custom Reporter

This will take you through the export/import process

First time users click on Help.  This will open the Help File for the Crystal Reports® for Trakker software.

Click on “Report Design Environment” & review Main Custom Reporter Screen

1. Click on “New Report”

2. Explain basic layout of screen

a. Left contains functions, tables, formulas, etc.

b. Right contains the report being designed

c. The top has the quick buttons for saving / exporting / printing the report

d. The very top has the tabs to go from the Design window to the Preview window

http://www.thetrakker.com/forms/request_a_report_pre_designed.asp
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3. Right click on the right (in the white section) of the Main Report

a. Click Report

b. Click Report Expert

i.  Click “Yes”

c. This will start the Report Expert

d. Click “Other”

e. Click ODBC

f. Click MS Access Database

g. Click “Custom Reporter Database.mdb

h. Click “OK”

i. The screen should look like:

j. Scroll down the Data Explorer and Click “Mortgor”

i. Note:  Mortgor is the “Primary” table for the Trakker Database System

k. Click “Add”

l. Click “Next Due”

m. Click “Add”

n. Click “Close”

o. Click on the tab at the top named “Fields”

i. Note:  To highlight a 

ii. Choose the following fields from “Mortgor”

1. Acct

2. First Name

3. Last Name

4. OrigLoanAmt

iii. Choose the following from “NextDue”

1. NextDueDate

2. Balance

3. PastDueFeesInt

iv. Note: The screen should have all of the fields added to the Right Side.  There should be a total of 7 fields.

1. Mortgor.Acct

2. Mortgor.FirstName

3. Mortgor.LastName
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4. Mortgor.OrigLoanAmt

5. NextDue.NextDueDate

6. NextDue.Balance

7. NextDue.PastDueFeesInt

p. Click on the tab at the top named Group

i. We will not be grouping anthing at this time.

q. Click on the tab at the top named Total

i. We will not be Totaling anthing at this time.

r. Click on the tab at the top named Style

i. Click the “Red/Blue Border” Style

s. In the Title field type “Simple Acct Report”

t. Click “Finish”

u. It is suggested that you correct the formatting and alignment of the fields in the report.

i. This was done by clicking on a field and adjusting the size.

ii. Moving the fields was done by clicking and dragging the field to the new location.

v. Note:  Date fields should be formatted.  This is due to the “nature” of Crystal Reports®.  To adjust the formatting
of a field:

i. Right click on the field

ii. Click on Format

iii. Click the Date/Time tab from the Table

iv. Click on the Date format that you wish to use.

1. Note the “Stored Field only contains the Date, not the time.

w. Now you should be ready to click on the “Preview” tab.

x. Your report should look like:
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4. Save the report

a. Do this by clicking on the Design screen, then click on the icon that looks like a Diskette

b. Choose a location to save your report and the name

c. Choose Save

MDB Custom Reporter for Trakker

Run the custom reporter by clicking on the Reporter Menu (within Trakker), then Custom Reporter

This will take you through the export/import process

At this time the app will inform you that your data has been updated and that the database is ready.

1. To access the MDB database go to your Start Menu, Programs, The Trakker, MDB Database

2. This should open in MS Access®

3. The client should become familiar with the different Tables

a. The Tables are where the data is stored for their reports.
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4. The client may pull “Queries” on this data to better refine their reports, or to obtain a simple list of information.

5. MS Access® has a Report Wizard built in that may assist them in designing a report.

a. This wizard differs on each version of MS Access®.

20.11 Unchangeable fields in Trakker

Fields that can not be changed once you have selected Finish and have an
account number

1. Lender Number

2. Portfolio and Type of loan (but these have been set in the Parameter
Options already, but if it is different then the default than this will
need to be changed in the setup process.

3. Past Due Fees 

4. Begin Servicing Date

5. Escrow Balance 

6. Maintenance Balance 

7. Closing Date

8. Type (Straight/Balloon)

9. Payment Period (Annual, Semi-Annual, Quarterly, Monthly, etc.)

10. Current Balance

11. Last Payment Received

12. Next Payment Due

20.12 Simple Interest Computation

Simple Interest Computation - Variable Interest

The rate is averaged based upon its daily value. 
 So if a rate changed twice during a period (say from 1/1 to 2/15) it would be calculated as such:
 1/1 - 1/10 @ 5% (10 days @ 5)cc - 50
 1/11 - 1/31 @ 6% (21 days @ 6) - 126 
 2/1 - 1/15 @ 7% (15 days @ 7)c - 105 
                                 cccc  46 days - 281 

 So the average rate would be 281 / 46 = 6.1086956521739130434782608695652 
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Simple Interest Computation - Average Calculation in Variable Interest Rate - 

Each adjustment period would be average independently.

Consider the previous rates I used for an example. If we threw in a balance adjustment on 1/20, we would
end up with two calculations that basically get added together

Calc 1 (for 1/1 - 1/20)
1/1  - 1/10  @ 5% (10 days @ 5)   - 50
1/11 - 1/20  @ 6% (10 days @ 6)   - 60
    20 days        - 110 = 5.5%
Calc 2 (for 1/21 - 2/15)
1/21 - 1/31  @ 6% (11 days @ 6)   - 66
2/1  - 2/15  @ 7% (15 days @ 7)   - 105
              26 days        - 171 = 
6.5769230769230769230769230769231
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21 Worksheets

21.1 Sample Loans - Regular Account
 

 

  New Loan Data Entry Form

    Lender Number:     9999
     Borrower Type:   Individual/  Corporation       

  

    EDI Link:     Y,N
    EDI File Path:
   Portfolio:     Mortgage                                           Loan Type:    Secured
    Name On Account:      Sam Smith        

   

    Collateral Address:  1 N. Main St.        

  

    City:    Oz            

    State:    GA                                                     ZIP: 009999     

   

    Country:    USA          

  

    Loan Class Code:    TT         

  

    Multiple Borrowers:     Y/  N  ( If there are multiple borrowers please print the Additional Borrowers
Worksheet )   

    1st Borrower Information,          

     

    Type Of Account:    Individual/Joint        

    Borrower Type:    Individual/  Corporation       

      

    First Name:     Sam                                                                                                                   Middle Name:
    Last Name:     Smith     

 Generation:  Sr, Jr,     

    Date Of Birth:    12/17/ 1934  

   Sex:    Male/Female
    Mailing Address:   1 N. Main St. 
   Home Phone:    1-999-555-1212
    City:    Oz
    Work Phone: 1-800-555-1212
    State:    GA                                                                                                                                            Zip:    009999
 

    Account Information     

Appraisal Amount:    $35,000.00
 Appraisal Description:
  Late Fee Required:     Y/ N       

  Permitted Days Late:    15                                           % Of Payment:  10%        $ Amount:       

  Service Fee Required:    Y/  N   
Type Of Fee:     Flat $ Fee   % Of Payment   % Of Balance

                 Service Fee Amount:
Pre Payment Penalty %
If Paid Before:     

 Current Past Due:        

                
Began Servicing Date:    03 / 01 / 1999        

    

 Requires Escrow:        Y/N          

  Escrow Payment:
Escrow Balance:
Escrow    Amount:       

Requires Maint. Fee:   YN/        

        

Balance:                                                          Fee:       Cap:  
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Points Paid:     Y/N          

  

Prepaid Interest:     

 Prepaid/YTD Interest:
Amount:            

   

 Payment Type:    Straight/  Balloon        

  Payment Period:       

 Interest Basis     Interest Bearing / Simple   Reg. Amortizing
 Days Per Year:     365        

  

 Original Loan Balance:     $28,000.00     Current Balance:    $28,000.00     

  

 Interest Rate:    8.5%                                     Interest Type:     Adjustable/  Fixed   

       

 Payment Amount:    $574.76     Term: 60       

 Payment # Balloon Due:     Balloon Amount:       

 Loan Closing Date:     03 / 01 / 1999     Last Payment Received:     03 / 01 / 1999
    

 Next Due Date:     04 / 01 / 1999            

      Comments:       
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21.2 New Loan Worksheet
New Loan Worksheet SAMPLE

New Loan Data Entry Form – Standard Account
Lender Number: Borrower Type:  Individual/Joint

EDI Link: Y/N EDI File Path:
Portfolio: Loan Type:
Name On Account:

Collateral Address:

City:
State:                                     Zip:

Country:
Loan Class Code:

Multiple Borrowers: Y/N ( If there are multiple borrowers please print the Additional
Borrowers Worksheet )
1st Borrower Information
Type Of Account:  Individual/Joint

Borrower Type: individual/Corporation                                    Fed Tax ID/SSN:
First Name:                      Middle Name:
Last Name:                      Generation:  Sr, Jr, etc
Date Of Birth: MM/DD/YYYY    Sex: Male/Female
Mailing Address:          Home Phone:
City:                      Work Phone:
State:                      Zip:
Account Information

Appraisal Amount:               Appraisal Description:
Late Fee Required: Y/N

Permitted Days Late:          % Of Payment:             $ Amount:

Service Fee Required: Y/N    Type Of Fee: Flat $ Fee % Of Payment % Of
Balance
Service Fee Amount:
Pre Payment Penalty %:     If Paid Before: MM/DD/YYYY
Current Past Due:
Began Servicing Date:

Requires Escrow:  Y/N
Escrow Payment:  $                     Escrow Balance: $            
Type of Escrow:       Insurance       Co. Tax             City Tax          Other2           Other3
Date Last Paid:
Amount:
How often paid out:
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Requires Maint. Fee: Y/N

Balance:  $                      Fee: $                                    Cap:  $

Points Paid: Y/N
Prepaid Interest:  Credit/Prepaid/YTD Interest            Amount:  $

Loan Closing Date:MM/DD/YYYY                                              Last Payment Received:
MM/DD/YYYY
Next Due Date:  MM/DD/YYYY

Comments:
Payment Type: Straight/Balloon

Payment Period: Monthly,Quarterly,Semi-Annually, Annually
Interest Basis: Interest Bearing/Simple Reg. Amortizing
Days Per Year: 365 360

Interest Only: Y/N

Interest Rate:  Fixed          Date Scheduled: 
Note:  If other than "Fixed" is chosen you will need the additional sheets for that type of loan.
Market Index:          Payment Scheduled:
Original Loan Balance:         Current Balance:

Interest Rate:          Interest Type: Adjustable/Fixed

Payment Amount:                Term:

Payment # Balloon Due:       Balloon Amount:

21.3 NLW Webpage Input
New Loan Data Entry Form
Your Name: Your Company Name:

Lender Number: Borrower Type:
Individual Corporation

Portfolio:
   

Loan Type:
                       

Short Name: (Example: Washington / George / Martha)

Collateral Address:

City: State:
                                         

           
Zip:

Country:

Loan Class Code: (Note: Refer to list from MFS)

Appraisal: Property ID:
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Collateral
Description:

Late Fee Required: Yes No Permitted Days Late:

Late Fee Charged: $ or %

Pre-Payment Penalty: % If Paid Prior To:

Current Past Due
Fees: $

Began Servicing Date

Requires Escrow:
Yes No

Escrow Payment:
$

Escrow Balance:

Insurance Co. Tax City
Tax Other 2 Other 3 

Date Last Paid:
mm/dd/yy Please Fax

copies of Last
insurance & tax
bills to:
1-800-294-8532

Amount:

How Often Paid Out:

Escrow Collected @ Closing: Please forward a check for this amount.

Insurance Co Info: Company Name:

Phone Number: Policy Number:

Requires Escrow Maint.: Yes No

Main
tena
nce
Fee:

$ Maint. Balance:

Maint. Fee Cap:
$

Points Paid:
Yes No

Amo
unt: $

Prepaid / Credit Interest:
Prepaid/YTD Credit

Int.

Amo
unt: $

Payment Type:
Straight Balloon

Payment Period:
Annual Semi-An

nual
Bi-M
onth
ly

Weekly

Quarterly Monthly
Bi-W
eekl
y
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Interest Basis:
Regular Amortizing

Sim
ple
Inter
est /
Inter
est
Bear
ing
Days
Per
Year
:

360 365

Original Loan Balance: $

Curr
ent
Loan
Bala
nce:

$

Interest Rate:
%

P&I Payment: $

Rem
ainin
g
Ter
m:

Payment # Balloon Due:

Ball
oon
Due
Amo
unt:

$

Multi-Investor Info

Program/Investor Type/Loan Class
Code

$
Allocate
d

%
Alloc
ated

P & I Amount

Loan Closing Date:

Last
Pay
ment
Rece
ived:

Next Due Date:

Comments:

(Note: 34 Characters Only)

Borrower's Personal Information
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Type Of
Account:        

( Borrower # 1 )

Borrower Type:
Business Personal

Fed ID:

First Name: Middle Name:

Last Name: Generation:

Mailing Address: Home Phone:

City: Work Phone:

State:
                                       

             
Zip: Country:

Date Of Birth: Sex:
  

Type Of
Account:        

( Borrower # 2 )

Borrower Type:
Business Personal

Fed ID:

First Name: Middle Name:

Last Name: Generation:

Mailing Address: Home Phone:

City: Work Phone:

State:
                                       

             
Zip: Country:

Date Of Birth: Sex:
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21.4 NLW Additional Borrower
2nd Borrower Information
Type of Account________________________ Fed Tax ID / SSN ________________________
Borrower Type ________________________ Middle Name ________________________
First Name ________________________ Generation ________________________
Last Name ________________________ Sex             ________________________
Date Of Birth ________________________ Home Phone ________________________
Mailing Address ________________________ Work Phone ________________________
City ________________________
State    Zip ________________________
3rd Borrower Information
Type of Account________________________ Fed Tax ID / SSN
________________________
Borrower Type ________________________ Middle Name ________________________
First Name ________________________ Generation ________________________
Last Name ________________________ Sex ________________________
Date Of Birth ________________________ Home Phone ________________________
Mailing Address ________________________ Work Phone ________________________
City ________________________
State    Zip ________________________
4th Borrower Information
Type of Account________________________ Fed Tax ID / SSN
________________________
Borrower Type ________________________ Middle Name ________________________
First Name ________________________ Generation ________________________
Last Name ________________________ Sex ________________________
Date Of Birth ________________________ Home Phone ________________________
Mailing Address ________________________ Work Phone ________________________
City ________________________
State    Zip ________________________
5th Borrower Information
Type of Account________________________ Fed Tax ID / SSN
________________________
Borrower Type ________________________ Middle Name ________________________
First Name ________________________ Generation ________________________
Last Name ________________________ Sex ________________________
Date Of Birth ________________________ Home Phone ________________________
Mailing Address ________________________ Work Phone ________________________
City ________________________
State    Zip ________________________
6th Borrower Information
Type of Account________________________ Fed Tax ID / SSN
________________________
Borrower Type ________________________ Middle Name ________________________
First Name ________________________ Generation ________________________
Last Name ________________________ Sex ________________________
Date Of Birth ________________________ Home Phone ________________________
Mailing Address ________________________ Work Phone ________________________
City ________________________
State    Zip ________________________
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21.5 NLW Multi Investor
Investor Number ___________________ Type  Investor to . . . Borrower Lender
Balance $ or %  ____________ Payment $ or %  ____________
Rate _________________%
Loan Class Code ___________________ Print 1098s Yes   No
Comment __________________________________________________________________
Investor Number ___________________ Type  Investor to . . . Borrower Lender
Balance $ or %  ____________ Payment $ or %  ____________
Rate _________________%
Loan Class Code ___________________ Print 1098s Yes   No
Comment __________________________________________________________________
Investor Number ___________________ Type  Investor to . . . Borrower Lender
Balance $ or %  ____________ Payment $ or %  ____________
Rate _________________%
Loan Class Code ___________________ Print 1098s Yes   No
Comment __________________________________________________________________
Investor Number ___________________ Type  Investor to . . . Borrower Lender
Balance $ or %  ____________ Payment $ or %  ____________
Rate _________________%
Loan Class Code ___________________ Print 1098s Yes   No
Comment __________________________________________________________________
Investor Number ___________________ Type  Investor to . . . Borrower Lender
Balance $ or %  ____________ Payment $ or %  ____________
Rate _________________%
Loan Class Code ___________________ Print 1098s Yes   No
Comment __________________________________________________________________
Investor Number ___________________ Type  Investor to . . . Borrower Lender
Balance $ or %  ____________ Payment $ or %  ____________
Rate _________________%
Loan Class Code ___________________ Print 1098s Yes   No
Comment __________________________________________________________________
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21.6 NLW Payment Schedule
Payment Number Change Rate To
_______________ ____________% Note:  Enter Initial Rate Here
_______________ ____________%
_______________ ____________%
_______________ ____________%
_______________ ____________%
_______________ ____________%
_______________ ____________%
_______________ ____________%
_______________ ____________%
_______________ ____________%
_______________ ____________%
_______________ ____________%
_______________ ____________%
_______________ ____________%
_______________ ____________%
_______________ ____________%
_______________ ____________%
_______________ ____________%
_______________ ____________%
_______________ ____________%
_______________ ____________%
_______________ ____________%
_______________ ____________%
_______________ ____________%
_______________ ____________%
_______________ ____________%

21.7 NLW Date Scheduled
 

 

  Date   Change Rate To     

  ____/____/______   ____________%   Enter Initial Rate Here
  ____/____/______   ____________%     

  ____/____/______   ____________%     

  ____/____/______   ____________%     

  ____/____/______   ____________%     

  ____/____/______   ____________%     

  ____/____/______   ____________%     

  ____/____/______   ____________%     

  ____/____/______   ____________%     

  ____/____/______   ____________%     

  ____/____/______   ____________%     

  ____/____/______   ____________%     

  ____/____/______   ____________%     

  ____/____/______   ____________%     

  ____/____/______   ____________%     

  ____/____/______   ____________%     

  ____/____/______   ____________%     

  ____/____/______   ____________%     

  ____/____/______   ____________%     

  ____/____/______   ____________%     

  ____/____/______   ____________%     
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21.8 Multi-Investor Payoff Worksheet
PAYOFF CALCULATION FOR MULTI-INVESTOR LOANS

MAIN ACCT #_____________________
PAYOFF DATE: _____/________/__________
GIVEN TO: ______________________________________

PAYOFF AMOUNT BALANCE INTEREST LATE FEES SUSPENSE BAL

__________________________ __________ ___________ _______________

------------------------------------------------------------------------------------------------------------
SUB-ACCOUNT #_______________

PAYOFF AMOUNT BALANCE INTEREST LATE FEES SUSPENSE BAL

__________________________ __________ ___________ _______________

SUB-ACCOUNT#_______________

PAYOFF AMOUNT BALANCE INTEREST LATE FEES SUSPENSE BAL

__________________________ __________ ___________ _______________

SUB-ACCOUNT#_______________

PAYOFF AMOUNT BALANCE INTEREST LATE FEES SUSPENSE BAL

__________________________ __________ ___________ _______________

SUB-ACCOUNT#_______________

PAYOFF AMOUNT BALANCE INTEREST LATE FEES SUSPENSE BAL

__________________________ __________ ___________ _______________

SUB-ACCOUNT#_______________

PAYOFF AMOUNT BALANCE INTEREST LATE FEES SUSPENSE BAL

__________________________ __________ ___________ _______________
------------------------------------------------------------------------------------------------------------

SUB-ACCOUNT GRAND TOTAL:

________________ __________ __________ ___________ _______________

SUB-ACCT TOTAL SHOULD EQUAL MAIN ACCT
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21.9 NLW Adjustable Rate Mortgage
New Loan Worksheet SAMPLE

New Loan Data Entry Form – Adjustable Rate Mortgages
Lender Number: Borrower Type:  Individual/Joint

EDI Link: EDI File Path:
Portfolio: Loan Type:
Name On Account:

Collateral Address:

City:
State:                                     Zip:

Country:
Loan Class Code:

Multiple Borrowers: Y/N ( If there are multiple borrowers please print the Additional
Borrowers Worksheet )
1st Borrower Information

Type Of Account:  Individual/Joint

Borrower Type: individual/Corporation                                    Fed Tax ID/SSN:
First Name:                      Middle Name:
Last Name:                      Generation:  Sr, Jr, etc
Date Of Birth: MM/DD/YYY    Sex: Male/Female
Mailing Address:          Home Phone:
City:                      Work Phone:
State:                      Zip:
Account Information

Appraisal Amount:               Appraisal Description:
Late Fee Required: Y/N

Permitted Days Late:          % Of Payment:             $ Amount:

Service Fee Required: Y/N    Type Of Fee: Flat $ Fee % Of Payment % Of
Balance
Service Fee Amount:
Pre Payment Penalty %:     If Paid Before: MM/DD/YYYY
Current Past Due:
Began Servicing Date:

Requires Escrow:  Y/N          Escrow Payment:  $          Escrow Balance: $
          

Type of Escrow:       Insurance       Co. Tax             City Tax          Other2           Other3
Date Last Paid:
Amount:
How often paid out:
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Requires Maint. Fee: Y/N

Balance:  $                      Fee: $                                    Cap:  $

Points Paid: Y/N

Prepaid Interest:  Credit/Prepaid/YTD Interest            Amount:  $

Loan Closing Date:MM/DD/YYYY                                              Last Payment Received:
MM/DD/YYYY
Next Due Date:  MM/DD/YYYY

Comments:
Payment Type: Straight/Balloon

Payment Period: Monthly,Quarterly,Semi-Annually, Annually
Interest Basis: Interest Bearing/Simple Reg. Amortizing
Days Per Year: 365 360

Interest Only: Y/N

Interest Rate Type: Adjustable Market Index: Date Scheduled: Payment Scheduled:
Market Index: 
The Evaluation Period:                      Margin:
Fixed Initial Rate: Y/N
Rate:                          Date: MM/DD/YYYY
Rate Change Limits: Max Decrease, Max Increase and Limit period
Max Decrease:                                  Max Increase 
Limit Period:
Rate Floor:                                        Cap:

Date Scheduled:
Date Change: MM/DD/YYYY                Rate:

Payment Scheduled:
Payment Number:                             Rate:

Original Loan Balance:                      Current Balance:
Payment Amount:                            Term: Months

Payment # Balloon Due:                   Balloon Amount:
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22 Compound Interest
Compound Interest

Definition - Compounding of Interest
Compounding of interest is when the lender wishes to earn "interest on interest" to increase their
overall loan yield.  The computation of compounded interest is dependent on the frequency of
payments made by the borrower; for example, monthly, quarterly, or yearly.  Additionally, it should be
disclosed legally to the borrower in the promissory note if required by state and/or national lending
statutes and/or rules.  It is, therefore, strongly suggested that all statutes and rules be consulted as
well as the company's accountant for accuracy of calculations.

Using Compounded Interest
The note's stated interest rate should, first, be converted to an ANNUAL PERCENTAGE RATE (APR)
reflecting the compounding of interest.  This new APR can then be easily inputted into Trakker to
provide the interest computation needed; again, dependent on the frequency of payments.

For example, on a loan for $10,000 at a note rate of 10%, the APR is approximately the following
rates.  It is suggested that the lender's accountant and legal consultant be asked for guidance in
reviewing rates disclosed to the borrower and inputted into Trakker.

Monthly Payment APR: 10.03%
Quarterly Payment APR: 10.10%
Yearly APR:  10.52%

Naturally, if you have a note rate of 20%, it's just a matter of using a factor of 2 (2 x 10% = 20%) to get
the approximate APR:
Monthly Payment APR:  20.06%
Quarterly Payment APR: 20.2%
Yearly Payment APR: 21.04%

This information was determined by computing interest daily on the above note over a 365 day period
and extrapolating total interest earned on yearly, quarterly, and monthly payments, then dividing by the
original note amount to obtain the approximate APR.  Please refer to the attached Excel spreadsheet
for additional information.

ESTIMATED COMPUTATION OF COMPOUNDED INTEREST RATES

LOAN AMOUNT: 10000
NOTE RATE: 10.00%
INTEREST BASIS: 365DAYS
APPROX. APR YEARLY PAY'T: 10.52%

QTRLY PAY'T: 10.10%
MONTLY PAY'T: 10.03%

Pay't # INTEREST YEARLY
COMPOUNDED
INTEREST

QUARTERLY
COMPOUNDED
INTEREST

MONTHLY
COMPOUNDED
INTEREST

1 2.73973 2.73973
2 0.00075061 2.74048
3 0.000750816 2.74123
4 0.000751021 2.74198
5 0.000751227 2.74273
6 0.000751433 2.74348
7 0.000751639 2.74423
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8 0.000751845 2.74498
9 0.000752051 2.74574

10 0.000752257 2.74649
11 0.000752463 2.74724
12 0.000752669 2.74799
13 0.000752875 2.74875
14 0.000753081 2.74950
15 0.000753288 2.75025
16 0.000753494 2.75101
17 0.0007537 2.75176
18 0.000753907 2.75251
19 0.000754114 2.75327
20 0.00075432 2.75402
21 0.000754527 2.75478
22 0.000754734 2.75553
23 0.00075494 2.75629
24 0.000755147 2.75704
25 0.000755354 2.75780
26 0.000755561 2.75855
27 0.000755768 2.75931
28 0.000755975 2.76006
29 0.000756182 2.76082
30 0.000756389 2.76158 82.51913
31 0.000756597 2.76233
32 0.000756804 2.76309
33 0.000757011 2.76385
34 0.000757219 2.76461
35 0.000757426 2.76536
36 0.000757634 2.76612
37 0.000757841 2.76688
38 0.000758049 2.76764
39 0.000758256 2.76839
40 0.000758464 2.76915
41 0.000758672 2.76991
42 0.00075888 2.77067
43 0.000759088 2.77143
44 0.000759296 2.77219
45 0.000759504 2.77295
46 0.000759712 2.77371
47 0.00075992 2.77447
48 0.000760128 2.77523
49 0.000760336 2.77599
50 0.000760545 2.77675
51 0.000760753 2.77751
52 0.000760962 2.77827
53 0.00076117 2.77903
54 0.000761379 2.77979
55 0.000761587 2.78055
56 0.000761796 2.78132
57 0.000762005 2.78208
58 0.000762213 2.78284
59 0.000762422 2.78360
60 0.000762631 2.78437
61 0.00076284 2.78513
62 0.000763049 2.78589
63 0.000763258 2.78665
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64 0.000763467 2.78742
65 0.000763676 2.78818
66 0.000763885 2.78895
67 0.000764095 2.78971
68 0.000764304 2.79047
69 0.000764514 2.79124
70 0.000764723 2.79200
71 0.000764932 2.79277
72 0.000765142 2.79353
73 0.000765352 2.79430
74 0.000765561 2.79506
75 0.000765771 2.79583
76 0.000765981 2.79660
77 0.000766191 2.79736
78 0.000766401 2.79813
79 0.000766611 2.79890
80 0.000766821 2.79966
81 0.000767031 2.80043
82 0.000767241 2.80120
83 0.000767451 2.80196
84 0.000767661 2.80273
85 0.000767872 2.80350
86 0.000768082 2.80427
87 0.000768292 2.80504
88 0.000768503 2.80580
89 0.000768714 2.80657
90 0.000768924 2.80734
91 0.000769135 2.80811 252.41395
92 0.000769346 2.80888
93 0.000769556 2.80965
94 0.000769767 2.81042
95 0.000769978 2.81119
96 0.000770189 2.81196
97 0.0007704 2.81273
98 0.000770611 2.81350
99 0.000770822 2.81427

100 0.000771033 2.81504
101 0.000771245 2.81581
102 0.000771456 2.81659
103 0.000771667 2.81736
104 0.000771879 2.81813
105 0.00077209 2.81890
106 0.000772302 2.81967
107 0.000772513 2.82045
108 0.000772725 2.82122
109 0.000772937 2.82199
110 0.000773148 2.82276
111 0.00077336 2.82354
112 0.000773572 2.82431
113 0.000773784 2.82509
114 0.000773996 2.82586
115 0.000774208 2.82663
116 0.00077442 2.82741
117 0.000774632 2.82818
118 0.000774845 2.82896
119 0.000775057 2.82973
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120 0.000775269 2.83051
121 0.000775482 2.83128
122 0.000775694 2.83206
123 0.000775907 2.83284
124 0.000776119 2.83361
125 0.000776332 2.83439
126 0.000776545 2.83516
127 0.000776757 2.83594
128 0.00077697 2.83672
129 0.000777183 2.83749
130 0.000777396 2.83827
131 0.000777609 2.83905
132 0.000777822 2.83983
133 0.000778035 2.84061
134 0.000778248 2.84138
135 0.000778461 2.84216
136 0.000778675 2.84294
137 0.000778888 2.84372
138 0.000779101 2.84450
139 0.000779315 2.84528
140 0.000779528 2.84606
141 0.000779742 2.84684
142 0.000779956 2.84762
143 0.000780169 2.84840
144 0.000780383 2.84918
145 0.000780597 2.84996
146 0.000780811 2.85074
147 0.000781025 2.85152
148 0.000781239 2.85230
149 0.000781453 2.85308
150 0.000781667 2.85387
151 0.000781881 2.85465
152 0.000782095 2.85543
153 0.000782309 2.85621
154 0.000782524 2.85699
155 0.000782738 2.85778
156 0.000782953 2.85856
157 0.000783167 2.85934
158 0.000783382 2.86013
159 0.000783596 2.86091
160 0.000783811 2.86169
161 0.000784026 2.86248
162 0.00078424 2.86326
163 0.000784455 2.86405
164 0.00078467 2.86483
165 0.000784885 2.86562
166 0.0007851 2.86640
167 0.000785315 2.86719
168 0.00078553 2.86797
169 0.000785746 2.86876
170 0.000785961 2.86954
171 0.000786176 2.87033
172 0.000786392 2.87112
173 0.000786607 2.87190
174 0.000786823 2.87269
175 0.000787038 2.87348



Compound Interest 290

Copyright Multi-Financial Services Company, Inc. 2012©

176 0.000787254 2.87426
177 0.00078747 2.87505
178 0.000787685 2.87584
179 0.000787901 2.87663
180 0.000788117 2.87741
181 0.000788333 2.87820
182 0.000788549 2.87899
183 0.000788765 2.87978
184 0.000788981 2.88057
185 0.000789197 2.88136
186 0.000789413 2.88215
187 0.00078963 2.88294
188 0.000789846 2.88373
189 0.000790062 2.88452
190 0.000790279 2.88531
191 0.000790495 2.88610
192 0.000790712 2.88689
193 0.000790929 2.88768
194 0.000791145 2.88847
195 0.000791362 2.88926
196 0.000791579 2.89005
197 0.000791796 2.89085
198 0.000792013 2.89164
199 0.00079223 2.89243
200 0.000792447 2.89322
201 0.000792664 2.89402
202 0.000792881 2.89481
203 0.000793098 2.89560
204 0.000793315 2.89639
205 0.000793533 2.89719
206 0.00079375 2.89798
207 0.000793968 2.89878
208 0.000794185 2.89957
209 0.000794403 2.90036
210 0.00079462 2.90116
211 0.000794838 2.90195
212 0.000795056 2.90275
213 0.000795274 2.90354
214 0.000795492 2.90434
215 0.00079571 2.90514
216 0.000795928 2.90593
217 0.000796146 2.90673
218 0.000796364 2.90752
219 0.000796582 2.90832
220 0.0007968 2.90912
221 0.000797018 2.90991
222 0.000797237 2.91071
223 0.000797455 2.91151
224 0.000797674 2.91231
225 0.000797892 2.91310
226 0.000798111 2.91390
227 0.00079833 2.91470
228 0.000798548 2.91550
229 0.000798767 2.91630
230 0.000798986 2.91710
231 0.000799205 2.91790
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232 0.000799424 2.91870
233 0.000799643 2.91950
234 0.000799862 2.92030
235 0.000800081 2.92110
236 0.0008003 2.92190
237 0.000800519 2.92270
238 0.000800739 2.92350
239 0.000800958 2.92430
240 0.000801178 2.92510
241 0.000801397 2.92590
242 0.000801617 2.92670
243 0.000801836 2.92750
244 0.000802056 2.92831
245 0.000802276 2.92911
246 0.000802495 2.92991
247 0.000802715 2.93071
248 0.000802935 2.93152
249 0.000803155 2.93232
250 0.000803375 2.93312
251 0.000803595 2.93393
252 0.000803816 2.93473
253 0.000804036 2.93553
254 0.000804256 2.93634
255 0.000804476 2.93714
256 0.000804697 2.93795
257 0.000804917 2.93875
258 0.000805138 2.93956
259 0.000805358 2.94036
260 0.000805579 2.94117
261 0.0008058 2.94197
262 0.00080602 2.94278
263 0.000806241 2.94359
264 0.000806462 2.94439
265 0.000806683 2.94520
266 0.000806904 2.94601
267 0.000807125 2.94681
268 0.000807346 2.94762
269 0.000807568 2.94843
270 0.000807789 2.94924
271 0.00080801 2.95004
272 0.000808231 2.95085
273 0.000808453 2.95166
274 0.000808674 2.95247
275 0.000808896 2.95328
276 0.000809118 2.95409
277 0.000809339 2.95490
278 0.000809561 2.95571
279 0.000809783 2.95652
280 0.000810005 2.95733
281 0.000810227 2.95814
282 0.000810449 2.95895
283 0.000810671 2.95976
284 0.000810893 2.96057
285 0.000811115 2.96138
286 0.000811337 2.96219
287 0.000811559 2.96300
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288 0.000811782 2.96382
289 0.000812004 2.96463
290 0.000812227 2.96544
291 0.000812449 2.96625
292 0.000812672 2.96706
293 0.000812894 2.96788
294 0.000813117 2.96869
295 0.00081334 2.96950
296 0.000813563 2.97032
297 0.000813786 2.97113
298 0.000814009 2.97195
299 0.000814232 2.97276
300 0.000814455 2.97357
301 0.000814678 2.97439
302 0.000814901 2.97520
303 0.000815124 2.97602
304 0.000815348 2.97683
305 0.000815571 2.97765
306 0.000815794 2.97847
307 0.000816018 2.97928
308 0.000816241 2.98010
309 0.000816465 2.98091
310 0.000816689 2.98173
311 0.000816912 2.98255
312 0.000817136 2.98336
313 0.00081736 2.98418
314 0.000817584 2.98500
315 0.000817808 2.98582
316 0.000818032 2.98664
317 0.000818256 2.98745
318 0.00081848 2.98827
319 0.000818705 2.98909
320 0.000818929 2.98991
321 0.000819153 2.99073
322 0.000819378 2.99155
323 0.000819602 2.99237
324 0.000819827 2.99319
325 0.000820051 2.99401
326 0.000820276 2.99483
327 0.000820501 2.99565
328 0.000820726 2.99647
329 0.00082095 2.99729
330 0.000821175 2.99811
331 0.0008214 2.99893
332 0.000821625 2.99975
333 0.000821851 3.00058
334 0.000822076 3.00140
335 0.000822301 3.00222
336 0.000822526 3.00304
337 0.000822752 3.00387
338 0.000822977 3.00469
339 0.000823202 3.00551
340 0.000823428 3.00634
341 0.000823654 3.00716
342 0.000823879 3.00798
343 0.000824105 3.00881
344 0.000824331 3.00963
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345 0.000824557 3.01046
346 0.000824782 3.01128
347 0.000825008 3.01211
348 0.000825234 3.01293
349 0.000825461 3.01376
350 0.000825687 3.01458
351 0.000825913 3.01541
352 0.000826139 3.01623
353 0.000826366 3.01706
354 0.000826592 3.01789
355 0.000826818 3.01871
356 0.000827045 3.01954
357 0.000827272 3.02037
358 0.000827498 3.02120
359 0.000827725 3.02202
360 0.000827952 3.02285
361 0.000828179 3.02368
362 0.000828405 3.02451
363 0.000828632 3.02534
364 0.000828859 3.02617
365 0.000829086 3.02699

TOTAL INTEREST: 1051.55782 252.41395 82.51913

APR: 10.52% 10.10% 10.03%
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23 Email

Email

Important:  Trakker's email capability requires the use of Microsoft Outlook and Outlook
must be set as the default email provider for windows.

23.1 Borrower Email Setup

Borrower Email Setup

Setting up a borrower's email address is done in two different steps.

First, ensure that you have a user defined field set up.

1) Go to System -> Parameter Options – User Defined.

2) Click on the alpha numeric tab

3) Check if there is a listing for E-MailAdd

4) If not Select add and then type E-MailAdd and give it a 60 character field length.
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5) Select OK

Secondly, open the particular borrower you would like to add an email address for.

1) Then go to Change -> General -> Defined Fields.

2) Click Alpha-numeric Tab

3) Click on your defined field titled E-MailAdd 

4) Click the Edit button.
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5)  Input Email address.

6)  Select OK

Done! Trakker is now set up to send an email to this borrower.

Note:  Once the first part of the set up is complete, only the second step needs to be completed
for each additional borrower.
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23.2 Lender Email Email Setup

Lender Email Email Setup

Lender email addresses can be entered as follows...

1)  From the main Trakker screen Select Review -> Lender -> Review
2)  Type the lender number of the lender you would like to add an email address to or select the list

button to choose the proper lender.
3)  Type the lender's email address in the email section of the lender screen.
4)  Select OK

Complete!



Trakker - Loan Servicing Software Help File299

Copyright Multi-Financial Services Company, Inc. 2012©

23.3 Sending Emails

Sending Emails

Emails may be sent from Trakker from any borrowers screen once the email addresses have been
entered.  

1)  To send an email to the either Lender or Borrower simply push the corresponding button on the
right side of the borrower's screen.

2)  An Outlook type window will appear with correct email address already filled in.
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3)  Type the subject and the body of the message.

4)  Outlook will launch

5)  Press the send button.

6)  Email sent.

7)  The body of the email message will be written to the contact log.

Complete!
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24 CDFI  XML Export

CDFI XML Export

This report is only for CDFI clients. 

24.1 CDFI XML Setup

Setup
1)  The CDFI Export function must first be activated through Trakker's operator screen.
2)  The following user defined fields should be setup within Trakker to report the proper information. 

(See section 6.12 of this help file for information on User Defined Fields)

User
Defined
Data Type
Field
Name

COND
ITION
ALLY
REQU
IRED
IF:

Validations Reject If: Ma
nda
tor
y

Length Comme
nt

Description Example
Data

Number
Fields
AreaRealE
stateTotal

Purpo
se =
Real
Estate

Square Feet of
Real Estate -
Total >=
(Square Feet
of Real Estate
-
Manufacturing)
+ (Square Feet
of Real Estate
-Office) +
(Square Feet
of Real Estate
- Retail)

Purpose =
Business
or
Microenter
prise

   For real estate
Projects, report the
total number of
square feet that are
expected to be
constructed,
rehabilitated, or
acquired with funding
from the transaction.

2300

SquareFe
etOfRealE
stateManu
facturing

Purpo
se =
Real
Estate

 Purpose =
Business
or
Microenter
prise

   For real estate
Projects, report the
number of square
feet of manufacturing
space that are
expected to be
constructed,
rehabilitated, or
acquired with funding
from the transaction.

800
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SquareFe
etOfRealE
stateOffic
e

Purpo
se =
Real
Estate

 Purpose =
Business
or
Microenter
prise

   For real estate
Projects, report the
number of square
feet of office space
that are expected to
be
constructed,
rehabilitated, or
acquired with funding
from the transaction.

1000

SquareFe
etOfRealE
stateRetai
l

Purpo
se =
Real
Estate

 Purpose =
Business
or
Microenter
prise

   For real estate
Projects, report the
number of square
feet of retail space
that are expected to
be
constructed,
rehabilitated, or
acquired with funding
from the transaction.

500

HousingU
nitsSale

Purpo
se =
Real
Estate

 Housing
Units -
Sale <
Affordable
Housing
Units -
Sale

   For real estate
Projects, report the
number of for-sale
housing units to be
constructed,
rehabilitated, or
acquired with funding
from the transaction.

2

HousingU
nitsRental

Purpo
se =
Real
Estate

 Housing
Units -
Sale <
Affordable
Housing
Units -
Rental

   For real estate
projects, report the
number of rental
housing units to be
constructed,
rehabilitated,
or acquired with
funding from the
transaction.

2

Affordable
HousingU
nitsSale

Purpo
se =
Real
Estate

Purpose =
Real Estate

    Of the total Housing
Units - Sale to be
rehabilitated,
constructed, or
acquired with funding
from this
transaction, report
the number that are
projected to be
affordable housing
units.

0
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Affordable
HousingU
nitsRental

Purpo
se =
Real
Estate

Purpose =
Real Estate

    Of the total Housing
Units - Rental to be
rehabilitated,
constructed, or
acquired with funding
from
this transaction,
report the number
that are projected to
be affordable
housing units.

0

ProjectNu
mber

 Each Project
Number may
only be used
for one Project
per reporting
period. CDFIs
MUST use the
same Project
Number for
each
reporting
period that a
particular
Project is
submitted.

  8  Assign a unique
identifier to each
Project. Project
Number is used to
link a Financial
Note(s) to a
distinct Project and
to track Projects
across reporting
periods.

12345

NAICSCo
de

      If applicable, report
the 6-digit North
American Industry
Classifications
(NAICS) Code. The
NAICS
code replaced the
former Standard
Industrial
Classification (SIC)
system and is used
to report
business revenue on
the federal tax
return. For additional
information, see IRS
Schedule C Form,
question B or
www.census.gov/epc
d/www/naics.html.

311421
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NumberOf
TimesLoa
nRestruct
ured

  Transactio
n Type =
Equity
Investment

  Annual
Update
Required

For each loan and
line of credit, report
the number of times
the loan was
restructured during
the
life of the loan.
Restructured refers
to a change to the
original terms of the
loan (i.e., amount,
interest rate or type,
term, or payment
schedule).
Restructuring
amends the original
loan
agreement, but does
not pay it off.

1

NumberOf
TimesRefi
nanced

  Transactio
n Type =
Equity
Investment

  Annual
Update
Required

For each loan and
line of credit, report
the number of times
the loan was
refinanced during the
life
of the debt.
Refinanced refers to
origination a new
loan that pays of an
existing loan.

1

CreditSco
re

  Investee
Type =
Individual
or
Business

   If applicable, report
the most recently
collected credit score
of the primary
investee(s)/borrower
(s). If there is more
than one
investee/borrower,
use the credit score
of the primary
investee/borrower. If
there is more than
one primary
investee/borrower,
report the highest
credit score. Credit
Score is not
applicable if the
borrower is a
corporation.

679

Decimal
Fields
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JobsAtTi
meOfLoan
Investmen
t

Purpo
se =
Busine
ss or
Microe
nterpri
se

   8.2  For business
Projects, report the
number of full-time
equivalent (FTE)
jobs in the business
at the
time the Project was
originated. One FTE
is a 35-hour or more
work week. In
calculating FTEs,
part-time employees
should be combined.
Example: 2 part-time
employees that each
work 17.5 hours
equals one FTE (2
employees x 17.5
hours = 35 hours).
Exclude construction
jobs.

35.00

FairValue
AtEndOfR
eportingP
eriod

Transa
ction
Type =
Equity
Invest
ment

 Transactio
n Type =
Term Loan
or Line of
Credit

 15.2 Annual
Update
Required

For equity
investments, report
the estimated fair
value of the Financial
Note at the reporting
period
end.

12500.00

JobsAtRe
portingPe
riodEnd

Purpo
se =
Busine
ss or
Microe
nterpri
se

   9.2 Annual
Update
Required

For business
Projects, report the
number of full-time
equivalent (FTE)
jobs in the business
at the
reporting period end.
One FTE is a
35-hour or more
work week. In
calculating FTEs,
part-time
employees should be
combined.
Example: 2 part-time
employees that each
work 17.5 hours
equals one FTE (2
employees x 17.5
hours = 35 hours).
Exclude construction
jobs.

25.20
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Projected
JobsToBe
CreatedAt
Business

Purpo
se =
Busine
ss or
Microe
nterpri
se

 Purpose =
Real
Estate

 9.2  For business
Projects, report the
number of full-time
equivalent (FTE)
jobs projected to be
created
in the business due
to this financing. One
FTE is a 35-hour or
more work week. In
calculating
FTEs, part-time
employees should be
combined.
Example: 2 part-time
employees that each
work 17.5 hours
equals one FTE (2
employees x 17.5
hours = 35 hours).
Exclude construction
jobs.  Include direct
jobs. Include indirect
jobs, if applicable.
Exclude induced
jobs.

25.00

Projected
JobsToBe
CreatedC
onstruct

Purpo
se =
Real
Estate

 Purpose =
Business
or
Microenter
prise

 9.2  For real estate
Projects, report the
number of
construction jobs
projected to be
created in the due
to this financing.
Include direct jobs.
Include indirect jobs,
if applicable. Exclude
induced jobs.
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EquityInje
ctionAmo
unt

  Purpose =
Consumer
or Home
Improvem
ent

 15.2  If applicable, report
the equity injection
amount provided by
the
investee/borrower.
Equity injection
is an underwriting
mechanism used to
help borrowers who
lack collateral to
qualify for a loan.
The
equity injection
measures the
amount of the
borrower's own
assets invested in
the business.
• Include both cash
and non-cash
injections.
Example 1: Down
payment for a
purchase mortgage.
Example 2: Value of
machinery the
borrower purchased
for the financed
project.

25000.00

AmountC
hargedOff

  Transactio
n Type =
Equity
Investment
OR Loan
Status =
Active

 15.2 Annual
Update
Required

If applicable, report
the amount charged
off during the
reporting period.

2500.00

AmountR
ecovered

  Transactio
n Type =
Equity
Investment
OR Loan
Status =
Active

 15.2 Annual
Update
Required

If applicable, report
the amount
recovered during the
reporting period.

15000.00

AnnualGr
ossReven
ueAtRepo
rtingPerio
d

    15.2 Annual
Update
Required

For business
transactions, report
the
investee's/borrower's
annual gross
business revenue
during
the most recent
12-month period for
which the
information is
available.

35000.00
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DSFCOSH
oursOfAs
sistanceP
rovided

    9.2 Annual
Update
Required

Report the total
number of hours of
Development
Services (DS) that
the CDFI provided to
the
investee/borrower
during the reporting
period.

256.50

DSFCOSH
oursOfAs
sistanceP
ostLoan

    8.2  Report the total
number of hours of
Development
Services (DS) that
the CDFI provided to
the
investee/borrower
from origination to
the end of the first
reporting period
which the
loan/investment
is reported to the
Fund. This is a
one-time entry point
per transaction.

365.00

DSFCOSH
oursOfAs
sistanceA
tTimeOf

    8.2  Report the total
cumulative hours of
Development
Services (DS) that
the CDFI provided to
the
investee/borrower
from time of the
initial intake until the
origination of the
Project.

350.00

Grossreve
nueAtTim
eOfInvest
ment

    15.2  For business
transactions, report
the
investee's/borrower's
annual gross
revenue during the
most
recent 12-month
period prior to
Project origination
for which the
information is
available.

12000.00
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TotalProje
ctCost

 Total Project
Cost >=
Original
Loan/Investme
nt Amount
Total Project
Cost >= 'Total
Project Cost -
Public
Sources'  Total
Project Cost
>= 'Total
Project Cost -
Affiliates &
Related
Programs' +
Original
Loan/Investme
nt Amount 
Total Project
Cost >= 'Total
Project Cost -
Public
Sources' +
'Total Project
Cost - Affiliates
& Related
Programs' +
Original
Loan/Investme
nt Amount

Purpose =
Consumer

 15.2  Report the total cost
of the Project being
financed.
·  Include all sources
of financing
·  Include the CDFI's
portion of the
financing.

250000.00

TotalProje
ctCostPub
licSource
s

  Purpose =
Consumer

 15.2  Report the portion (in
dollars) of the Total
Project Cost
provided by public
sources.
·  Include federal,
state, and local
government funds.
·  Exclude
foundation grants.
·  Exclude CDFI
funds.

100000.00

TotalProje
ctCostAffi
liatesRelat
ed

    15.2  Report the portion (in
dollars) of the Total
Project Cost
provided by the
CDFI's affiliates and
related
programs.

50000.00
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Projected
JobsToBe
CreatedAt
TenantBu
s

  Purpose
NOT =
Real
Estate

 9.2  For real estate
Projects, report the
number of full-time
equivalent (FTE)
jobs projected to be
created in business
located at the
property financed.
One FTE is a
35-hour or more
work week.
In calculating FTEs,
part-time employees
should be combined.
Example: 2 part-time
employees that each
work 17.5 hours
equals one FTE (2
employees x 17.5
hours = 35 hours).
·  Exclude
construction jobs.
·  Include direct jobs.
·  Include indirect
jobs, if applicable.
·  Exclude induced
jobs.

25.50

AskingRe
ntPerSqua
reFoot

 Purpose =
Real Estate

  9.2  For real estate
Projects, report the
proposed average
asking rent per
square foot per
month for
any commercial
space funded by the
CDFI.

105.00

CapacityO
fEducatio
nCommun
ity

Comm
unity
Facility
= YES
AND
All
other
Capaci
ty of
Comm
unity
Facility
data
points
are
blank
or "Not
Applic
able."

   9.2  If the project
financed includes an
educational facility,
report the number of
student seats
available
in the school.

200.00
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CapacityO
fChildcare
Communit
y

Comm
unity
Facility
= YES
AND
All
other
Capaci
ty of
Comm
unity
Facility
data
points
are
blank
or "Not
Applic
able."

   9.2  If the project
financed includes a
childcare facility,
report the number of
childcare slots
available in
the facility.

250.00

CapacityO
fHealthcar
eCommun
ity

Comm
unity
Facility
= YES
AND
All
other
Capaci
ty of
Comm
unity
Facility
data
points
are
blank
or "Not
Applic
able."

   9.2  If the project
financed includes a
healthcare facility,
report the projected
number of patients
served
per year.

300.00

CapacityO
fArtsCent
erCommu
nity

Comm
unity
Facility
= YES
AND
All
other
Capaci
ty of
Comm
unity
Facility
data
points
are
blank
or "Not
Applic
able."

   9.2  If the project
financed includes an
arts center, report
the capacity of the
arts center.
Example: If the
project is a theater,
report the seating
capacity

100.00
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CapacityO
fOtherCo
mmunityF
acility

Comm
unity
Facility
= YES
AND
All
other
Capaci
ty of
Comm
unity
Facility
data
points
are
blank
or "Not
Applic
able."

    9.2  If the project
financed is a
community facility
that serves a
purpose other than
education, childcare,
healthcare, or arts,
report the capacity
related to that other
purpose.

50.00

OtherImpa
ct1Numbe
rOfUnits

Other
Impact
(1) -
Explai
n
report
ed.

   9.2  If the Organization
reported an Other
Impact (1) - Explain,
report the number of
units
accomplished for this
impact during the
reporting period.

2.50

OtherImpa
ct2Numbe
rOfUnits

Other
Impact
(2) -
Explai
n
report
ed.

   9.2  If the Organization
reported an Other
Impact (2) - Explain,
report the number of
units
accomplished for this
impact during the
reporting period.

3.50

Date Field
DateBusin
essEstabli
shed

      If applicable, report
the date formal
papers were filed to
establish the
investee's/borrower's
business or the date
the first sales
occurred.

3/15/2005

Alpha/Nu
meric
Field
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Purpose  If: Purpose =
Home
Purchase or
Home
Improvement
Then: Investee
Type =
Individual

 YE
S

50 Valid 
Values: 
CONSU
MER 
Consum
er 
BUSINE
SS B
usiness 
MICRO 
Microent
erprise 
HOMEP
URCH 
Home
Purchas
e 
HOMEI
MP 
Home
improve
ment 
RECOC
OM Real
Estate
Construc
tion
Commer
cial 
RECOM
ULTI 
Real
Estate
Construc
tion Multi
Family 
RECOSI
NGLE 
Real
Estate
Construc
tion
Single
Family 
RERHC
OM Real
Estate
Rehabilit
ation
Commer
cial 
RERHM
ULTI 
Real
Estate
Rehabilit
ation
Multi
Family 
RERHSI
NGLE 
Real
Estate
Rehabilit
ation
Multi
Family 
OTHER

Identify the primary
purpose of the
Financial Note. If
there are multiple
purposes (for
example,
a loan funding both
the purchase of a
fixed asset and a
facility
improvement), select
the
purpose with the
largest percent of the
transaction. Classify
loans/investments in
CDFIs as
"Other".

CONSUM
ER
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Transacti
onType

   YE
S

50 Valid
Values: 
 TERM
Term
Loan
EQTYIN
V Equity
Investme
nt
LOC
Line of
Credit
DEBTE
QTY
Debt
with
Equity
OTHER
Other

Report the type of
transaction.

TERM

InvesteeT
ype

   YE
S

50 Valid
Values: 
IND
Individua
l
BUS
Business
CDFI
CDFI

·  Report whether
the Project is an
investment in an
individual, a
business or another
CDFI.
·  Loans/investments
in nonprofit entities,
other than CDFIs,
should be reported
as "Business."
·  Exclude loan
purchases from the
TLR.

BUS
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EquityLik
eFeatures

Transa
ction
Type =
Debt
with
Equity
and
Date
Origin
ated >
12/31/
2005

   50 Valid
Values:  
CONVD
EBT
Converti
ble Debt
PERFIN
T
Perform
ance-Ba
sed
Interest
Rate
ROYAL
TIES
Royalties
WARRA
NTS
Warrant
s
OTHER
Other

For debt with equity,
report the type of
equity-like feature.
Equity-like features
offer some upside
potential above the
return of principal
and interest. The
equity-like feature, or
"kicker," can be tied
either to future
revenues (royalties
or participation
agreements) or to
equity (convertible
debt or
debt with warrants),
or may include an
interest rate that
adjusts based on the
borrower's
performance. If the
loan has more than
one equity-like
feature, choose the
one appearing first in
the loan agreement.

CONVDEB
T

GuaranteeTransa
ction
Type =
Term
Loan,
Line of
Credit,
or
Debt
with
Equity
and
Date
Origin
ated >
12/31/
2005

 Transactio
n Type =
Equity
Investment

 50 Valid
Values: 
 SBA
Small
Business
Administ
ration
(SBA)
USDA
US Dept
of
Agricultu
re
(USDA) 
OTHER
GOV
Other
Federal
Govern
ment
Source
PERSO
NAL
Personal
Guarant
ee
OTHER
NONE

For each loan and
line of credit, if any
portion of the loan is
guaranteed, report
the source.
• "Personal
Guarantee" option
was added in CIIS
4.0.
• Exclude
performance
guarantees.

SBA
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LienPositi
on

Transa
ction
Type =
Term
Loan,
Line of
Credit,
or
Debt
with
Equity
and
Date
Origin
ated >
12/31/
2005

 Transactio
n Type =
Equity
Investment

 50 Valid
Values:  
FIRST
First
SECON
D
Second
UNSEC
URED
Unsecur
ed Debt
OTHER

For each loan and
line of credit, report
the CDFI's lien
position.
• If no other lender
has priority over the
CDFI in the case of
default, the lien
position is first.
Report
a loan with a shared
first position as first.
• If another lender
receives priority in
the case of a default,
the lien position is
second.
• If more than one
other lender receives
priority, the lien
position is "Other."

FIRST

Collateral
Type

Transa
ction
Type =
Term
Loan,
Line of
Credit,
or
Debt
with
Equity
and
Date
Origin
ated >
12/31/
2005

   50 Valid
Values: 
RE Real
Estate
REOTH
ER
Other
Real
Estate
VEH
Vehicle
EQUIP
Equipme
nt
INVENT
ORY
Inventory
REC
Receiva
bles
HOMEE
QTY
Home
Equity
OTHER
NONE

For each loan and
line of credit, report
the type of collateral
pledged for the
loan/investment.
Collateral is an asset
pledged to a lender
until a loan is repaid.
If more than one type
of collateral
was pledged, choose
the option with the
highest estimated
value. Rents or
leases pledged as
collateral should be
included as
"Receivables."
• The "Personal
Guarantee" option
was removed from
Collateral Type in
CIIS 4.0. Personal
Guarantees are now
reported under the
Guarantee (R) data
point.

RE
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FirstTime
HomeBuy
er

Purpo
se =
Home
Purch
ase

   50 Valid
Values:
YES Yes
NO No
DK Don't
Know
NA Not
Applicabl
e

Report whether the
homebuyer is a
first-time homebuyer
(has not owned a
home during the
threeyear
period preceding the
CDFI-assisted
purchase of a
principal residence).
·  If there is more
than one borrower,
respond for the
primary borrower.
·  If there is more
than one primary
borrower, report
whether at least one
borrower qualifies as
a
first-time homebuyer.

YES

JobType Purpo
se =
Busine
ss
Microe
nterpri
se
Real
Estate

 Purpose  
Business,
Microenter
prise or
Real
Estate

  Valid
Values: 
DIRECT
Direct
jobs
DWINDI
RECT
Direct
jobs and
Indirect
jobs

Indicate whether the
types of jobs being
reported are “Direct”
or “Direct and
Indirect”. Typically
such job estimates
are based on new
hires that the project
business expects to
be able to make
as a result of the
new financing. If,
however, the project
is large and
complex, the
business or
developer may
estimate the job
effects based on
economic models
that may include
both direct
and indirect jobs.

DIRECT
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JobSourc
e

Purpo
se =
Busine
ss
Microe
nterpri
se
Real
Estate

 Purpose  
Business,
Microenter
prise or
Real
Estate

  Valid
Values:  
NEWFIN
ANCING
New
hires
that the
project
business
expects
to be
able to
make as
a result
of the
new
financing
.
WAGED
ATA
Estimate
s based
on state
or
local
wage
data and
projecte
d
wage
and
salary
expendit
ures
attributa
ble to
project
financing
.
ECONO
MICIMP
ACT
Estimate
s based
on
economi
c
impact
modeling
systems
such
as
IMPLAN,
RIMSII,
or REMI.
RULEO
FTHUM
B
Estimate
s based
on
develope
rs
“rules of
thumb”
about
jobs
created
by type
of
business
and
square-f
ootage
built.
OTHER

Select the source of
the job estimates
that are reported in
the TLR

NEWFINA
NCING
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JobSourc
eOther

Job
Sourc
e =
Other

    Report Source of
Job Estimates not
covered above.

Any text
that you
choose.

Forgivabl
eLoan

    50 Valid
Values: 
YES or
NO

Report Source of
Job Estimates not
covered above.

NO

EntityStru
cture

  Investee
Type =
Individual

 50 Valid
Values:  
NONPR
OFIT
Non-Prof
it or
Not-for-P
rofit 
FORPR
OFIT
For-Profi
t
TRIBAL
Tribal or
Village
Govern
ment
OTHER

If applicable, report
the
borrower/investee's
business or
government
structure.

NONPROF
IT

MinorityO
wnedOrC
ontrolled

    50 Valid
Values: 
YES or
NO

Report whether the
investee/borrower is
more than 50%
owned or controlled
by one or more
minorities.
·  If the business is a
for-profit entity,
report whether more
than 50% of the
owners are
minorities.
·  If the business is a
nonprofit entity,
report whether more
than 50% of its
Board of Directors
are minorities (or, if
the Chief Executive
Officer, Executive
Director, General
Partner, or
Managing Member is
a minority).

YES
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WomanO
wnedOrC
ontrolled

    50 Valid
Values: 
YES or
NO

Report whether if the
investee/borrower is
more than 50%
owned or controlled
by women.
·  If the business is a
for-profit entity,
report whether more
than 50% of its
owners are women.
·  If the business is a
nonprofit entity,
report whether more
than 50% of its
Board of Directors
are women (or, if the
Chief Executive
Officer, Executive
Director, General
Partner, or
Managing Member is
a woman).

YES

LowIncom
eOwnedO
rControlle
d

    50 Valid
Values: 
YES or
NO

Report whether the
investee/borrower is
more than 50%
owned or controlled
be low-income
persons.
·  If the business is a
for-profit entity,
report whether more
than 50% of its
owners are
lowincome
persons.
·  If the business is a
nonprofit entity,
report whether more
than 50% of its
Board of Directors
are low income
persons (or, if the
Chief Executive
Officer, Executive
Director, General
Partner, or Managing
Member is a low
income person).

YES

Refinance
dOriginal
Transacti
onID

  Transactio
n Type =
Equity
Investment

 20  If the loan or line of
credit was
refinanced, report
the Originator
Transaction ID for
the refinanced
loan or line of credit.

1071



CDFI  XML Export 322

Copyright Multi-Financial Services Company, Inc. 2012©

LowIncom
eStatus

  Investee
Type =
CDFI

 50 Valid
Values:
LOW
Low-inco
me
investee/
borrower
VERYL
OW Very
low-inco
me
investee/
borrower
OTHER
Other
NA Not
Applicabl
e

Report the income
status of the
investee/borrower.
See the CIIS
Glossary for detailed
definitions
of "Low-Income" and
"Very Low-Income."
·  If there is more
than one
investee/borrower,
respond for the
primary
investee/borrower.
·  If there is more
than one primary
investee/borrower,
select the income
status of the highest
income primary
investee/borrower.

LOW

OtherTarg
etedPopul
ations

    50 Valid
Values: 
YES or
NO

Report whether the
transaction serves
an Other Targeted
Population (OTP) as
defined in the
CDFI’s Certification
or Assistance
Agreement. See the
CIIS glossary for a
detailed definition of
"Other Targeted
Population."

YES

LITPEndU
sers

    50 Valid
Values: 
YES or
NO

Report whether the
transaction serves
Low-Income
Targeted Population
(LITP) End Users.
LITP
End Users are
low-income and very
low-income persons
that benefit from a
loan/investment
made
to another
investee/borrower.
·  Example:
Residents of housing
for which the CDFI
made a construction
or rehabilitation loan
may qualify as LITP
End Users.

YES
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OTPEndU
sers

    50 Valid
Values: 
YES or
NO

Report whether the
transaction serves
Other Targeted
Population (OTP)
End Users. OTP End
Users are persons of
OTPs that benefit
from a
loan/investment
made to another
investee/borrower.
·  Example:
Residents of housing
for which the CDFI
made a construction
or rehabilitation loan
may qualify as LITP
End Users.

YES

IAEndUse
rs

    50 Valid
Values: 
YES or
NO

Report whether the
transaction serves
Investment Area (IA)
End Users. IA End
Users are
residents of an IA
that benefit from a
loan/investment
made to another
investee/borrower for
a
service or facility.
·  Example:
Employees of a
business or users of
a community facility
located in the IA may
qualify as IA End
Users.

NO
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HZEndUs
ers

    50 Valid
Values: 
YES or
NO

Report whether the
transaction serves
Hot Zone (HZ) End
Users. HZ End
Users are residents
of
a HZ that benefit
from a
loan/investment
made to another
investee/borrower for
a service or
facility.
·  Example:
Employees of a
business or users of
a community facility
located in the HZ
may
qualify as HZ End
Users.

NO

FemaleHe
adedHous
ehold

    50 Valid
Values: 
YES or
NO

Report whether the
homebuyer is a
single or separated
woman who will be
the primary support
for
a household that
includes at least one
dependent or other
qualifying individual
as allowed by IRS
regulations. A single
woman with no
dependents does not
qualify.

NO

BankedAt
TimeOfInt
ake

    50 Valid
Values: 
YES or
NO

Report whether the
investee/borrower
had a bank or credit
union account at the
time of intake.
·  If there is more
than one
investee/borrower,
respond for the
primary
investee/borrower.
·  If there is more
than one primary
investee/borrower,
report whether at
least one
investee/borrower
was banked at the
time of intake.

NO
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RejectedB
yBankOrC
reditUnion

    50 Valid
Values: 
YES or
NO

Report whether the
investee/borrower
was rejected by a
bank or credit union
for a similar
loan/investment
within the 12 months
prior to applying for
this loan/investment.
"Similar
loan/investment
request" is defined
as a loan/investment
for the same or
similar purpose and
amount.
·  If there is more
than one
investee/borrower,
respond for the
primary
investee/borrower.
·  If there is more
than one primary
investee/borrower,
report whether at
least one
investee/borrower
was rejected by a
bank or credit union.

NO

CapacityO
fCommuni
tyFacility
Opt

     Valid
Values: 
YES or
NO

Report whether the
project financed is a
community facility. If
the project is a
community facility,
CIIS requires the
user to provide a
numeric response
greater than zero or
"Don’t Know" to at
least
one of the
Community Facility
Capacity data points
that follow.

YES

Memo
Fields
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OtherImpa
ct1Explain

    150 If the Organization
measures a
community
development
impact(s) that is not
covered above,
Users may report
this as an "Other
Impact." Include only
quantitative impacts
that the CDFI has
measured during the
reporting period.

Any text
that you
choose
can be
entered
for this

OtherImpa
ct2Explain

    150  If the Organization
measures a
community
development
impact(s) that is not
covered above,
Users may report
this as an "Other
Impact." Include only
quantitative impacts
that the CDFI has
measured during the
reporting period.

Any text
that you
choose
can be
entered
for this
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24.2 CDFI XML Processing

Processing

1)  Log into Trakker
2)  Select Reporter
3)  Select Custom Reporter Tab

4)  Select CDFI Export Module and Execute
5)  Identify the desired name and path for your new XML export file and Save the file.
6)  Upload your new XML file to CDFI.  COMPLETE!



Part

XXV
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25 Appendix

25.1 Appendix A
 
 

This appendix was created for the purpose of providing you with various sample letters that are found within the program.
These letters were created to be a standard for the program in both their content and text but can be edited using Notepad
or Word Pad. Notepad is the recommend choice of the two programs even though it lacks some of the more widely known
features because of its level of compatibility with the program. (For more on customizing letters please refer to 
CUSTOMIZING LETTERS) 

 

 We recommend that you first read and evaluate the SAMPLE LETTERS - INTRODUCTION to give you a more clear
understanding of each of the letters shown.

Click on any of the links listed below to view a sample of the program letters:
 

· SAMPLE LETTERS - INTRODUCTION 
 

· PASTDUE NOTICE #1 
 

· PASTDUE NOTICE #2 
 

· PASTDUE NOTICE #3 (RECENT PAYMENT MADE) 
 

· 10-DAY BRING CURRENT CERTIFIED LETTER 
 

· PAYOFF LETTER 
 

· PAYMENT RECEIPT 
 

· INTEREST RATE CHANGE LETTER 
 

· RETURN CHECK NOTICE 

25.2 Appendix B
 

One of the more powerful features of the program is that it offers a flat style database for the recording and tracking of
important dates. Dates such as Insurance Due dates, Coupon Book Due dates, and other user defined dates. Below are
links to some of the more common reports generated by the program, under the Important Due Dates section of the
Dates/Data menu. There are of course other reports such as Hazard Insurance Due and various other escrow transactions;
however, they do not have samples shown here because the layout of each report is the same as the County Taxes
Accounts Due Report - Sample. Only the title of the report is different.

 

 

· IMPORTANT DATES - SAMPLE REPORTS 
 

· County Taxes Accounts Due Report - Sample
 

· Coupon Book - Example 
 

· Interest Rate #1 - Sample 
 

· Pending Insurance Due Report - Sample 
 

25.3 Appendix C
 

 

 

This appendix provides a copy of all the "management" reports generated within 'Reporter'. These reports are defined as
management reports since they are typically used by management at the end of any weekly, monthly, yearly, etc. time
period.  These reports cannot be changed as with the letters in Appendix A . Other sample reports for your loan-servicing
program are in Appendix B (Important Dates).  

The user does have the ability to create their own custom reports utilizing their data in any manner they wish via the Data
Conversion Utility.  For more on this subject, please see: Utilities where the subject of converting the program's binary data
to an ASCII tab-delimited format is discussed.  Naturally, when converted this data is easily importable into a spreadsheet,
word processing, database, or similar program capable of importing ASCII tab-delimited data.

 

The following samples are available in this Appendix C:
Delinquency Report 
ACCOUNT SUMMARY REPORT - SAMPLE 
PAYMENT SUMMARY REPORT - SAMPLE 
AGING REPORT - SAMPLE 
INTEREST PAID SUMMARY REPORT - SAMPLE 
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ESCROW ACCOUNT TRANSACTION REPORT - SAMPLE 
LATE FEES DUE REPORT -SAMPLE 
SUSPENSE ACCOUNT SUMMARY REPORT -SAMPLE 
COUPON BOOK - SAMPLE 
AMORTIZATION SCHEDULE-SAMPLE 

25.4 Appendix D
 

TAX FORM 1098-SERVICER'S
 

 

          Your Company Name
          Your Company Address
          City, ST  Zip

          FED-ID#               SSN#                  Account Interest$

                                                         INTEREST COLLECTED FOR:
        Mary Seminole                              Mortgage Svcs. of America
        2545 Capital Street                       123 Oak St.
        Apt 345
        Tallahassee, FL 34555                  Tallahassee, FL 32333
        U.S.A.
 

        9999-1003                                      99-1234567

IRS FORM 4804

      FORM 4804 TRANSMITTAL OF INFORMATION RETURNS

      REPORTED MAGNETICALLY/ELECTRONICALLY

      ================================================================

      1.  Type of files represented by this transmittal: ORIGINAL
      2.  Tax year for which media is submitted:  2001
      3.  Transmitter control code assigned by IRS:
      4.  Name of transmitter:  Your Company Name
 

      5.  Name of person to contact regarding files:
                  Enter Your Name Here
      6.  Name, address of company and name and title of person to whom
          problem files are to be returned:
            Enter Your Name Here
            Your Company Name
            Address
            City, ST, Zip
            Phone #
      7.  Type of media submitted: MAGNETIC
      8.  Total number of media in shipment:  1
      =======================================================
 

              AFFIDAVIT
      UNDER PENALTIES OF PERJURY, I DECLARE THAT I HAVE EXAMINED THIS
      TRANSMITTAL INCLUDING ACCOMPANYING DOCUMENTS, AND, TO THE BEST OF MY
      KNOWLEDGE AND BELIEF, IT IS CORRECT AND COMPLETE

      _____________________________  ___________________  __/__/____
 

         NAME                                                 TITLE                              DATE
 

         FORM 4802 TRANSMITTAL of INFORMATION RETURNS
          REPORTED MAGNETICALLY/ELECTRONICALLY
          CONTINUATION OF FORM 4804
      =======================================================
          NAME AND ADDRESS OF PAYER:
          Your Company Name Here
          Your Address
          City, ST ZIP
        FEDERAL TAX ID: 99-12345657
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        TYPE OF RETURN 1098 # OF PAYEES:  1
      ========================================================
        TOTAL NUMBER OF BORROWER RECORDS:  1
 

        TOTAL NUMBER OF LENDER RECORDS:  0
      =========================================================

25.5 Appendix E
 

 

REQUESTING TECHNICAL SUPPORT
 

 

 

If you have a question or problem for which you cannot find the answer in this manual, you are welcome to call or write
with any questions or problems.  Before you call or write, please follow these steps:

 

 

· Verify that your equipment is compatible with the program.  Requirements are listed in this manual at:  Introduction 
 

· Verify that your computer and all peripheral equipment are turned on, and is functioning properly.  Make sure that the
printer cables are securely connected to your computer.

 

· Verify that you have enough RAM memory available to run the program. The minimum memory requirements for the
program are listed in this manual at: Introduction 

 

Please READ THE MANUAL.  The Help Desk has found that more than 85% of the questions are answered in the
manual.

 

If your questions have not been answered after following the above steps, you may call or write to the Help Desk
. Before you call or write, please answer the questions on the Technical Support Form:  Technical Support Form 
 

 

The Help Desk telephone number is 850-559-9123. Our Support staff will answer this number between 9:00 AM and
5:00 PM EST Monday through Friday.  If possible, please be sitting at your computer when you call.   Your computer should
already be turned on and ready to go.  When calling the Help Desk, you MUST provide the name under which you are
registered.  Without this information, we cannot provide technical support.

 

 

If you wish to contact our support staff by means other than phone, please see what options are available in the Help
Desk section.

 

 

For a printable version of the Technical Support Form please review the Technical Support Form section.
 

25.6 Appendix F
 

 Supply Forms Order Sheet
 

  Purchase Order Number    

______________________________________________________________________
    Company Name     ______________________________________________________________________
    Billing   Address    

______________________________________________________________________
    City     ______________________________________________________________________
    State     _____________________     Zip     ___________________________
    Shipping   Address    

______________________________________________________________________
    City     ______________________________________________________________________
    State     _____________________     Zip     ___________________________
    Preferred Shipping:     Overnight / 2-Day / Regular   (Please Circle One)
    Pricing May Vary Please Contact Our Support Staff and We Will Fax You A Current Price Schedule  

  Please Circle Each Item You Wish To Order – Quantity And Type Of Printer   

    Past Due Notices
    Type Of Printer   Laser   Ink jet   Dot Matrix    

    

  Quantity   ,000   ,500   ,000   ,500   ,000  

,000   ,000   ,000   ,000   

    Coupons
    Type Of Printer   Laser   Ink jet   Dot Matrix    
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  Quantity   ,000   ,500   ,000   ,500   ,000  

,000   ,000   ,000   ,000     

    1098 Forms
    Form A – I.R.S. Copy
    Quantity         ,000   ,000  

,000   ,000         

      Form B – Customer Copy
    Quantity         ,000   ,000  

,000   ,000         

      Form C – Your Copy
    Quantity         ,000   ,000  

,000   ,000         

      Standard 2 Window Envelopes
    Quantity         ,000   ,000  

,000   ,000         

 

PLEASE FAX TO: 1-800-294-8532 AND ALLOW 2-3 WEEKS DELIVERY
AN INVOICE WILL ARRIVE SHORTLY  . . . THANK YOU FOR YOUR ORDER!!

25.7 Appendix G
 

 

EXAMPLE I
 

CASH BALANCING FORM
 

BALANCING TO DEPOSIT SLIPS
SETTLEMENT DATE:   _____/_____/_____

 
FOR DEPOSITS DATED: _____/_____/_____ THROUGH

_____/_____/_____

TOTALS FROM PAYMENT SUMMARY REPORT:
 
1.  TOTAL LATE/NSF FEES RECEIVED:
$_________________
 

 
2.  TOTAL SERVICE FEES RECEIVED:
$__________________
 

 
3.  TOTAL PRINCIPAL & INTEREST RECEIVED:
$__________________
 

 
4.  TOTAL ESCROW RECEIVED:
$__________________
 

TOTALS FROM SUSPENSE REPORT:
 
5.  TOTAL CASH-IN FROM SUSPENSE REPORT:
$__________________
 

 
6.  TOTAL CREDITS FROM SUSPENSE REPORT:
$_________________)
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ADJUSTMENTS:
     OVERAGE'S ON PAYOFFS RETURNED TO 
 
     BORROWER:
$__________________
     ____________________________________:
$__________________
     ____________________________________:
$__________________
     ____________________________________:
$__________________
     ____________________________________:
$__________________
     ____________________________________:
$__________________
 7. TOTAL ADJUSTMENTS:
$_________________
 

 
8.  GRAND TOTALS (1+2+3+4+5-6+7):
$__________________
 

TOTALS OF DEPOSIT SLIPS:
 
9.  DEPOSIT TOTALS:
$__________________
 

 
10.  DIFFERENCE (8 - 9):
$__________________
 

      
 

 

 
EXAMPLE II

CASH BALANCING FORM
BALANCING TO CHECKBOOK

SETTLEMENT DATE:   _____/_____/_____
 

 
1. FEES RECEIVED:
 
BEGINNING FEES BALANCE:   
$______________
ADDITIONS TO FEES:
$______________
SUBTRACTIONS TO FEES:     
($_____________)
 

 FEES BALANCE:
 $________________

 
2.            ESCROW RECEIVED:
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BEGINNING ESCROW BALANCE:     
$______________
ADDITIONS TO ESCROW:                 
$______________
SUBTRACTIONS FROM ESCROW:  
($______________)

ESCROW BALANCE:
$________________

 

 
3. SUSPENSE RECEIVED:
 
BEGINNING SUSPENSE BALANCE:  
$______________
ADDITIONS TO SUSPENSE:
$______________
SUBTRACTIONS FROM ESCROW:   
($______________)             

     SUSPENSE BALANCE: 
    $__________________ 

 
4. PRINCIPAL & INTEREST
 
BEGINNING P&I BALANCE:
$______________
ADDITIONS TO P&I:
$______________
SUBTRACTIONS FROM P&I
($_____________)
CORRECTIONS:
$______________

 P & I BALANCE:  
 $_______________

 
5. ADJUSTMENTS:
 
___________________________:      $______________
___________________________:      $______________
___________________________:      $______________
 
TOTAL ADJUSTMENTS:
$_______________
 

 
GRAND TOTALS (1+2+3+4+5):
$_______________
 

CHECKBOOK TOTAL:
$_______________

DIFFERENCE:
$_______________
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25.8 Appendix H
  

 

The following information explains the various files created by the "Data Out" function, which takes binary file information
and converts it to a useable ASCII – Tab-Delimited format.  The following is broken down by the converted file name with a
general explanation of each file and the definition of each column heading.  All files can be brought directly into Excel or into
an MDB Database.  Listed below is a full list of each file that is exported.  To review a full explanation of each file click on
the name of the file.  

 

Note: Due to the width of each file please note that the descriptions for each file will be listed vertically instead of
horizontally.

 

(Year).xls                            Payment Files
balldate.xls                          Balloon Due Dates
citydate.xls                          Escrow City Due Dates
cntydate.xls                         Escrow County Due Dates
comment.xls                        Loan Comment Line
contactlog.xls                      Account Contact Logs
coupon.xls                           Coupon Due Dates
datamisc.xls                         Data Misc. File
escrow.xls                          Escrow Transactions
insrdate.xls                          Escrow City Transactions  
intdate1.xls                          Escrow City Transactions
intdate2.xls                          Escrow City Transactions
invest3.xls                           Investor Primary & Sub Account Links
investor.xls                          Investor Listing
late.xls                                 Late Letter Printed Dates
lender.xls                             Lender Name & Number
lender2.xls                           Lender Detail Information
maintenance.xls                   Lender Detail Information
maintenance2.xls                 Lender Detail Information 
mor3relatives.xls                 Account Other Contacts
morcontacts.xls                   Borrower List & Personal Information
mortgor.xls                           Primary Table - Includes MOST information entered during the "New Loan Wizard"
mortgor3.xls                         Borrower  Detail & Credit Bureau Information
nextdue.xls                          Account Current Balance, Next Due & Last Payment Recv'd Dates, & Past Due Balance
oth1date.xls                         Important Due Dates (Other 1)  
oth2date.xls                         Important Due Dates (Other 2)
oth3date.xls                         Important Due Dates (Other 3)
oth4date.xls                         Important Due Dates (Other 4)
purgelog.xls                         Purge Log
suspense.xls                       Suspense Account Transactions
userfields.asc                      User Defined Fields
usr1date.xls                         Important Due Dates (User 1)
usr2date.xls                         Important Due Dates (User 2)  
usr3date.xls                         Important Due Dates (User 3)
usr4date.xls                         Important Due Dates (User 4)
usr5date.xls                         Important Due Dates (User 5)
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26 Version History

26.1 Version 2.4.0.33
New in this version: 2.4.0.33

1. Agency reporting for FNMA, GNMA & Freddie Mac
2. Expanded Variable Interest Rate Function
3. Print to Screen reports
4. More Flexible escrow accounting system, including identifying future escrow payments
5. Enhanced the user interface in the Main Menu under Date/Data>Misc.

Database>add/modify by separating the Loan options  and Borrower options. 
6. Borrower's tool bar has an added reporter option that simulates the Borrower options in

the Main Menu Date/Data section
7. More LOS (Loan Origination Software) interface then ANY other servicing system
8. .mdb data file access
9. International formatting standards

10. XML standards for new loan import
11. Expanded ASP borrower page capabilities
12. Enhanced the utilities that enable the Help Desk Staff to troubleshoot reported problems
13. Enhanced the Service Fee option to include an annual calculations
14. More pre-developed Crystal Reports

26.2 Version 2.4.0.1
New in this version:

1. Access to Help File via the Internet
2. Variable Interest Rate Loan Servicing
3. User Defined Fields
4. Flexibility in Posting Short Payments

(How Interest, Principle and Fees are posted)
5. Crystal Reports Development
6. Import new loans from more LOS Software 
7. Credit Bureau Reporting
8. Remote Backup Capabilities
9.     Corrected the Bring Current Screen interest calculation.   
        Trakker was reporting the Interest Short in the Interest Due and Interest Short 

26.3 Version 2.2.0
 

New in this version:
 
· Escrow Maintenance Fee
 

Escrow Maintenance Overview 
 
A new feature added to The Trakker in Version 2.2.0, the Escrow Maintenance Account would allow your company to

track an escrow fee that is used for keeping property up to par.  This fee can be turned on and off and setup for each
individual account.  Your company can setup a fee "cap", or the highest amount to be stored in the Escrow Maintenance
Account.  

 
· Escrow Maintenance Fee Report
 
This report will detail all activity within the Maintenance Fee Account.
 
· Escrow Maintenance Fee Custom Letter Variables Added
 
We have added 5 new variables that you may use for your Custom or Existing letters.  Please review CUSTOMIZING

LETTERS for additional information on how to utilize these variables.
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· Variable Interest Rate Loans
 
You can now enter Market Index, Date based, and Payment based variable interest rate loans in Trakker.  
 

Modifications in this version:
 
· Data Out Utility
 
Added the new files for the Escrow Maintenance Fee account.
 
Appendix H – Data Conversion Utility
 
Multi-Investor Accounts – Entry
 
You can now enter multi-investor accounts quickly via modifications that were made to the new loan wizard.
Please review Entering a Multi-Investor Loan for a walk through.
 
· Borrower's Screen
 
The borrower's screen has been modified in the following areas:
 
Escrow Type now states what type of escrow the account has attached to it.  For example if the account has regular

escrow only the "Escrow Type" window will have "STD Escrow" listed, if the account has both standard escrow and
maintenance escrow the "Escrow Type" window will have STD & Maintenance listed.

 
The short payment history (located at the bottom of the borrower's screen) includes the new Maintenance escrow account

payment.  Note:  this is the amount of funds that came from the payment and is stored in the Maintenance escrow account.
 
The Escrow menu has changed to allow for the separation of Standard Escrow Items & Escrow Maintenance Fee Items.
 
· Escrow Analysis Screen
 
Modifications were made to this screen removing the Est. Esc and Bal S/B.  These were removed due to numerous

customer requests. 
 
· Reports
 
Corrected the alignment on numerous reports throughout the system.
Corrected font errors on the collection reports.
Added the collection code to the delinquency report.
 
· Logon Screen
 
Removed the case sensitivity on the logon user name and password.  This was done based on customer requests.
 
· System Default Options
 
Added Escrow to the system default options setting window
Added EDI link path
 
· Payment Posting
 
You can now enter a comment when posting a payment.  Clicking on Comment will bring up the contact log and allow you

to enter comments during the posting of payments.
 
There is now a check number box that will allow you to enter the last 4 numbers of a check when posting a payment.
 
· Collateral Address
 
You can now modify the collateral address on any loan.
 
· Fee and Balance Adjustment
 
These functions now have a "date check" on them to disallow entering of adjustments prior to transactions already in the

system.
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· Suspense Account and Posting Errors
 
If a payment is transferred from the suspense account and then voided, the funds return to the suspense account.
 
· Year End Statement
 
Added escrow summary at the bottom of the year end letters.
 
· Custom Letters
 
Added the ability to "call" the collateral address and the comment fields into your custom letters
 
· Account History Screen
 
Added the ability to print the Escrow history
 
· New Loan Wizard
 
The new loan wizard now includes information required to properly setup the Escrow Maintenance Fee account.
 
The "Escrow Maintenance Fee" section can be enabled by clicking on "Required" and entering the correct information. 

The Balance is the current balance, the Fee is the amount that is required with each payment, and the Cap is the maximum
amount allowed to be stored in this account.

 

 
The "Finish" screen has also been modified, per customer request to display additional information:
 



Version History 340

Copyright Multi-Financial Services Company, Inc. 2012©

· Crystal Reports and MDB Reporter Add-On Module for Trakker 
 
This new and exciting feature packed add-on module for Trakker 
 
The MDB Custom Reporter Add-On Module is an import function that imports all of the data files from Trakker directly into

a pre-designed database.  This module will allow you to use existing reporting applications or if you know how to utilize the
reporting functions in a database program, like Microsoft® Access®, you can design your custom reports at a very low cost.

 
For more information on these or any other item from Multi-Financial Services Company, Inc. please review our web site

at www.thetrakker.com or e-mail our support manager at supportmgr@thetrakker.com
 

26.4 Version 2.1.0
 
 

Modifications in this version:
 
· Data Out Utility
 

The dataout utility now includes all Trakker Data Files and All information included in each file.
 

Please refer to Appendix H for additional information on the Dataout files and format.
 

· ACH Payment File Import
 

As of this version you can now process a payment import file.  This can assist you in processing ACH
payments.  To review additional information on this function please review ACH File Import 

 

· The Borrower's Screen
 

Per the request of a number of clients, the borrower 's screen has been increased to allow for additional
information.  Some clients may have seen an increase in the borrower 's screen as of the Version 2.0.7.  This
was a preview of the increased screen.  With the responses that our support department received about the
increased size we decreased the size of the screen to fit a screen resolution of 800 X 600.  

 

If you have suggestions for this screen or any other screen (size, layout, or content) please send your
suggestions to our support manager at supportmgr@thetrakker.com.  

 

· The Availability for Add-On Modules.
 

We have modified the program to allow for custom modules to interact directly with Trakker and its data
files.  If you have a suggestion for an Add-On Module that you need please send your suggestions to our support
manager at supportmgr@thetrakker.com.
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With this ability our programming staff have been developing two Custom Reporting modules for
Trakker.  Both modules are (as of December 16, 2002) currently in their beta testing stage.  If you wish to
receive additional information on either of these custom reporting modules please contact our support
department at 850-559-9123, by e-mail at support@thetrakker.com, or visit our web site at
www.thetrakker.com.

 

One of the modules is based on Crystal Reports© and has most of the report design functions in their
full application.  Crystal Reports© can be found on the shelves at a price near a thousand dollars!  

 

The MDB Custom Reporter Add-On Module is an import function that imports all of the data files from
Trakker directly into a pre-designed database.  This module will allow you to use existing reporting applications
or if you know how to utilize the reporting functions in a database program, like Microsoft® Access®, you can
design your custom reports at a very low cost.

 

· Payment History Screen (located in the Borrower's screen)
 

As of the release of Version 2.0 this screen was corrected where it was displaying an incorrect payment
paid (due date).  This was a problem that some of our clients reported within the Version 1.6.0 release.  After
those clients updated to Version 2.0 a small few of these clients still experienced a display problem with this
screen.  Our programmers rewrote the screen to ensure that this problem never returned.  This has been tested
and determined that the problem has been removed.  We apologize for any inconvenience that this may have
caused.

 

· EDI Link – Updated 
 

The EDI link was updated with the release of a new version of Point© and Loan Handler© to allow for
changes these programs made to their exported files and to allow additional information to be imported into
Trakker.

 

· Contact Log
 

Each borrower's contact log now logs additional security items.
 

The log now includes an entry that is written by the Auto-Coupon function.
 

· Additional Variables Available for Custom Letters
 

You can now include additional information in your custom letters.  Please review the updated list of
available fields in the CUSTOM LETTERS AVAILABLE FIELDS help topic.

 

· IRS Reporting Data File
 

Per the IRS requirements we have updated the reporting file for 2002.  We have created a test file, sent
it to the IRS, and it has been approved for your January/February 2003 submissions.

 

· IRS Reporting Filter
 

We have now added a "Filter" to the program that will allow you to report an account based on the
amount of interest received.  The minimum reporting amount can be set in the System Parameters.  Go to
System, Parameter Options, System Parameters.

 

26.5 Version 2.0.7
 

Version 2.0.7
 

 

Modifications in this version:
 

· EDI Link
 

The EDI Link was modified to allow for additional information to be imported from Point© and Loan
Handler©.

 

· The Borrower's Screen
 

Per the request of a growing number of clients we have increased the Borrower's screen to allow for
additional information.
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26.6 Version 2.0.6
 

Version 2.0.6
 

 

Modifications in this version:
 

· Borrower Service Fee (Charged to the borrower not lender)
 

The borrower service fee now is automatically added to the payment amount and is deducted from the
payment when the payment is posted.

 

· New Loan Wizard
 

The past due amount (current past due amount, used on existing past due loans) now transfers into the
loan's past due column if entered in.

 

26.7 Version 2.0.5
 

Version 2.0.5
 

 

Modifications in this version:

· Borrower Service Fee
 

Changed due to an error where the program was not recording the decimal and accepting 5.00 as 500.00
(example).

 

· Important Due Date Reports
 

All Important Due Date reports now include the account name.
 

· Bring Current Screen
 

The service fee is now displayed on the screen. 
 

26.8 Version 2.0.4
 

Version 2.0.4
 

 

Modifications in this version:
· I.R.S. E-File
 

Per the requirements for the Electronic Filing for the I.R.S. we have modified the creation of the
electronic file creation.  The procedure remains the same to create the file but modifications to the file's internal
structure has changed.  This change was approved by the IRS   in February.

 

· Bi-Monthly
 

Per the request of some of our clients we have added the ability to set the payment schedule for twice a
month.  This would put the due  dates every 15 days.

 

NOTE:  This is a beta feature.  Please direct any questions, comments, or suggestions to Terry Ryan
at terry@thetrakker.com.

 

26.9 Version 2.0.2
 

Version 2.0.2
 

 

Modifications in this version:
 

· Coupon Printing
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Corrected an error on the form where the Zip code was replaced by the phone number on Lender information.
Corrected an error on the header where if the header is set to lender and the lender is a corporation, the first name

on the header will appear as a " $ ".
 Corrected an error when "Mail To" was selected to Servicer the program printed the Lender Information
 

· Property ID ( In the Appraisal / Description screen )
 

Corrected a problem where the program would not "Hold" the information that was entered. 
Note:  If you currently do not have any information entered in this field but do have appraisal description the information

on the description may by "copied" to the Property ID field.  To correct, just delete the information in the Property ID field and
enter the correct information.

 

· Payment Summary Report
 

Corrected an issue when you begin entering in a date the curser does not "Tab" to the next field.
 

· Year End Summary Report
 

Corrected an issue when you begin entering in a date the curser does not "Tab" to the next field.
 

· Interest Paid Report
 

Corrected an issue when you begin entering in a date the curser does not "Tab" to the next field.
 ·  Escrow Transaction Report
 

Corrected an issue when you begin entering in a date the curser does not "Tab" to the next field.
 Corrected an error on the report on the way the date's year is printed ( ie.  101 – instead of 2001 ).
 Corrected an error if the report is pulled with a specific loan class code the report prints without any account

information.
 

· Suspense Account Summary Report
 

Corrected an issue when you begin entering in a date the curser does not "Tab" to the next field.
 

· Contact Log
 

When an account is purged from the system Version 2.0+ now records which account was purged and who purged the
account. However, this entry was being placed in the next account in the system.  Example:  Account 1015 is purged, the
entry of what account and who purged it would be placed in Account 1016.  This entry is now recorded to Account 0000 and
can be viewed by pulling up the Purge Log.

 

New Feature:  Purge Log
As with Version 2.0.2 you can now view the Purge Log from the main program screen by selecting Review, Loan, Review

and entering in "0000".  This is a secured area so you will need to contact your program Administrator for your "Rights" to
this section.

 

· Other Contacts (In the Borrower's Screen)
 

Corrected an issue where all information is recorded on an additional contact except the Last Name.
 

Note:  In order for the program to record the State location you must have the Country location selected also.
 

· Purge
 

Corrected an issue if an account is purged then the Borrower information on the accounts following the account
purged moved up one        account.  Example:  Acct 1010 is purged.  Account 1011 will have the borrower information for
account 1012.

 

 

26.10 Version 2.0.1
 

Version 2.0.1
 

 

 

Modifications in this version:
 

· Payment Summary Report
 

Corrected an alignment problem where the totals Fees and Service Fees totals did not show up on the report.
 

· Interest History Report
 

Added Accrual Adjustment Column
 



Version History 344

Copyright Multi-Financial Services Company, Inc. 2012©

26.11 Version 2.0.0
 

What's New in 2.0
 

 

New Features in this version:
 

· Credit Reporting
 

You can now create an encrypted file that can be sent to the credit bureau.  We have tested this function with the
following credit agencies and each has tested to be fully compliant.

 

Trans-Union
 

Experian
 

Due to "Internal Policies" within Equifax we were unable to verify that our file that was created per their specifications is
correct. Therefore we cannot, at this time, verify that the Equifax file can be read by that agency.  We are working to find a
way around this issue and will let you, our customers, know when the file has been verified.

 

Please refer to the following sections for more details:
 

Setting Up Your System For Credit Reporting 
 

How to Generate A Credit Reporting File 
 

Account Credit Reporting Information 
 

Note:  When a credit file is created a report will automatically print that will inform you of ANY accounts that were not
reported due to an error. To prevent these errors please make sure that all borrower and co-borrower information is
complete.

 

NOTE: Upgrade Information
 

After you have upgraded your program to Version 2.0, you will need to go into each account and edit the borrower's and
co-borrower's personal information.  This is due to the program now storing full information on each person listed on your
accounts.  For example, if you have a borrower and co-borrower on a Joint account, you will need to go to that account and
edit the borrower's personal information and make sure that all of the information is entered and is correct.  You will then
need to edit the co-borrower's personal information and make sure that all of the information is entered and is correct.  

 

To change the personal information on your borrowers and co-borrowers please go to the account screen, choose
Change, General, and then Borrowers, a new screen will then open.  To edit a borrower's information click on that borrower's
name and choose Edit.  Please note that there are three tabs at the top, Borrower, Address, and Demographics.  To edit a
co-borrower's information choose the co-borrower's name and click on Edit.  There are two tabs at the top for a co-borrower,
Borrower and Demographics.  If the address differs from the main borrower on the account choose the option at the bottom
of the Borrower tab "If the address is different click here", and the Address tab will appear.

 

· User Defined Fields
 

We have added 250 user-defined fields to allow you to better keep track of information on each of your clients.
 

Please refer to the following sections for more details:
 

User Defined Fields 
 

· Enhanced Security
 

Per our valued customer's request we have greatly expanded the security of the program.  There are now many
more areas of the               program, which are secured.  Instead of making the user login over and over again we have
made a single login that keeps track of what is done within the program.  You can review the security section for more details
at:  Program Security 

 

Modifications in this version:
 

· Coupon Book Options
 

You now have the ability to select "Lender" or "Servicer" for the following options on the coupon book:  Cover Page
Header, Make Checks Payable To, and Mail Checks To

 

Please review:  AUTO COUPON PRINTING 
 

· Pre-Payment Penalty
    Now included in the Payoff calculation.
 

Please review:  PAYOFF 
 

· Escrow Analysis 
 

Report modified due to penny difference on some instances.
 

· EDI Link modifications
 

The EDI Link now imports more information than ever before.  
 

Please review  ESTABLISHING EDI LINK WITH ORIGINATION SOFTWARE  
 

· I.R.S. File Generation
 

The file that is generated has been modified per I.R.S. Requirements
 

· Loan Import Report
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    After you import a loan the report that is generated now displays the new accounts and what lender number was
selected.

 

· Investor Payment Summary Report
 

Adjusted the lineup at the bottom of this report to allow for a figure larger than 11 digits.
 

· New Loan Report
 

Fixed report due to a error when generating this report for a large number of accounts.
 

· New Loan Wizard:
 

EDI Link:  When utilizing the EDI Link the "Loan Class Code" was grayed out. This will now be an editable field when
using the EDI Link. Late Fee  Screen:  When the "No Late Fee" selection is selected the dollar amount did not gray out, and
when the "No Service Fee" selection is selected the dollar amount for "No Late Fee" grays out. This has now been corrected.

 

Borrower information screen now accepts up to six borrowers.
 

Various other additional fields related to Credit Reporting were added.  Fields such as Loan Type, Portfolio, and
Additional Borrower Information.

 

Modifications to the Help File:
We have made a large number of changes to the help file to better assist our customers.  In future releases and updates

please check this section for a summarized list of the items modified and/or added in the help file.
New Sections
 

· Full Walk through on the New Loan Wizard Entering A New Loan  
 

· Utilization of the Suspense account      Utilizing The Suspense Account 
 

· How to input various common types of payments Different Types Of Payments 
 

· Network Setup Networking 
 

· Workstation Setup     Workstation Setup 
 

· Credit Reporting Setup and Use
Setting Up Your System For Credit Reporting  
Account Credit Reporting Information 
 

How to Generate A Credit Reporting File 
 

· Full Instructions on how to submit your data to our support staff    Submit Your Data To Our Support
Staff 

 

· Modified the Forms Ordering Section  

Forms Ordering 
 

Appendix F 
 

Modifications to this version
 

 Complete directions on how to setup your program
 

Adjusted reports to better preview an actual printout
 

All items relating to the setup of a loan have been re-written due to the changes of program version 2.0
 

Please note that there is now a single section that covers the New Loan Setup Wizard
 

The Table of Contents has be reorganized to better assist our valued customers
 

Importing existing data instructions and examples have been modified
 

More extensive Program FAQ section
 

More extensive Technical FAQ section
 

Updated the Program Security section
 

Added a variable to the Custom Letter Overlay Variables
 

Modified the Technical Support Request Form
 

Modified the Network Troubleshooting section
 

Sub Releases
 

Version 2.0.1 
 Version 2.0.2 

Version 2.0.4 
 Version 2.0.5 
 Version 2.0.6 
 Version 2.0.7 
 



Version History 346

Copyright Multi-Financial Services Company, Inc. 2012©

26.12 Version 1.6.0
 

What's New In Version 1.6.0
 

 
 

When we set out to create a new version we ask ourselves, "How can we make the program easier for our clients to
use?" 

 
 

We knew that improving an already user-friendly program was going to be difficult. So what did we do to handle this
situation? We looked to you, our valued clients.  Through questionnaires, client comments and suggestions we have been
able to improve upon the program to better suit the needs of you, the user.

With added features such as:
 

AUTO COUPON PRINTING 
 

Having the ability to print multiple Coupon Books with the click of a button. Global parameters are set and the Coupon
Dates are automatically updated. For more information follow the link above.

 

 

Separate menu choices for CHANGING LOAN AND PASTDUE FEE BALANCES 
 

By adding separate menus for Balance Adjustments or Fee Adjustments the functions are now easier to find and utilize.
Even Prior Interest amounts can be administered in just a few easy steps. Reversal of Borrower Fees is tracked in the
Comment Log as well as in the Transaction window of the Borrowers screen to create an easier path of tracking monies. (
Reversed fees are no longer entered into the suspense account by the program.)

 

 

Automatic Updating of the Coupon Book Due Dates when using manual Coupon Printing
 

No longer does the end user have to manually update the Important Due Dates database whenever new Coupon Books
are printed manually. The program will automatically update the Due Date saving you both time and money.

 

 

The ability to print Coupon Books after competing the new loan wizard. (Please refer to Enter A New Loan)
 

You are now given the option at the end of the New Loan Wizard to print a Coupon Book for any new account entered into
the program. In order to utilize this convenient feature you must first define the Auto-Coupon Parameters as outlined in 
AUTO COUPON PRINTING. 

 

 

Y2K Compliant 
 

Enter 2 digit or 4 digit years in any of the date fields in the program. The program can recognize dates in either format for
easier use, less keystrokes and fewer mistakes.

 

 

Allowance of future dates in the New Loan Wizard
 

For those loans that have pre-paid credit that must be recorded the software will now allow future dates to be entered
in the Last Payment Received field for easier tracking of interest when posting payments. The maximum is 60 days forward
from the date the loan is entered (For more information please refer to Enter A New Loan).

 

 

Automated Back Ups of the Late.dta and Comment.log files.
 

Now whenever the Collection System automatically prints Past-Due Notices the program will automatically create a back
up files based on the system date to aid the user in recovering this valuable data in the event of errors during the printing of
Past Due Notices. For example the late.dta file will be called late040220001.bak if the Past Due Notice utility was executed
on 04/02/2001. These back up files will be stored in the same folder you use to house the program (by default this folder is
called MFS).

 

 

Principal and Interest Payment Calculations
 

Once information such as Loan Balance, Interest Rate and Term have been entered, enter the amount of the payment
and when you click on Next (see Enter A New Loan), Trakker will perform a standard calculation used for generating
payments and compare it to the payment amount entered. If the two amounts are different then Trakker will display a
message with the amount the program calculated. Click Yes to go back to change the payment amount entered or click No
to proceed with the New Loan Wizard. NOTE: Multi-Financial Services Co., Inc., Trakker Loan Servicing Software™
does not advise any of its clients, either current or potential, to deviate from the payment amount expressed on the
Legal Note made between our clients and their borrowers. The new P&I Calculation feature is intended to be used
as a guideline to prevent major data entry errors when entering new loan information. Any deviation from the
payment amount stipulated on the Legal Loan License Agreement is strictly the decision of the client and/or their
company's management.

 

 

Escrow Reserve Parameters
 

Users now have the ability to manage how many months they will allow for a reserve amount when dealing with
escrow accounts (Please see ESCROW ACCOUNT INFORMATION for more on working with Escrow Accounts). Choose
from either 0, 1 or 2 months. NOTE: In accordance with Federal Laws, Trakker Loan Servicing Software ™ is not
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currently set to allow more than 2 months of Escrow Reserve to be kept in the system. If the amount is in excess of
the 2-month reserve limit at the time an Escrow Analysis is ran a warning message will be displayed and Trakker
will not execute the analysis will be displayed.

 

 

Have checks made payable to either the Servicing Company or the Lender
 

Now companies have the option to choose whether to have the Servicing Company's name or the Lender's name printed
on the Coupon Books in the Make Checks Payable To section. By default this option is set to Servicing Company. To
change this option from the Servicer to the Lender simply change the selection found under Auto Coupon Options in the
System, Parameter Options menu. (See AUTO COUPON PRINTING for more on changing Auto-Coupon Options.) Note:
The Servicing Company's mailing address will still be used when the Make Checks Payable To option is set to
Lender.

 

 

And by increasing the power of previous features such as:
 

Convert Data (Please see Utilities for more information)
 

Now all files, both binary and text, are exported to the Dataout folder for easier access to pertinent data for reporting
purposes. Use Excel, Word or Access to view the data and create easy and meaningful reports.

 

 
 

ACCOUNT SUMMARY REPORT  
 

We have added Original Loan Amount and Per Diem Totals to the report to aid in financial reporting. Also included is
the option to include Closed Loans as well as Accrual Amounts on any given day (future dates are still not allowed).

 

 

ESTABLISHING EDI LINK WITH ORIGINATION SOFTWARE  such as Calyx Point, Byte's The Qualifier Series and
Contour's Loan Handler

 

By using the Electronic Data Interface (EDI) you save time and money when the program directly imports pertinent
information from these various origination programs. With our newest member, Calyx's Point, importing loan information is
done in just a few easy steps, most of which can be done directly from the Point borrowers screen.

 

 

MISCELLANEOUS DATABASE 
 

With added tracking features such as No Late Notice Printing and Borrower Pay Fees as well as ACH Borrower and
Points Paid keeping track of important data is easier than ever. The Miscellaneous Database can track these criteria and
keep you from wasting money sending Late Notices or even Coupon Books to accounts that do not require them (such as
ACH Borrowers or Bankruptcies).

 

 

CUSTOM LETTERS AVAILABLE FIELDS 
 

By improving fields such as ~total_next_due~, ~bring_current~ and ~interest_due~ you, the user, can create custom
letters to fit the needs of your business. Custom Letters such as, Interest Due Invoices or Custom Past-Due Notices are just
a few of the options available to you when using this powerful feature. (For more information on creating Custom Letters
please refer to CUSTOMIZING LETTERS.)

 

 

Accrual of Interest 
 

The accrual of interest has been modified to better account for loans paid ahead and those paid in arrears. As such, an
"adjustment" column has been added to the Accrual Report that is available on-screen and in print. Should you have any
questions on changes made, please contact our Programming Department directly at 800-326-4112 x 306

 

 

What does all of this mean to you the user?
 

 It means increased productivity with fewer man-hours.  With all of these added features plus FREE Technical Support
Version 1.6.0 is by far the most innovative Loan Servicing Software on the market today.

 

What's Next?
 

What can you look forward to in our next version release?
Look for features such as:
 

Credit Bureau Reporting
 

Export pertinent information to generate a file used in reporting to various Credit Bureaus
 

Just a few of the new fields being added specifically for this feature:
 

Portfolio
 

Loan Type
 

Appraisal Amounts
 

Race, Gender, Date of Birth information and much more…
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Co-Borrower Screens
 

Additional fields such as Co-Borrower Names, Addresses, Home and Work Phones to enable lenders to enter
c0-borrower information

 

 

Additional Contact Screens 
 

Additional screens to enter secondary contact persons, phone numbers and addresses for the purpose of debt collection.
Other screens will include Collateral Description and Persons Associated with the loan.

 

 

Additional User Defined Fields
 

When additional fields are needed that are just not provided by default in most programs you will have the added fields
needed for those unique situations where default fields are just not enough. With additional fields types such as:

 

Dates
 

Decimal
 

Memo
 

Numeric
 

Alpha
 

You will have all of the additional space needed to track loan specific information for the ever-changing world of Loan
Servicing.

 

System Wide and User Defined Defaults
 

Now users will be able to define default settings for information in the New Loan Wizard. No more having to enter
information that is a company standard over and over again. Simply set the defaults under the System, Parameter Options
menu and these defaults will be the standard for every new loan entered into the system but still allowing the user to change
from the defaults for those loans that fall outside the normal.

 

Some of the User Defined Defaults will include:
 

Lender Number – for those who are the only lender that they service
 

State – in both the Collateral and Mailing Address screens
 

Late Fees – User can set a System wide standard for late fees assessed
 

Service Fees – For companies who service loans for other lenders
 

 

System Defined Defaults (System Defined defaults cannot be changed to default to another selection by the user but
users will be allowed to change the selection for that particular loan that they are entering) will include:

 

Borrower Type – set to individual
List Loan Comments – set to the "On" position
 

Payment Period – set to monthly
 

Loan Type – set to straight
 

And this is just a few of the defaults to make entry of new loans easier and more efficient.
 

 
Have an Idea or Question?
 

We welcome any suggestions that you may have for future versions and encourage you to contact our Help Desk either
by phone, fax or email.

 

26.13 Version 1.5.0
 

Version 1.5.0 As Of 1/24/00
 

 

Below is a summary of all the major and minor changes made to your loan servicing program since Version 1.4.0 came
out.  This is a VERY COMPLETE summary of all changes and it was felt that even minor changes would be of some interest
to you and your staff; especially, if your company made a request to change something.  If a particular change affects the
HELP file, you'll also find a "link" linking you directly with that HELP topic for additional information.  Additionally, at the end
of this list, you'll find a list of projects either currently under way or anticipated in the coming months.  As always, thank you
very much for your suggestions and also your patience as changes move along in the project list.  

 

1.5.0       -NEW HELP FILE TOPIC CREATED DESCRIBING :HUD ESCROW ANALYSIS" AND  HOW IT WORKS ( HUD
AGGREGATE ESCROW ANALYSIS 

 

 

-ENHANCED THE "REGULAR AMORTIZING INTEREST ACCRUAL METHOD" TO ACCOMMODATE CHANGES MADE
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BY YOU IN AN ACCOUNT'S BALANCE (POSTITIVE OR NEGATIVE) WHICH THROWS OFF THE ORIGINAL
AMORTIZATION SCHEDULE (SEE Accrual of Interest FOR ADDITIONAL INFORMATION)

 

 

-ENHANCED INTEREST ACCRUALS IN GENERAL BY ALLOWING THE ABILITY TO CAPTURE INTEREST PAID
"LIFE TO DATE" OF AN EXISTING LOAN BEING SETUP – AN EXISTING LOAN WILL BE RECOGNIZED WHEN THE
"DATE OF NOTE" AND "DATE OF LAST PAYMENT" ARE DIFFERENT – ADDITIONAL FIELDS WILL THEN BE
DISPLAYED ON THE FOLLOWING SCREEN REQUESTING "LIFE TO DATE" INTEREST FIGURES 

-ESCROW ANALYSIS REPORT WAS HAVING A PROBLEM WITH CORRECT ADJUSTMENTS - THIS IS NOW FIXED
 

 

-SPELLING OF "PRINCIPLE" TO "PRINCIPAL" FIXED ON THE PAYMENT OVERAGE SCREEN
 

 

-FIXED PAST DUE CHECK FEE WHEN IT WOULD NOT REVERSE WITH LATE FEE
 

 

-CORRECTED BRING CURRENT OPTION CALCULATING THE AMOUNT CORRECTLY FOR INTEREST BEARING
ACCOUNTS

 

 

-NEW HISTORY LETTER "END OF YEAR STATEMENT" FOR ALL CLIENTS HAS BEEN CREATED
 

 

-ON THE PAYOFF WHEN THE CHECK AMOUNT IS LESS THAN A PAYOFF - THE SPECIFIC INTEREST + LATE FEE
HAS TO  BE DEFINED IN THE "DUE BOX" THE LATE FEES WERE NOT BEING ADDED TO THE PAST DUE FEES SO
YOU COULD NOT TELL THE CORRECT FEES AMOUNT. THIS HAS BEEN FIXED

 

 

-ADDED "SUBTRACT FROM SUSPENSE" INTO THE PAYOFF SCREEN

-FIXED "COLLECTION CALL REPORT" FOR PRINTING AFTER PAGE 2
 

 

-HISTORY LETTER INCLUDED THE ENTIRE ADDRESS AS WELL AS THE ACCOUNT NUMBER ALSO MOVED THE
LETTERHEAD TO THE TOP OF THE LETTER AS REQUESTED BY CLIENT

 

 

-POSTING TO SUSPENSE WAS ADDING THE LAST BALANCE OF THE PREVIOUS RECORD IN THE
SUSPENSE.SSP FILE TO THE BALANCE OF THE CURRENT RECORD PLUS THE AMOUNT BEING POSTED TO
SUSPENSE

 

 

-FIXED THE DELINQUENCY REPORT WITH A MINOR Y2K PROBLEM PRINTING DATES
 

 

-MODIFIED THE DELINQUENCY REPORT TO PRINT CONTACT LOG COMMENTS FROM DECEMBER 

 

-THE CONTACT SCREEN FOR COMMENTS HAD AN UNLIMITED TEXT EDITOR FOR THE DATE RANGES
 

 

-THE NEW HELP FILE TOPIC Yearly History Statement to Borrower WAS CREATED FOR THE "END OF YEAR
HISTORY STATEMENT"

 

 

1.4.9 -FIXED DATE PROBLEM WHEN SUSPENSE REPORT INVOLVING A DATE OF 1ST OF ANY 30 DAY MONTH
 

 

-ADDED A VARIABLE TO LETTERS.OVL AND CUSTOM1.OVL AND CUSTOM2.OVL CALLED:
 

"TOTAL_NEXT_DUE"
 

 -WHICH ADDS THE "BRING CURRENT" AMOUNT AND THE "NEXT MONTHLY PAYMENT" AMOUNT.  SEE HELP
TOPICS:

 

CUSTOM LETTERS AVAILABLE FIELDS 
 

-EDI LINK IMPORTER PROGRAM READY FOR USE WITH CALYX'S "POINT" ORIGINATION PROGRAM
 

 

-ADDED WARNING MESSAGE FOR OTHER "HOW PAID" CODES IN BOTH INCORRECT POSTING AND NSF
CHECK THIS WILL LET THE USER KNOW WHEN THEY REMOVE A TRANSACTION WITH AN OVERAGE TO
SUSPENSE

 

 

--NEW HELP FILE HAS DIRECTIONS ON IMPORTING FROM POPULAR LOAN ORIGINATION PROGRAMS (E.G.
CONTOUR, BYTE, POINT) – SEE:

 

ESTABLISHING EDI LINK WITH ORIGINATION SOFTWARE  
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--CORRECTED MINOR Y2K GLITCH IN VIEWING PAYMENT HISTORY SCREEN
 

 

-CORRECTED SERVICE FEE TOTALS ROUNDING PROBLEM IN REGULAR AND INVESTOR PAYMENT SUMMARY
REPORTS

 

 

-ENHANCED VOID/INCORRECT POSTING WARNING MESSAGE WHEN PAYMENT ORIGINALLY CAME FROM THE
SUSPENSE ACCOUNT

 

 

-ENHANCED VIEW/HISTORY FOR SUSPENSE TRANSACTIONS – NOW BETTER DESCRIBES EACH
TRANSACTION FROM AND TO THE SUSPENSE ACCOUNT

 

 

-CHANGED VOID/NSF ROUTINES:
 

-NOW PUTS FULL PAYMENT BACK IN SUSPENSE IF THE PAYMENT WAS ORIGINALLY A SUSPENSE TRANSFER
-ELIMINATED THE ARE IN THE NSF BOX INDICATING, "LOAN ONLY" AND "SUSPENSE ONLY" SINCE NEVER

USED
-CREATED NEW ACTION CODES FOR VIEW AND PRINT HISTORY FOR INCORRECT POSTINGS AND NSF

RETURN CHECKS
 

1.4.5  -A NEW OPTION WAS CREATED FOR INTEREST BEARING ACCOUNTS TO INCLUDE 360 DAY
INTEREST CALCULATION OPTIONS IN ADDITION TO STANDARD 365 OPTION

 

26.14 Version 1.4.0
 

VERSION 1.4.0  AS OF 8/12/99
 

 

INTRODUCTION
 

Version 1.4.0 has the following changes and are more fully described in the sections below and the HELP file sections as
indicated:

 

-Balances and past due fees can now have various fees/amounts added to them manually via a password secured
function based on user defined;

-Custom letters and letters in the Letters.ovl file can now have:
-Fonts changed
-Underline, bold, and italicize letters
-Size of letters changed
-Left and right margins defined
-Labels can now be created for use on multiple column label forms
-Suspense report has been modified to better assist servicing personnel balance to daily deposits

 

-PRELIMINARY accrual of interest shown now on the Account Summary Report
 

The following changes are readily apparent are just for your informational purpose:
 

-The borrower's credit history is now on their Main Borrower Screen (account status now at the top)
-Fixed rate is the default when inputting a new account; thus, an imputer can easily tab to the next field
-Payment screen now has current date, regular payment amount, and check as defaults
-Corrected problem with Address2 printing on multiple past due notices

 

PROGRAM CHANGES
I.    CHANGING BALANCES AND PAST DUE FEES

Version 1.4.0 introduces our first foray into formal security clearances for users to perform certain functions since it
introduces the ability to change a loan's balance. In this version, functions that now require security authority now are:

 

-Purging
 

-Changing an Account's Balance (includes adding "outside" fees to the Past due Fees Column on the Borrower
Screen);

 

We've had several requests to increase/decrease a loan's balance for various reasons. Some of which are:
-Principal payments between regular payments by a borrower
-Government grant funds received to lower the balance

 

-Fees have been incurred by the borrower that should be added to the loan balance (note: fees can also now be
added to "Past due                      -Fees" if the user so wishes for these extra fees)

 

Neither of these actions will change the due date of the loan.  
 

Specifically, "Security Authority" means that each licensee needs to determine who within their organization will have
authority to perform each of these highly sensitive functions; especially, being able to change a loan's balance! As our
clients request other functions that we consider to be "high security", these will be added to the security authority menu.
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The following new HELP topics will assist in implementing this new function:

Program Security 
CHANGING LOAN AND PASTDUE FEE BALANCES 

II.   CHANGING FONTS IN CUSTOM LETTERS AND LETTERS.OVL FILE
 

You are now able to bold, underline, & italicize characters in addition to setting a left margin for one or more lines.
 

Please see the following new HELP topic for these changes:
Changing Fonts in Letters 
This topic is also referenced in:

 

CUSTOMIZING LETTERS
 

III.   MODIFIED SUSPENSE REPORT
 

Due to a request from some clients, the Suspense Report has been slightly modified to better define Beginning and
Ending Balance changes in order to balance to daily deposit slips.

 

Please see the following modified HELP topic:
 

SUSPENSE ACCOUNT SUMMARY 
 

SUSPENSE ACCOUNT SUMMARY REPORT -SAMPLE     
 

And the following related sections related to Balancing Procedures that have been affected:
Balancing Procedures 
Appendix G 

IV.       PRELIMINARY ACCRUAL – ACCOUNT SUMMARY REPORT
 

This PRELIMINARY/TEST modification to the Account Summary Report allows users to obtain an accrual figure for all
their loans monthly on the last day of each month.  This function is in a "test" mode and all clients needing accruals are
urged to review the results and the new section on Accrual of Interest and then make comments via phone call, fax,
or e-mail (support@thetrakker.com) as soon as possible.  For more extensive information please see the following new
HELP topic:

 

Accrual of Interest 
And the related Account Summary Report, which has been modified:
ACCOUNT SUMMARY REPORT 
ACCOUNT SUMMARY REPORT - SAMPLE 

V.   SUSPENSE ACCOUNT CHANGE
 

Modified the suspense account when an insufficient check is received back on a prior payment.  Previously the date of
the original transaction was written to the suspense data file, thus, when balancing that week the suspense report's
Beginning Balance will not be consistent with last week's Ending Balance.  Now the date of the return check transaction will
be reflected in the Suspense data file and each report will show correct ending and beginning figures from week-to-week.

 

Likewise, the inputting of the Beginning Date has been modified to be consistent with all other reports requesting date
ranges.  That is, if June 30th was the last balancing date, the beginning date for the next balancing will be July 1st instead of
June 30th as previously done and caused inconsistency with other reports.

 

VI. PRINTING COUPON BOOKS FOR SIMPLE INTEREST LOANS
 

Yes, coupon books can now be printed for Simple Interest loans!!  Information regarding interest, principal, and escrow
paid has been omitted to avoid any confusion to the borrower.  Your servicing program will recognize interest types
automatically (Simple Interest and Regular Amortizing) and will be transparent to the user printing coupon books; thus,
books can be printed now for ALL accounts whether interest is calculated on the Simple Interest or Regular Amortizing
methods.

 

 

VII. CORRECTION: NOT ENOUGH LEFT FOR ESCROW PAYMENTS ON SIMPLE INTEREST LOANS
 

This correction now takes the Escrow payment out FIRST prior to taking any past due or current interest for Simple
Interest method loans.  

 

VIII. BACKING UP DATA FILES
 

A new section, Backing Up Data Files- IMPORTANT!!  , has been added and is extremely important!  Please read as soon
as possible!!

 

IX. PASTDUE LATE FEE NOTICES
 

A generic Past due Late Fee Notice has been added to the Letters.ovl file for your use.  It has been formatted to be used
in conjunction with our standard Past due Notice Mailers.  Naturally, you can change wording, format, etc. as your company
wishes.  (NOTE: THE PROGRAM DOES NOT SEND THESE NOTICES TO ACCOUNTS PREVIOUSLY IDENTIFIED IN 
COLLECTION SYSTEM AS ACCOUNTS THAT SHOULD NOT BE CONTACTED FOR PREVIOUSLY DEFINED
REASONS) This notice can be found at the very end of the Letters.ovl file.
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The CUSTOM LETTERS AVAILABLE FIELDS has been modified to better define "Local Variables" and which
letters/notices they are ONLY used in.  An additional variable has been added, "Local 3" which at this time is used ONLY in
the new Past due Late Fees Notice.

Lastly, the "INDEX" of the HELP file has been considerably changed to allow extensive searches based on key-words
inputted.  This Index will continue to be updated over time.

 

CHANGES BEING WORKED ON 

AUTOMATIC POSTING OF PAYMENTS, I.E. BATCH PROCESSING
 

We're now working on automatically posting of payments in two ways:
 

-Receiving a simple ASCII text file having the loan account number and dollar amount paid
-Develop a screen where the input operator inputs a deposit slip date, then enters an account number and dollar amount

for each payment, provide a sub-total for each deposit slip, continue posting other deposits if it balances, and then
post all payments automatically when input is complete.  This will require "pre-entering" into the System part of the program
such things as your company's policies on such things as:

 

-What should be done on payment overage's:
-If account is current
-If account is past due

 

-What happens to small amounts in suspense when a suspense transfer is made and the account is now current
-How should multiple payments be handled if there are outstanding late fees
 

-What to do with payments just received that are less than the regular payment
 

To mention just a few of the recognized decisions your management will have to make prior to effectively using this new
function – PLEASE SEND COMMENTS ON THIS FUNCTION TO: support@thetrakker.com or fax them to:  850-562-8532.

 

INTEREST ACCRUALS
 

Responses will be reviewed for the initial release of interest accruing for Interest Bearing/Simple Interest loans,
modifications made, and then we'll proceed to accruals for Regular Amortizing loans.  Your comments for Regular
Amortizing loan accruals are urgently needed for this important project on such things as:

 

             -Accruing new loans in the first 2 months with and without prepaid/credit interest
             -Accruing interest on paid off loans in the last month
             -Accruing interest on multiple payments in one month
             -Accruing interest on past due and/or paid ahead loans
 

Naturally, our company CPA will be advising on FASB accounting standards, however, your individual input is requested.



Part

XXVII
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27 Technical Information

27.1 Program FAQ's
 

 

Listed below are some of the most commonly asked questions about the Trakker program and the links that will provide
their answers.

 

Reports
 

Question – What is the Account Summary Report and how do I run the report?
 

Answer   – This report will print the following information: loan account number, name of the borrower, date and amount of
last payment received, next payment due date, amount past due (if any), beginning and ending principal balances, escrow
balance (if any), and suspense account balance (if any).  

 

· To run this report:  From the main screen click on Reporter, Management Reports, and Account Summary Report.
 

· More Information on this report can be reviewed at:  ACCOUNT SUMMARY REPORT 
 

· An example of this report can be seen at:  ACCOUNT SUMMARY REPORT - SAMPLE 
 

 

Question – What is the Payment Summary Report and how do I run the report?
 

Answer   – For each lender and/or loan type specified, this report will print those loans with payment activity during a
period of time specified by the operator.  The following information is printed:  loan account number, name of the borrower,
date payment was received, the amount of principal and interest paid, the balance of the account, the escrow balance (if
any), any late fees that were paid, and the servicing fee charged.

 

·  To run this report:  From the main screen click on Reporter, Management Reports, and Payment Summary Report.
 

· More information on this report can be reviewed at:  PAYMENT SUMMARY REPORT 
 

· An example of this report can be seen at:  PAYMENT SUMMARY REPORT - SAMPLE 
 

 

Question – Is there a report for viewing interest that has been paid?
 

Answer   – There are two reports that will show the amount of interest that has been paid, Interest Paid Report and
Payment Summary Report.  

 

· To learn more about these reports please click on the appropriate link:  INTEREST PAID REPORT  PAYMENT
SUMMARY REPORT 

 

· An example of these reports can be seen at:  INTEREST PAID SUMMARY REPORT - SAMPLE PAYMENT
SUMMARY REPORT - SAMPLE 

 

 

Question – How do I print out a Coupon Book for my borrowers?
 

Answer   – As of Version 1.6.0 there are now two ways to print coupon books.  
 

· The first and most productive is the Auto-Coupon Printing function.  This function allows the program to "look" at each
account, the last date on the last coupon that was printed for that account, the next due date, and decide if the
account(s) need a new coupon book or not.  This function looks at ALL accounts and the information related to each. 
To use this function you must first have the number of coupons setup in the Auto-Coupon Options section of the
Program setup.  

 

· More information on Auto-Coupon Printing can be reviewed at:  AUTO COUPON PRINTING 
 

The second way is to print the coupons manually.  This allows you to print or re-print a coupon book for a single
account.  

 

To print coupon books, either for an individual account or all accounts, from the main screen click on Reporter,
Utilities, and click on Coupon Book or Auto-Coupon Printing.

 

 

Review, Loan
 

New Account
 

Question – Several of my loans have pre-paid interest. How do I enter this into Trakker?
 

Answer   – On the 10th screen at the bottom you will see a section that deals with Pre-Paid and Credit Interest.
 

· To read more on this section of the New Loan Wizard please review:  New Loan Wizard - Prepaid Credit / YTD
Interest 

 

 

Question – What are Loan Class Codes and some of the ways they would be useful to me?
 

Answer   – The Loan Class Codes enable the user to be able to categorize loans and print reports by individual loan type,
if so desired.  Each code is user defined and consists of two characters that can be a number, a letter, or a combination of
both.  These codes give the operator the ability to analyze each TYPE of loan that is made; first loan, second loan, mobile
home, land, and so forth.  
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· More information on Loan Class Codes can be reviewed at:  LOAN CLASS CODES 
 

 

Question – I have posted a payment amount that is incorrect. How do I make the correction to reflect the correct
amounts?

 

Answer   – This can be done easily from the borrowers screen.  After you are in the account in which you want to remove
the incorrect payment, click on Void and Incorrect Posting.  Immediately after you click on Incorrect Posting the LAST
payment is removed from the system.  The payment that was removed should now have a PE in the HP (How Paid) column.

 

· More information on removing payments can be reviewed at: Incorrect Posting 
 

 

Review
 

Question – How is interest accrued by the Trakker program?
Answer   – Please review Accrual of Interest for full details.
 

 

Question – How do I create an invoice for loans that pay interest only for a certain period of time?
 

Answer   – This can be done via a customized letter.
 

· Please review our section on customizing letters at:  CUSTOMIZING LETTERS 
 

 

Question – When I post a payment how does Trakker dispense the funds to the account?
 

Answer   – Please review the following section for full details on this:  Post to Loan 
 

 

Other
 

Question – How do I remove an account from the Trakker program completely?
 

Answer   – In order to remove an account from the system you will need to purge the account.  It is advised that you make
sure that you have a full backup of the program prior to purging an account.  Once the account is purged it cannot be
retrieved and placed back into the system by any other means than re-input.  To purge an account go to the Main Screen,
click on System, Utilities, and Purge Account.  

 

· For more details on Purging Accounts please review:  Purge Account 
 

27.2 Technical FAQ's
 

 

 

Question - How do I backup my data, and how often should this be done?  What or where should I back it up to?
Answer-    Please review:  Backing Up Data Files- IMPORTANT!!  

Question - How do I tell the program how many coupons I want printed automatically when utilizing the Auto-Coupon
utility?

Answer -   Please review: AUTO COUPON PRINTING 

Question - How do I define users in the program, and what they can or cannot do?
 Answer -   Please review: Program Security 

Question- I have setup the program to be used on a network, but am experiencing some problems getting the program to
maintain settings like Custom Fees, Escrow Reserve, and Custom Letter Names.  How do I correct this?

Answer- This is caused when the program is unable to locate the Custom.ini file.  This can be corrected easily.  Please
review the section on  Networking and Workstation Setup and make sure that your setup matches.  If you are still
experiencing this problem please feel free to contact our support staff for further assistance. 

Question- Is the program ODBC compliant.
 

Answer- Yes, the program is ODBC (Open Database Connectivity) compliant via the Convert Data utility.  You can use
this utility to export the encrypted data to a Dataout directory.  After it is exported you can use Excel, Access, Word, and any
other text editor that has the ability to read ASCII Tab Delimited files to create reports or any variety of functions.  To read
more on ODBC please view Microsoft's© documentation at:  www.microsoft.com/data/odbc/default.htm 

27.3 Add On Modules
 

 An Add-On Module is an external module that is directly tied into a primary software application.  Currently there are two
Add-On Modules available from Multi-Financial Services Company, Inc.  Both available Add-On Modules are designed to
add the ability to design custom reports.  
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Custom Reporter Add-On Module
 
Custom Reporter is an add-on module to The Trakker Loan Servicing Software, operating as a separate executable file,

and consists of one of various reporter development programs Multi-Financial Services Co., Inc. has reviewed and made
available to our clients and prospective clients.  

In general, the Custom Reporter will allow you to create many customized reports for your company using the hundreds of
different data fields Trakker utilizes to store data, including the 250 User-Defined fields.  Custom Reporter will also allow you
to create reports from other programs accessible databases.  Should you have any questions or problems using the Custom
Reporter, please call  the Help Desk at: 850-559-9123or E-mail at: support@thetrakker.com 

 
Should your company wish to purchase the Custom Reporter module, please call our Sales or the Help Desk Departments

at the same number.
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27.4 Technical Support Form
 

 Please Print, Fill Out and Fax to 1-850-656-3655
 

  Company Name   _______________________________________________    

  

  Address   _______________________________________________     

  

  City   _________________   State   _____________________  

    

  Phone Number   _________________   Ext.   _____________________
      

  Software Product   _________________   Version   _____________________
      

  Activation Code   ____________________________      

        

  Does your company have in-house technical support?     Yes / No       

        

  Machine Information          

           

    

  Brand of Computer   ______________________________________________   

    

  Available Memory (RAM)   ______________________________________________    Note:  These items
    Version of Operating System   ______________________________________________   can be located
by
   Other programs currently running                                                                                                                          
             ______________________________________________ Right clicking on "My Computer" and then
           

______________________________________________    Properties
             

______________________________________________       

  Printer Brand and Model   ______________________________________________   

    

  Is the Printer local or networked                                                                                                                        
   ______________________________________________       

  If the problem is a printing problem have you tried another printer?  

______________________________________________       

    If So, What type of printer?   ______________________      

  Program Information          

           

    

  Exact wording of error message                                                                                                                        
                         _______________________________________________________   

           

_______________________________________________________   

  Describe the problem fully   _______________________________________________________  

           

_______________________________________________________   

  Can you consistently reproduce the problem?                                                                                                        
                                         _______________________________________________________   

  What steps do you take to reproduce the problem?                                                                                         
                                                        _______________________________________________________  

                                                  
                                                                                                       
_______________________________________________________   

  Have you experienced this problem before?     Yes / No        

           

  If Yes, what was done to correct it last time?                                                                                                        
                                         _______________________________________________________   
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27.5 Forms Ordering
 

 

Various forms are available from Multi-Financial Services Co., Inc. including:
  
Ø Coupon book forms
Ø Past due notice forms
Ø IRS 1098 yearly interest paid forms
 
 
With the exception of the past due notice forms, all forms are available for dot matrix, laser or ink jet printers.  All forms

are also available in a variety of quantities to meet your individual needs and are all shipped directly to your door!  Payment
is by invoice and due upon receipt.  IRS forms are pre-printed and are NOT printed from the program due to
CONSIDERABLE programming expense to meet IRS printing standards.  Forms are usually received within two weeks after
ordering.  For those having access to the Internet, forms can be ordered from the following location:www.thetrakker.com

 
If you do not have access to the Internet, please go to Appendix F , print out this topic, complete the order sheet and fax

to: 1-800-294-8532.
 
 

27.6 Program Troubleshooting
 
 
 

Problem: Am getting Error 100 and/or Error 101
 

Solution: This comes up when a report is run and is caused by an old purge program failing to remove all of the data
from the "nextdue.idx" data file.  Be sure you have at least Version 1.0.7.   If not, go to the program's web page 
www.thetrakker.com and download the "Latest Update" or call 850-559-9123 to have the latest version sent to you.  Once
received, re-purge accounts previously purged.  You can determine which have been by performing a "Data Out" (see 
Utilities) and then review the "mortgor.ata" file in the Data Out subdirectory. Since this file is in numerical order, any account
number that is missing has previously been purged.  Make a list of these numbers and re-purge.

 

Additional Information:  Error 100 or 101 
 

 

Problem: I am getting negative amounts in the "Past due" column on certain Borrower accounts.
 

Solution: Be sure you have Version 1.0.4 or higher.  This error was corrected with that version.  Also, this problem
existed only for Interest Bearing method accounts.  

 

 

Problem: Name of Lender, Servicer, or Borrower will not fit into their respective fields.
 

Solution: Try abbreviating their names.  This is a standard problem in any computer program when there is only so
much space to input information.

 

 

Problem: When inputting a new account, the same new account number is being received.
 

Solution: Some how your owner3.dta data file has gotten corrupted.  Using a text editor, bring up this file and you'll
see two numbers.  The one on the right is suppose to be the NEXT new account number.  Just change this number to one or
two numbers higher, then save the file.  

 

 

Problem: An open Borrower account is not showing up on the Account Summary Report.
 

Solution: The ONLY way this can happen (unless the account has been closed) is if the "Began Servicing Date" is
put in incorrectly when the account was originally entered, i.e. a date that is past the Account Summary report date.  This
can be confirmed by doing a System/Utilities/Data Convert routine and then view the "Mortgor.ata" file using a spreadsheet
program.  Look columns AC, AD, and AE for the mor.begin_date values.  If these dates are AFTER your Account Summary
Report date then the account was setup incorrectly and needs to be purged and re-entered.  If the date is correct, please call
us for additional assistance.

 

 

Problem: A closed account IS showing on the Account Summary Report
 

Solution: Somehow there are two accounts with the same account number.  Perform a Data Out routine
(System/Utilities/Convert Data).  Using a spreadsheet program, open the mortgor.ata file contained in the Dataout folder in
the MFS folder.  Look in Column D to see if another account is using the same account number.  If so, contact us for
additional assistance.

 

Problem: When posting payments the date in the Post to Loan box differs from the current date.
 

Solution: This occurs if the program is left open over one or more nights.  To correct this simply exit the program
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and restart it.
 

 

Other Resources:
Error 100 or 101 
Delinquency Report Errors 
Receipt Letter Errors 
ROUNDING ERRORS 
Incorrect Payoff Amounts 
Custom Letter Errors 

27.7 Submit Your Data To Our Support Staff
 Before starting the instructions below please make sure that our support staff are aware of the problem that you

are encountering.  This should only be done if our support staff has requested your files.  If you have any questions
please feel free to contact our support staff at 850-559-9123

 
Instructions to "Archive" and "E-mail" your software to our Help Desk Staff
First we need to locate your software
 
· Right click on your shortcut (icon)
. Left click on "Properties"
· Left click on the "Shortcut" tab
· Take note of the information in the "Start In" location

This is the location (folder) that your program is stored in
· Left click on "Cancel"
 
Next we will "Archive" your software
 
· Double click on "My Computer"
· Locate the folder that your software is stored in.
 
The following is an example; your program may be located in another location.  If it is your notes from the first step for that

location.
.  Double click on "C:\" then locate the "MFS" folder
· This is the folder that your software resides in.
· Left click on that folder  Ie: MFS
· Click on "File"
· Click on "Add to zip"
 
If you do not see "Add to Zip" please refer to our web site for a link to the WinZip download page.
· Type in:  C:\"today's date".zip
 
Example C:\08-16-01.zip
· This will backup your software to a Zip file and place it onto your computer
· Close your Zip program
 

NOTE: If you do not have WinZip© installed on your computer please consult your technician to make sure that you have
permission to install the           WinZip© program.  You can obtain the program at the following website:
www.winzip.com 

Now you have "Zipped" your software and it is ready to be sent in for repair.

This step will vary depending on what manner you use to send mail.  The instructions below are the instructions on how to
send a file using Hotmail.  If         you are unable to follow these directions for ANY reason please feel free to contact our
support staff either by phone or E-mail at 850-559-9123               support@thetrakker.com.

 
· Open your mail client (or browser)
 
  If by browser you need to sign in to your web based mail service
  Examples of a mail client: Outlook©, Outlook Express©
 
· Click on "Compose New Message" or "New Message"
· In the "Recipient" field enter: support@thetrakker.com 
· In the "Subject" field enter:
 
Please enter a brief description of the problem you are having
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I.e.:  Lost Password
I.e.: Error 101
 
· In the "Message Body" or "Message Area" enter:
 
Your Name
Your Company
Your Phone Number
 
A detailed description of the problem you are encountering
 
· Click on "Attach File" or "File Attachment" or "Add Attachment"
 
The terminology will vary depending on what manner you are using to send the message
 
· It will ask you "Attachment location"
· You can either type in the location of the file or click browse ( I will explain both )
 
Enter the location of the file by typing
 
Type in:  C:\"today's date".zip
 Example C:\08-16-01.zip
 
· Browse for the file
· Click browse
. Left click on "Look In" (or the down arrow to the right)
. Locate the Zip file we created in earlier steps
. Left click on the zip file 
· Click on "Attach" 
· You should now be back at the "New Message" screen 
· Click Send
 

27.8 Backing Up Data Files- IMPORTANT!!
 

 

 

The user of this loan servicing software is responsible for periodically backing up the program and its related data files. 
Due to today's technology, tape backup drives, zip drives, CD burners, etc. allow for easy and automatic backing up of
important data either for an entire hard drive or selected folders and/or files.  Naturally, the concept of backing up is
EXTREMELY IMPORTANT since loss of your data could and can adversely affect your company- even to the extent of
causing it to go out of business if extremely critical data is lost!  Ways of losing your data are many, for example:

 

Ø Electrical failure corrupts one or more data files
 

Ø Disgruntled employee decides to delete or substantially alter files
 

Ø Power surge wipes out the hard drive
 

Ø Electrical surge comes through the telephone line during a storm and wipes out data
 

Ø Your computer is physically destroyed in any number of ways
 

Ø Thieves steal your computer
 

 

The frequency of backing up is up to the user, however, is equally critical.  It could be on an hourly, daily, weekly, monthly
or some such time period.  Basically, the user simply has to decide:

 

"If my system were to crash, be destroyed, etc., how much data do I want to RE-ENTER and balance back to since the
last backup?"

 

Once that question is answered, then it's a simple matter of setting a time schedule AND sticking to it for making
backups.  Naturally, if your data files are located on a server to which all users have access, it is YOUR responsibility to
communicate your backup policy to the network's system Administrator to make sure it's done. Additionally, the user should
adopt a policy of storing backups "OFF SITE" in case some disaster affects the company's premises.

 

 

Secondly, once the frequency is determined the user needs to then decide how long to maintain prior backups.  It is not
unusual to maintain several/many prior backups; mainly in case one or more is also corrupt.

 

 

Third, if your servicing program's folder is going to be backed up individually it is suggested that ALL the contents of the
main folder are backed up.  It is NOT necessary to backup any sub-folders.

 

 

Fourth, it is HIGHLY suggested that backed up files be tested periodically to determine their actual usefulness.  It would
be equally disastrous if a wonderful backup policy were adhered to only to learn that the backed up data files were not there,
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were unrecoverable, etc.
 

 

Fifth, under certain circumstances, when a loss of certain data occurs and the user does not either have a backup or does
not wish to use the backup, but instead wishes the licensor (Multi-Financial Services Co., Inc.) to recreate certain data file, it
should contact the licensor and an estimated cost to do so will be determined. IF IT IS ABLE TO DO SO WITH AVAILABLE
DATA!!  This means that under certain circumstances, the licensor MAY NOT be able to reconstruct certain data files.  In
the event that a reconstruction is possible, the user should, naturally, understand that the licensor will have to do this task on
an availability of time basis but every effort will be made to assist the user in every manner possible.  

 

 

Lastly, again, it is your, the user's, responsibility to adopt and maintain an adequate backup policy within your company. 
Should there be any questions, please call the Help Desk at anytime (850-559-9123).

27.9 Printing Problems
 
 

 

Problem: Reports take an abnormally long time to print
Solution: Generally, operating on a standard 200-300 MH speed machine, with less than 1000 accounts, an Account

Summary Report should take approximately 5-10 minutes depending on the speed of the printer.  Likewise the Payment
Summary Report should only take 10-15 minutes.  If it takes much more than this, then your Screen Saver may be involved
and should be turned off.  Go to your Clipboard, hit your right mouse button once, choose Properties, Screen Saver, and
then indicate "None".  If you're connected to a network, printing will be slower if you're sharing a printer with other users. 
Also, if you are receiving a report with other users information mingled in with your report, please refer to the next
Problem/Solution below for a solution to this.

 
 
Problem: Printing jobs are being interrupted by other jobs printing either on the same paper or on other sheets in

between our print job pages.
Solution: Your PRINT SPOOLER needs to be changed to "Wait until last page is printed before printing". Go to My

Computer, choose Printers, choose your specific printer, and then choose properties/Details/Spooler Settings.  Choose
"Wait until last page is printed before printing" option.

 

Problem: I request a report, it spools, but nothing prints to my Network printer.
Solution: Try ending and recapturing the printer.
 

Problem: Prints only one line per page
Solution: Please refer to the second Problem/Solution.
 
 
Problem: Can't print anything or perform an EDI Link…. both are being done on the network
Solution: Check to see if all rights have been assigned and also try reassigning rights, making printers and program

are shown in the right location e.g. workstation or server.
 
 
Problem: I get "Illegal Operation" when trying to print Escrow Information
Solution: Check to see if there is any Escrow Information entered.
 
 
Problem: I installed the program in another folder on my machine or I've installed the program on another computer

and nothing will print now.
Solution: First, delete all the information in the new folder you created.  Second, re-install the program into the new

folder using your latest update diskette.  Third, now copy all data files into the new folder.  Everything should be ok now.
 
 
Problem: Past due notices are not printing correctly or within margin
Solution: Couple of ideas:  First, check to see if you have Version 1.1.0 or higher (go to Help and choose About and

you'll see the version number.  If not, contact us at :850-559-9123 to get this update since your letters.ovl file was changed
for Windows printing past due notices better.  If you already have Version 1.1.0 or higher, have you made some changes to
the letters.ovl file to "personalize" it for your company?  If so, go back in the letters.ovl file and continue editing.  

 

Problem: When printing past due notices, there are blank notices printed between printed ones.
Solution: Check your printer settings and be sure they're set for custom setting with an 850 by 550 size. When

completed, be sure to change settings back to previous setting.
 

 Problem: Past due notice does not print for a particular account.



Technical Information 362

Copyright Multi-Financial Services Company, Inc. 2012©

 Solution: Check account and be sure it is past due and past it's grace period.  Although it may be past due, a notice
won't print until the grace period has past.

27.10 Network Problems
 

 

 

As of Version 1.1.0, all networks including Window 95 and 98, Microsoft NT, and Novell are fully supported by your
loan-servicing package.  Below are some solutions to some commonly asked network questions; however, if any problem
persists, contact us at:  850-559-9123.  Please review Technical FAQ for more information.

 

Problem:  I request a report, it spools, but nothing prints to my network printer.
 

Solution: Try ending and recapturing the printer.  If this does not work, log off of your network and then log back on.  This
may require for you to reboot your computer.

 

 

Problem:  Can't print anything or perform an EDI link
 

Solution:  Check to see if all rights have been assigned in a network situation also try reassigning rights, e.g., the
printer(s) and/or program on the workstation and not on server or vice versa.  Naturally make sure the printer is turned on,
there's a supply of paper, and the printer cable is connected to both the computer and printer correctly.

 

 

Problem:  The program crashes and gives an illegal operation message on a network system.
 

Solution:   The network card may be defective.  Have someone check the "packets" being sent out using appropriate
monitoring equipment and software by a qualified technician.  

 

 

Problem:  The program doesn't seem to keep the Custom Fees, Escrow Settings, and just about any other setting that I
set.

 

Solution:   This only occurs from a workstation that is using the program that is located on a server or another
workstation that is sharing the program, and is not setup properly.  Please review our section on Networking and Workstation
Setup to make sure that your computer is properly configured.  If these sections do not assist you in resolving your issue
please feel free to contact our Help Desk.

 

27.11 Program Security
 

 

Introduction
As a rule, your loan-servicing program relies on three levels of security.  First level is with your network system to provide

overall security on gaining access to the program.  Systems, such as Microsoft's NT©/2000© and Novel©, provide access to
individual people within a typical company usually on a Read-Only or Read and Write security access.  The second level of
protection is within the program, which prevents actual data from being changed manually by the user.  The data files that
the program uses to store each of your client's information are encrypted in binary files.

 
The third level of security modified in Version 2.0 involves the use of a login screen.  After a user logs in to the program

certain sections of the program, which have been previously password protected, will now be accessible if your company's
Administrator has allowed access to that section.  This change allows a user to login once instead of multiple times when
using the program.  Sections which security can be "locked" out are:

 
· User Administrator
· Purging Accounts
· Adding to or Removing from a Loan's Balance
· Adding or Removing fees and/or Past Due fees
· Modifying the Days Per Year basis on Interest bearing accounts
· Adding or Removing Borrowers from an account
· Modifying an accounts Appraisal and Collateral information
· Modifying an accounts Interest Rate or Payment amount
· Setting the ability to Suppress Credit Data
· Adding or Removing the printing of Late Notices
· Viewing of a borrower's Credit Information

 
 
Others will be added over time in response to our user's needs and willingness to accept responsibility for changes made

to vital data. 

Assigning Passwords And Authorizations
Your company needs to first designate a person(s) to be assigned the responsibility to be the program's Administrator

(typically, someone who will have the ability to perform all secured functions).  Also more than one person may be assigned
this task in case one person was out sick, on vacation, etc. The Administrator then authorizes others to perform tasks.  
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Setup first Administrator by:
 
· Choose System/Options
· Choose Administer Users
· Enter information requested

Setting up users who will be authorized to perform one or more secured functions:
 
· Administrator is the only one who can authorize others so they need to sign into the Administer Users function
· Choose System/Options
· Choose Administer Users
· Enter Name and Password
· Choose Add and allow the new user to enter their name and password
· Administrator indicates the authorities granted and chooses OK
 

Administering Users

Editing user authorities:
 
· The Administrator is the only person who can edit users
· Choose System/Options
· Choose Administer Users
· Enter Name and Password
· Highlight the user's name and choose Edit
· Edit information and choose OK

27.12 Networking
 

The directions below should direct you through creating a location in which the program will reside on a network.  If you
encounter any problems please feel free to contact our Help Desk staff at 850-559-9123.

 

· NT4/2000/Novell Server setup requirements
 

Create a directory for the program to reside  IE: VOL_1\MFS
 

Set user accounts to have all rights except Administrator to this directory, any subdirectory, and all files located
within.

 

 

· Windows 95/98/2000/ME Peer to Peer Network setup requirements
 

Install the program from the workstation using the directions below.
 

Double click on "My Computer"
 

Double click on "C:"
 

Right click on "MFS"
 

Click on "Sharing"
 

Click on "Share As"
 

Click on "Full"
 

Click on "OK"
 

 
 

· Program Network Install Instructions
Windows 95/98/2000/ME/NT4/2000/Novell Server Side Setup
 

From a workstation download the software from our website (if using a diskette for installations please make the proper
adjustments).

 

Double click on the file you downloaded 
 

Downloaded filename may differ if you changed it during the download process
 

The default name is: trakkerdemo.exe
 

It will prompt you to unzip the setup file to a temporary location
 

The default location is: C:\MFS
 

You can change this if you wish
 

After the unzip process is completed, locate the folder you extracted the files to and double click on Setup.exe
 

Follow the directions until you get to the "Install location"
 

At this point you will want to redirect the install to put the files on your server.
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You can do this by either typing in the location or by clicking on "Browse" and locating the destination.
 

Follow the rest of the directions until it finishes.
 

 

For workstation setup, please refer to our Workstation Setup section.

27.13 Workstation Setup
 

 

The directions below should answer any questions you have regarding the setup of an additional workstation on your
network.  Please note that this does not include "How To" network your PC, nor does it get into any detail as to how to create
users, modify network settings, or any other "Technical" issue.  The following assumes that your network is already setup
and the computers can connect to and "see" each other via your network.

 

 

Any questions regarding how to setup users or how to attach your computer to your network should be directed to your
technical support for your company or outside consulting group.

 

Additional Workstation Setup (Directions for either setup)
 

· Map a drive to the location of the software
 

To do this double click on "Network Neighborhood"
 

Double click on "Entire Network"
 

Double click on the group or tree 
 

Double click on the server or PC that the software resides on
 

Double click on the volume that the software is stored in
 

Locate the directory that you stored (or plan to store) the software in.
 

IE: MFS
 

Right click on that directory
 

Click on "Map Network Drive"
 

Choose a drive letter that is not currently in use
 

If mapped properly when you click on the mapped drive you should see the MFS folder
 

The folder itself not the contents.
 

 

· Copying required files
 

There is only one file currently required.
 

From a workstation:
 

Double click on "My Computer"
 

Double click on the drive that is mapped to the remote location of the MFS software
 

Locate the files "ROBOEX32.DLL" and "INETWH32.DLL"
 

Note:  You may or may not see the "DLL" on the file.
 

Single click on this file(s)
 

Click on "Edit"
 

Click on "Copy"
 

Go back to your local hard drive by double clicking on "C:"
 

Double click on "Windows"
 

Double click on "System32"
 

Click on "Edit"
 

Click on "Paste"
 

27.14 Errors
27.14.1 Custom Letter Errors

 

Remember that for this topic and with other topics pertaining to customizing letters, a variable is a field that is
entered into the letter to provide variant information. For example, to insert a borrowers name into a letter without having to
type it every time for different borrowers the variables would be ~first_name~ ~last_name~.

Common Errors
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1) Error – After creating a custom letter and trying to print, the screen displays an error message "Bad Character in OVL

File".
     Analysis – This message appears when a variable name has been entered incorrectly.
    Solution – Using the Help File Topic Custom Letters Available Fields verify the entry of each variable used in the letter.
 
2) Error – When a custom letter is printed the variables show up as printed text instead of having the values desired.
     Analysis – When variables show "as typed" instead of with the values desired usually this means that the tildes (~)

have not been placed before and after the variable name.
    Solution – Open the CUSTOM(X).OVL file in question and verify that each variable has a tilde (~) before and after the

desired variable.
 
3) Error – After creating several custom letters and trying to print them, two of the letters print on the same page.
     Analysis – When two or more custom letters are created they must be separated by a carat (^). This is what tells the

program that they are separate letters and are not to be printed together.
    Solution – Open the CUSTOM(X).OVL file in question and insert a carat (^) on a line between the two letters. Be sure

to do a File, Save so that your changes are saved.
 
4) Error – After creating a custom letter and attempting to print it out nothing prints on the page.
     Analysis – Normally when a blank page comes out the carat (^) is missing from the opening line of the OVL file.
    Solution – Open the CUSTOM(X).OVL file in question and insert a carat (^) on the line above the very first letter.
 
5) Error – After opening the CUSTOM(X).OVL file with Word or Word Perfect, making changes to the file, then trying to

print a letter the screen displays the message "Unable To Open OVL File".
    Analysis – The CUSTOM.OVL files are an ASCII tab delimited file that must be viewed and modified using Notepad.  If

they are associated as Word or Word Perfect documents they will not be recognized by the Trakker program.
   Solution – To repair this error takes several steps:
    1) Navigate to the MFS folder on the host computer (the host is the computer that houses the Trakker program).
   2) Go to View on the Menu Bar and choose Folder Options.
   3) In the Folder Options dialog box click on the File Types tab. Locate the OVL File in the list box.
   4) Click on OVL File and then click Remove. You will receive a prompt asking if you are sure you wish to remove this.
   5) Click Yes. Close the Folder Options dialog box.
   6) Double click the CUSTOM(X).OVL file and when the Open With dialog box appears choose Notepad from the list.
 

27.14.2 Receipt Letter Errors
 

 

 

Common Errors
 
1)After posting a payment and choosing "OK-Receipt" there are incorrect amounts shown for the next payment due on the

Receipt Letter.
 
  Analysis – When working to make customizations in the LETTERS.OVL file variable names can sometimes be changed

to incorrect values. This is also an error in versions prior to Version 1.6.0 where the variable used gave incorrect totals of the
next payment due.

 
2)  Suspect incorrect variable
 
   a) From the MFS folder that houses the program open the LETTERS.OVL file using NOTEPAD (you must always use

NOTEPAD when viewing or editing any of the OVL files.  Using WORD OR WORD PERFECT can cause corruption of the
OVL file.)

 
   b) Once the LETTERS.OVL file is open scroll down until you locate the Receipt Letter.
 
   c) In the line "Your next payment is due ~due_date~ in the amount of" verify that the variable following is

~total_next_due~. Make sure to include the tildes (~) in the variables or else they will simply print on the letters as plain text.
 
   d) After changing the variable click File then Save to save your changes.
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27.14.3 Error 100 or 101
 

 

 

Problem – When running a report (normally an Account Summary or a Delinquency) screen displays an Error 100/101
message and system freezes. 

 
Analysis – Usually caused by incorrect data entries in new loans. Most errors in entry are found in the MORTGOR.DTA,

NEXTDUE.IDX or (year).DTA files. These errors can also occur when an account has been purged under the following
circumstances:

  a)  Another user is in the program at the time account was purged.
  b)  A new loan is entered immediately after purging an account and before the program was closed then reopened.

 
Solution – To be done after pressing, CTRL+ALT+DEL to bring up the Task Manager, then highlighting the program and

clicking "END TASK" to close the program:
  1) If an account has been recently purged.
        i. Re-purge the account to clean out any residual information.
        ii. Purge the new loan that was set up and close the program.
        iii. Open the program and reenter the new loan.
   2) For suspect errors in the MORTGOR.DTA, NEXTDUE.IDX or (year).DTA files.
 
        i. Perform a Data Out using the Convert Data utility.
        ii. Verify the Begin Service Date is not before the Loan Closing Date or that invalid dates are not entered into

any of the date fields.

The second type of error cannot be corrected directly through the program. For help in correcting these errors contact our 
Help Desk.

27.14.4 Delinquency Report Errors
 
 

When performing the difficult task of collections accurate reports are vital. Following the steps below easily
solves most errors with the Delinquency report.

Common Errors
1)  Account known to be past due is not appearing on the Delinquency Report.
This error is similar to a common error with the Account Summary Report. If the Begin Service Date of the

account is later than the Report Date used when executing the account then it will not appear on the report. Also
the days used to determine the parameters for a Delinquency Report are exclusive, meaning they are NOT
included in the report.

 
2)  Suspected incorrect Begin Service Date:
Perform the Convert Data utility. Once the files have been converted the Begin Service Date can be viewed in

the MORTGOR.ATA file. If the Begin Service Date is set after the date that the report was ran the account will
either have to be purged and reentered or leave the account as is until the Report Date is the same as or later
than the Begin Service Date.

 
3)  Incorrect Parameters Defined
 In the "past due more than" line enter a number one (1) less than the actual days requested (i.e.- if accounts

more than 15 days delinquent are requested enter 14). In the "less than" line enter a number one (1) greater
than the actual days requested (i.e. – if accounts less than 90 days delinquent are requested enter 91). For
reports where any account greater than 15 days delinquent is requested enter 9999 in the "less than" line.

 
4)  When trying to run the Delinquency Report the screen displays the error message "Error 101/100"
Please Refer To: Error 100 or 101 
 

27.14.5 Incorrect Payoff Amounts
 

Borrowers may send in, from time to time, incorrect payoff amounts. The following lists how Trakker can be used to
handle these errors.

Common Errors

1) Error – Borrower has sent in a payoff that is less than the calculated payoff in the program.
    Analysis – This is a management decision as to whether or not to accept the amount sent.
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    Solution - If payoff is to be accepted
                                a. Calculate payoff normally 
                                b. Enter in amount sent
                                c. When prompted, enter in the amounts you wish applied to late fees and interest
                                d.Choose Ok. Loan is now Paid Off
    If payoff is not to be accepted
                                a. Post amount sent to the Suspense account
                                b. Contact Borrower
2) Error – Borrower has sent in a payoff that is greater than the calculated payoff in the program.
    Analysis – Again another management decision on whether to post the amount or contact the borrower. Usually  there

is a set dollar amount that is not sent back to the borrower if they are over (such as an over payment of $.25).
    Solution – Process the payoff in normal fashion and enter the amount received.
 
Program will automatically place the overage into the Suspense account and then the refund can be handled according to

Office Policy concerning over payments.

If a refund check is to be issued (in accordance with Office Policy) then go to Post, Debit Suspense to remove the
overage monies from the suspense account. Notes can also be added to the contact log under History, Contact to help
create a better "paper trail".
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Existing Loans:converting     234
Experian     36, 101, 344
Exporting     22
EXTENSION PAYMENTS     113, 262
Extra Principal Payment     100
EXTREMELY IMPORTANT     360
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F2     22
F4     22
F5     22
Fannie Mae     19, 109, 117, 208, 337
FAQ s     354
FASB     350
Fax     45
Fax Numbers     45
FEDERAL TAX ID     49, 54, 330
Federal Trade Commission
 www.ftc.gov/os/statutes/fcrajump.htm     101
FEES     80, 88, 97
FIELDS  WHICH MAY OR MAY NOT BE THE SAME
AS THE PRIOR INFORMATION     151
FILE FORMAT     151
File Importer     153
Final Payment     76
Final Screen     49, 54
FINISH     49, 54
FINISH:loan     49, 54
First     49, 54
First Name     49, 54
Flat Dollar Fee     49, 54
FNMA     19, 109, 117, 208

FNMA Report     208
FNMA Reporter     26
FONT     226
FONT:WITHIN     226
Fonts     226
Fonts:Changing     226
FORM 4802 TRANSMITTAL     330
FORM 4804 TRANSMITTAL OF INFORMATION
RETURNS     330
Forms Ordering     358
Forms Ordering Section     344

- G -
General Information     80, 97
General Ledger     180
General Login     362
Generate     264, 329
Generation     49, 54, 80, 97
Global Parameters     32, 200
Grant Reduction     100

- H -
Handling Escrow     107
HANDLING ESCROW FOR     107
Hardware     13
Hazard Insurance     76, 80, 105, 329
Hazard Insurance Due     329
Help Desk     3, 232, 254, 359, 360
Help file     49, 54, 337, 344
Helpful Hints     113, 262
HISTORICAL     174, 234
History     22, 80
History Screen     96
How To     364
How to Generate A Credit Reporting File     264
HOW TO GET STARTED     14
How:Generate     36
HP     80
HUD AGGREGATE ESCROW ANALYSIS     256
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I.R.S.     80, 97, 178, 344
I.R.S. Form Filing     211
ID     97, 342
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IE     363
Illegal Operation     361, 362
Important Dates     145, 146, 205
IMPORTANT DATES INFORMATION     146, 205
Important Dates/Database     145
Important Due Dates     329
IMPORTANT PAST DUE NOTICE     216
Importers     24
Importing     174
Importing Escrow Information     172
importing Loans     173
Incorrect Payoff Amounts     366
INCORRECT POSTING     100
Increase/decrease     350
Increase/decrease:requests     350
Individual     49, 54
INETWH32.DLL     364
Information     76, 101, 264
INFORMATION RETURNS     330
In-House     76
Inkjet     358
Inputting:Collection Codes     20
Instructions     15, 38, 224, 363
Instructions on Loan Defaults     42
Insurance     105
Insurance Due     76
Insurance Due dates     329
Insurance Fees     100
Interest     49, 54, 80, 254
INTEREST ACCRUALS     350
Interest Basis     49, 54, 97
Interest Bearing     49, 54
Interest Bearing accounts     97
Interest Bearing/Simple Interest     49, 54, 88, 100,
254, 350
Interest Bearing/Simple Interest:accruing     350
INTEREST CALCULATIONS ON LOAN BALANCE
CHANGES     100
Interest Calulation     116, 125, 129, 132
Interest Change     220
INTEREST COLLECTED FOR     330
Interest Computation     269
Interest History Report     343
Interest Incurred     97
Interest Only Loan     116
Interest Paid     97, 178, 181, 342
INTEREST PAID REPORT     181
INTEREST PAID SUMMARY REPORT     188, 329

Interest Rate     49, 54, 97, 329
Interest Rate #1 - Sample     207, 329
Interest Rate #1 Report     207
INTEREST RATE CHANGE LETTER     329
Interest Type     22
Interest:Accrual     254, 350
Internal Policies     344
International Business Machine Corporation     8
Introduction     362
Investor     80, 97, 103, 136, 139
Investor Account     103
Investor Accounts     139
INVESTOR RELATIONSHIP     80, 136
Investor Reporting     136
Investors     142
IRS     146, 211, 330, 342
IRS Efile     342
IRS Filing     211
IRS FORM 4804     330
IRS Form Filing     211
IRS TAX FILING     212
IRS.001     211
IRS's Martinsburg Computing Center     211
IRSTAX.001     212
ITALIC     226
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Large payments     89
Larger Than Normal Payment     89
Last Name     49, 54
Last payment     49, 54
Last Payment Received     49, 54, 123, 269
Late     22, 49, 54, 146
Late Fee     42, 49, 54, 80, 97
LATE FEES DUE REPORT     182, 192, 196, 197,
239, 329
Late Letter Report     178, 264
Late Notice     20, 146, 195, 238
Legal Fees     80, 97
Lender     22, 49, 54, 344
Lender Information     14, 19
Letters     22, 49, 54, 80, 329
Letters Overlay Variables     113, 262
LETTERS.OVL     113, 262
Letters.ovl file     226
Line of Credit Draw     123
List     22
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Loan     22, 45, 88, 178
Loan Balance     22, 49, 54
Loan Class Code     49, 54
Loan Class Code Screen     49, 54
Loan Class Codes     80, 97, 258, 342, 344
Loan Closing Date     49, 54
Loan Defaults     42, 49, 54
Loan Import Report     344
Loan Officer     45
Loan Portfolios     232
Loan Pre-paid interest     49, 54
Loan Type     22, 42, 49, 54, 269, 344
Loan Wizard     344
Loan:Post     22
LOAN'S BALANCE     100
LOANS TO YOUR COMPANY BY AN INVESTOR    
136
LOC Draw     123
Locator Number     45
log     97
Login     344
LOS     337
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M.F.S     8
MAIN BORROWER     76
Main Screen     19, 178, 264
Main Screen System/Utilities     242
Main Toolbar     145
Maintenance Balance     269
Maintenance Fee     107
Maintenance Fees     100
Management Reports     22
Map Network Drive     364
Market Index     125, 129
Market Indexes - Setup & Updating     40
MDA Reporter     26
Memo     45
Method     89
Metro2     264
MFS\DATAOUT     242
Microsoft Corporation     8
Microsoft NT     362
Microsoft s NT©/2000©     362
Misc     146
Misc Database     20
MISCELLANEOUS DATABASE     146

MODIFIED SUSPENSE REPORT     350
Modifying     362
Money Order     80
Month/Year     80
Multi Financial Services     8
Multi Investor     282
Multi-Investor     103, 136, 139, 282
Multiple Account Import File Example     155
Multiple Accounts     155
Multiple Imports     155
Multiple Investors     136
My Computer     361, 363, 364
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Name     45, 80, 97
Naming     49, 54
Network     355, 361, 362, 363, 364
Network Install Instructions     363
Network Neighborhood     364
Network Platforms     13
Network Problems     362
Network Setup     344
Network Troubleshooting     344
Networking     363
Networks including Window 95     362
New accounts     80
New Features     342, 344
NEW LENDER     19
New Loan     22, 24, 49, 54, 107, 139, 184
New Loan Wizard     344
New Loan Worksheet     274
New Loan:Entering     22
New Sections     344
Next     49, 54
Next Due Dates     22, 49, 54, 76
Next Payment Due     269
NLW Date Scheduled     281
Non Escrow     80
Non Performing Loan     123
Non Sufficient Funds     80
Non-Cash Transactions     100
Non-Escrow Account     49, 54
NOT     49, 54
Notice Printing     232
Notices     108
Novel©     362
Novell     362, 363
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Novell  Server Side Setup     363
Novell Server     363
NSF     76, 80
NSF Fees     76
NT4     363
Number     45, 97
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ODBC     355
ODBC Compliancy     259
OFF SITE     360
Open Database Connectivity     355
Open Loan Accrual Totals     254
Operating System     13
Original     49, 54
Original Balance     49, 54, 76
Original:sets     49, 54
Origination Program     49, 54
OS     13
Other Contacts     49, 54, 80, 97, 342
Other Contacts:Adding     49, 54
Other Escrow     145
Other Fees     80
Our Support Staff     331, 344, 355, 359
Our Support Staff:Submit Your Data     344, 359
Outside Investor     136
Overage     89, 94
Overage To Suspense     89

- P -
Paet Due #3     217
Paid     97
Paid Interest     49, 54
Parameter Options     14, 24, 36, 39, 80, 97
Parameters     38, 42, 45, 80, 97, 235
Password     29
Passwords     362
PAST DUE     49, 54, 88
Past Due #2     217
Past Due Amounts     49, 54
Past Due Fees     192, 197, 269
Past due Notices     234
Pastdue     22, 76, 232, 234, 235, 254, 358
Pastdue Fees     100, 350
Pastdue Fees Column     350

Pastdue Fees Column:Borrower Screen     350
PASTDUE NOTICE     216, 329
Pastdue Notices     22, 113, 262, 264
PASTDUE NOTICES AND 10-DAY BRING
CURRENT LETTER     108
Pastdue Notices:Printing     22
Pastdue:reversing     100
Payment Basis     49, 54
payment codes     76, 89, 250
Payment Frequency     22
Payment History     22, 80, 173, 174
Payment History Screen     22
Payment History:Reviewing     22
Payment Penalty     49, 54
Payment Period     49, 54, 80, 97, 269
Payment processing     80
PAYMENT RECEIPT     218, 329
Payment Received     49, 54
Payment Schedule     132
Payment Summary     113, 178, 262, 342, 344
Payment Summary Report     22, 100, 180, 186, 329,
332, 342, 343, 344, 361
Payment Summary Report - Investor Due Sample    
187
Payments     22, 38, 42, 49, 54, 76, 89, 94, 97, 178
Payments:Percent     49, 54
Payments:Posting     22
Payoff     22, 80, 103, 282, 329
PAYOFF LETTER     220, 329
PAYOFF LETTERS     113, 262
Payor     146
Payor Fee     146
PC     364
PE     80
Peer Network     363
Peer Network:Windows 95/98/2000/ME Peer     363
Pending Insurance Due Report     207, 329
Pending Insurance Due Report - Sample     205, 329
Per Diem     179
Percent     49, 54, 97
Percent Of Balance     42, 49, 54
Percent Of Payment     42, 49, 54, 80, 97
Percent:Balance     49, 54
Percent:Payment     49, 54
PERFORMING TRANSACTIONS     100
Period     49, 54, 76, 80
Permissions     29
Permitted Days Late     42
Please READ THE MANUAL     331
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Points     49, 54
Points Paid     49, 54
Points Paid button     49, 54
Portfolio     101, 269
Post     22, 76, 80, 88, 89, 94
Post To Suspense     80, 94
Post:Contact Information     22
Post:Loan     22
Post:Payment     22
Posting Errors     76, 80
Posting order     88
Posting Payment short     337
Posting Payments     24
Postings     22, 88
Postings:Suspense Account     22
Pre Payment Penalty     49, 54
Pre Payment Penalty / Past Due Amounts     49, 54
Prepaid / Credit / YTD Interest     49, 54
Prepaid Interest     49, 54, 80, 97
PRE-PAID INTEREST     76
Prepaid Interest AND     49, 54
Pre-paid/credit     254
Prepaid/Credit Interest     49, 54
PREPARING FOR CHANGING     100
PREPARING FOR CHANGING:LOAN'S BALANCE  
  100
PREPARING FOR INPUTTING OF INVESTOR
RELATED LOANS     136
Pre-Payment Penalty     80, 97, 344
Pressing     49, 54
Pressing:Select     49, 54
Primary     49, 54
Principal     49, 54, 76, 80, 89, 94, 97
Principal Only payment     89
Principle Payments     92
Print     13, 22, 96
PRINT AMORTIZATION SCHEDULE     198
PRINT BRING CURRENT RECOMMENDATION
REPORT     264
PRINT COLLECTION CALL REPORT     264
PRINT COLLECTION CODE REPORTS     264
Print Contact log     96
PRINT COUPONBOOKS     32, 200, 202
Print Payoff Letter     22
PRINT SPOOLER     361
Printer     17
Printers     361, 362
Printing     22, 108, 113, 232, 262, 361

PRINTING ADDRESS LABELS AND MULTIPLE
COLUMN LABELS     350
PRINTING INVESTOR RELATED COUPONBOOKS
    136
PRINTING INVESTOR REPORTS     136
Printing:Bring Current Recommendation     232
Printing:Collection Call     232
Printing:pastdue     232
Printing:Pastdue Notices     22
Printouts     49, 54
Problem     331, 355, 361, 362, 363
procedures     14
PROCEDURES FOR INPUTTING HISTORICAL
INFORMATION FOR AN IMMEDIATE ESCROW
ANALYSIS     107
Processing     80, 97
Program     14, 42, 45, 49, 54, 101, 331, 362, 363
PROGRAM CHANGES     350
Program FAQ     344, 354
Program FAQ s     354
PROGRAM FEATURES     26
Program Problems     358
Program Security     80, 97, 101, 344, 355, 362
Program Troubleshooting     358
Program:List     49, 54
Program:login     362
Properties     361
Properties/Details/Spooler Settings     361
Purge Account     242
Purge Log     342
Purging Accounts     22

- Q -
Question     36, 331, 355, 362, 364
Questions     101
QUICK REFERENCE     22
Quick Reference Section     22

- R -
RAM     13
RATE     49, 54, 76, 329
Receipt Letter Errors     365
Receive     76, 89
RECENT PAYMENT MADE     329
Record     49, 54, 76
Record Number     49, 54
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Record:SSN     49, 54
Reg Amort     120
Regular Amortizing     49, 54, 88, 100, 254, 350
Regular Amortizing account     76
Regular Amortizing loans     49, 54, 76
Regular Payment     89
Remaining     88
Remote Backup Capabilities     337
Removing     362
Removing Borrowers     362
Reopen Account     80, 97
Report     179, 180, 181, 183, 184
Report Manager     193
Reporter     15, 24, 178, 224, 232, 235, 264, 329
Reporter Letters     228
Reporter Option     337
Reporter/Collection System     234
Reporter/Collection System:choosing     234
Reporting     36, 146
Reporting File     344
Reporting Information     80, 97, 101, 344
Reporting Setup     344
Reports     14, 22, 49, 54, 80, 97, 101, 178, 179, 181,
182, 193, 195, 196, 212, 234, 235, 236, 238, 239,
254, 329, 342, 355, 361
Reports take     361
Reposted     88
REQUESTING     331
RETAINS TITLE AND OWNERSHIP     5
Return Check     219
RETURN CHECK NOTICE     329
Returned     76
Returned Check Fee     80, 97
Reverse Bad Check Fee     96
Reverse Borrower Fee     100
Reverse Fee     100
Reverse Fees     80, 97
Reversing     100
REVERSING BALANCE CHANGES FOR LOAN
AND PASTDUE FEES     100
Reversing:pastdue     100
Review     24, 76
Review/Lender/New     19
Reviewing     22
Reviewing:Account     22
Reviewing:Payment History     22
Rights     342
ROBOEX32.DLL     364
ROUNDING ERRORS     254

Running The Program     24, 331

- S -
Sales     3
Sales Department     3, 22
SAMPLE     178, 188, 190, 192, 197, 329
SAMPLE LETTERS     216, 329
Sample Loans - Regular Account     272
Sample Notice     178
SAMPLE REPORTS     146, 205, 329
Schedule     125
Screen     45, 76
Screen:Pre-Payment Penalty     80
Secondary     49, 54
Security     97, 344, 362
Security Authority     350
See     76
Select     49, 54
Select Overage/Adjust     80
Select:pressing     49, 54
Selecting Your Lender     49, 54
Service     49, 54
Service Fee     42, 49, 54, 80, 97, 337, 344
Servicer     14
Set     49, 54
Setting Custom Letter Names     15, 224
Setting Loan Defaults     49, 54
Setting Up Escrow Reserve     39
Setting Up Loan Defaults     42
SETTING UP YOUR NEW INVESTOR RELATED
LOANS     136
Setting Up Your System For Credit Reporting     36
Setting:Custom Fees     38
Setup Wizard     344
Sharing     363
Shorter Than Normal Payment     89
Simple Interest     76, 80, 97, 116, 120, 269, 350
Simple Interest:printed     350
Single Account Import File Example     153
Single Balloon payment     121
single payment     121
Site Id     80, 97
Software     45, 360, 362, 363, 364
Special Topics     22
SPECIFIC LEGAL RIGHTS     5
SSN     49, 54
SSN:record     49, 54
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ST     76
STATE TO STATE     5
Status     76, 101
Steps     14
STEPS IN SETTING UP AN INVESTOR RELATED
LOAN     136
Straight loan     49, 54
Sub Account     103, 139
Subdirectory     363
Sub-investor     89, 136
Sub-Investor Loan     89, 136
SUBLICENSE     5
Submit your data     344
Submit Your Data To Our Support Staff     359
Substitute     142
Substitute Investors     142
SUMMARY OF AGING REPORT     191, 194, 237
Supply Forms Order Sheet     331
Support@thetrakker.com     359
Suppress     362
Suspense     76, 80, 89, 94, 183, 342, 344, 350
Suspense Account     22, 76, 178, 342
Suspense Account Summary     178, 183, 329, 342
SUSPENSE ACCOUNT SUMMARY REPORT    
192, 329
Suspense Account:postings     22
SUSPENSE BALANCE     76
Suspense History     22
Suspense Report     350
SUSPENSE TRANSFER     76
System     14, 24, 49, 54, 76, 97, 178, 235, 264, 344,
362, 364
System Operator     14
System Parameters     232, 234, 235
System Parameters:Bring Current Letters     232
System Parameters:Defining     232
System/Operator     80

- T -
Table     49, 54
Table Of Contents     49, 54
Tax     80, 178
Tax filing     97, 178
TAX FORM 1098-SERVICER'S     330
Taxes     105
TCC     211, 212
Tech Support     3, 232, 254, 359, 360

Tech Support Staff     359
Technical     36, 331, 344, 355, 362, 363, 364
Technical FAQ     344, 355, 362
Technical support     3, 331, 364
Technical Support Form     331, 357
Technical Support Request Form     344
Term     49, 54, 76
Text     45
Text Editor     216
Text/numeric     45
The Borrower     76
The Borrower Screen     76
THE BORROWER'S TOOL BAR     76
THE LICENSEE     5
TO     49, 54
Tool Bar     76
Top     49, 54, 76, 80
Top portion     76
Total Accrual     179
Total Interest Paid     179
TRADEMARKS     8
Transaction     178
Transactions     76, 80
TRANSFER EXISTING LOANS     151
Transfer From Suspense     80, 94
Transmitter Control Code     211
Transmitting Report     208
Transunion     36, 101, 264
Trans-Union     344
TWO-MONTH RESERVE     105
TX DATE     76
Type     49, 54, 76, 269
TYPE ACCOUNT     76
Type:Borrower     49, 54
Type:payment     80
Type:set     49, 54
Types 0f Payments     80
Types Of Payments     89

- U -
Up Data Files     360
Up Data Files:Backing     360
Upgrades     344
Use     49, 54, 76
User Defined     97
User Defined Fields     45, 80, 97, 344
Users     49, 54, 76, 362, 363, 364
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Users:Administering     362
USING CUSTOM LETTERS     223
USING THE IMPORTANT DATE FUNCTION     145
Utilities     178, 242, 355
Utilize     94, 344
Utilize:Suspense account     80
Utilizes     254
Utilizes:Account Summary     254
Utilizing     94
Utilizing The Miscellaneous Database     146
Utilizing The Suspense Account     76, 80, 94

- V -
Variable     125, 129, 132
Variable Interest     125, 129, 132, 269, 283, 337
Variable Loans     125
Variable Rate     125, 129, 132
VERIFYING FEDERAL TAX I.D     211
Version     36, 362
Version 1.1.0     362
VERSION 1.4.0  AS OF 8/12/99     350
Version 1.5.0 As Of 1/24/00     348
Version 2.0     32, 36, 42, 200, 342, 344, 362
Version 2.0.1     343
Version 2.0.2     342
Version 2.0.4     342
Version 2.0.5     342
Version 2.0.6     342
Version 2.0.7     341
Version 2.1.0     340
Version 2.2.0     337
Version 2.2.0:Escrow Maintence Account     337
VI  PRINTING COUPON BOOKS FOR SIMPLE
INTEREST LOANS     350
View Contact     96
View/edit     76
Visible     49, 54
VOID     100
Void Last Payment     76

- W -
WARNING     49, 54
WARRANTY     5
Web Site Links     101
Website     363

Welcome     3
What s New In Version 1.x.x     346
Windows     49, 54, 361, 362, 363, 364
Windows 95/98/2000/ME Peer     363
Work     49, 54
Worksheet     282
Workstation Setup     344, 355, 362, 363, 364
www.acb-credit.com     36
www.equifax.com     36
www.experian.com     36
www.thetrakker.com     358
www.transunion.com     36

- X -
XML     151
XML ARM     168
XML Escrow     170
XML Format     160
XML import     151
XML Importer     160
XML Standard     166

- Y -
Year End Statement     188
Year End Summary Report     342
Year file     173
Yearly History     180
Yearly History Statement to Borrower     180
Yearly Report     180
Yes     49, 54

- Z -
Zip     76
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